
COMPUTER 
APPLICATIONS FOR 
MANAGERS



Book: Computer Applications for Managers
(Lumen)



This text is disseminated via the Open Education Resource (OER) LibreTexts Project (https://LibreTexts.org) and like the hundreds
of other texts available within this powerful platform, it is freely available for reading, printing and "consuming." Most, but not all,
pages in the library have licenses that may allow individuals to make changes, save, and print this book. Carefully
consult the applicable license(s) before pursuing such effects.

Instructors can adopt existing LibreTexts texts or Remix them to quickly build course-specific resources to meet the needs of their
students. Unlike traditional textbooks, LibreTexts’ web based origins allow powerful integration of advanced features and new
technologies to support learning. 

The LibreTexts mission is to unite students, faculty and scholars in a cooperative effort to develop an easy-to-use online platform
for the construction, customization, and dissemination of OER content to reduce the burdens of unreasonable textbook costs to our
students and society. The LibreTexts project is a multi-institutional collaborative venture to develop the next generation of open-
access texts to improve postsecondary education at all levels of higher learning by developing an Open Access Resource
environment. The project currently consists of 14 independently operating and interconnected libraries that are constantly being
optimized by students, faculty, and outside experts to supplant conventional paper-based books. These free textbook alternatives are
organized within a central environment that is both vertically (from advance to basic level) and horizontally (across different fields)
integrated.

The LibreTexts libraries are Powered by NICE CXOne and are supported by the Department of Education Open Textbook Pilot
Project, the UC Davis Office of the Provost, the UC Davis Library, the California State University Affordable Learning Solutions
Program, and Merlot. This material is based upon work supported by the National Science Foundation under Grant No. 1246120,
1525057, and 1413739.

Any opinions, findings, and conclusions or recommendations expressed in this material are those of the author(s) and do not
necessarily reflect the views of the National Science Foundation nor the US Department of Education.

Have questions or comments? For information about adoptions or adaptions contact info@LibreTexts.org. More information on our
activities can be found via Facebook (https://facebook.com/Libretexts), Twitter (https://twitter.com/libretexts), or our blog
(http://Blog.Libretexts.org).

This text was compiled on 03/07/2025

https://libretexts.org/
https://www.nice.com/products
mailto:info@LibreTexts.org
https://facebook.com/Libretexts
https://twitter.com/libretexts
http://blog.libretexts.org/


1 https://biz.libretexts.org/@go/page/48835

TABLE OF CONTENTS

2.1: About This Course

Licensing

2.2: Course Contents at a Glance

3: Faculty Resources
1.1: Faculty Resources Overview
1.2: Pacing
1.3: Offline Content Access
1.5: Assignments

1: Introduction to Computers
1.1: Why It Matters- Introduction to Computers
1.2: Introduction to Computer Concepts
1.3: Hardware
1.4: Software
1.5: Security
1.6: Privacy
1.7: Introduction to Operating Systems
1.8: Identifying Your Operating System (OS)
1.9: Introduction to Navigate Programs
1.10: Managing Windows
1.11: Keyboard Shortcuts
1.12: Introduction to Finding Programs and Files
1.13: Start Menu
1.14: Creating Files and Folders
1.15: Organizing Files and Folders
1.16: Deleting Files and Folders
1.17: Introduction to File Management
1.18: Local Files
1.19: Network Files
1.20: Online Files
1.21: Introduction to Snips and Screenshots
1.22: Snips and Screenshots
1.23: Putting It Together- Intro to Computers
1.24: Assignment- Download Files
1.25: Assignment- Identify Your OS
1.26: Assignment- Empty the Recycle Bin
1.27: Discussion- Computers vs. Smartphones

2: Internet Research
2.1: Why It Matters- Internet Research
2.2: Introduction to Using and Searching the Internet
2.3: Internet Browsers
2.4: Basic Browser Tools
2.5: Introduction to Ethical Business Research

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/04:_2.1:_About_This_Course
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/04:_Licensing
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/05:_2.2:_Course_Contents_at_a_Glance
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/06:_3:_Faculty_Resources
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/06:_3:_Faculty_Resources/1.01:_Faculty_Resources_Overview
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/06:_3:_Faculty_Resources/1.02:_Pacing
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/06:_3:_Faculty_Resources/1.03:_Offline_Content_Access
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/00:_Front_Matter/06:_3:_Faculty_Resources/1.05:_Assignments
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.01:_Why_It_Matters-_Introduction_to_Computers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.02:_Introduction_to_Computer_Concepts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.03:_Hardware
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.04:_Software
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.05:_Security
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.06:_Privacy
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.07:_Introduction_to_Operating_Systems
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.08:_Identifying_Your_Operating_System_(OS)
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.09:_Introduction_to_Navigate_Programs
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.10:_Managing_Windows
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.11:_Keyboard_Shortcuts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.12:_Introduction_to_Finding_Programs_and_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.13:_Start_Menu
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.14:_Creating_Files_and_Folders
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.15:_Organizing_Files_and_Folders
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.16:_Deleting_Files_and_Folders
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.17:_Introduction_to_File_Management
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.18:_Local_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.19:_Network_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.20:_Online_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.21:_Introduction_to_Snips_and_Screenshots
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.22:_Snips_and_Screenshots
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.23:_Putting_It_Together-_Intro_to_Computers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.24:_Assignment-_Download_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.25:_Assignment-_Identify_Your_OS
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.26:_Assignment-_Empty_the_Recycle_Bin
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/01:_Introduction_to_Computers/1.27:_Discussion-_Computers_vs._Smartphones
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.01:_Why_It_Matters-_Internet_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.02:_Introduction_to_Using_and_Searching_the_Internet
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.03:_Internet_Browsers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.04:_Basic_Browser_Tools
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.05:_Introduction_to_Ethical_Business_Research


2 https://biz.libretexts.org/@go/page/48835

2.6: Ethical Research
2.7: Data and Customer Rights
2.8: Introduction to Basic Searches
2.9: Web Searching
2.10: Identifying Search Results
2.11: Opening Search Results
2.12: Introduction to Advanced Searches
2.13: Adjusting Search Parameters
2.14: Image Searches
2.15: Putting It Together- Internet Research
2.16: Assignment- Search the Internet
2.17: Discussion- Search Results
2.18: Discussion- Personal Data and Ethical Business Use

3: Microsoft Word Basic Skills
3.1: Why It Matters- Microsoft Word Basic Skills
3.2: Introduction to Using Word
3.3: Creating a New Blank Document and Finding Your Way Around
3.4: Saving Files
3.5: File Extensions
3.6: Introduction to Basic Text Formatting
3.7: Selecting and Moving Text
3.8: Bold, Italics, Underline
3.9: Fonts
3.10: Alignment, Justification, and Indentation
3.11: Line and Paragraph Spacing
3.12: Introduction to Workspace Tools
3.13: Spell Check and Dictionaries
3.14: Find and Replace
3.15: Introduction to Lists
3.16: Lists
3.17: Putting It Together- Microsoft Word Basic Skills
3.18: Assignment- Create Basic Document
3.19: Discussion- Paragraph Styles

4: Microsoft Word Intermediate Skills
4.1: Why It Matters- Microsoft Word Intermediate Skills
4.2: Introduction to Page Layout
4.3: Tab Stops
4.4: Columns
4.5: Headers and Footers
4.6: Introduction to Text Boxes
4.7: Text Boxes
4.8: Introduction to Tables
4.9: Creating Tables
4.10: Converting Text to a Table
4.11: Formatting Tables
4.12: Introduction to Images
4.13: Adding Images
4.14: Text Wrap
4.15: Introduction to Hyperlinks

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.06:_Ethical_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.07:_Data_and_Customer_Rights
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.08:_Introduction_to_Basic_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.09:_Web_Searching
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.10:_Identifying_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.11:_Opening_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.12:_Introduction_to_Advanced_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.13:_Adjusting_Search_Parameters
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.14:_Image_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.15:_Putting_It_Together-_Internet_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.16:_Assignment-_Search_the_Internet
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.17:_Discussion-_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/02:_Internet_Research/2.18:_Discussion-_Personal_Data_and_Ethical_Business_Use
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.01:_Why_It_Matters-_Microsoft_Word_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.02:_Introduction_to_Using_Word
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.03:_Creating_a_New_Blank_Document_and_Finding_Your_Way_Around
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.04:_Saving_Files
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.05:_File_Extensions
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.06:_Introduction_to_Basic_Text_Formatting
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.07:_Selecting_and_Moving_Text
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.08:_Bold_Italics_Underline
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.09:_Fonts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.10:_Alignment_Justification_and_Indentation
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.11:_Line_and_Paragraph_Spacing
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.12:_Introduction_to_Workspace_Tools
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.13:_Spell_Check_and_Dictionaries
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.14:_Find_and_Replace
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.15:_Introduction_to_Lists
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.16:_Lists
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.17:_Putting_It_Together-_Microsoft_Word_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.18:_Assignment-_Create_Basic_Document
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/03:_Microsoft_Word_Basic_Skills/3.19:_Discussion-_Paragraph_Styles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.01:_Why_It_Matters-_Microsoft_Word_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.02:_Introduction_to_Page_Layout
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.03:_Tab_Stops
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.04:_Columns
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.05:_Headers_and_Footers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.06:_Introduction_to_Text_Boxes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.07:_Text_Boxes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.08:_Introduction_to_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.09:_Creating_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.10:_Converting_Text_to_a_Table
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.11:_Formatting_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.12:_Introduction_to_Images
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.13:_Adding_Images
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.14:_Text_Wrap
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.15:_Introduction_to_Hyperlinks


3 https://biz.libretexts.org/@go/page/48835

4.16: Hyperlinks
4.17: Putting It Together- Microsoft Word Intermediate Skills
4.18: Assignment- Create Document with Tables and Images
4.19: Discussion- Cover Pages

5: Microsoft Word Advanced Skills
5.1: Why It Matters- Microsoft Word Advanced Skills
5.2: Introduction to Advanced File Creation and Text Formatting
5.3: Creating a New Document from a Template
5.4: Text Effects
5.5: Introduction to Watermarks and Icons
5.6: Watermarks
5.7: Icons in Word
5.8: Introduction to Citations
5.9: Citations
5.10: Introduction to Mail Merge
5.11: Mail Merge
5.12: Introduction to Internet and Word
5.13: Internet and Word
5.14: Putting It Together- Microsoft Word Advanced Skills
5.15: Assignment- Edit a Newsletter
5.16: Discussion- Advanced Shortcuts

6: Microsoft Excel Basic Skills
6.1: Why It Matters- Microsoft Excel Basic Skills
6.2: Introduction to Using Excel
6.3: Creating a New Workbook
6.4: Entering Data
6.5: Introduction to Basic Formatting and Layout
6.6: Table Styles
6.7: Cell Styles
6.8: Cell Format
6.9: Comma Styles
6.10: Rearranging Tables
6.11: Changing Width of Columns and Rows
6.12: Introduction to Using Multiple Worksheets
6.13: Creating a Workbook with Multiple Worksheets
6.14: Putting It Together- Microsoft Excel Basic Skills
6.15: Assignment- Organize Sales Data
6.16: Discussion- Merging and Centering Cells

7: Microsoft Excel Intermediate Skills
7.1: Why It Matters- Microsoft Excel Intermediate Skills
7.2: Introduction to Using Excel for Data Analysis
7.3: Sorting Data
7.4: Filtering Data
7.5: Functions
7.6: Introduction to Automating Data Entry
7.7: Flash Fill
7.8: SUM Data
7.9: Simple Math

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.16:_Hyperlinks
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.17:_Putting_It_Together-_Microsoft_Word_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.18:_Assignment-_Create_Document_with_Tables_and_Images
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/04:_Microsoft_Word_Intermediate_Skills/4.19:_Discussion-_Cover_Pages
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.01:_Why_It_Matters-_Microsoft_Word_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.02:_Introduction_to_Advanced_File_Creation_and_Text_Formatting
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.03:_Creating_a_New_Document_from_a_Template
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.04:_Text_Effects
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.05:_Introduction_to_Watermarks_and_Icons
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.06:_Watermarks
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.07:_Icons_in_Word
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.08:_Introduction_to_Citations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.09:_Citations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.10:_Introduction_to_Mail_Merge
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.11:_Mail_Merge
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.12:_Introduction_to_Internet_and_Word
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.13:_Internet_and_Word
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.14:_Putting_It_Together-_Microsoft_Word_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.15:_Assignment-_Edit_a_Newsletter
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/05:_Microsoft_Word_Advanced_Skills/5.16:_Discussion-_Advanced_Shortcuts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.01:_Why_It_Matters-_Microsoft_Excel_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.02:_Introduction_to_Using_Excel
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.03:_Creating_a_New_Workbook
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.04:_Entering_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.05:_Introduction_to_Basic_Formatting_and_Layout
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.06:_Table_Styles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.07:_Cell_Styles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.08:_Cell_Format
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.09:_Comma_Styles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.10:_Rearranging_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.11:_Changing_Width_of_Columns_and_Rows
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.12:_Introduction_to_Using_Multiple_Worksheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.13:_Creating_a_Workbook_with_Multiple_Worksheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.14:_Putting_It_Together-_Microsoft_Excel_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.15:_Assignment-_Organize_Sales_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/06:_Microsoft_Excel_Basic_Skills/6.16:_Discussion-_Merging_and_Centering_Cells
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.01:_Why_It_Matters-_Microsoft_Excel_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.02:_Introduction_to_Using_Excel_for_Data_Analysis
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.03:_Sorting_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.04:_Filtering_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.05:_Functions
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.06:_Introduction_to_Automating_Data_Entry
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.07:_Flash_Fill
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.08:_SUM_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.09:_Simple_Math


4 https://biz.libretexts.org/@go/page/48835

7.10: Introduction to Graphics
7.11: Graphics
7.12: Modify Graphics
7.13: Format Graphics
7.14: Introduction to Charts
7.15: Charts
7.16: Clustered Column Charts
7.17: Chart Styles
7.18: Putting It Together- Microsoft Excel Intermediate Skills
7.19: Assignment- Analyze Yearly Trends
7.20: Discussion- Hard Return within a Cell

8: Microsoft Excel Advanced Skills
8.1: Why It Matters- Microsoft Excel Advanced Skills
8.2: Introduction to Sparklines
8.3: Sparklines
8.4: Introduction to More Formatting and Layout
8.5: Conditional Formatting
8.6: Viewing a Worksheet
8.7: Introduction to Pivot Tables
8.8: Pivot Tables
8.9: Introduction to Macros
8.10: Macros
8.11: Recording a Macro
8.12: Introduction to Statistical Functions and Formulas
8.13: What is a Function?
8.14: Lookup Functions and Formulas
8.15: Logical Functions and Formulas
8.16: Financial Functions and Formulas
8.17: Introduction to Add-Ins
8.18: Add-Ins
8.19: Introduction to Internet and Excel
8.20: Internet and Excel
8.21: Putting It Together- Microsoft Excel Advanced Skills
8.22: Assignment- Create Macro for Car Loan Spreadsheet
8.23: Discussion- Excel Worksheet as a Webpage

9: Microsoft PowerPoint Basic Skills
9.1: Why It Matters- Microsoft PowerPoint Basic Skills
9.2: Introduction to Creating Presentations
9.3: New Presentations
9.4: Themes
9.5: Introduction to Using PowerPoint
9.6: Editing a Presentation
9.7: Organizing Slides
9.8: Views
9.9: Introduction to Objects in PowerPoint
9.10: Text Boxes
9.11: Images and Clip Art
9.12: SmartArt
9.13: Arranging Objects

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.10:_Introduction_to_Graphics
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.11:_Graphics
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.12:_Modify_Graphics
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.13:_Format_Graphics
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.14:_Introduction_to_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.15:_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.16:_Clustered_Column_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.17:_Chart_Styles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.18:_Putting_It_Together-_Microsoft_Excel_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.19:_Assignment-_Analyze_Yearly_Trends
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/07:_Microsoft_Excel_Intermediate_Skills/7.20:_Discussion-_Hard_Return_within_a_Cell
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.01:_Why_It_Matters-_Microsoft_Excel_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.02:_Introduction_to_Sparklines
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.03:_Sparklines
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.04:_Introduction_to_More_Formatting_and_Layout
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.05:_Conditional_Formatting
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.06:_Viewing_a_Worksheet
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.07:_Introduction_to_Pivot_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.08:_Pivot_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.09:_Introduction_to_Macros
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.10:_Macros
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.11:_Recording_a_Macro
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.12:_Introduction_to_Statistical_Functions_and_Formulas
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.13:_What_is_a_Function
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.14:_Lookup_Functions_and_Formulas
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.15:_Logical_Functions_and_Formulas
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.16:_Financial_Functions_and_Formulas
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.17:_Introduction_to_Add-Ins
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.18:_Add-Ins
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.19:_Introduction_to_Internet_and_Excel
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.20:_Internet_and_Excel
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.21:_Putting_It_Together-_Microsoft_Excel_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.22:_Assignment-_Create_Macro_for_Car_Loan_Spreadsheet
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/08:_Microsoft_Excel_Advanced_Skills/8.23:_Discussion-_Excel_Worksheet_as_a_Webpage
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.01:_Why_It_Matters-_Microsoft_PowerPoint_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.02:_Introduction_to_Creating_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.03:_New_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.04:_Themes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.05:_Introduction_to_Using_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.06:_Editing_a_Presentation
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.07:_Organizing_Slides
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.08:_Views
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.09:_Introduction_to_Objects_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.10:_Text_Boxes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.11:_Images_and_Clip_Art
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.12:_SmartArt
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.13:_Arranging_Objects


5 https://biz.libretexts.org/@go/page/48835

9.14: Grouping Objects
9.15: Putting It Together- Microsoft PowerPoint Basic Skills
9.16: Assignment- Present Sales Information
9.17: Discussion- Infographics and Custom Shapes

10: Microsoft PowerPoint Intermediate Skills
10.1: Why It Matters- Microsoft PowerPoint Intermediate Skills
10.2: Introduction to Transition Effects
10.3: Transition Effects
10.4: Introduction to Headers and Footers
10.5: Headers and Footers
10.6: Introduction to Videos in PowerPoint
10.7: Inserting Videos in PowerPoint
10.8: Embedding Videos in PowerPoint
10.9: Uploading Videos in PowerPoint
10.10: Introduction to Lists
10.11: Creating Lists
10.12: Modifying Lists
10.13: Putting It Together- Microsoft PowerPoint Intermediate Skills
10.14: Assignment- Create a New Presentation
10.15: Discussion- Making a PowerPoint Presentation into a Video

11: Microsoft PowerPoint Advanced Skills
11.1: Why It Matters- Microsoft PowerPoint Advanced Skills
11.2: Introduction to Colors
11.3: Color Themes
11.4: Custom Color Themes
11.5: Introduction to Tables in PowerPoint
11.6: Create Tables
11.7: Format Tables
11.8: Modify Tables
11.9: Introduction to Animations in PowerPoint
11.10: Animations in PowerPoint
11.11: Introduction to Charts in PowerPoint
11.12: Create Charts
11.13: Format Charts
11.14: Modify Charts
11.15: Introduction to Customized PowerPoint Template
11.16: Customized PowerPoint Templates
11.17: Introduction to Internet and PowerPoint
11.18: Internet and PowerPoint
11.19: Putting It Together- Microsoft PowerPoint Advanced Skills
11.20: Assignment- Modify Existing PowerPoint Presentations
11.21: Discussion- Ten Extra Tips for PowerPoint

12: Microsoft Access Basic Skills
12.1: Why It Matters- Microsoft Access Basic Skills
12.2: Introduction to Creating Database Tables
12.3: Creating a Database
12.4: Naming Databases
12.5: Creating an Access Table

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.14:_Grouping_Objects
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.15:_Putting_It_Together-_Microsoft_PowerPoint_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.16:_Assignment-_Present_Sales_Information
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/09:_Microsoft_PowerPoint_Basic_Skills/9.17:_Discussion-_Infographics_and_Custom_Shapes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.01:_Why_It_Matters-_Microsoft_PowerPoint_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.02:_Introduction_to_Transition_Effects
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.03:_Transition_Effects
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.04:_Introduction_to_Headers_and_Footers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.05:_Headers_and_Footers
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.06:_Introduction_to_Videos_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.07:_Inserting_Videos_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.08:_Embedding_Videos_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.09:_Uploading_Videos_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.10:_Introduction_to_Lists
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.11:_Creating_Lists
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.12:_Modifying_Lists
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.13:_Putting_It_Together-_Microsoft_PowerPoint_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.14:_Assignment-_Create_a_New_Presentation
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/10:_Microsoft_PowerPoint_Intermediate_Skills/10.15:_Discussion-_Making_a_PowerPoint_Presentation_into_a_Video
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.01:_Why_It_Matters-_Microsoft_PowerPoint_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.02:_Introduction_to_Colors
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.03:_Color_Themes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.04:_Custom_Color_Themes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.05:_Introduction_to_Tables_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.06:_Create_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.07:_Format_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.08:_Modify_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.09:_Introduction_to_Animations_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.10:_Animations_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.11:_Introduction_to_Charts_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.12:_Create_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.13:_Format_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.14:_Modify_Charts
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.15:_Introduction_to_Customized_PowerPoint_Template
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.16:_Customized_PowerPoint_Templates
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.17:_Introduction_to_Internet_and_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.18:_Internet_and_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.19:_Putting_It_Together-_Microsoft_PowerPoint_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.20:_Assignment-_Modify_Existing_PowerPoint_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/11:_Microsoft_PowerPoint_Advanced_Skills/11.21:_Discussion-_Ten_Extra_Tips_for_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.01:_Why_It_Matters-_Microsoft_Access_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.02:_Introduction_to_Creating_Database_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.03:_Creating_a_Database
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.04:_Naming_Databases
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.05:_Creating_an_Access_Table


6 https://biz.libretexts.org/@go/page/48835

12.6: Introduction to Fields in Access
12.7: Field Properties
12.8: Field Names and Data Types
12.9: Introduction to Table Primary Key
12.10: Primary Key
12.11: Set a Primary Key
12.12: Introduction to Indexes
12.13: What is an Index?
12.14: To Index or Not to Index?
12.15: Putting It Together- Microsoft Access Basic Skills
12.16: Assignment- Create New Access Database
12.17: Discussion- Selecting Primary Key Tips

13: Microsoft Access Intermediate Skills
13.1: Why It Matters- Microsoft Access Intermediate Skills
13.2: Introduction to Table Relationships
13.3: Database Principles
13.4: Flat File vs Normalized Data
13.5: Types of Table Relationships
13.6: Introduction to Working with Tables
13.7: Datasheets
13.8: Entering Data
13.9: Changing Values
13.10: Introduction to Working with Datasheets
13.11: Adding Values and Records in Datasheets
13.12: Deleting Records in Datasheets
13.13: Introduction to Sorting and Filtering Data
13.14: Displaying Records in Datasheets
13.15: Sorting Data
13.16: Aggregating Data
13.17: Printing Records
13.18: Putting It Together- Microsoft Access Intermediate Skills
13.19: Assignment- Modify Access Database
13.20: Discussion- Moving Columns and Fields

14: Microsoft Access Advanced Skills
14.1: Why It Matters- Microsoft Access Advanced Skills
14.2: Introduction to Importing and Exporting Data
14.3: External Data
14.4: Import and Export Options
14.5: Introduction to Queries
14.6: What Are Queries?
14.7: Adding Criteria to a Query
14.8: Saving Queries
14.9: Introduction to Forms and Reports
14.10: Understanding Forms
14.11: Creating Basic Forms
14.12: Form Controls and Views
14.13: Presenting Data on Reports
14.14: Introduction to Analyzing Data
14.15: Transforming Data

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.06:_Introduction_to_Fields_in_Access
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.07:_Field_Properties
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.08:_Field_Names_and_Data_Types
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.09:_Introduction_to_Table_Primary_Key
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.10:_Primary_Key
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.11:_Set_a_Primary_Key
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.12:_Introduction_to_Indexes
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.13:_What_is_an_Index
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.14:_To_Index_or_Not_to_Index
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.15:_Putting_It_Together-_Microsoft_Access_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.16:_Assignment-_Create_New_Access_Database
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/12:_Microsoft_Access_Basic_Skills/12.17:_Discussion-_Selecting_Primary_Key_Tips
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.01:_Why_It_Matters-_Microsoft_Access_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.02:_Introduction_to_Table_Relationships
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.03:_Database_Principles
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.04:_Flat_File_vs_Normalized_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.05:_Types_of_Table_Relationships
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.06:_Introduction_to_Working_with_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.07:_Datasheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.08:_Entering_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.09:_Changing_Values
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.10:_Introduction_to_Working_with_Datasheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.11:_Adding_Values_and_Records_in_Datasheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.12:_Deleting_Records_in_Datasheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.13:_Introduction_to_Sorting_and_Filtering_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.14:_Displaying_Records_in_Datasheets
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.15:_Sorting_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.16:_Aggregating_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.17:_Printing_Records
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.18:_Putting_It_Together-_Microsoft_Access_Intermediate_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.19:_Assignment-_Modify_Access_Database
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/13:_Microsoft_Access_Intermediate_Skills/13.20:_Discussion-_Moving_Columns_and_Fields
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.01:_Why_It_Matters-_Microsoft_Access_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.02:_Introduction_to_Importing_and_Exporting_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.03:_External_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.04:_Import_and_Export_Options
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.05:_Introduction_to_Queries
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.06:_What_Are_Queries
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.07:_Adding_Criteria_to_a_Query
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.08:_Saving_Queries
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.09:_Introduction_to_Forms_and_Reports
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.10:_Understanding_Forms
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.11:_Creating_Basic_Forms
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.12:_Form_Controls_and_Views
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.13:_Presenting_Data_on_Reports
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.14:_Introduction_to_Analyzing_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.15:_Transforming_Data


7 https://biz.libretexts.org/@go/page/48835

14.16: Understanding Calculations
14.17: Using Conditional Analysis
14.18: Using Subqueries
14.19: Understanding Domain Aggregation
14.20: Putting It Together- Microsoft Access Advanced Skills
14.21: Assignment- Create Queries for Access Database
14.22: Discussion- Ways to Manage Access Tables

15: Integration
15.1: Why It Matters- Integration
15.2: Introduction to Using Word with Excel and PowerPoint
15.3: Customized Word Templates
15.4: Excel Table in Word Document
15.5: Excel Chart in Word Document
15.6: PowerPoint in Word Document
15.7: Introduction to Using PowerPoint with Excel
15.8: Excel Table in PowerPoint
15.9: Excel Chart in PowerPoint
15.10: Introduction to Integrating Access
15.11: Access and Mail Merge
15.12: Excel Table from Access Data
15.13: Access Data from Excel Table
15.14: Putting It Together- Integration
15.15: Assignment- Create Mail Merge Letters
15.16: Discussion- Audio Integration

16: Resources- Capstone Assignment
16.1: Assignment- Create Capstone Presentation

17: Ancillary Materials
17.1: PowerPoint Presentations

Index

Glossary

Detailed Licensing

https://libretexts.org/
https://biz.libretexts.org/@go/page/48835?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.16:_Understanding_Calculations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.17:_Using_Conditional_Analysis
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.18:_Using_Subqueries
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.19:_Understanding_Domain_Aggregation
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.20:_Putting_It_Together-_Microsoft_Access_Advanced_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.21:_Assignment-_Create_Queries_for_Access_Database
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/14:_Microsoft_Access_Advanced_Skills/14.22:_Discussion-_Ways_to_Manage_Access_Tables
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.01:_Why_It_Matters-_Integration
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.02:_Introduction_to_Using_Word_with_Excel_and_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.03:_Customized_Word_Templates
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.04:_Excel_Table_in_Word_Document
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.05:_Excel_Chart_in_Word_Document
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.06:_PowerPoint_in_Word_Document
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.07:_Introduction_to_Using_PowerPoint_with_Excel
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.08:_Excel_Table_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.09:_Excel_Chart_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.10:_Introduction_to_Integrating_Access
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.11:_Access_and_Mail_Merge
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.12:_Excel_Table_from_Access_Data
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.13:_Access_Data_from_Excel_Table
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.14:_Putting_It_Together-_Integration
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.15:_Assignment-_Create_Mail_Merge_Letters
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/15:_Integration/15.16:_Discussion-_Audio_Integration
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/16:_Resources-_Capstone_Assignment
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/16:_Resources-_Capstone_Assignment/16.01:_Assignment-_Create_Capstone_Presentation
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/17:_Ancillary_Materials
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/17:_Ancillary_Materials/17.01:_PowerPoint_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/zz:_Back_Matter/10:_Index
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/zz:_Back_Matter/11:_Glossary
https://biz.libretexts.org/Courses/Lumen_Learning/Book:_Computer_Applications_for_Managers_(Lumen)/zz:_Back_Matter/30:_Detailed_Licensing


2.1.1 https://biz.libretexts.org/@go/page/46393

2.1: About This Course
This course is aimed at beginning to intermediate computer users. It teaches a range of computer skills from the basics of using
Windows, to basic internet literacy, to creating projects using Microsoft Office. Assignments show step-by-step visuals to help
students complete projects, and include integration across Microsoft Word, Excel, PowerPoint, and Access.

This course was developed by Lumen Learning in conjunction with Cerritos College, with contributing work from Sherri
Pendelton, Shelli Carter, and Robert Danielson, as well as videos from multiple sources.

Course Improvements
This new edition of Computer Applications for Managers includes improvements and enhancements including:

New learning outcomes in Module 2: Internet Research discussing ethical business research
Expanded and resequenced Microsoft Word modules
One new Microsoft Excel module and resequenced pre-existing Excel modules
One new Microsoft PowerPoint module and resequenced pre-existing PowerPoint modules
Three new Microsoft Access modules

Module 12: Microsoft Access Basic Skills
Module 13: Microsoft Access Intermediate Skills
Module 14: Microsoft Access Advanced Skills

Expansion of Module 15: Integration to include Microsoft Access

We believe in making continuous improvements to our courses in order to enhance and facilitate student learning. This newest
version of the course includes data-driven improvements to assessment questions and text content in order to better illustrate,
clarify, and evaluate concepts.

About Lumen
Lumen Learning’s mission is to make great learning opportunities available to all students, regardless of socioeconomic
background.

We do this by using open educational resources (OER) to create well-designed and low-cost course materials that replace expensive
textbooks. Because learning is about more than affordability and access, we also apply learning science insights and efficacy
research to develop learning activities that are engineered to improve subject mastery, course completion and retention.

If you’d like to connect with us to learn more about adopting this course, please Contact Us.

You can also make an appointment for OER Office Hours to connect virtually with a live Lumen expert about any question you
may have.
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2.2: Course Contents at a Glance

The following list shows a summary of the topics covered in this course. To see all of the course pages, visit the Table of Contents.

Module 1: Introduction to Computers
Computer Concepts
Operating Systems
Navigate Programs
Finding Programs and Files
File Management
Snips and Screenshots

Module 2: Internet Research
Using and Searching the Internet
Ethical Business Research
Basic Searches
Advanced Searches

Module 3: Microsoft Word Basic Skills
Using Word
Basic Text Formatting
Workspace Tools
Lists

Module 4: Microsoft Word Intermediate Skills
Page Layout
Text Boxes
Tables
Images
Hyperlinks

Module 5: Microsoft Word Advanced Skills
Advanced File Creation
Watermarks and Icons
Citations
Mail Merge
Internet and Word

Module 6: Microsoft Excel Basic Skills
Using Excel
Basic Formatting and Layout
Using Multiple Worksheets

Module 7: Microsoft Excel Intermediate Skills
Using Excel for Data Analysis
Automating Data Entry
Graphics
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Charts

Module 8: Microsoft Excel Advanced Skills
Sparklines
More Formatting and Layout
Pivot Tables
Macros
Statistical Functions and Formulas
Add-Ins
Internet and Excel

Module 9: Microsoft PowerPoint Basic Skills
Creating Presentations
Using PowerPoint
Objects in PowerPoint

Module 10: Microsoft PowerPoint Intermediate Skills
Transition Effects
Headers and Footers
Videos and Arranged Objects
Lists

Module 11: Microsoft PowerPoint Advanced Skills
Colors
Tables in PowerPoint
Animations in PowerPoint
Charts in PowerPoint
Customized PowerPoint Template
Internet and PowerPoint

Module 12: Microsoft Access Basic Skills
Creating Database Tables
Fields in Access
Table Primary Key
Indexes

Module 13: Microsoft Access Intermediate Skills
Table Relationships
Working with Tables
Working with Datasheets
Sorting and Filtering Data

Module 14: Microsoft Access Advanced Skills
Importing and Exporting Data
Queries
Forms and Reports
Analyzing Data

Module 15: Integration
Using Word with Excel and PowerPoint
Using PowerPoint with Excel
Integrating Access
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CHAPTER OVERVIEW

1: Introduction to Computers

Discuss basic computer concepts and definitions
Determine what operating system you have
Navigate programs
Locate and manage files and folders
Discuss proper file and folder management techniques in a variety of environments
Take a screenshot

1.1: Why It Matters- Introduction to Computers
1.2: Introduction to Computer Concepts
1.3: Hardware
1.4: Software
1.5: Security
1.6: Privacy
1.7: Introduction to Operating Systems
1.8: Identifying Your Operating System (OS)
1.9: Introduction to Navigate Programs
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1.1: Why It Matters- Introduction to Computers

Why learn how to use computers?

Almost every job in management uses computers in some capacity. Your ability to effectively use computers in day-to-day tasks
can be the difference between getting work done on time or being overwhelmed with your workload. Computers make many tasks
much more efficient. You may have to invest a little time up front to learn the skills, but once you gain some computer literacy you
will find many tasks much easier and faster to accomplish.

Here are just a few of the tasks in business management that use computers and the programs we will cover in this course:

keeping track of inventory
organizing and accessing databases of customer information
managing budgets
writing internal communication to other employees
designing presentations to shareholders, coworkers, or bosses
representing the company in communication to customers
coordinating multiple people’s schedules
searching the internet for useful information

In order to accomplish these tasks, you will first need to develop a foundation in basic computer literacy.
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1.2: Introduction to Computer Concepts

What you’ll learn to do: Discuss basic computer concepts and definitions

In this section we will explore the components that make up the personal computer. Of course, computer hardware alone is not
sufficient to power computers—software is required. We will break down the software necessary to support computing and learn
the difference between system software and application software.

We are all familiar with the power and convenience of connecting individual computers and mobile devices. We will discuss the
downside of being connected—information security and personal privacy. Finally, we will learn best practices in file management
and organization in three environments: local, network and online.
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1.3: Hardware

Discuss the role hardware plays in computing

Computer hardware (usually simply called hardware when a computing context is concerned) is the collection of physical elements
that constitutes a computer system. Computer hardware is the physical parts or components of a computer, such as the monitor,
mouse, keyboard, computer data storage, hard disk drive (HDD), graphic cards, sound cards, memory, motherboard, and so on, all
of which are physical objects that are tangible.

Mainboard
The motherboard is the main component of a computer. It is a large rectangular board with integrated circuitry that connects the
other parts of the computer including the CPU, the RAM, the disk drives (CD, DVD, hard disk, or any others) as well as any
peripherals connected via the ports or the expansion slots.

Components directly attached to or part of the motherboard include:

The CPU (Central Processing Unit) performs most of the calculations which enable a computer to function, and is sometimes
referred to as the “brain” of the computer. It is usually cooled by a heat sink and fan. Most newer CPUs include an on-die
Graphics Processing Unit (GPU).
The Chipset, which includes the north bridge, mediates communication between the CPU and the other components of the
system, including main memory.
The Random-Access Memory (RAM) stores the code and data that are being actively accessed by the CPU.
The Read-Only Memory (ROM) stores the BIOS that runs when the computer is powered on or otherwise begins execution, a
process known as Bootstrapping, or “booting” or “booting up.”
The BIOS (Basic Input Output System) includes boot firmware and power management firmware. Newer motherboards use
Unified Extensible Firmware Interface (UEFI) instead of BIOS.
Buses connect the CPU to various internal components and to expand cards for graphics and sound.
The CMOS battery is also attached to the motherboard. This battery is the same as a watch battery or a battery for a remote to a
car’s central locking system. Most batteries are CR2032, which powers the memory for date and time in the BIOS chip.

Storage

Computer data storage, often called storage, refers to computer components and recording media that retain digital data. Data
storage is a core function and fundamental component of computers. The price of solid-state drives (SSD), which store data on
flash memory, has dropped a lot in recent years, making them a better choice than ever to add to a computer to make booting up
and accessing files faster.

Fixed media

Data is stored by a computer using a variety of media. Hard disk drives are found in virtually all older computers, due to their high
capacity and low cost, but solid-state drives are faster and more power efficient, although currently more expensive than hard
drives, so are often found in more expensive computers. Some systems may use a disk array controller for greater performance or
reliability.

Removable media

To transfer data between computers, a USB flash drive or Optical disc may be used. Their usefulness depends on being readable by
other systems; the majority of machines have an optical disk drive, and virtually all have a USB port.
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Input and Output

Input and output devices are typically housed externally to the main computer chassis. The following are either standard or very
common to many computer systems.

Input

Input devices allow the user to enter information into the system, or control its operation. Most personal computers have a mouse
and keyboard, but laptop systems typically use a touchpad instead of a mouse. Other input devices include webcams, microphones,
joysticks, and image scanners.

Output device

Output devices display information in a human readable form. Such devices could include printers, speakers, monitors or a Braille
embosser.
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1.4: Software

Discuss the role software plays in computing

System Software
System software is computer software designed to operate and control the computer hardware and to provide a platform for running
application software. System software can be separated into two different categories, operating systems and utility software.

The operating system (prominent examples being Microsoft Windows, Mac OS X, Chrome OS, and Linux), allows the parts of
a computer to work together by performing tasks like transferring data between memory and disks or rendering output onto a
display device. It also provides a platform to run high-level system software and application software.

A kernel is the core part of the operating system that defines an API for applications programs (including some system
software) and an interface to device drivers.

Device drivers such as computer BIOS and device firmware provide basic functionality to operate and control the
hardware connected to or built into the computer.

A user interface “allows users to interact with a computer.” Since the 1980s, the graphical user interface (GUI) has been
perhaps the most common user interface technology. The command-line interface is still a commonly used alternative.

Utility software helps to analyze, configure, optimize and maintain the computer, such as virus protection.

https://assessments.lumenlearning.co...essments/18541

Additional Software

In contrast to system software, software that allows users to do things like create text documents, play games, listen to music, or
web browsers to surf the web are called application software. The line where the distinction should be drawn is not always clear.
Most operating systems bundle such software. Such software is not considered system software when it can be uninstalled without
affecting the functioning of other software.

Exceptions could be web browsers such as Internet Explorer, where Microsoft argued in court that it was system software that
could not be uninstalled. Later examples are Chrome OS and Firefox OS where the browser functions as the only user interface and
the only way to run programs (and other web browser cannot be installed in their place), then they can well be argued to be (part
of) the operating system and then system software.
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1.5: Security

Learning Outcomes
Discuss the importance of security in the business computing environment

A computer being secure depends on a number of technologies working properly. A modern operating system provides access to a
number of resources, which are available to software running on the system, and to external devices like networks via the kernel.

The operating system must be capable of distinguishing between requests which
should be allowed to be processed, and others which should not be processed. While some systems may simply distinguish between
“privileged” and “non-privileged,” systems commonly have a form of requester identity, such as a username. To establish identity
there may be a process of authentication. Often a username must be quoted, and each username may have a password. Other
methods of authentication, such as magnetic cards or biometric data, might be used instead. In some cases, especially connections
from the network, resources may be accessed with no authentication at all (such as reading files over a network share). Also
covered by the concept or equester identity is authorization; the particular services and resources accessible by the requester once
logged into a system are tied to either the requester’s user account or to the variously configured groups of users to which the
requester belongs.

In addition to the allow or disallow model of security, a system with a high level of security also offers auditing options. These
would allow tracking of requests for access to resources (such as, “who has been reading this file?”). Internal security, or security
from an already running program is only possible if all possibly harmful requests must be carried out through interrupts to the
operating system kernel. If programs can directly access hardware and resources, they cannot be secured.

External security involves a request from outside the computer, such as a login at a connected console or some kind of network
connection. External requests are often passed through device drivers to the operating system’s kernel, where they can be passed
onto applications, or carried out directly.

Why Does Security MatteR?

Security of operating systems has long been a concern because of highly sensitive data held on computers, both of a commercial
and military nature. The United States Government Department of Defense (DoD) created the Trusted Computer System Evaluation
Criteria (TCSEC) which is a standard that sets basic requirements for assessing the effectiveness of security. This became of vital
importance to operating system makers, because the TCSEC was used to evaluate, classify and select trusted operating systems
being considered for the processing, storage and retrieval of sensitive or classified information.

Network services include offerings such as file sharing, print services, email, web sites, and file transfer protocols (FTP), most of
which can have compromised security. At the front line of security are hardware devices known as firewalls or intrusion
detection/prevention systems. At the operating system level, there are a number of software firewalls available, as well as intrusion
detection/prevention systems. Most modern operating systems include a software firewall, which is enabled by default. A software
firewall can be configured to allow or deny network traffic to or from a service or application running on the operating system.
Therefore, one can install and be running an insecure service, such as Telnet or FTP, and not have to be threatened by a security
breach because the firewall would deny all traffic trying to connect to the service on that port.
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1.6: Privacy

Discuss the challenges to privacy in the business computing environment

Information privacy, or data privacy, is the relationship between collection and dissemination of data, technology, the public
expectation of privacy, and the legal and political issues surrounding them.

Privacy concerns exist wherever personally identifiable information or other sensitive information is collected and stored—in
digital form or otherwise. Improper or non-existent disclosure control can be the root cause for privacy issues. Data privacy issues
can arise in response to information from a wide range of sources, such as:

Healthcare records
Criminal justice investigations and proceedings
Financial institutions and transactions
Biological traits, such as genetic material
Residence and geographic records
Ethnicity
Privacy breach
Location-based service and geolocation

The challenge in data privacy is to share data while protecting personally identifiable information. The fields of data security and
information security design and utility software, hardware and human resources exist to address this issue. As the laws and
regulations related to Data Protection are constantly changing, it is important to keep abreast of any changes in the law and
continually reassess your compliance with data privacy and security regulations.

The Internet and Security

The ability to control the information one reveals about oneself over the Internet, and who can access that information, has become
a growing concern. These concerns include whether email can be stored or read by third parties without consent, or whether third
parties can continue to track the web sites someone has visited. Another concern is web sites which are visited collect, store, and
possibly share personally identifiable information about users.

The advent of various search engines and the use of data mining created a capability for data about individuals to be collected and
combined from a wide variety of sources very easily. The FTC has provided a set of guidelines that represent widely accepted
concepts concerning fair information practices in an electronic marketplace called the Fair Information Practice Principles.

Everything is accessible over the Internet nowadays. A major issue with privacy relates back to social networking. For example,
there are millions of users on Facebook, Twitter, and other social media platforms, and regulations have changed. People may be
tagged in photos or have valuable information exposed about themselves either by choice or most of the time unexpectedly by
others.

It is important to be cautious of what is being said over the Internet and what information is being displayed as well as photos
because this all can searched across the web and used to access private databases making it easy for anyone to quickly go online
and profile a person.
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1.7: Introduction to Operating Systems

What you’ll learn to do: determine what operating system you have.

Every computer has an operating system: put simply, this is the system that allows your computer to operate. It is important to
know which operating system your computer has because the steps to accomplish various tasks varies between operating systems.
Reading directions on how to change the desktop background in Windows 10 may not help you if you are running Windows XP,
and those directions will be useless if you are using a Mac. However, nearly all versions of Windows and macOS are capable of
doing the same things.
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1.8: Identifying Your Operating System (OS)

Determine what operating system you have.

An operating system (OS) is system software that manages computer hardware and software resources and provides common services for computer
programs. Nearly every computer program requires an operating system to function. The two most common operating systems are Microsoft Windows
and Apple’s macOS. This course’s main focus will be Windows 10 and 7.

Although this class will be focusing on Windows 10 and 7, the things you will learn in this module can be done by any version of Windows or macOS. If
you are not running Windows 10 or 7, you can find directions online by searching for the task you are trying to do and the name of your operating
system. (For example, you might search for “create folder windows vista.”)

Windows vs. Mac

Apple logo

To identify your operating system, start by narrowing down which brand of OS you have. Often you can determine whether you are running Windows or
macOS without even turning on your computer:

Is there an Apple logo somewhere on your computer?
Does your computer have a Command key (⌘) on the keyboard?
Was your computer purchased at an Apple store?

If the answer to any of those questions is yes, then you most likely have a computer that runs macOS.

Another good way to see whether you are running Windows or Mac is simply to turn the computer on. As the operating system boots up, it will display a
logo. A Windows logo means you are running Windows, while an Apple logo means you are running macOS.

If you have determined that you are running Windows, there are many methods to determine your specific operating system, not all of which are listed
here. It doesn’t matter which method you use; what’s important is figuring out which operating system you have. If one method doesn’t work, try
another.

Method 1

Press the Windows key (at the bottom of the keyboard, looks like four squares) and R key at the same time to open the Run dialog box. Type in “winver.”

Click OK. A window should open called About Windows that tells you which operating system you are using.
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This computer is using Windows 10.

Method 2
Open the Start menu by clicking the bottom left-hand corner of your screen. If you see a search text box, select it and then type “about” or “about your
pc.” If you do not see a search text box, then just start typing “about” or “about your pc.” Select About your PC. If you do not see About your PC, try a
different method.
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This computer is running Windows 10 Home Version 1607 with a 64-bit operating system.

Method 3
Open the Start menu by clicking the bottom left-hand corner of your screen. Right-click on Computer, then select Properties.
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This computer is running Windows 7 Professional with a 64-bit operating system.

Method 4
Open the Start menu by clicking the bottom left-hand corner of your screen.If you see a search text box, select it and then type “System Information” in
the search box. If you do not see a search text box, then just start typing “system” or “system information.” Select System Information under Programs. If
you do not see System Information, try a different method.
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This computer is running Windows 7 Professional with a 64-bit operating system.

Methods 2–4 also provide additional information on your computer that is useful for troubleshooting and determining what programs you will be able to
run. For example, many software programs have a version for a x32-based processor and another for a x64-based processor. For the purposes of this
course, you only need to know which edition of Windows you have.

https://assessments.lumenlearning.co...essments/18544

Contributors and Attributions
CC licensed content, Shared previously

definition of OS. Provided by: Wikipedia. Located at: https://en.Wikipedia.org/wiki/Operating_system. License: CC BY-SA: Attribution-ShareAlike

Public domain content
Apple logo. Provided by: Wikipedia. Located at: https://en.Wikipedia.org/wiki/File:Apple_logo_black.svg. License: Public Domain: No Known
Copyright

Lumen Learning authored content
Identifying Your Operating System (OS). Authored by: Lumen Learning. License: CC BY: Attribution

1.8: Identifying Your Operating System (OS) is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Practice Questions

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46410?pdf
https://assessments.lumenlearning.com/assessments/18544
https://en.wikipedia.org/wiki/Operating_system
https://creativecommons.org/licenses/by-sa/4.0
https://en.wikipedia.org/wiki/File:Apple_logo_black.svg
https://creativecommons.org/about/pdm
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/01%3A_Introduction_to_Computers/1.08%3A_Identifying_Your_Operating_System_(OS)
https://creativecommons.org/licenses/by/


1.9.1 https://biz.libretexts.org/@go/page/46411

1.9: Introduction to Navigate Programs

What you’ll learn to do: navigate programs

This section will help you interact with the programs on your computer. Knowing how to control windows and programs is
essential for multitasking and improving your workflow. We will also cover some terminology so you can better understand
instructions, both in this course and elsewhere.
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1.10: Managing Windows

Manage multiple windows

There are several terms that are commonly used in discussions about and instructions for computer use. This guide will define these common terms to help you read
instructions.

Desktop
Desktop refers to the main screen of the computer. It is the first screen you see after logging in. The desktop’s appearance can vary widely because it is highly customizable,
but generally desktops will feature a large image, icons, and a taskbar (covered later on this page).

The Windows 10 desktop.

The Windows 7 desktop.

Note that the word desktop is also used to refer to a desktop computer. A desktop computer is not portable (it stays on the desk) while a laptop computer is portable.

Window
A window is a viewing area that graphically displays a program so that the user can interact with it. A window is adjustable, so it can take up the entire screen or just part of
the screen. Note that this is a different term from the Windows operating system—Macs also have windows.

A Windows 7 window. A Mac window.

The look of windows varies by operating system and program. Not every program’s window will function the same. For example, many programs open in full screen by
default, so you will not see any of the window’s toolbars or buttons. Most windows have the same features, which we will cover here.
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Diagram of a Windows 10 window.
1. Menu bar. This toolbar contains various commands that often lead to dialog menus (covered later on this page). Windows computers have this bar at the top of

windows; Macs have this bar at the top of the screen instead. The options contained in this toolbar vary greatly from program to program.
2. Title bar. This shows the title of the program (in this case, Notepad) and has the minimize, maximize/resize, and close buttons. If the window is not maximized, you can

click and drag the title bar to move the window.
3. Minimize. Minimizing a program means making the program “collapse” into the taskbar. A minimized window is no longer visible but still running.
4. Maximize/resize. Clicking this button will maximize the window so it takes up the whole screen. If the window is already maximized, clicking this button will resize the

window to be smaller.
5. Close. This button closes the window.
6. Resize corner. Clicking and dragging this button will change the size of the window.

Working with Multiple Windows: Resizing

Resizing windows can help you see multiple windows at once, as shown below.
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Menu Bar and Dialog Menus

Clicking an option on the menu bar, such as File, opens a dialog menu that gives you more options to interact with the program.

A window with a dialog menu.
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Instructions in this course—and elsewhere—will often use shorthand to indicate how to get to a particular command through dialog menus. This shorthand separates phrases
that should be clicked with a > symbol. For example, the instructions for the screenshot above would be “File>Save.”

Taskbar
The taskbar runs at one edge of the screen, almost always the bottom. The taskbar is used to access the Start menu and currently running programs. Like the desktop, it is
very customizable.

Windows 10 taskbar
1. Start menu button. The appearance of the Start button varies between versions, but it is always the left-most button of the taskbar. The Start menu can also be opened by

pressing the Windows key ( ) on the keyboard.
2. Pinned programs. Programs can be pinned to the taskbar so that they are quicker to get to: you can open a pinned program simply by clicking on it. You can customize

which programs are pinned to the taskbar by opening a program, then right-clicking on the program’s taskbar icon and selecting “Pin to Taskbar.” You can also unpin
pinned programs by right-clicking the program’s icon and selecting “Unpin from Taskbar.”

3. Open (minimized) program. The icons of open programs will appear to the right of the pinned programs. In Windows 10, the blue line beneath the icon indicates the
program is minimized.

4. System tray. The system tray is on the right side of the taskbar. It displays the date and time and has icons that show helpful information related to computer and
program functions. The icons in the system tray vary widely from computer to computer depending on what programs are installed and what version of Windows you
have, so do not worry if your system tray does not match the screenshots in this course or your classmates’ system trays. In the screenshot above, from left to right in the
system tray:

Arrow. When clicked expands to show more system tray icons
Battery. This is a feature of laptop computers. Hover over the battery icon to see how much charge is left.
Network. This icon shows the status of your internet connection. In the screenshot above, the computer is connected to the internet with a cable; wireless connection
icons often look like a fan or a bar chart.
Sound. Clicking on the sound icon in the system tray allows you to change the volume or mute your computer.
Date/time.
Notification center. When your computer needs updates or has security notifications, those messages can be accessed here.
Show desktop. At the very far right side of the taskbar is a thin line. Clicking the sliver of the taskbar between that line and the edge of your screen will minimize all
programs. Hovering the mouse over that sliver of screen will allow you to “peek” at the desktop.

Note that Macs do not have a taskbar, but they do have a similar feature called the Dock.

Working with Multiple Windows: Taskbar

The taskbar can be very useful for multitasking. By clicking between the icons of two open windows on the taskbar, you can work in two different documents or programs at
once. Move your mouse over an icon to have a preview of the other window, then click on it to switch.

Hover to preview the program.

Click the icon on the taskbar to switch.
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1.11: Keyboard Shortcuts

Use keyboard shortcuts to perform tasks

A keyboard shortcut is a series of keys you can press to complete a computer command. As a common convention, keys that are
meant to be pressed at the same time are joined by a + in written text. For example, Ctrl+S means you should press the Ctrl and S
keys at the same time.

There are many, many keyboard shortcuts. However, you will probably only need to use a few. We will use many of these shortcuts
throughout the course.

These are a few of the most common shortcuts that you’ll use as you navigate your computer. There are both Windows and
Mac shortcuts listed. Note that Ctrl stands for the control key, and Cmnd stands for the command key.

Table 1. Common Keyboard Shortcuts

Command Windows Shortcut Mac Shortcut Explanation

Cut Ctrl+X Cmnd+X
Copies and removes an item or
text; used with Paste

Copy Ctrl+C Cmnd+C
Copies an item or text; used
with Paste

Paste Ctrl+V Cmnd+V
Inserts the last cut or copied
item or text

Select All Ctrl+A Cmnd+A Selects all text or items

Undo Ctrl+Z Cmnd+Z Undoes the last action

Redo Ctrl+Y Cmnd+Y Redoes the last thing undone

Task Manager/Force Quit Ctrl+Alt+Delete Cmnd+Opt+Esc
Opens Task Manager (see
note)

Close window Alt+F4 Cmnd+W

Closes window; (in Windows,
this command shuts down
computer if all windows are
closed)

New Ctrl+N Cmnd+N
Opens a new window, tab, or
document

Open Ctrl+O Cmnd+O Opens a file or document

Save Ctrl+S Cmnd+S Saves a file

Find Ctrl+F Cmnd+F

Opens search tools; in most
programs, opens a search box
to find specific words on a
page
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Note: Cut vs. Copy
Cut Copy

Cutting and copying can be used on files, folders, and text. Both are followed by the Paste command. So what’s the difference
between cutting and copying?

The cut command removes the selected data from its original position, while the copy command creates a duplicate; in both cases
the selected data is kept in a temporary storage tool called the clipboard. The data in the clipboard is later inserted in the position
where the paste command is issued. The data is available to any application supporting the feature, thus allowing easy data transfer
between applications.

Think of using scissors to cut out a line of text on a printed sheet of paper and pasting it onto another sheet of paper. The line is no
longer part of the original piece of paper when you cut it out. Now think of using a copy machine to copy the sheet of paper. The
line of text is still on the original sheet of paper.

Note: Task Manager/Force Quit

Task Manager/Force Quit (Ctrl+Alt+Delete or Command+Option+Esc) is a useful tool for terminating crashed programs or
shutting down a frozen computer. Task Manager interrupts whatever your computer is doing and allows you to shut down your
computer or access the Task Manager. The Task Manager shows every program currently being used and allows you to close
unresponsive programs or background tasks.

The Windows 10 Ctrl+Alt+Delete screen. (Click the image to
enlarge.)

Windows 10 Task Manager. To close a program, select the
program then click End task.
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Overview of Keys
Below is a diagram of the keyboard with some keys labeled. Do not be worried if your keyboard does not match the diagram or
does not have exactly the same keys.

Control Key

The control key, or Ctrl key, is essential to many common shortcuts. It does not do anything when pressed by itself, but when
pressed at the same time as other keys, it can modify the other key’s function.

Note: The Command Key

If you’re using a computer with Mac OS, you’ll most likely have a Command (Cmnd) key instead of a Ctrl key. In most keyboard
shortcuts, command will replace Ctrl (for example, on a Windows machine Ctrl+C copies, and on a Mac machine, Cmnd+C
copies).

There is also a control key on some Mac machines, but its function is entirely different. For now, you won’t need to worry about it.

Alt Key

The alt key, or alternate key, triggers an alternate use for keys. For example, many special characters (characters not commonly
found on the keyboard, such as ¿ or ¢) are available when pressing Alt and the right series of numbers. Like the control key, the alt
key is also essential to many common shortcuts.

Note: The Option Key

If you’re using a computer with Mac OS, you’ll most likely have an Option (Opt) key instead of a Alt key. In some keyboard
shortcuts, Opt will replace Alt, but the two are less directly related.

Windows Key

The Windows key (also known as Win key, start key, or home) causes the start menu to open. The logo may vary slightly from the
design in the diagram above. If the Windows key is missing, Ctrl+Esc can serve the same function.
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This logo was
used from 2012
to the present.

This logo was
used 2002–2012.

Menu Key

The menu key, or application key, is usually represented by a small icon depicting a pointer hovering above a menu. It is typically
found on the right side of the keyboard between the right Windows logo key and the right control key (or between the right alt key
and the right control key). The menu key is frequently omitted in the interest of space, particularly on portable and laptop
keyboards. The key’s primary function is to launch a context menu with the keyboard rather than with the usual right-mouse button.
It can be used when the right-mouse button is not present on a mouse.

Escape Key

The escape key, or Esc, is at the top-left corner of the keyboard. It can be used as a shortcut in dialog boxes to close programs.

Print Screen Key

The print screen key, or Prt Sc key, is used for taking screenshots. Pressing Prt Sc will take a snapshot of the entire screen, and
pressing Prt Sc+Alt will take a snapshot of just the currently selected window. The default save location of screenshots taken is
C:\Users\<user name>\Pictures\Screenshots.

Note: Print Screen on a Mac

If you’re using a computer with Mac OS, you most likely won’t have a print screen key. Instead, you can use one of the following
shortcuts:

Cmnd+Shift+3 will take a screenshot of your full screen
Cmnd+Shift+4 will bring up a crosshair and let you drag to select a portion of your screen to screenshot

https://assessments.lumenlearning.co...essments/18547

More Shortcuts (If You Really Want Them)

For a full list of Windows shortcuts, consult Microsoft’s list of shortcuts.

For a full list of Mac shortcuts, consult Apple’s list of shortcuts.
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1.12: Introduction to Finding Programs and Files

What you’ll learn to do: locate and manage files and folders.

As you use your computer to create and download files, it’s easy to become buried in a sea of tiny icons with vague names. Just as it is important to organize papers so that
you can find them later, it is important to organize your computer files by creating folders and putting files inside of them.

Failing to organizing your files makes it harder to find them later.
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1.13: Start Menu

Navigate the Start menu to locate programs, files, and settings.

The Start menu provides access to every program installed on the computer. To open the Start menu, click the the Start menu button at the bottom-left
corner of the screen or press the Windows key on the keyboard.

Windows 7 start menu

Windows 10 start menu

Frequently Used Programs

In Windows 7 and older operating systems, the most frequently used programs are listed in the left section of the Start menu, with the folder All
Programs near the bottom-left corner. The All Programs folder leads to every program installed on the computer. Windows 10 does not have the All
Programs folder, but instead lists all programs on the left section of the start menu, with the most used at the top.

Windows 7 frequently used programs
Windows 10 frequently used programs

Control Panel

The Start menu also provides access to Control Panel, a settings program that allows you to change the computer’s settings. In Windows 7 and older,
Control Panel is labeled Control Panel on the right section of the Start menu, while in Windows 10 it is represented by a gear icon on the left above the
Start button.
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Windows 7
Windows 10

The Start menu also provides a search text box or search button. Press the search button or type a word in the search box to search the computer for a
program or file. (In Windows 10, the search box is not visible, but typing will trigger a search for what is being typed.)

Windows 7 search Windows 10 search

https://assessments.lumenlearning.co...essments/18548

Open a Program

Like dialog menus, the Start menu also can use the > shorthand in instructions for navigating. For example, in Windows 7, the snipping tool is at
Start>All Programs>Accessories.
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Shutting Down
You can also use the Start menu to turn your computer off. In Windows 7 and older, the power button is usually marked Shut Down near the right corner
of the Start menu. In Windows 7, clicking the arrow to the right of the Shut Down button gives you additional options. In Windows 10, the power button
is a power icon located on the left directly above the Start menu button. Clicking it will also provide additional options.

Windows 7
Windows 10

A Look at Some Shut Down Options
Not every shut down option is available on every version of Windows, but here are some common shut down options and what they mean.

Switch user: Switch between user accounts.
Log off: Logs you out of the computer. The computer is still on, but programs are closed and you must enter your password to use the computer
again.
Lock: Locks the computer. You will not be logged out, and programs will still be running, but you must enter your password to use the computer
again.
Restart: Logs you out of the computer, closes all programs, shuts down Windows, turns the computer off, then turns the computer back on and
restarts Windows. You will have to enter your password to use the computer again.
Shut down: Logs you out of the computer, closes all programs, shuts down Windows, and turns the computer off.
Sleep: This is sort of like pausing the computer. The screen will go dark, and you will be unable to use the computer until you wake it up by shaking
the mouse or pressing a key on the keyboard. The computer will appear to be off. However, what is actually happening is that the computer will go
into a low-power state. It will still be on, and programs will still be running, but the computer will use considerably less power. This is useful
because waking the computer from sleep is much quicker than waiting for the computer to turn on and boot up Windows. By default, shutting your
laptop lid will put the computer to sleep, and reopening the lid will wake the computer up.

Note about Windows 8

Windows 8 has a Start screen rather than a Start menu because Windows 8 was designed primarily for tablets. You can find instructions on navigating
the Windows 8 start screen here.
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1.14: Creating Files and Folders

Create files and folders.

File Explorer
In Windows, the primary way of interacting with files and folders is through the File Explorer application. (In older versions of Windows, this may be called Windows
Explorer. In Macs, the equivalent would be Finder.)

There are a couple of ways to open File Explorer. The shortcut Win+E will open File Explorer. It can also be opened by clicking the Start button and typing “File
Explorer” or by right-clicking any folder and selecting Open. By default, File Explorer is pinned to the task bar (see below), and it can be opened from there.

Open the Start menu and type “File Explorer.”

Find File Explorer pinned to the taskbar.

Right-click a folder and select Open.

Some folders already exist in File Explorer, such as Documents, Desktop, and Downloads. (Documents may be called “My Documents” in older versions of Windows).
You can create more folders or folders within folders to allow for better organization.

To create a folder, right-click, then select New>Folder.

Right-click in File Explorer, then select New>Folder.

In Windows 7, there is a New folder button near the top of the window. In Windows 10, you can also click the Home tab, then the New Folder button.
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Windows 7 New folder button

Windows 10 New folder button

Renaming Files

To rename a file or folder, right-click the file or folder, then select Rename.

You can also click the name of the file or folder once, wait one second, then click the name of the file or folder again.

Note that in Windows, a file cannot contain any of the following characters: \ / : * ? " < > | . This is because those characters have special meaning in
Windows. (For example \ is included in file paths.) If Windows encounters a file or folder with those symbols, it could potentially misread the file or folder name and
cause problems. As a precaution, Windows will not let you save files or folders with those characters, so don’t worry about saving a file with those characters in the
name by mistake.

Macs are less stringent about what characters can be included in a file or folder’s name; only the colon (:) cannot be used. However, it is a good practice to avoid using
the Windows-prohibited characters in file names because the file name will be automatically changed when moved to a Windows computer.
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1.15: Organizing Files and Folders

Organize files and folders.

Finding a Specific Folder or File: File Paths
When looking for a specific folder or file, it is helpful to follow the file path. The file path tells you what folders to click on to get to the file.
Read it left to right to show what folders to click on to get to the file; read it right to left to show which folders are nested in each folder.

For example:

C:\Users\Sierra Rowan\Documents\Projects\suppliers

This file path means that the file is in the suppliers folder, which is in the Projects folder, which is in the Documents folder, which is in the
Sierra Rowan username folder, which is in the Users folder, which is on the C drive of the computer.

Note that the backslash is another shorthand format you might see in instructions to indicate which folder is being discussed. (For example,
“Go to the Documents\Office Templates folder”)

Traveling the File Path

Rather than remembering the file path for a specific file, you can use the toolbar at the top of File Explorer or the Properties window.

Toolbar Method

For example, the screenshot below shows a folder in Windows 7 called New folder. The file path for this folder is
C:\Users\user\Documents\New folder. In the screenshot below, the user could click Documents to go up one folder to the Documents folder,
and the small double-arrow on the left to go up to higher folders such as user.

The screenshot shows a folder in Windows 7 called New folder. The file path for this folder is
C:\Users\user\Documents\New folder. The user could click Documents to go up one folder to the Documents folder, and
the small double-arrow on the left to go up to higher folders such as user.

Clicking the blank space to the right of the folder name will reveal the entire file path, which can be copied and pasted elsewhere.
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Properties Method

Right-click the file or anywhere in the folder and select Properties. A window will pop up displaying the file path of the file or folder. (Note
that it does not include New folder itself.)

https://assessments.lumenlearning.co...essments/18550

Selecting and Moving Files
There are several ways to move files:

Click and drag the file into a folder.
Click a file, cut using Ctrl+X, then paste into the new folder using Ctrl+V
Click a file, copy using Ctrl+C, then paste into the new folder using Ctrl+V (leaves the original file where it is)

Note that the copies are not connected; edits made to one copy will not be reflected in the other copy.
Right-click a file, select either Copy or Cut in the dialog menu, then right-click in the folder and select Paste.

Moving Multiple Files

There are a few different ways to select multiple files (which we’ll discuss below). Once you’ve selected multiple files, anything you do to a
single file will be done to all selected files. (For example, clicking and dragging will move all selected files, hitting Ctrl+C will copy all
selected files, etc.)

You can select multiple files at once using the following shortcuts: Hold down Ctrl while clicking to select multiple files. Hold down Shift
while clicking to select two files and all the files between them. Press Ctrl+A to select all files. (Note that when using Ctrl+A, you can use
Ctrl+Click to deselect files. You’ll want to deselect the destination folder, since a folder cannot be in itself.)

Practice Question
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Ctrl+Click Click+Shift+Click

Ctrl+A
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1.16: Deleting Files and Folders

Learning Outcomes
Delete and restore files and folders using the Recycle Bin.

To delete a file or folder (or multiple selected files), right-click on the file and select Delete. You can also select the file and hit the
Delete key on the keyboard. Deleting a folder deletes all its contents as well.

You may get a dialog prompt that asks if you want to move the file to the recycling bin. If that happens, say yes. If you didn’t get a
dialog prompt, the file was still sent to the Recycle Bin. (The Mac equivalent is called Trash.) Deleted files are not gone forever;
they are sent to the Recycle Bin.

Recycling Bin

An empty and occupied
Recycle Bin

Deleted files are not gone forever. When a file is deleted, it is sent to the Recycle Bin. The Recycle Bin can be found on the
Desktop. Its icon resembles a recycle bin or trash can, and the icon changes depending on whether the Recycle Bin contains any
files.

The recycle bin is a holding place for deleted files. To permanently delete a file, you can delete it again from the Recycle Bin, or
you can empty the Recycle Bin. It is recommended you empty the Recycle Bin every once in a while to free up space.

If you delete something by accident, or if you change your mind about a deleted file, you can un-delete it by restoring the file from
the Recycle Bin.

To restore or permanently delete a file, right-click on the file and select either Restore or Delete. Deleted files are permanently
deleted; restored files are restored to their original location before being deleted.
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Right-clicking a file

You can restore or permanently delete individual files or multiple files at once using the Manage option on the toolbar.

In the toolbar in the screenshot above, from left to right:

Empty Recycle Bin: Permanently deletes everything in the Recycle Bin.
Recycle Bin properties: Allows you to choose how much space to allot to the Recycle Bin. When the Recycle Bin reaches
capacity, it will automatically delete its oldest files. The Recycle Bin properties also has an option to automatically delete files
permanently. (Unless you know what you are doing, it is recommended you leave Recycle Bin properties alone.)
Restore all items: Restores everything in the Recycle Bin to its former location.
Restore the selected items: Restores only the file or files you have selected.
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1.17: Introduction to File Management

What you’ll learn to do: Discuss proper file and folder management techniques in a variety of
environments

Now that we’ve discussed the basics of file management, let’s dive into the unique needs and strategies for local files, network
files, and online files.
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1.18: Local Files

Learning Outcomes
Discuss proper file management techniques for local files

File management includes folder structures and naming conventions, plus the choice of appropriate formats. Before we begin our
discussion, take a moment to think about how you name files that you create.

Practice Question
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With regards to folder structures, a good way to go about organizing your data is to create a hierarchy of folders. As an example,
you could use a folder for each project, with two subfolders:

“Data,” to store your research data, including images, databases, media, etc.
“Documentation,” to store all relevant project documents, including, e.g. methodology and consent forms.

The more complex the project, the more detailed your folder structure can be. If you are working alone or in a small team, you
might wish to use just a handful of subfolders. However, if you work on a large project you could create a range of subfolders to
suit the team’s needs. As an example, under “Data,” you might create a subfolder for each data type, such as “Databases,”
“Images,” and “Sounds.” Similarly, under “Documentation” you might create a subfolder for each category of document, such as
“Methodology,” “Consent forms,” and “Information sheets.”

When it comes to file naming, we recommend using simple but meaningful names. Best practice includes the following:

Capital letters should be used to delimit words in the place of spaces or underscores
File names and paths should avoid unnecessary repetition and redundancy
Numbers should always include at least two digits (i.e. 01 to 09 instead of 1 to 9)

Naming will follow a convention chosen by you and other project members. For instance, you may decide that
“InterviewTra07JD20180214” means “Interview Transcript 7, written by John Doe, on 14/02/2018.” You will need to describe such
conventions as part of your study metadata.

Practice Question
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Finally, choosing appropriate file formats is key to ensuring data is reusable, as some formats become obsolete in time and may
make your research inaccessible. You can use whatever software or format is convenient during your work, but when sharing the
data you should follow best practice and ensure future reusability of your work. The US Library of Congress maintains a
recommended formats statement , which we invite you to consult. This lists a series of file formats in order of preference by output
type, including recommended metadata fields.

When saving data for sharing, you might need to convert your working files. If you do so, always ensure that the conversion was
successful and that no errors appear (e.g. missing values, wrong characters, text formatting, resolution, etc.).
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1.19: Network Files

Discuss proper file management techniques for network files

There is a saying about file management storage that goes “lots of copies keeps stuff safe.” The idea behind the principle is that
even if your main storage system fails, you still have access to your data.

If you have very important data, you may want to keep many copies, but most people should follow the 3-2-1 Rule and keep three
copies of their files. This rule states that you should have 3 copies of your data in 2 locations on more than 1 type of storage media.

The offsite copy is particularly critical. Many people keep their data and a backup copy on-site, but this doesn’t factor in scenarios
where the building floods or burns down (as can happen in a chemistry building) or a natural disaster occurs. Storing a copy of your
data off-site can make the recovery process easier if everything local is lost.

While the 3-2-1 Rule mainly concerns redundancy, it’s also a recommendation for variety in that data should not all be stored on
one type of hardware. Computer hard drives fail, cloud storage can be disrupted, and CDs will go bad over time; each storage type
has its own strengths and weakness so using several types of storage spreads your risk around. So if the first copy your data is on
your computer, look for other options for your backups like external hard drives, cloud storage, local server, CDs/DVDs, tape
backup, etc. Finally, always keep a local copy of your data if its main storage is in the cloud. Accidents happen, even with well-run
cloud storage, so it’s always best to have a copy of your data in your direct control, just in case.

Here’s an example of following the 3-2-1 Rule using resources a research has locally available:

a copy on my computer (onsite)
a copy backed up weekly to the office shared drive (onsite)
a copy backed up automatically to the cloud

The 3-2-1 Rule is simply an interpretation of the old expression, ‘don’t put all of your eggs in one basket.’ This applies not only to
the number of copies of your data but also the technology upon which they are stored. With a little bit of planning, it is very easy to
ensure that your data are backed up in way that dramatically reduces the risk of total loss.

Backups

Part of following the 3-2-1 Rule means having backups in place. When looking for good backup options, consider the following:

Any backup is better than none
Automatic backup is better than manual
Your work is only as safe as your backup plan
Check your backups periodically

You should check your backups for two reasons. First, you need to know that they are working properly. A backup that is not
working is not a backup at all. You should test your backups once or twice a year and any time you make changes to your backup
system. If your data are particularly complex to back up or particularly valuable, considering testing your backups more frequently.

The second reason to test your backups is to know how to restore from backup. You don’t want to be learning how to restore from
backup when you’re already in a panic over losing the main copy of your data. Knowing how to restore from backup ahead of time
will make the data recovery process go much more smoothly.

It’s a small thing to periodically test restore from backup, but it will give you peace of mind that your data are being properly
backed up and that you will be able to recover everything if something happens to your main copy.
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1.20: Online Files

Learning Outcomes
Discuss proper file management techniques for online files

When we talk about file management for online files, we are talking about cloud technology.

Cloud file sharing, also called cloud-based file sharing or online file sharing, is a system in which a user is allotted storage space
on a server and reads and writes are carried out over the Internet.

Cloud storage involves stashing data on hardware in a remote physical location, which can be accessed from any device via the
internet. Clients send files to a data server maintained by a cloud provider instead of (or as well as) storing it on their own hard
drives.

To keep data secure, the front line of defense for any cloud system is encryption. Yes, the only way to keep your data safe for
certain is to lock it up in a safe beneath the ground. That being said, your cloud-stored data is generally safer than your locally
stored data.

There are several very good commercial cloud sharing services. File sharing services provide two key capabilities:

They allow you to share files between your own devices including Macs, iPhones, iPads and Windows-based PCs. This makes
it easy to access your data wherever you are and on whatever device you’re using.
They let you share files or folders with others sometimes with permissions or date-based restrictions. Such capabilities are
incredibly effective for workgroup collaboration.

Numerous cloud-based file sharing services exist but the most popular are Box, Dropbox, Google Drive, iCloud Drive, and
Microsoft’s OneDrive. All offer free plans with limited amounts of storage.

Practice Question
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1.21: Introduction to Snips and Screenshots

What you’ll learn to do: take a screenshot.

A screenshot is a saved image of what is displayed on a computer screen. It is useful for showing others what is on your screen, and
it is how you will submit some assignments in this course.
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1.22: Snips and Screenshots

Take a screenshot.

You can take a snip, or a screenshot that is of only part of the screen, with the Snipping Tool, or you can take a screenshot of the
entire screen with the Print Screen button.

Snipping Tool
In Windows 10, you can open the snipping tool by going to Start>Windows Accessories>Snipping Tool, or by opening the Start
menu and typing “Snipping Tool.” In Windows 7, you can open the snipping tool by going to Start>All
Programs>Accessories>Snipping Tool. Older versions of Windows might have the snipping tool in a similar location; however they
may not have the snipping tool at all, in which case the Print Screen button should be used to take screenshots.

The Windows 10 snipping tool

The snipping tool will open a small window with New, Cancel, and Options buttons. You can take rectangular, freeform, window,
or full-screen snapshots. Windows 10’s snipping tool also has a Delay button, which can be helpful for capturing menus or dialog
boxes.

Take a Rectangular Screenshot with the Snipping Tool

Click New, then click and drag over the portion of the screen you want to screenshot. The snipping tool window will disappear as
soon as you start clicking and dragging to take your screenshot. (If you hit New by mistake you can cancel the snip by clicking the
cancel button before you click and drag.)

Once you’ve captured the screenshot, the snipping tool window will reappear with some new options available.

Save. Copy. Send to. Pen. Highlighter. Eraser.
1. Save. Saves the current screenshot. If you do not save the screenshot, it will be automatically deleted when you take a new

screenshot or close the snipping tool.
2. Copy. Copies the current screenshot so you can paste it into an image editing program, like Paint, GIMP, or Photoshop.
3. Send to. Opens Microsoft Outlook so you can email the screenshot to someone. Clicking the dropdown arrow to the right of the

button allows you to choose whether to send the screenshot in the email or as an attachment.
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4. Pen. Allows you to draw on and mark the screenshot. Clicking the dropdown arrow to the right of the button allows you to
change the color of the pen.

5. Highlighter. Allows you to highlight anything on the screenshot.
6. Eraser. Erases the effects of the pen and highlighter tools. (Note that Ctrl+Z does not work on the pen or highlighter tool; you

must use the eraser to correct mistakes.)

Don’t forget to save your screenshot!

Other Screenshots with the Snipping Tool

By default, the snipping tool is set to take rectangular screenshots. You can change this by clicking the dropdown arrow to the right
of the New button and choosing between free-form, rectangular, window, and full-screen snips.

Free-form snip: Draw an
irregularly shaped screenshot.

Window snip: Pick a window to
take a screenshot of it

Screen snip: Take a screenshot
of the entire screen.

Timed Screenshots with the Snipping Tool

Some things, such as dialog menus, are hard to take a screenshot of. Timed screenshots are especially useful for taking screenshots
of these dialog menus or other click-triggered items, since the delay gives you enough time to open those items.

To take a timed screenshot, click the arrow to the right of the Delay button, then select how many seconds you want the snipping
tool to wait before taking the screenshot. The default setting is 0.

After setting the number of seconds to delay, click New to start the timer. For example, if you selected a 5-second delay, once you
click the New button you have five seconds to get your screen ready for a screenshot. At the five-second mark, the screen will
freeze in place and the snipping tool will reappear. You can then take a screenshot using whichever shape (free-form, rectangular,
window, full-screen) you previously selected with the New dropdown menu.

Getting the timing right can be tricky, but don’t worry—you can always try again by taking a new screenshot. Only the screenshots
you save using the Save button are kept.
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Taking a delayed screenshot

https://assessments.lumenlearning.co...essments/18556

NOTE

If you are running Windows 8 or older and do not have the Delay button, you can still take a screenshot of dialog menus or click-
triggered items with the Print Screen button.

Print Screen
As previously mentioned in Keyboard Shortcuts, another way to take a screenshot is to use the Print Screen button (Prt Scn).
Pressing just the Print Screen button will take a picture of everything visible on your computer screen; Pressing Prt Scn+Alt will
take a picture of the currently active window (the window you last interacted with). Screenshots taken with the print screen button
must be pasted (with Ctrl+V) into an image editing software such as Paint, GIMP, or Photoshop.

Screenshots on a Mac

On Mac computers, pushing Command+Shift+3 will take a full-screen screenshot. Pushing Command+Shift+4 then clicking and
dragging will create a rectangular screenshot. Hitting Command+Shift+4+Space and then clicking a window will create a window
screenshot. Mac users can also use the Grab tool, found in the Applications/Utilities folder. By default, Mac screenshots are saved
to the desktop.
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1.23: Putting It Together- Intro to Computers
Now that you know some of the basic terminology and have some basic organization principles down, you are one step closer to
computer literacy. In the rest of this course, you learn about the internet and some essential software programs commonly used in
business.

Remember if you get stuck or can’t remember how to do something from this module, you can always come back and review.
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1.24: Assignment- Download Files
At the end of this course, you will submit a capstone assignment that will use everything you have learned and involve creating
several documents.

For this portion of the assignment, you will download the files you will use in your final assignment.

Instructions
1. Create a folder on your desktop called Rowan. This is where you will save all of your assignments. To keep your computer

better organized, you may want to move previous assignments into this folder.
2. Download this Word template. Save the file in the Rowan folder.
3. Download this Excel workbook. Save the file in the Rowan folder.
4. Download this PowerPoint presentation. Save the file in the Rowan folder.
5. Take a screenshot of the three files in the Rowan folder on your desktop. Save the snip as BA132_LastName_RecycleBin.png,

replacing “LastName” with your own last name. (Example: BA132_Hywater_RecycleBin.png)
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1.25: Assignment- Identify Your OS
For this assignment, you will take and save a screenshot of the window that identifies your operating system. Follow the directions,
then submit your assignment. If you get stuck on a step, review this module and ask your classmates for help in the discussion
forum.

Instructions
1. Open the window that identifies your operating system using any of the methods discussed on the Identifying Your OS page.
2. Open the Snipping tool by using one of the methods discussed in the Snips and Screenshots page.
3. Take a rectangular or a window snip of the window displaying your operating system.
4. Save the snip as BA132_LastName_OperatingSystem.png, replacing “LastName” with your own last name. (Example:

BA132_Hywater_OperatingSystem.png)
5. Submit your image in your course online.

Contributors and Attributions
CC licensed content, Shared previously

Assignment: Identify Your OS. Authored by: Lumen Learning. License: CC BY: Attribution

1.25: Assignment- Identify Your OS is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46427?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/01%3A_Introduction_to_Computers/1.25%3A_Assignment-_Identify_Your_OS
https://courses.lumenlearning.com/wm-compapp/chapter/identifying-your-operating-system-os
https://courses.lumenlearning.com/wm-compapp/chapter/snips-and-screenshots
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/01%3A_Introduction_to_Computers/1.25%3A_Assignment-_Identify_Your_OS
https://creativecommons.org/licenses/by/


1.26.1 https://biz.libretexts.org/@go/page/46428

1.26: Assignment- Empty the Recycle Bin
For this assignment, you will empty your Recycle Bin. Follow the directions, then submit your assignment. If you get stuck on a
step, review this module and ask your classmates for help in the discussion forum.

If you have a Mac, substitute “Trash” for “Recycle Bin” in the instructions (except for naming your screenshot).

Instructions
1. Open the Recycle Bin (or equivalent) by double-clicking the icon on the desktop (or using any other method discussed in the

Deleting Files section of Organizing Files and Folders).
2. Check the Recycle Bin to see if there are any files you wish to keep. If so, restore those files.
3. Empty the Recycle Bin using the methods discussed in Organizing Files and Folders.
4. Open the Snipping tool by using one of the methods discussed in the Snips and Screenshots page.
5. Take a rectangular or a window snip of the Recycle Bin window.
6. Save the snip as BA132_LastName_RecycleBin.png, replacing “LastName” with your own last name. (Example:

BA132_Hywater_RecycleBin.png)
7. Submit your image in your course online.
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1.27: Discussion- Computers vs. Smartphones
Many tasks that used to be accomplished by using a desktop or laptop computer are now possible to do on smartphones. The
newest smartphone models for example, have the computing power of workstations from a few years ago. Although smartphones
are getting faster, smarter and are increasing number of useful applications, many businesses are slow to utilize these new features.
Let’s explore some of the pros and cons of using a smartphone as the main productive technology source.

Watch this video about a student’s experiment from 2018 to use his smartphone exclusively for five days as his computer. After
watching the video consider a few questions to discuss.

A link to an interactive elements can be found at the bottom of this page.

You can also view the transcript for the video “I Tried Making a Phone My Only Computer” here (opens in new window).

Discussion Questions
Are there good reasons for businesses to still use computers to accomplish tasks instead of smartphones? What are they?
Do you think the future office environment will eliminate computers use in favor of smartphones?
What skills from using smartphones can be transferred to a work environment?

Share your opinions below and respond to two of your classmates’ thoughts.

Contributors and Attributions
CC licensed content, Original

Discussion: Computers vs. Smartphones. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY:
Attribution

All rights reserved content
I Tried Making a Phone My Only Computer -- Experiments Ep. 3. Authored by: Ho Young Won. Located at:
https://www.youtube.com/watch?v=XE-t30Zo7q4. License: All Rights Reserved. License Terms: Standard YouTube License

1.27: Discussion- Computers vs. Smartphones is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46429?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/01%3A_Introduction_to_Computers/1.27%3A_Discussion-_Computers_vs._Smartphones
https://course-building.s3-us-west-2.amazonaws.com/ComputerApps/Transcripts/ITriedMakingAPhoneMyOnlyComputer_Transcript.txt
https://creativecommons.org/licenses/by/4.0
https://www.youtube.com/watch?v=XE-t30Zo7q4
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/01%3A_Introduction_to_Computers/1.27%3A_Discussion-_Computers_vs._Smartphones
https://creativecommons.org/licenses/by/


1

CHAPTER OVERVIEW

2: Internet Research

Access and navigate the internet
Discuss the importance and qualities of ethical business research
Perform basic web searches
Narrow a search to find more useful results

2.1: Why It Matters- Internet Research
2.2: Introduction to Using and Searching the Internet
2.3: Internet Browsers
2.4: Basic Browser Tools
2.5: Introduction to Ethical Business Research
2.6: Ethical Research
2.7: Data and Customer Rights
2.8: Introduction to Basic Searches
2.9: Web Searching
2.10: Identifying Search Results
2.11: Opening Search Results
2.12: Introduction to Advanced Searches
2.13: Adjusting Search Parameters
2.14: Image Searches
2.15: Putting It Together- Internet Research
2.16: Assignment- Search the Internet
2.17: Discussion- Search Results
2.18: Discussion- Personal Data and Ethical Business Use

2: Internet Research is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Learning Objectives

https://libretexts.org/
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.01%3A_Why_It_Matters-_Internet_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.02%3A_Introduction_to_Using_and_Searching_the_Internet
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.03%3A_Internet_Browsers
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.04%3A_Basic_Browser_Tools
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.05%3A_Introduction_to_Ethical_Business_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.06%3A_Ethical_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.07%3A_Data_and_Customer_Rights
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.08%3A_Introduction_to_Basic_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.09%3A_Web_Searching
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.10%3A_Identifying_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.11%3A_Opening_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.12%3A_Introduction_to_Advanced_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.13%3A_Adjusting_Search_Parameters
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.14%3A_Image_Searches
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.15%3A_Putting_It_Together-_Internet_Research
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.16%3A_Assignment-_Search_the_Internet
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.17%3A_Discussion-_Search_Results
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.18%3A_Discussion-_Personal_Data_and_Ethical_Business_Use
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research
https://creativecommons.org/licenses/by/


2.1.1 https://biz.libretexts.org/@go/page/46430

2.1: Why It Matters- Internet Research

Why learn how to run an internet search?

In today’s world, businesses depend heavily on computer technology and its connection to the World Wide Web to access vast
amounts of information, to conduct research, and to communicate quickly with other business and customers. Understanding how
to access and use that information is vital to both small and large business.

Managers frequently create reports and presentations to communicate company and competitive landscape information to a variety
of audiences. The ability to understand web browsers and to effectively search for needed data, images, articles, and other
information has become a critical skill to have in the global business world of today.

This module focuses on the basic skills needed to conduct meaningful and useful searches with the internet for business. The
lessons to learn in this module include:

Identifying and understanding web browser basics.
Conducting searches in the web.
Searching for images.
Understanding a variety of tools to modify and narrow searches.
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2.2: Introduction to Using and Searching the Internet

What you’ll learn to do: access and navigate the internet.

The ability to identify and operate a web browser is a crucial skill in today’s business environment. In addition to browser
identification, a basic understanding of general browser navigation assist you in searches, presentations, and beyond. While
different browsers have different features, there are a lot of similarities among them.
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2.3: Internet Browsers

Identify three main browsers used to access the internet.

A web browser (commonly referred to as a browser) is a software application for retrieving, presenting, and traversing information
resources on the World Wide Web (also known as the internet or the Net). The most popular web browsers are Google Chrome,
Microsoft Edge (formerly Internet Explorer), Mozilla Firefox, and Apple’s Safari. If you have a Windows computer, Microsoft
Edge (or its older counterpart, Internet Explorer) are already installed on your computer. If you are running an Apple computer, you
already have Safari installed on your computer. You may also have other browsers installed on your computer. If the browser you
want to use is not installed on your computer, download links for Chrome and Firefox are in their respective sections below.

This course will focus first on the three primary browsers (Chrome, Firefox, and Edge) and then walk through a set of tools and
skills which can be used in any browser.

Identifying Browsers

There are three primary browsers that are used to access the internet that you need to be able to identify and use. Each of these
browsers is made by a separate company, and has a different look, but there are many tools and shortcuts that can generally be used
on any of the browsers.

Microsoft Edge

You have most likely heard the name of one or more of these browsers, but let’s first identify the Microsoft Edge browser.

This is the icon associated with the Edge browser. This is a recent
change to the original Microsoft browser which was called
Internet Explorer.

The older Internet Explorer (IE) icon may be on your desktop, but
the Edge browser is the preferred browser for Microsoft now. For
your reference, the older IE icon looked like this.

Unlike other browsers, which must be downloaded, Microsoft Edge (or Internet Explorer) comes with Windows. That means if you
have a Windows computer, Edge (or Explorer) is already on your computer. The Edge icon on a Windows 10 computer system can
be found either on the bottom taskbar or along the side. Click on the icon with the mouse and it will open the browser. The icon
might be in slightly different places on your desktop, but look for the icon and double click on it to open the browser. Regardless of
which version of Windows you have, you can also open the browser from the start menu. Select the start button, and when you see
the icon for Edge, select it and it will open.
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After clicking with the mouse on the Edge icon, a window will open up and will look like this window if new (#1), or may have a
news page displayed (#2), or it will open to the business default page that has already been established by the company’s
Information Technology (IT) department.

https://assessments.lumenlearning.co...essments/18557

Google Chrome

One of the most popular web browsers is Google Chrome (often simply referred to as Chrome). This icon is associated with the
Chrome browser. This browser will be used as an example in this course in order to learn basic browser navigation skills and
perform the other assignments and tasks associated with this module.

If Chrome is on your computer, the Chrome browser icon can be found on the Windows 10 desktop in the bottom task bar or along
the side. Regardless of which version of Windows you have, you can also open the browser from the start menu. Select the start
button and type in Chrome. If the Chrome browser is on your computer, it will be displayed in the menu, where you can now see
the icon and select it to open.

If you wish to use this browser but do not have it on your computer, it can be downloaded and added by going to this website
https://www.google.com/chrome/ and selecting the Download option from the top menu.
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After clicking on the Chrome icon, a window will open up and look like this window, or it will open to the business default page
that has already been established by the company’s IT department. You may already notice that some of the features have
similarities between the browser windows. Now to the final browser identification.

Mozilla Firefox

Mozilla Firefox (often simply referred to as Firefox) is a browser created by the company Mozilla and is another browser
frequently used to “surf” or search the World Wide Web. This is the icon associated with the Firefox browser.

If Firefox is on your computer, the Firefox icon on your Windows 10 computer system can be found either on the bottom taskbar or
along the side. The icon might be in slightly different places on your desktop, but look for the icon and click on it to open the
browser. Just like the other two browsers, it may also be opened in the Start menu box by typing Firefox, then selecting the option
to open it.

If you wish to use this browser but do not have it on your computer, you can open a browser that you do have and use this address
to download the Firefox browser https://www.mozilla.org/en-US/firefox/ onto your computer.
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After clicking on the Firefox icon, a window will open and look similar to this window, or will be on a default page that has been
set up by the company.
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2.4: Basic Browser Tools

Identify basic navigation tools used in a browser.

Now that you are familiar with what the three main browsers look like, where to locate them, and how to open them, it’s time to learn a few of the basic tools to navigate and use a browser window.
Even though we are the Chrome browser as an example to show these tools, they can be used in almost any browser.

1. Arrow Buttons. These two arrows navigate the browser back (the left arrow) to a previously viewed webpage or forward (the right arrow) to more currently viewed webpages. These buttons can
be pushed more than once to cause the browser to go back or forward further to web pages rendered in a browser session’s history.

2. Refresh Button. This button reloads a webpage. Refreshing will update the information on a webpage if it has changed. If a webpage has not completely loaded, refreshing will reload the page so
that it completely renders on the screen.

3. New Tab Button. Opens a new page in the same window when selected. This option allows for many websites to be open but contained within one main window frame. This keeps the desktop
from being cluttered with too many open windows. 

A browser with many tabs open will look to this.
4. Address Bar. This text field on a browser that identifies the webpage currently being viewed in a browser window. All address bars are located at the top of the browser window. A user can type

in a new address to navigate to a new webpage. Each website on the internet is reached by a web address known as a URL (Uniform Resource Locator) that references a specific location on the
internet. Type a URL into the address bar of a browser, then press the Enter (Return) key on the keyboard to make the browser load the webpage associated with the URL. As browsers have gotten
more sophisticated, most do not require for http:// or even the www to be typed in order for the webpage to be discovered.

5. Resizing and Closing Buttons. As covered in Common Terminology, these buttons allow a user to change the size of a browser window. 

a. Minimize Button. Represented by an underscore in the upper right corner of the window. When minimized, the browser will remain on the taskbar but not be visibly open on the desktop.

b. Maximize Button. Represented by a square in the upper right corner of the window. When maximized, a browser window will enlarge a window, typically filling the entire computer screen.

c. Close Browser Button. The button in the upper right corner which is an X will terminate a browser session. This button allows a user to quickly close a browser window when they are finished surf
the internet. Note: If there are multiple tab windows open a browser it will usually ask if you want to close all of the tabs before shutting down the browser.

6. Menu Button. In Chrome, the menu is indicated by three vertical dots in the upper right corner of the browser window (Edge uses three horizontal dots; Firefox uses three stacked horizontal
lines). Once the menu button is selected a dropdown menu will appear. 
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Dropdown Menu. Once the menu button (#1) is clicked, it will display a dropdown menu (#2) with a variety of choices.
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Hyperlinks
A hyperlink (also called a link) is a section of text, an image, graphic or icon that is linked to a specific webpage, image, file or object. This is commonly seen in a browser as text, often a blue color.

Once the link is selected, the webpage automatically navigates to the linked webpage, icon, image, graphic or file. This is one of the main tools used when conducting a search on the web.

https://assessments.lumenlearning.co...essments/18561

Bonus Tool

If you are ever asked by a support technician for the version of your browser, a quick way to discover your version is to go to this website http://www.whatsmybrowser.org/. It will tell you the browser
type and additional information (like the operating system you are working with on your computer) so you know how your browser is configured.

Browsers and the World Wide Web

Now that you are more familiar with web browsers and their navigation, here is an explanation of the bigger picture about how they work. Watch this video to understand how browsers link you to the
World Wide Web.

Practice Questions
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A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=106
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2.5: Introduction to Ethical Business Research

What you’ll learn to do: Discuss the importance and qualities of ethical business research

As our lives become more and more virtual, the amount of personal data we create dramatically increases. While this personal data
can be an incredible tool for businesses, it’s essential to remember that each data point is actually a person or a person’s choice.
When doing business research, you must do so in an ethical manner.
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2.6: Ethical Research

Discuss the importance of ethical research

Today’s advances in technology allow for collection of data, information and analysis of that information to depths and breadths
like never before. As the technological world has changed, the business world has too. Business research and the ethical
considerations in the collection, research and use of the results are now more important than ever. As the market calls for business
to be conducted with more transparency and social responsibility, customers expect business research to be conducted ethically.
This also means that if unethical research is used, technology makes it easier to discover and expose online which in turn
diminishes social trust and may even decrease customer sales and retention for that business.

The world is now more connected than ever and even though a business may be in the United States, many customers or business
partners may reside in countries all over the world. This increases the need to conduct ethical business research with this wider
world connection in mind. Ethical research is one of the foundational components of business ethics to be aware of and to practice
in order to create a competitive and sustainable business in today’s world.

Ethical Research Principles

As a manager, part of your responsibility to a company and its employees is to ensure ethical research principles are understood
and used when conducting research. It’s important to know if those principles are clearly defined and stated within the company. If
not, there are many resources to assist in defining ethical business research for you and your team.

Over time, various organizations have developed research principles as research guidelines for social, scientific, educational, and
business research. Ethical research is important for fostering a trusting, relational connection between all parties connected with the
research. So, what is the essence of these business research principles?

Ethical research principles include:

Respect for Persons and Their Autonomy. A person’s rights and decisions are respected.
Beneficence and Nonmaleficence. Everyone involved is safe, considered and research ethically conducted.
Fidelity and Integrity. Research is well designed, planned, process, outcomes, clear to everyone.
Justice. Making sure the research is fair and inclusive.

Watch this video explaining the meaning of these principles. This video is regarding international development, but it is just as
relevant for ethical business research.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Principles and Guidelines for Ethical Research and Evaluation in Development”
here (opens in new window).

You still may be asking yourself why the need to conduct ethical business research? What is so important
about following ethical standards? To answer those questions read through these next points and think
through your own specific business scenario and how it benefits from conducting ethical business
research.
It’s important to follow ethical business research guidelines because they:

Promote research to be truthful, inclusive, and minimize error or misrepresentation.
Promote guiding standards of conduct for all people involved in the research.
Promote accountability to businesses, customers, clients, and parties connected to the research.
Promote public trust which can lead to public support of business.
Promote compliance to laws, social responsibility, moral and ethical values, public health, etc.

What are ways to conduct ethical business research? Let’s look at an example.
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In today’s world, billions of pieces of information are easily searched for online, but search engines do not determine what
information is correct, useful, accurate, valuable, etc. Online searches return organized online data and information when
search terms match the information, but search engines do not qualify that information. It is up to the researcher to validate and
reference the source of the information being used.

How does a business researcher conduct ethical online research?

Double checks information and sources used in business to account for its accuracy.
Correctly attributes and sites data sources, reports, information, etc.
Understands the copyright and fair use of images, content, audio, etc.
Avoids plagiarism and taking credit for someone else’s ideas

With all of the information available on the internet, it is especially important for business to maintain their ethical standards
and not rely on incorrect information or misuse another business or person’s work without the correct siting or payment for
using images, ideas, audio, etc.

https://assessments.lumenlearning.co...essments/18562

But what potentially happens to a business if ethical methods aren’t used? Let’s look briefly at a different example.

Non-Ethical Research Consequences

What if a business fostered an environment where its research was not conducted with guiding ethical standards? Can you think of
a few examples? Here are a few ways businesses use unethical activities with research:

misrepresent research results;
break respondent confidentiality;
violate non-disclosure agreements;
avoid legal liability;
plagiarism;
manipulate research data or participants for favorable outcomes.

One very public and famous example of research manipulation occurred over decades in tobacco and cigarette companies.
Even though the scientific research proved smoking caused lung cancer and did harm to those who used it and people who
were around it, tobacco companies’ manipulated the research results and denied the scientific facts thus endangering people’s
health in the pursuit of profit. Now millions of dollars have be spent in lawsuits and the true results have been exposed to the
public.

Additional consequences for unethical business research mean faster exposure and customer reaction happen now because of the
rise of the internet, citizen reporters, whistleblower laws, and informed customers, when shady research practices are discovered.

Technology and strengthened whistleblower laws have made it safer for customers or employees to expose unethical practices
when discovered. Check out this article about one such instance: Duke University Agrees To Pay U.S. $112.5 Million To Settle
False Claims Act Allegations Related To Scientific Research Misconduct.

The United States Department Of Labor also has a Whistleblower Protection Program, put in place to protect those who report.

As the world and business becomes more transparent, customers, clients and business partners can more easily find out if research
has not been conducted ethically and the business backlash can be expensive and even cripple a company’s revenue and public
image. Yet one more reason it is important for a business to conduct its research ethically.

Example: Ethical Online Research

Practice Question

Example: Tobacco Research

Try It
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Setting up ethical business research practices from the beginning and creating a company which adheres to those practices not only
help a company to avoid social backlash for unethical practices, but continually foster customer trust and in turn can lead to better
relations between business, customers and society.

Sources
Bryman, Alan, and Emma Bell. “Ethics in Business Research.” In Business Research Methods, 3rd ed., 122–46. Oxford University
Press, 2011.
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2.7: Data and Customer Rights

Discuss customer rights regarding their personal data

As more mobile devices, social media, applications and ecommerce websites weave themselves ever tighter into customer’s lives,
more information is collected, and personal information shared to improve the consumer experience. This deeper infiltration into
people’s privacy and lives raises concerns about privacy and the potential for data leaks, unauthorized use of data and even
malicious cyberattacks all which increase the likelihood of identity theft.

With the ever-increasing risks involved as the economy and world move forward with technology, we’ll ask three questions: What
constitutes personal data when it comes to customers? What is the current state of customer rights with regards to personal data?
What is being done to have more protection and customer rights in the future?

Personal Data

Personal data means any information that can identify an individual person or customer. Sometimes it is called personal
information or personally identifiable information (PII). In the U.S. according to the National Institute of Standards and
Technology, which is a part of the U.S. Department of Commerce, personal data has been defined as:

any information about an individual maintained by an agency, including (1) any information that can be used to distinguish or trace
an individual’s identity, such as name, social security number, date and place of birth, mother’s maiden name, or biometric records;
and (2) any other information that is linked or linkable to an individual, such as medical, educational, financial, and employment
information.

Additional specific examples of PII include:

Bank account numbers
Passport numbers
Credit Card numbers
Driver’s license number

This information also have the potential to be PPI because when combined they have the potential to disclose the identity of an
individual.

Full Name
Home Address, City, State, Postcode, Country
Telephone/Mobile number
Age, birthdate, Gender or race
Web cookies (cookies record actions taken on individual computers and repot back to cookie website)

As you can see, much of this type of information about individuals is disclosed daily when searching, shopping and working
online. So, what kind of protections and rights do customers have when it comes to their own data? First, we’ll look at the laws
surrounding protection.

https://assessments.lumenlearning.co...essments/18564

Consumer Data Privacy Legislation and Laws

As of the start of 2020, there are no overreaching data specific federal law enacted in the U.S., but in 2018, legislation was enacted
in a few U.S. states (California & Vermont) to give new rights to customers about the collection of their personal information.
Those law are as follows:

California’s Consumer Privacy Act of 2018 went into effect Jan. 1, 2020 and has one of the most extensive online privacy laws
in the U.S. which not only effects companies within the state’s borders, but also with any company doing business with CA
residents. These consumer rights include the right to:
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Know what personal information is being collected about them.
Know whether their personal information is sold or disclosed and to whom.
Say no to the sale of personal information.
Access their personal information.
Equal service and price, even if they exercise their privacy rights.

Vermont’s law which requires that data brokers disclose what data is being collected about individuals and allow them to opt
out of data collection.

In 2019, some states introduced privacy and consumer data protection acts to the legislature and they are in various states of
discussion. Those states included Maine, Nevada, Pennsylvania, Massachusetts, Hawaii, New York, and Maryland. It is important
for a business to know the current laws surrounding consumer data protection as this is in constant flux and new laws may be
passed in the future.

To read a comprehensive list of each state’s legislation related to privacy and consumer data protection, follow this link to the
National Conference of State Legislatures website.

European Union
Europe is taking the lead when it comes to consumer data privacy rights. In 2018, the E.U. enacted a more comprehensive
consumer data privacy law called the General Data Protection Regulation (GDPR) law. The GDPR law clearly states how
companies must protect personal data collected about E.U. citizens and extends its reach beyond the European boarders and
encompasses any global business selling to or having EU customers. It also dictates the terms for violations of this law as fines that
could cost 4 percent of a company’s global profits. A steep penality that has companies taking this law very seriously. Watch this
video to gain a more comprehensive understanding of GDPR.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “What is GDPR?” here (opens in new window).

What rights is the GDPR enforcing for E.U. customers and consumers? It requires that:

Simple language be used to explain how collected data is going to be handled by a company.
Customers must give explicit consent to a company before it can do anything with the data.
Customers must be given the opportunity to request copies of data held by the company.
Customers must be given the opportunity to delete their company stored data entirely.
Companies must report data breaches to consumers within 72 hours.

This type of overarching data rights law is being considered around the world as to what does seem to work, and how can it be
improved or modified to fit specific countries or states.

Future of Customer Data Rights
Could something like the GDPR work if enacted in the U.S.? Many would like to adopt these standards but there is a long road to
travel to make this fit with the U.S. economy.

The US wants to copy Europe’s strict data privacy law—but only some of it. This video walks through exploring the possibility
of having GDPR go global and some of the difficulties involved with doing so.

https://assessments.lumenlearning.co...essments/18565

What is apparent for the future, is that customer data rights are an ever-evolving issue that will need to be updated and new laws
considered as new technology emerges and the consumer landscape continues to evolve.

Try It

Try It

Practice Question
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Understand more how your personal data is being used by businesses and what the future may look like when it comes to your
own data by watching this 17-minute TEDxBermuda talk given in 2015.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “The Future of Your Personal Data” here (opens in new window).

1. McCallister, Erika, Grance, Tim, Scarfone, Karen. Guide to Protecting the Confidentiality of Personal Identifiable Information
(PII). Special Publication 800–122. Gaithersbueg, MD: U.S. Department of Commerce, 2010. ↵ 

2. Nicastro, Dom. “Examining Where 8 US States Stand on Consumer Data Privacy Laws.” CMSWire.com, August 30, 2019. ↵ 
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2.8: Introduction to Basic Searches

What you’ll learn to do: perform basic web searches.

Being able to conduct an effective web search can help you enhance your business presentations, class reports, or personal
information gathering and problem-solving. The basic tools for search can be used on any web browser.
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2.9: Web Searching

Perform a web search using two different search engines.

The most productive way to conduct a search on the internet is through a search engine. A web search engine is a software system
designed to search for information on the World Wide Web. The search results are generally presented in a line of results often
referred to as search engine results pages (SEROs). The information may be a mix of web pages, images, and other types of files.
Some search engines also mine data available in databases or open directories.

There are a number of various search engines available and some of them may seem familiar to you. The top web search engines
are Google, Bing, Yahoo, Ask.com, and AOL.com. For the purpose of this course, we will be searching using the Google Chrome
web browser, and search first with the Google search engine and then Microsoft’s Bing search engine.

Searching on Chrome
Your supervisor at Rowan Retail asked you to find out what the most popular kids toys are this year. He wants to have those toys
stocked in the store for the upcoming holiday season. In order for you to find out that information, you turn on a computer and get
ready to conduct a search on the internet.

The first step is to open a Chrome browser by clicking on the desktop icon or the icon on the computer desktop’s taskbar. Once the
browser window is open, type www.google.com into the address bar on the top of the browser window and press the Enter (or
Return) key on the keyboard.

The browser now displays the large Google search bar. As you begin to enter the phrase most popular toys of 2017 into the search
bar, notice how the search bar moves to the top of the screen as the words are typed. This movement is normal; continue to type the
phrase.

Learning Objectives
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As the words are typed, the search engine will display a dropdown list of suggested search options. At this point either continue
typing the phrase or select the option of most popular toys 2017. Selecting a suggestion option is done in two ways; either by using
the mouse to click on the desired option, or by using the down arrow key on the keyboard to select an option, then pushing the
Enter (or Return) key.

The search is now entered and the webpage displays the results of your search. Notice how the results are displayed. Box #1 is the
first page of the search results. Box #2 is an advertisement targeted to be relevant to the search. The search results in the list are
titled by hyperlinks in a larger font and in a blue color. These links direct you to a website with information about the search. The
advertisements on the right side are linked to something to buy. When conducting a search for information, the primary focus is on
the list of search results, not the advertisements.
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Read through the search results title and select the one most closely matching the information you are searching for to give your
boss. Click on the results which seem most relevant to the search. Using these results, you can tell your boss what the top toys are
for the season.

https://assessments.lumenlearning.co...essments/18568

Microsoft Bing Search
Now search in a different search engine—Bing.

The general manager of the Rowen Retail asks you for ideas to improve the store’s customer service experiences. She wants to be
able to hear about customers’ experiences in a timely manner and address any service issues that are discovered. She would also
like to generate ideas for creating delightful experiences for the store customers. You decide to try searching for ideas on the Bing
search engine, so you turn on a computer and get ready to conduct search on the internet.

The first step is to open a Chrome browser by clicking on the desktop icon or the icon on the computer desktop’s taskbar. With the
browser window now open, type www.bing.com in the browser’s address bar and press the Enter (or Return) key. Notice that with
Bing, the main web page is always a photograph or picture.

Practice Question
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Now that the Bing search page is open, type in your key words, retail customer service improvement, into the search bar. You see
suggestions begin to appear, but none of them are what you are searching for so keep typing.

Now that you have typed in your full search phrase, push the Enter (or Return) button or click on the blue magnifying glass to the
right of the search box. The search results will look like this:
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This search displays similarity to the Google search display, with one difference. To the right on the page are suggestions for
related searches which you can click on to search with similar yet different keywords and phrases. Like the Google search, the first
few search results are ads for companies or software related to your search. These are indicated by the “Ad” label placed before the
web address. In order to discover more results, pull the scroll bar down the page.

If you select the top result it links to an article from Inc. Magazine about improving the customer service experience. Reading
through this article will give you information and ideas which you can research further and present to your boss. Scan through the
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other results on this page. There are many additional articles, ideas, and search results to discover as you continue to research more
ideas.
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You have now seen two different search engines, two different searches, and a few different ways to begin searching. Keep reading
through the next sections to learn additional ways to become more effective when searching on the web.

For more information about URLs and the information within web addresses, watch the video below.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=116
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2.10: Identifying Search Results

Identify number of results from each search.

Number of Search Results
In the previous section, you learned how to conduct a web search in a search engine. How do you know how many results from a
search you received? Let’s go take a look.

First, open the Chrome browser; make sure you use the Google search box and type in a search for accounting terminology. The
results will look similar to this page:

Look just above the definition box to see a large number: 32,800,000. This is the total number of accessible webpages and images
about accounting terminology. It also took the search engine only 0.37 seconds to find all of this information. Amazing!

Learning Objectives
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Change the search key words just a bit to see how the number of results changes. Type in accounting terms and see how many
results are displayed.

The small change in keywords decreased the results to 247,000,000. Any keyword search conducted will return a number of results
which you can see displayed like these examples. Often when there are so many search results it may become more difficult to
conduct effective research on a topic. There are ways to narrow down the results and conduct a more focused search which we will
go over a little later. Before we leave this subject however, there is one more way in Google search to visually see the size of the
search results. Scroll down to the bottom of the search results page.
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The larger the number of Os in the Google logo, the more results from the search you just created.

Now you know how to discover the number of your search results. This number changes for each search result. Have some fun and
play around with searches to see the numbers change.
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Bonus Search Navigation Tools

Here are a few bonus tools for navigating through search results.

1. Under the Google logo there are numbers. If the number 3 is selected, the third search result page will be displayed. If the
number 6, then the sixth search result page is displayed, and so on.

2. Selecting the right arrow button takes the browser window to the very next search result page (page 2) and continues to go page
by page (3, 4, 5, etc.) as long as you click the arrow button.

3. Clicking on the Next word navigates the browser window to the very next search result page (page 2) and continues to go page
by page (3, 4, 5, etc.) as long as you click the arrow button.

4. Once past the first results page a left arrow and Previous option appear. Use either of these to navigate to previous search result
pages.
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2.11: Opening Search Results

Open the first web search engine result.

Identifying Search Engine Categories
Each search result is categorized into a variety of subjects. Being able to navigate to the different types of search results is an
important skill to have when searching the internet. A browser has a small menu above the search results indicating these
categories.

Lets say that you are put in charge of creating a sales flyer for Rowan Retail store. It is suggested you use graphic design to make
the flyer stand out. This is the first time you have heard of graphic design and you wish to learn a little more about it. Using the
Google search engine, you can conduct a search on graphic design.

First open a browser window by clicking on the desktop icon or the icon on the computer desktop’s taskbar, then type in
www.google.com in the address bar and press the Enter (or Return) key on the keyboard.

In the Google search bar, type graphic design definition and press the Enter (or Return) key. The webpage displays the results of
your search. Above the displayed search results there is a small menu bar with six choices.

Search results are defaulted to All which means that every type of category (i.e. images, news, videos, shopping, etc.) is listed in
the search results displayed on the page. This menu is used when choosing to narrow a search by different categories. The More
option when selected drops down a small menu with additional category options. Now let’s explore how these categories work.
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Open First Web Search for All
With a browser window open and the Google search bar ready, type in retail development. Notice how the menu defaults to the All
option. The page displays maps of retail stores, a book about retail development, and various other websites. Locate the first search
result with an article or website and open the result by clicking on the left mouse button.

This opens the link to a webpage about the 2017 Global Retail Development Index which lists countries indicating their standing in
the retail development business. If this fits the search you are looking for, you can continue to read through this article. Nice job!

https://assessments.lumenlearning.co...essments/18571

Open First Web Search for News

Now we’ll to try a different category for search results by returning to the previous screen with search results for retail
development. Click on the back button at the top of the browser. When the page returns to the results, click on News in the search
category menu. The page will now refresh and appear with the latest news articles about retail development. Notice the blue bar
under the word News. This is used to visually indicate which category is currently being displayed.

Practice Question

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46440?pdf
https://assessments.lumenlearning.com/assessments/18571


2.11.3 https://biz.libretexts.org/@go/page/46440

Now identify the first news search result and click with the left mouse button to open that news article.

The hyperlinked article webpage will now be displayed. In this case, the link opened an article in the Bartlesville Examiner-
Enterprise news about the strong industrial and retail development this last year. You are now on your way to finding more news
items that fit the search.
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Open First Web Search for Video
Once again we’ll return to the previous screen with search results for retail development by clicking on the back button at the top of
the browser. When the page returns to the results, click on Video in the search category menu. The page will now refresh and
appear with the latest videos about retail development. Notice the blue bar is now under the word Video.

One more time, identify the first search result at the top of the list and click on the first link to open this video on the webpage.
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This link navigates the webpage to a Huntington, West Virginia news channel website containing a video about plans for a retail
development site. Some videos begin to play as soon as the webpage is loaded, but others like this video, will have a circle with an
arrow in the center of the video. This play button must be clicked to start the video playing.

Often with videos there are commercials that play before the video content. Be sure to wait through the commercial (or click on a
skip button if that appears) and then watch the content video.

https://assessments.lumenlearning.co...essments/18572

Review
There are different ways that search results are categorized. Decide which type may be most relevant to the search you are
conducting. If you are unsure which might be most effective, select a few different types and click on additional results to explore
and learn. Take some time to experiment and become comfortable with finding results and exploring the focused categories on a
search engine.

Contributors and Attributions
CC licensed content, Original

Opening Search Results. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY: Attribution

2.11: Opening Search Results is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Practice Question

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46440?pdf
https://assessments.lumenlearning.com/assessments/18572
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/02%3A_Internet_Research/2.11%3A_Opening_Search_Results
https://creativecommons.org/licenses/by/


2.12.1 https://biz.libretexts.org/@go/page/46441

2.12: Introduction to Advanced Searches

What you’ll learn to do: narrow a search to find more useful results.

Conducting searches in the Google search engine can lead to literally millions of results. In order to make searches more effective,
search results can be narrowed down through a few simple changes.
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2.13: Adjusting Search Parameters

Add additional parameters to the web search.
Identify changes in the search results.

Adding Boolean Operators
There are three terms used to modify a search using a Boolean operator. These terms are AND, OR, and NOT. In order to use these
terms they must be typed using all capital letters to work. Here is a video introducing how these three operators work in searches.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=124

Now let’s walk through a search using each of these operators.

AND

First we’ll start with AND. After a browser is open and the Google search bar is available, type in the search you want. For this
example, the search will be marketing AND services. Look at the page from the search and note the amount of search results. There
are over 785 million search results! What happens if the OR operator is used next for the same search? Does it increase or decrease
the results amount? Let’s find out.

Learning Objectives
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OR
Next is the OR operator. In the Google search bar, type in the next search using OR. For this example, the search will be marketing
OR services. This results page has even more results with over 7 billion possibilities! That’s far too many to search effectively.
Time to try another Boolean operator to narrow those results further.

https://assessments.lumenlearning.co...essments/18573

NOT
Last is the NOT operator. With the browser window open, type the same search using the operator NOT in the Google search bar.
For this example, the search will be marketing NOT services. The results page now has fewer results with 679 million. That is still
a huge number of results. The search results still may not be narrow enough so other methods can be used to reduce the number to a
more reasonable amount. Now let’s explore other ways to narrow a search.

Practice Question
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Adding Boolean Modifiers
What is a Boolean Modifier? It is a character that can be used in a search phrase to modify search results to a desired effect. The
three focused on in this course are: quotation marks “”, an asterisk *, and parenthesis (). This video gives an overview of how to
use each in a search.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=124

Now let’s walk through a search using each of these modifiers.

Quotation Marks
The first modifier to try is quotation marks. After a browser is open and the Google search bar is available, type in the search you
want using quotation marks. This time the search finds results for the specific phrase in the exact order retail store display shelves.
In order to see the difference quotation marks make, first run a search without using quotation marks. How many search results are
incurred from this first search?
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The results for the first search are over 1.2 million! That number is far too many to tackle for this search. A smaller number would
be more effective. It’s time to narrow the search results. This can be accomplished by enclosing the search between quotation
marks. Type “retail store display shelves” into the Google search box and notice the amount of search results with that exact
phrase. The search results are now 385,000. That is far fewer than the original one million plus!

Asterisk
You may not know the exact wording you wish to use for a search. Maybe there is a song in your head and you can’t remember the
exact phrase to sing. Possibly your search needs to include a few different word prospects. By using an asterisk in a search, more
results will be included in that search.

What if your employee at Rowan Retail needs to conduct a search for pet supplies, pet supply stores, pet suppliers and more? The
asterisk is the Boolean modifier to use. Try the search pet suppl* in the Google search bar. The search results include all of the
various aspects of the search the employee needed.
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https://assessments.lumenlearning.co...essments/18574

Parentheses
Parentheses (also sometime called Brackets) can be used to enclose certain search terms in order to specify the order in which the
search engine should interpret them. Like in a math equation, the information within parenthesis is read first, then the information
outside of the parentheses is read next by the search engine. Often parentheses are used in conjunction with other Boolean search
terms. This may seem a little tricky, but we’ll walk through an example.

There has been a recent outbreak in the local community of mice and rats. Customers have purchased all the traps and poison from
your store and are asking you about other solutions and products you recommend. Your first stop is a Google search to research
possible options.

On your computer web browser, you type (rat OR mouse) AND trap into the search box. Google now retrieves its results which
contain the word mouse or rat together with the word trap.

Now you have potential solution for customers to use while the store is waiting to be resupplied. The customers are pleased with
the extra step you’ve taken with customer service.

Practice Question
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Minus Sign Elimination
What if you need to eliminate search results that do not fit a search query? The minus sign is used exactly for this reason. The video
shows a few examples about how this works.

A link to an interactive elements can be found at the bottom of this page.

You can view the transcript for “Google Search – Minus Sign” here (opens in new window).

Let’s look at another example. Let’s say you realize you need a more organized method for scheduling employee shifts. There are
thousands of ways to organize this task on Google, but you don’t want to see them all. In a Google search bar, type in monthly
employee schedule template and press the Enter key.

The search results include everything, Word templates, Excel templates, PDF format, etc. Now you realize that and Excel template
is what you need and not the other options. Modify your search terms to now read monthly employee schedule template -word -
PDF and press the Enter key. The search results will now eliminate any result containing Word or PDF in them. Make sure there is
no space between the minus sign and the word you want to eliminate from the results.
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There are plenty of Excel and spreadsheet templates from which you can choose to match your need. Neat! If you decide the
template works better as a Word document, simply replace the -word with -Excel -spreadsheet and those options will now
disappear from the results. This tool is one of the best to narrow down results to a more manageable size for your searches.

https://assessments.lumenlearning.co...essments/18575

Common Search Mistakes
Before leaving this section there are a few common mistakes to identify to make searches more effective. Here is the short list:

1. A misspelled or mistyped search word. If you type website instead of websight or you type internet instead of intermet, search
results can be a bit off because of the misspellings. Sometimes there will be no results at all. Be sure to check your spelling
when running a search. Google tries to help by making suggestions like this one: 

2. Extra Space. Leaving a space between the minus sign and the word (e.g. – hummingbird) so what you want eliminated is not
removed from the search results.

3. Not Clearing Previous Search. If a search is copied and pasted into the search bar, sometimes the previous search phrase
remains and the search is muddled. Make sure the old search words are cleared off.

4. Extra Words. If search terms are copied and pasted into the search bar, occasionally extra words are copied along with the
desired terms. Double \-check and eliminate extra words before searching.

https://assessments.lumenlearning.co...essments/18576

Bonus Information

If you are wondering about the origin of the term Boolean, run an internet search for “George Boole” to learn more about him.

Contributors and Attributions
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CC licensed content, Shared previously
Using Boolean Operators. Authored by: PfauLibrary. Located at: https://www.youtube.com/watch?v=Yw9Djl_0vK4. License:
CC BY: Attribution
George Bolle. Provided by: Wikipedia. Located at: https://en.Wikipedia.org/wiki/George_Boole. License: CC BY-SA:
Attribution-ShareAlike
Optimizing Your Google Search. Authored by: University of Michigan Library. Located at: https://www.youtube.com/watch?
v=2zQ5iHvpnNc. License: CC BY: Attribution

2.13: Adjusting Search Parameters is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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2.14: Image Searches

Perform a web search for an image.

In the last section, you learned about the search menu, which organizes a search into various categories. One search category that is
often used is the Images option. This section will teach a variety of ways to find images and how to use them.

Identify Image Search Engine Tools
To get started, let’s start with a simple, fun search of strawberry pie images. As before, first open a browser window by clicking on
the desktop icon or the icon on the computer desktop’s taskbar. Type in www.google.com in the address bar and press the Enter (or
Return) key on the keyboard.

In the Google search bar, type strawberry pie and press the Enter (or Return) key. The webpage displays the results of your search.
Above the displayed search results look at the menu with six choices. As with all searches, the search results are defaulted to the
All category.

To find just the images for a strawberry pie, click on the Images category in the menu bar and look at the results.

Learning Objectives
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What a delicious-looking webpage! Besides the delectable images, there are a few tools to understand and be able to use on an
image search results page.

1. Image Category Buttons. This bar is an additional menu of categories that narrow down or focus in on a particular type of
image. You many only want to see an ice cream strawberry pie or pie with ice cream scoops. For example, look over the options
and notice the one for ice cream. You can click that to focus on images that feature ice cream. Hooray!

2. Additional Category Button Arrow. If a narrower category is desired and the first options don’t fit what you are looking for,
click on the right arrow. This arrow moves the category menu bar to the right to display more options for narrowing down the
images. Once this moves, an additional arrow appears on the left side. Clicking on the left arrow moves the button menu back to
the previous buttons.

3. Scroll Bar. As in many other webpages, the scroll bar on the right is moved downward by clicking on the gray bar and dragging
it down. This action moves the main page downward to display additional images.

4. Safe Search. The default setting for images is set to be a safe search for images. This default filters out any explicit images that
may be associated with a particular search. It is important in a work setting to have this filter turned on. If you begin to search
for images and discover this setting has been turned off, select the SafeSearch button and make sure the Filter explicit results
option has a check mark on it. If it does not, click on the option to turn the filtering on for searches.

Search by Image
Google search has an option to search by a picture or image instead of words. To search using an image, click on the camera icon in
the main search bar.

Two options will appear after the camera icon is selected: type or paste an image’s URL, or upload an image file from the saved
files on your computer.
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To get a better sense of how to use these two options we’ll stick with strawberry pie images. Our first search is with a hyperlinked
image.

Search by Image Address
Open a tab for a webpage with an image of a strawberry pie. Remember the button to open a new tab is the small gray button next
to the currently open tab. Type in a webpage address. In the screenshot below, the webpage address is browneyedbaker.com and
once the page loads, search for the strawberry pie picture.

Scroll down to the image on the webpage and use the mouse to right-click on the image and open a menu. In the menu is an option
to Copy image address. Navigate down the menu to that option and then click the left mouse button to select this option. The image
URL is now copied.

Click back on the first tab with the main Google search box and make sure the Search by image box is displayed. In the Paste
image URL section, make sure the curser is in the text field before you use Ctrl+V to paste in the address and select the blue Search
by image button to begin the search.

Another option to paste in the address is to use the mouse buttons again. After making sure the cursor is in the address box, click on
the right mouse button to make a menu appear. Select the Paste as plain text option by clicking on the left mouse button. The
image’s hyperlinked address is now in the address box and to start the search, click on the blue Search by image button.
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The Google search engine does its best to identify the image and return results that match the image to which it was linked. It keeps
the image in the upper address bar and instead of defaulting to the All option keeps the search in the Images category. Notice
Google considers this its “best guess” for the image. Sometimes Google might not identify the image correctly, but that is okay.
You can find a different image of the same thing and try again.

Search by Uploaded Image File

Google search has an option to search for a picture file uploaded from a computer. Now we’ll use a different type of strawberry pie
image for Google to search with once uploaded. Return back to the search bar.

To search using an uploaded image, click on the camera icon in the main search bar.

Two options will appear after the camera icon is selected. Select the Upload an image tab. A button to Choose File will be
displayed.
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Click on Choose File to bring up a window for selecting an image file on the computer.

1. This is the window displaying the current files, folders, and network drives on the computer.
2. The left scrolling menu lists folders and directories on a computer.
3. This displays the current location shown by the window. Clicking this field will show you the file path for this location.
4. The search box can let you search for files, images, and text in the currently displayed window.
5. This is the file folder containing the image to be uploaded. To select this folder double-click on it or select it and click on the

Open button in the window’s bottom right corner.

The folder with the image file is now open. Scroll down until the image you find the image you want. To select the image either
double-click on the file or select it and click on the Open button in the window’s bottom right corner. Another method to find an
image on the computer is by file name. Type the file name into the search bar area of the computer window and click the small
magnifying glass or hit the Enter (or Return) key to search for and find the file.

Once the file is selected, Google will upload the image and automatically search for that image file. The results page is displayed
once the file is uploaded with the chocolate strawberry pie image.
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Like the URL search, a picture of the image file is in the main search box, the search results are in the Images category, and Google
has taken its best guess as to what the image represents. Notice in this case it is searching not just for a pie, but also a chocolate
strawberry cake. Uploaded images are a little trickier to work with, but Google still usually brings back relevant results. However,
you may need to scroll through the choices a bit more to find those that are a close match.

https://assessments.lumenlearning.co...essments/18578

Image Search
To run an image search for business, use the same methods as described in the above sections. Let’s identify an image to use in a
presentation for the office products team.

You and your team must present the newest office products you suggest be stocked in the store. The presentation will be to the
other managers so they can inform their teams of the latest trends customers may ask about. Your team has identified ten new
products to put in the presentation. Finding images for a presentation is quick using a Google image search. Start by searching for
an image of one of the most popular products: the Adjustable Sit-Stand Workstation.

Open a browser window, go to the Google search bar and enter the phrase adjustable sit-stand workstation. Select the Images
category and you will see a page of images for different products fitting that description. The upper images will be sponsored or
advertised products that fit the search and will have an arrow on the far right to look at more of the sponsored products. Look for an
image for the presentation and locate the one that looks exactly like the product that will be in the store.

Click on the image and a box will appear showing a variety of ways to navigate to the image selected.

Practice Question
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Below the title of the image are three buttons showing different actions you can take. Also notice there are additional suggested
smaller images related to the image which was selected. These can be navigated to by clicking on any of the images under the
Related Images headline.

If the image needs to be seen in a different setting, the Visit Page button opens a new tab or window with the website containing the
image. If the View Image button is selected, a new tab or window will open with only the image displayed.

If the Share button is selected, a small menu will appear giving a selection of social media apps that can be used to share the image
(e.g. Facebook, Twitter, Google+, and Email). This is an easy way to share possible images for presentations if you need to
collaborate on using specific images with your team.

Image searches can be run for all of the products for the team’s presentation. This is one of the quickest ways to find images for
almost anything you need.

https://assessments.lumenlearning.co...essments/18577

Finding Noncommercial Images

Watch this video to learn how to find images licensed for reuse and/or commercial use. 

A link to an interactive elements can be found at the bottom of this page.

Practice Question
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2.15: Putting It Together- Internet Research
After learning about different ways to conduct research on the internet, you can now more confidently try searching for business
information and even information to satisfy personal curiosity. The world is now open in a much larger way for you to discover
ways to improve business management reports, presentations, conduct competitive analysis, and experience the variety of business
information out on the web.

This module has covered quite a few methods for searching. As a quick refresher, watch this video that reiterates most of the
aspects from this module.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=128
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2.16: Assignment- Search the Internet
For this assignment, you will search using the Google search engine and take a screenshot of your search results screen. Follow the
directions and then submit your assignment. If you find a step that trips you up, review the module or ask for help from your
classmates in the discussion forum.

Instructions
1. Open a web browser (Chrome, Firefox, or Edge) by double-clicking the icon on the desktop (or using any other method covered

in Internet Browsers.)
2. Make sure the page is on the Google search page. Type in www.google.com in the address bar and press the Enter (or Return)

key.
3. In the google search bar, type in a search for one of the following terms:

cash flow
company culture
income statement
business metrics

Then hit the Enter (or Return) key.

4. Look at the search results Google returned for your search, then take a screenshot by using the following steps:

1. Open the Snipping tool by using one of the methods discussed in the Snips and Screenshots page.
2. Take a rectangular or a window snip of the search results.
3. Save the snip as BA132_LastName_SearchInternet.png, replacing “LastName” with your own last name. (Example:

BA132_Hywater_SearchInternet.png)
5. Submit your image in your course online.
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2.17: Discussion- Search Results
Use two different search engines to conduct the same search. Pick one of the following phrases to search:

big-box store
largest supermarket chain
brick and mortar store
computers in business

Search for your chosen phrase using Google. Next, use the same phrase to search on Microsoft Bing. Once you’ve run the same
search on the two different engines, compare the results.

Discussion Questions
Which search engine provided the most results?
Which search engine provided the most relevant results?
How could you make the search return even more relevant results regardless of search engine used?

Share your opinions below and respond to two of your classmates’ thoughts.
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2.18: Discussion- Personal Data and Ethical Business Use
In this module the importance of ethical business research and personal data rights have been discussed. The rise of technology
increases the ease at which businesses mine data to research personal interests, demographics, shopping habits, geographical
locations, etc. in order to personalize their sales pitch to you as well as populations of larger groups.

Watch this video talking about the ethical difficulties at these cross-roads of privacy, technology and business research. After
watching the video consider a few questions to discuss.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=134

You can view the transcript for “The Ethics of Data – Personal Data & Privacy” here (opens in new window).

Discussion Questions
What negative experience have you had with a company using your personal data?
What positive benefits does personal data sharing have for you in this sharing economy?
How would you like to have more control over what company’s do with personal information?

Share your opinions below and respond to two of your classmates’ thoughts.
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3.1: Why It Matters- Microsoft Word Basic Skills

Why learn to complete basic skills in Microsoft Word?

Communication in the workplace is very important. Whether you run a one-person freelance business or work for a company with
thousands of employees, reading and writing documents on a computer is a vital skill.

Microsoft Word is the most popular word processing program and is considered the standard word processor for most businesses.
Word can help you create documents, save them, print them, and share them with others.

Reports, brochures, flyers, and memos are all examples of documents you can create in Microsoft Word.
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3.2: Introduction to Using Word

What you’ll learn to do: create and save files in Microsoft Word.

Learning to use Microsoft Word is one of the most helpful and versatile workplace skills you can acquire, and creating and saving
files is the first step. Many of the skills you will learn for Microsoft Word can also be applied to Microsoft Excel and PowerPoint.

Contributors and Attributions
CC licensed content, Original

Introduction to Using Word. Authored by: Lumen Learning. License: CC BY: Attribution

3.2: Introduction to Using Word is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46449?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/03%3A_Microsoft_Word_Basic_Skills/3.02%3A_Introduction_to_Using_Word
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/03%3A_Microsoft_Word_Basic_Skills/3.02%3A_Introduction_to_Using_Word
https://creativecommons.org/licenses/by/


3.3.1 https://biz.libretexts.org/@go/page/46450

3.3: Creating a New Blank Document and Finding Your Way Around

Create a new Word document.

Opening a New Document
You can open Word from the Start menu (or the Applications folder on a Mac) by clicking on the Word icon. The Word icon comes in a
variety of forms depending on your OS and version of Word, but it always features the color blue and the letter W.

Some examples of Word icons

While this course is based on Office 2019, it’s important to note that while Microsoft offers the purchase of Office 2019, that
version is constantly updating to match the latest updates in Office 365. If Tom purchases and downloads a copy of “Office 2019”
on Friday, and Sally purchases and downloads a copy of “Office 2019” on Monday, they may have different versions because there
was a point release over the weekend.

Because of this model, Microsoft is more incremental in their updates to the products. While there was a fairly noticeable difference
between Office 2007 and Office 2010, Office 2016 and Office 2019 are comparably similar.

When you open Word, some versions of Word may take you straight to a new blank document. Newer versions such as Word 2019 will
take you to a menu called backstage view to choose to open a new blank document or open a new document from a template. If you
already have a file open in Word, you can create a new document by clicking File>New. You can also use the shortcut Ctrl+N
(Command+N for Mac).

To open a blank document, double-click the blank document option.
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Overview of Word Controls
We will cover what many of these buttons and toolbars do in the pages to come. In the meantime, here is a general overview of what
you can see in the program. Many of these features are also in other Office products like Excel and PowerPoint, so it’s a good idea to
get a handle of the terminology.

The Word window has three main sections: the ribbon, the document, and the status bar.

Practice Questions
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Ribbon
The ribbon is at the top of the Word window and includes the window title bar. The ribbon below is for Word 2019. If you have a
different version, your ribbon may not look exactly the same. However, most features will look similar and be near a similar area. If you
have a different version of Word and you cannot find the feature you need, run a web search for where is feature/button
wordversion, replacing feature/button with the feature or button you are trying to find and version with your version number. For
example, if you are using Word 2010 and can’t find the controls for adding a column, run a web search for where is column word 2010.

1. Quick access toolbar. The quick access toolbar shows commonly used commands so that you can execute those commands with
one button instead of a couple. By default, the quick access toolbar has (from left to right) Save, Undo, and Redo. You can
customize which commands are available in the quick access toolbar by clicking the arrow to the right of the Redo button.

2. Tabs. The tabs on the ribbon are a way of organizing the many tools and options Word has. Clicking each tab provides a whole new
set of options. The tabs you will most frequently use are the File tab and the Home tab.

3. Currently selected tab. The Home tab is selected by default when you open Word. The currently selected tab is white, while the
other tabs are blue.

4. Group names. Within each tab, commands are grouped according to type. Those type names are near the bottom of the ribbon. For
example, the Font group contains all the font tools and options.

5. Dialog box. Clicking the small, boxed-in arrow at the bottom right-hand corner of each group opens a dialog box with more options
for each group.

6. Hide ribbon. If you find the array of buttons too distracting, you can hide the ribbon by pushing the arrow at the bottom-right corner
of the ribbon. You can reopen the ribbon with the ribbon display options.

7. Ribbon display options. The ribbon display options allow you to hide or reveal all or parts of the ribbon.

Status Bar
The status bar is at the bottom of the Word window. Again, your status bar may look different or not even be visible, but here is an
explanation of what many icons on the status bar mean.

1. Page count. The page count shows the total number of pages in the document and which page is currently visible in the window.
2. Word count. The word count displays the total number of words in the document.
3. Spelling/grammar check. A tiny checkmark on the book icon indicates that there are no spelling or grammar errors. When there are

spelling or grammar errors, the checkmark becomes an X. Clicking the icon then will show options for correcting each mistake.
4. View options. From left to right: Read Mode, Print Layout, and Web Layout. By default, the document is in Print Layout. This

changes how the document appears in the Word window; it does not affect how the document appears when sent to others, viewed
on a different computer, or printed. (Click each image to enlarge.) 
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Read Mode Print Layout

Web Layout

5. Zoom. By moving the bar to the left or right, you can zoom in and out of the document. This allows you to see the entire page at
once or to magnify a small part of the document.

To customize the status bar, right-click on it to see a dialog menu that allows you to check and uncheck tools you want displayed.
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3.4: Saving Files

Save a file in Word.

Saving a file is critical for editing, preserving, and sharing your work. If the program closes or your computer shuts down
unexpectedly while you are using Word, don’t worry. By default, Word automatically saves your work every 10 minutes and will
reload that save upon reopening the program. However, it is still a good idea to save every once in a while.

https://assessments.lumenlearning.co...essments/18584

To save a file, you can click the Save icon in the top-left corner, click File>Save, or use the shortcut Ctrl+S (Command+S for
Macs).

Click the save icon (above) or File>New
(below).

Whichever method you choose, you will see the backstage view with some option about where to save your file. (Pre-2016 versions
of Word will skip straight to the dialog box—If this applies to you, skip ahead to the Save dialog box.) First, you must choose
where you want to save your file.

OneDrive—This is Microsoft’s cloud computing storage system. If you have a Microsoft account and sign in, you can use
OneDrive for free to store your documents.
This PC—This lets you save your file directly to your computer. By default, the save folder is called Documents with the file
path This PC/Documents.
Add a Place—If you save a lot of documents to a particular folder, you can add that folder as a Save As option here.
Browse—To save a different folder not listed above, click Browse. This will take you to a dialog box that lets you search your
computer for the folder you want to store your document in.
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Once in the Save dialog box, you can choose the folder you want to save your file in. Select that folder, then type a name for your
file in the File name field.

Ensure that you are saving the document as the correct file type. There are a variety of options to choose, but you will almost
always choose Word Document (which is the default).

Click Save in the bottom-left corner next to the Cancel button. Congratulations! Your file is saved! As you continue to edit your
file, you can click the save icon, select File>Save, or use the shortcut Ctrl+S (Cmnd+S for Macs) to save the file again.
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Save As
If you have already saved a file, you can save another copy of it in a different location or with a different name or file extension.
Click File>Save As and the Save dialog box will once again appear.
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3.5: File Extensions

Learning Outcomes
Distinguish different file types in Word and when to use them.

Let’s start by taking a look at the following scenario:

Roy is working on a report that needs to be done before noon so his coworker Salomé can present the data to some
prospective customers. Roy just barely manages to finish formatting the final draft. Quickly he saves the file in Microsoft
Word, emails the file to Salomé, and leaves to have a well-deserved lunch. When he gets back, Salomé tells him she couldn’t
open his file, and as a result she didn’t have the data the customers wanted and lost the sale.

Roy tries to figure out what went wrong and learns that Salomé is running a different version of Microsoft Word than he is,
but he’s not sure how that caused the problem.

What can cause this kind of problem? Using the wrong file extension.

A file extension is a shortened form of the file type at the end of a file name. These extensions determine your document’s file type,
and the file type determines what programs can open the file. While most programs can read most file types, not every program can
read every file type.

The default file type is .docx (Word Document). This file extension works in most Microsoft Word programs. However, there may
be times when you want to save a different file type. For example, older versions of Microsoft Word and computers without
Microsoft Word installed cannot read .docx file types. If you create a .docx file and send it to someone who has an old version of
Word or no Word at all, that person probably won’t be able to read your file. If you have an old version of Word (2003 or older),
you can open .docx files if you download Microsoft’s compatibility package.

Because of the variation in file type compatibility, it’s important to be mindful of what file types are readable by the programs other
people have.

Practice Question
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Below the field for the file name is the Save as type field, which has a dropdown menu with file extensions.

Common File Extensions in Word Processing
.docx (Word Document)—default Microsoft Word file, works with Microsoft Word 2007 and later. Improved scripts, macros,
and other features from the older .doc.
.doc (Word 97–2003 Document)—default Microsoft Word file from Microsoft Word 2003 and older.
.txt (Plain Text)—also known as plain text format. This file type saves only the words you type—no images, no formatting,
just raw text.
.rtf (Rich Text Format)—Like plain text, RTF saves only words, but it does save some basic formatting (like bold and italics)
.pdf (PDF)—PDF files are readable with Microsoft Edge (which comes with Windows 10), the free program Adobe Acrobat,
and other image-viewing programs. Viewers cannot edit PDF files, but they will be able to view them regardless of their
operating system or what programs they have.

3.5: File Extensions is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.6: Introduction to Basic Text Formatting

What you’ll learn to do: format text in Microsoft Word for clarity.

Knowing how to use Word’s formatting tools can help you do your work faster and make your documents more attractive and easy
to read.

Compare the documents below. Which one communicates more clearly?
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3.7: Selecting and Moving Text

Reorganize text within a paragraph.

To select text, click and drag your cursor across the text.

The text that is highlighted in gray is selected text. Selected text can be copied, cut, or pasted. Many features and settings in
Microsoft Office are applied only to text that is selected.

Moving Text

Like files and folders, there are many ways to move text once it is selected:

Cut using Ctrl+X (Cmnd+X), move your cursor to the new location of text, then paste to the new location with Ctrl+V
(Cmnd+V)
Copy using Ctrl+C (Cmnd+C), move your cursor to the new location of text, then paste to the new location with Ctrl+V
(Cmnd+V)
Right-click selected text, select either Copy or Cut, then right-click the new location of text and select Paste

You can move text between pages, between paragraphs, or even between programs or windows. For example, you can cut text you
typed in a Word document and paste it into an email, or you can copy text from the internet and paste it into a PowerPoint
presentation.

In many programs, you can also drag text to a new location within the same program. For example, in Microsoft Word, you can
select text, then click and drag it to a new location within the Word document.

https://assessments.lumenlearning.co...essments/18586

Review
A link to an interactive elements can be found at the bottom of this page.

Contributors and Attributions
CC licensed content, Original

Selecting and Moving Text. Authored by: Lumen Learning. License: CC BY: Attribution

All rights reserved content
Word 2016 - Move, Copy, and Delete Text. Authored by: Professor Adam Morgan. Located at: https://youtu.be/f8jBx5_dz7w.
License: All Rights Reserved

3.7: Selecting and Moving Text is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.8: Bold, Italics, Underline

Learning Outcomes
Make text italic, bold, or underlined.

When formatting a document, you may need to emphasize or distinguish words. You can do this with bold, italics, underline, or all
three.

To bold, italicize, or underline, select the text you want to change. Then, select the Bold, Italics, or Underline button in the Home
tab as shown below.

You can also select the text, then use a shortcut:

Bold Ctrl+B (Command+B for Macs)

Italics Ctrl+I (Command+I for Macs)

Underline Ctrl+U (Command+U for Macs)

Applying the formatting twice removes the formatting. For example, selecting bolded text and then clicking the Bold button will
remove the bold formatting.

Practice Questions
https://assessments.lumenlearning.co...essments/18587

https://assessments.lumenlearning.co...essments/18588

Contributors and Attributions
Lumen Learning authored content

Bold, Italics, Underline. Authored by: Lumen Learning. License: CC BY: Attribution

3.8: Bold, Italics, Underline is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.9: Fonts

Change the size, font, and color of text.

Changing the font and adding color can make your document much more attractive—and more likely to attract people to your
message. The font options can all be found in the Home tab on the left.

Older versions of Word may have font options in the top-left corner or in the Format menu. If you have an older version of Word,
search the internet for where to find the font options in your specific version.

Font Size
The font size is a number that indicates how many points are in the height of the text, or high tall the text is in points. A point is 1/72
of an inch, so a 12-point font would be 12/72 of an inch. Most people are comfortable reading 10-point fonts or higher, so a 10- or
12-point font is a good choice for writing a paragraph of text. However, many situations call for larger or smaller text.

https://assessments.lumenlearning.co...essments/18589

To change the font size in Word, go to the Home tab and click on the dropdown menu for the number in the font ribbon. You can
pick a number and then start typing in that size. For a preview, select the text you want to change, then open the font size dropdown
menu and hover your cursor over each number to see the text change. Finalize that size change by clicking the size number.

You can also choose a custom size by typing a number and hitting enter.

Learning Objectives

Practice Question
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You can also increase or decrease the font size by clicking the Increase Font Size and Decrease Font Size buttons.

https://assessments.lumenlearning.co...essments/18590

Font
The font changes the styling of letters in your text. The menu for changing the font is in the Home tab near the top-left corner. Like
the font size menu, hovering your mouse over each font option will change selected text so you can see a preview of what each font
looks like.

Practice Question
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If you already know what font you want, you can start typing the name to skip to it in the menu.

Font Color
What’s life without a little color? Select the text you want to change, then click the font color dropdown menu, which will give you a
wide array of colors to choose from.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46456?pdf


3.9.4 https://biz.libretexts.org/@go/page/46456

If you want a different color, you can choose More Colors… (below Standard Colors in the dropdown menu) to bring up a dialog
box with even more options.

https://libretexts.org/
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Case
Case controls how much of your text is capitalized, or whether your text is uppercase or lowercase. This is a useful feature if you
want to change the case of your text without having to type it again.

Case Definitions
sentence case: text starts with a capital letter, like a sentence
lowercase: text is all lowercase, with no capital letters
uppercase: text is all uppercase, with all capital letters
capitalize each word: each word is capitalized
toggle case: reverses the case of whatever is selected (uppercase letters become lowercase and vice versa)

https://libretexts.org/
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Sentence case. lowercase

UPPERCASE Capitalize Each Word

3.9: Fonts is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.10: Alignment, Justification, and Indentation

Change alignment of text.

Alignment
To align or justify text, move your cursor into the paragraph you want to change, then click the left-align, right-align, centered, or
justify buttons.

Alignment is how text flows in relation to the rest of the page (or column, table cell, text box, etc.). There are four main
alignments: left, right, center, and justified.

Left-aligned text is text that is aligned with a left edge. You can also left-align your text with the shortcut Ctrl+L (Cmnd+L).
Right-aligned text is text that is aligned with a right edge. You can also right-align your text with the shortcut Ctrl+R
(Cmnd+R).
Centered text is text that is centered between two edges. You can also center-align your text with the shortcut Ctrl+E
(Cmnd+E).

Left-aligned Centered Right-aligned

Justification controls the spacing between words. A justified text increases the space between words to fill the entire line so that it
is aligned with both the left and right edges. You can also center-align your text with the shortcut Ctrl+J (Cmnd+J).

Unjustified text Justified text

Learning Objectives
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You can also change the alignment and justification settings in the paragraph dialog box.

https://assessments.lumenlearning.co...essments/18591

Paragraph Dialog Box: Justification and Alignment

Open the paragraph dialog box by clicking the small arrow icon in the bottom-right corner of the Paragraph group.

The dropdown menu to change the alignment is near the top of the dialog box.

Indentation
In many documents, indenting is a good way to distinguish the start of a new paragraph, especially when there is no paragraph
spacing.

To indent, hit the Tab key once on your keyboard at the start of a paragraph.

One tab at the beginning of the first line of a paragraph.

For more control over indentation settings, use the paragraph dialog box.

Paragraph Dialog Box: Indentation
Open the paragraph dialog box by clicking the small arrow icon in the bottom-right corner of the Paragraph group.

The indentation section is toward the middle of the dialog box.

Practice Question
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The Left and Right settings indent the entire paragraph to the left and right.

Indentation Comparison

Without indentation

With 1-inch indentation on left and right sides

The Special dropdown menu allows you to choose to indent the first line of the paragraph or to create a hanging indent. Upon
choosing First or Hanging, another field will appear to let you choose how big the first line or hanging indent will be.
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Hanging indent

First line indent

https://assessments.lumenlearning.co...essments/18592

Contributors and Attributions
CC licensed content, Shared previously

Align Left. Authored by: Arthur Shlain. Located at: https://thenounproject.com/term/align-left/60845/. License: CC BY:
Attribution
Align Center. Authored by: Arthur Shlain. Located at: https://thenounproject.com/term/align-center/60844/. License: CC BY:
Attribution
Align Right. Authored by: Arthur Shlain. Located at: https://thenounproject.com/term/align-right/60847/. License: CC BY:
Attribution
Justify Text. Authored by: Arthur Shlain. Located at: https://thenounproject.com/term/justify-text/60846/. License: CC BY:
Attribution

Lumen Learning authored content
Alignment and Line Spacing. Authored by: Lumen Learning. License: CC BY: Attribution

3.10: Alignment, Justification, and Indentation is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.11: Line and Paragraph Spacing

Change line spacing of text.

Line Spacing
Line spacing is the distance between lines of text. Loose line spacing can make text much more readable, while tight line spacing can fit
more text in a space.

To change the line spacing, select the lines you want to change. Then go to the Home tab and find the line spacing button in the
Paragraph section. The line spacing button triggers a dropdown menu from which you can select a line spacing.

The numbers in the line spacing dropdown menu reflect how much the line spacing will increase relative to the size of the line. For
example, a line spacing of 1 means the line spacing will be as large as one line, a line spacing of 2 means the line spacing will be the size
of two lines, and so on.

1.0 spacing 2.0 line spacing

3.0 line spacing

https://assessments.lumenlearning.co...essments/18593

Paragraph Dialog Box: Line Spacing

Open the paragraph dialog box by clicking the small arrow icon in the bottom-right corner of the Paragraph group.

Learning Objectives

Practice Question
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You can use the Line spacing dropdown menu to choose Single, 1.5, or Double line spacing. The At least option lets you set a minimum
point value for the spacing, and Exactly lets you set an exact point value. Finally, the Multiple option lets you set a line spacing greater
than Double (for example, 3 for triple spacing).

Paragraph Spacing
You may have noticed that by default, Word adds a space between each paragraph. You can change the size of that space or eliminate it
completely by changing the paragraph spacing. There is an option to Add Space Before Paragraph or Remove Space After Paragraph in
the line spacing menu.

For more control over the paragraph spacing, go to the paragraph dialog box.

Paragraph Dialog Box: Paragraph Spacing
Open the paragraph dialog box by clicking the small arrow icon in the bottom-right corner of the Paragraph group.

The Spacing section controls how much space comes before and after a paragraph. Here, you can increase or decrease the amount of
points that come before and after the paragraph you have selected.
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https://assessments.lumenlearning.co...essments/18594

Contributors and Attributions
Lumen Learning authored content

Line and Paragraph Spacing. Authored by: Lumen Learning. License: CC BY: Attribution

3.11: Line and Paragraph Spacing is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.12: Introduction to Workspace Tools

What you’ll learn to do: use spell check and find and replace tools.

The tools covered in this section are not necessary for creating a good document. However, they will make creating and editing
documents much easier and save you time in the long run.

Contributors and Attributions
CC licensed content, Original

Introduction to Workspace Tools. Authored by: Lumen Learning. License: CC BY: Attribution

3.12: Introduction to Workspace Tools is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46459?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/03%3A_Microsoft_Word_Basic_Skills/3.12%3A_Introduction_to_Workspace_Tools
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/03%3A_Microsoft_Word_Basic_Skills/3.12%3A_Introduction_to_Workspace_Tools
https://creativecommons.org/licenses/by/


3.13.1 https://biz.libretexts.org/@go/page/46460

3.13: Spell Check and Dictionaries

Correct spelling and grammar errors.

As the screenshot above demonstrates, Spell Check and Grammar Check are potentially useful tools, but very fallible ones.

You’ve probably seen the angry red wavy lines indicating a misspelled word as you type a document. Sometimes, those red lines
may have been helpful, saving you from making an embarrassing typo. Other times, those red lines are just annoying and distracting.
In this section, we will cover how Spellcheck works and how you can best use it to your advantage.

How Spell Checker Works

At top, the American English dictionary won’t recognize correctly spelled
British English words. At bottom, Word’s dictionary may highlight correct
words not included in its dictionary.

The spell checker tool compares every word you type against its dictionary, or database of words. If a word isn’t in its dictionary, the
word is marked misspelled with a red underline. This means words that are correctly spelled may be marked as misspelled,
especially brand names, specialized industry or scientific terms, and words in another language. With a little tweaking, you can teach
Microsoft Word (and other Office programs) how to spell uncommon words and names you use regularly. That way, genuine
mistakes are not lost in a sea of red underlines.

https://assessments.lumenlearning.co...essments/18596

Adding Words to the Dictionary
The simplest method to add words to the dictionary is to right-click the marked word and select Add. If you do not wish to add the
word but do not want to see the red line, you can select Ignore or Ignore All. (Ignore ignores that word once; Ignore All ignores the
word through the entire document.)

Keep in mind that adding a word to the dictionary will not necessarily add all versions of that word. For example, after adding iPad
to the dictionary, the dictionary will still not recognize iPads.

The good news is that adding a word to the Microsoft Word dictionary will also add it to the dictionary for other Office products
such as Excel and PowerPoint.

Learning Objectives

Practice Question
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The dictionary is case-sensitive. Adding iPad will not add ipad (a good thing, since ipad is incorrect). Keep this in mind if the word
you want to add to the dictionary is capitalized because it is at the beginning of a sentence.

Adding the capitalized form of the word will not add the lowercase form of the word. To get around this, add the
lowercase word to the dictionary first.

Keep in mind that adding a word adds it to whichever language dictionary you are using. For example, adding “c’est la vie” to the
dictionary tells Microsoft Word that “c’est la vie” is an English word. That may be nice for the occasional borrowed term, but it will
get overwhelming if you find yourself using a lot of foreign words not typically used in English vernacular. We will cover other
language dictionaries later in this section.

Bonus: Switching Language Dictionaries

You can switch your dictionary to a different language. Go to Tools > Dictionary, Dictionary, and choose a different language.

A passage of bilingual text using the American English dictionary.

A passage of bilingual text using the Spanish dictionary.

Grammar Check
Grammar check works much like spell check, searching through your document for grammatical and style errors rather than spelling
errors. Grammar check underlines words or phrases in blue or green, depending on your version of Word.

Right-click on the underlined word or phrase to see suggested corrections. You can also choose Ignore, Ignore Once, or Ignore All if
the “error” is actually correct. Like spell check, grammar check is prone to errors. In some versions of Word, you may see an Ignore
Rule or “Don’t check for this issue” option. Clicking Ignore Rule will make Grammar check ignore that specific grammar rule in
your document while still looking for other grammar errors.
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https://assessments.lumenlearning.co...essments/18595

Contributors and Attributions
CC licensed content, Shared previously

Word the critic. Authored by: Anders Sandberg. Located at: https://www.flickr.com/photos/arenamontanus/2753162618.
License: CC BY: Attribution

Lumen Learning authored content
Spellcheck and Dictionaries. Authored by: Lumen Learning. License: CC BY: Attribution

3.13: Spell Check and Dictionaries is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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3.14: Find and Replace

Find and replace text.

Find and Replace helps you to find words or formats in a document and can let you replace all instances of a word or format. This is particularly handy in
long documents.

To use Find and Replace, use the shortcut Ctrl+H or navigate to Editing in the Home tab of the ribbon, then choose Replace. To just quickly find
something, use the shortcut Ctrl+F (Cmnd+F) or navigate to Home>Editing>Find.

Replace

Use the shortcut Ctrl+H or navigate to Home>Editing>Replace to reach the Find and Replace dialog box.

Type what you want to find in the Find what field, and the replacement in the Replace with field. (Note that you can move the Find and Replace dialog
box by clicking the title bar and dragging it elsewhere so you can see what was behind it.)

Find Next highlights the first occurrence of the Find word. Clicking Find Next again will highlight the second occurrence, clicking Find Next again will
highlight the next occurrence, and so on.

Find Next. The first Rowango is highlighted.

Clicking Replace replaces only the highlighted occurrence of the Find word.

Learning Objectives
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Replace. The first Rowango is replaced with RowanGo. The other Rowango words remain the same.

Replace All replaces every instance of the Find word with the Replace word. A small dialog box will appear to tell you how many replacements were
made.

Replace All. Notice that every instance of Rowango has been replaced with RowanGo. (highlighting added for this course and not part of the document)

The Pitfalls of Replace All

Be careful when you use Replace All. It will replace every occurrence of the Find phrase, including occurrences you hadn’t intended to replace. For
example, replacing every “kg” with “kilogram” could result in the word backilogramround instead of background. Use spaces in the Find field to avoid
this: replacing ” kg ” with ” kilogram ” will leave background the way it is. Some versions of Word also have a Whole Words checkbox option; this will
ignore when a search term appears in the middle of a word.

A link to an interactive elements can be found at the bottom of this page.

Replace: More Options
Click the More>>> button in the bottom-left corner of the Find and Replace dialog box to find more options. There are many options here, but we will
focus on three.
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1. Match case. Case is whether a letter is uppercase or lowercase. If the Match case box is checked, then Find and Replace becomes case-sensitive. For
example, checking the Match case button and then searching for “Fishing Goods” will find “Fishing Goods” but NOT “fishing goods” or “Fishing
goods.” If the Match case box is unchecked, then searching for “Fishing Goods” will find “Fishing Goods” and “fishing goods” and “Fishing goods”
and so on.

2. Format. Click the Format button to select from a variety of formatting options such as Font, Paragraph, and so on. When a formatting style is selected
for Find, the Find term must have that formatting to be found. (Leave the Find field blank and choose a formatting style to find all occurrences of that
formatting.) Similarly, choosing a formatting style for the Replace field will replace the Find term with whatever is in the Replace field with the
Replace formatting. For example, this search finds all instances of the word mobile and applies bold and green formatting: 

3. Special. Special refers to special characters, or characters that are not on the typical keyboard. In Find and Replace, some of these characters can also
be things like “any digit” or “any letter.”

Find Function

You can also find words with the Find function. Simply finding where a word is used in a document is faster with the Find function.

To open the Find function, use the shortcut Ctrl+F or navigate to Home>Editing>Find. This will open a Navigation menu to the left.
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Type in the Navigation text field that says “Search document” for the term you want to find. The term will be highlighted throughout the document. You
can scroll through the document to see the highlighted occurrences, or you can scroll down through the Navigation pane to see where each word occurs in
the text.

https://assessments.lumenlearning.co...essments/18597

A link to an interactive elements can be found at the bottom of this page.
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3.15: Introduction to Lists

What you’ll learn to do: create and format numbered and unnumbered lists.

Using lists can help you provide emphasis or visual clarity to your ideas.
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3.16: Lists

Create and format numbered and bulleted lists.

There are two kinds of lists: bulleted and numbered lists. The buttons for both are found in the Paragraph group, as seen in the screenshot below.
(Bulleted to the left, numbered to the right)

To start, select the text you want to change, then click either the bulleted or numbered list button. Alternatively, you can click the bulleted or numbered
list button and then start typing.

Bulleted list

Numbered list

If you click and hold either of the list buttons, more options will appear.
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Bulleted Options

In the bulleted options, you can select a new bullet from the bullet library. At the bottom, the Define New Bullet… option will let you pick any symbol or
even a picture from your computer to be the bullets.

Numbered Options

In the numbered options, you can choose what kind of numbering to give your numbered list. For example, you can use letters or Roman numerals. At the
bottom, the Define New Number Format… opens a dialog box that will let you further customize how your numbered lists appear.

https://assessments.lumenlearning.co...essments/18598

List Levels

The quickest way to increase the list level of a single line is to hit the Tab key once. To increase and decrease multiple lines, select the text you want to
change, then click the increase or decrease list level button as shown in the screenshot below.

Practice Question
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You can also use the Change List Level option at the bottom of the numbered options.

To customize how the list levels look, go to the list level options as shown in the screenshot below.

You can choose one of the different multilevel list styles available in the menu, or you can customize your own by choosing Define New List Style… or
Define New Multilevel List…

You can also change the list level of a line here by selecting Change List Level, then selecting a new level in the menu as pictured above.

Review
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A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=168
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3.17: Putting It Together- Microsoft Word Basic Skills

Now that you have some of the basic Word principles down, you can move on to more complicated formatting.

Remember if you get stuck or can’t remember how to do something from this module, you can always come back and review.
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3.18: Assignment- Create Basic Document
For this assignment, you will create and format a business memo. Follow the directions, then submit your assignment. If you get
stuck on a step, review this module and ask your classmates for help in the discussion forum.

Memo Text
To: All Employees 
From: Sierra Rowan, Store Manager 
Date: September 1, 2019 
Subject: New Shelves 
Some of you may have noticed in recent weeks that the shelves in the home goods section are beginning to sag. We will be
replacing those shelves with new, reinforced metal shelves starting next week. The shelves will be replaced 1:00–4:00 a.m., during
our least busy hours. Several aisles will be off-limits to customers during that time as a safety precaution. 
The following aisles will be affected: 
Kitchen appliances 
Kitchen & dining furniture 
Kitchen storage 
Home goods clearance 
Please direct customers looking for items in the affected aisles to the Outdoor Furniture and Patio Accessories areas.

Memo Directions
1. Create a new blank document in Microsoft Word.
2. Copy and paste the Memo Text (see above) into your Word document. 

3. Save the document to the Rowan folder on your desktop as BA132_LastName_Memo.docx, replacing “LastName” with your
own last name. (Example: BA132_Hywater_Memo) It is a good idea to save your work periodically. 
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4. Change the font of all the text to Arial, size 14. 

5. Select the first three lines of the memo (To through Date lines). Remove the spacing after the paragraphs or set the After
paragraph spacing to 0. 
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6. Select the Subject line. Set the After paragraph spacing to 30 pts. 
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7. Bold “To:”, “From:”, “Date:”, and “Subject:” in the first four lines. 

8. Justify the paragraph starting with “Some of you”. 
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9. Select the four lines “Kitchen appliances” through “Home goods clearance” and make them a bulleted list. 

10. Indent to 0.5 inches the first line of the “Some of you” paragraph and the “Please direct customers” paragraph.
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11. In the first four lines of the memo, hit the Tab key twice after To:, From:, and Date:. Hit the Tab key once after Subject:. 

12. Save your work and submit the document in your course online.
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3.19: Discussion- Paragraph Styles
Watch the five-minute video below. While the video shows an older version of Word (Microsoft Word 2010), the same features and
many of the same buttons are also found in other versions of Word, including 2019 and 365.

A link to an interactive elements can be found at the bottom of this page.

You can also view the transcript for the video “Word 2010: Paragraph Styles” here (opens in new window).

Discussion Questions
In what situations would the Styles feature be useful?
Would you ever use this feature?
Why or why not?

Share your opinions below and respond to two of your classmates’ thoughts.
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4.1: Why It Matters- Microsoft Word Intermediate Skills

Why learn to complete intermediate skills in Microsoft Word?

We have already learned to make documents clear and readable; however, there are other ways to make your document stand out
and creatively engage readers, such as changing the basic layout of a page. In this module, we will cover some layout techniques
and a few tools that will make documents easier to create and edit so you can really take control of Word.
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4.2: Introduction to Page Layout

What you’ll learn to do: change page layout.

There is more to a document than the text it contains. How that text is arranged can contribute to how a document is read or
perceived. In this section, you will learn a few page layout tools that can help you fit more information on a page or arrange
information so that it is communicated clearly.
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4.3: Tab Stops

Set tab stops.

You may recall from Alignment, Justification, and Indentation that hitting the Tab key indents a paragraph. Each hit of the Tab key
inserted a tab space. By default, a tab space stretches to fit the next 1/2 inch interval on the page. Tab stops control the width of a
tab space so that it can be greater or less than 1/2 an inch.

By changing the width of tab spaces, you can align text with tab stops rather than the edge of a column, page, or margin. This can be
useful for aligning text different ways in the same line.

Without tab stops

With tab stops

There are several kinds of tab stops, but the ones we will focus on in this course are the left tab, the center tab, and the right tab.

Left tab Center tab Right tab

Aligns text left along the tab stop line Aligns text centrally to the tab stop line Aligns text right along the tab stop line

There are two main methods for setting tab stops: the ruler and the tab dialog box.

Tab Stops Using the Ruler

First, make the ruler visible (if it isn’t visible already). Go to View>Show and check the Ruler box.
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The rulers display the width of the page in inches. The shaded-in gray spaces on the ruler represent the margins. This screenshot
shows margins of one inch.

To add a tab stop, select the paragraph or paragraphs the tab stop will be added to. Select the type of tab stop by clicking the tab
selector icon in the top-left corner until it shows the appropriate icon ( , , ). The tab selector button is located at the top of the
vertical ruler and to the left of the horizontal ruler.

Right now the Left Tab is selected.
Clicking the icon will switch to a
different Tab type.

(Note: there are more tab options, such as decimal tab, bar tab, first-line indent, and hanging indent. Feel free to experiment with
these later.)

Once the type of tab stop you want is selected, click anywhere along the horizontal ruler to place the tab stop.
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The tab stop is represented by the icon in the ruler. In the screenshot above, the right tab is marked with a green circle. Notice that
the lines below are right-aligned with the tab stop, with the exception of the last line. The last line is not aligned because the line is
too long for the text to fit with the right-align.

To move the tab stop, click and drag the tab icon along the ruler.

The selected paragraphs moved with the tab stop. (And notice that the last line is aligned now that there is enough space for the
text.)

To remove a tab stop, click the icon and drag it off of the ruler.

https://assessments.lumenlearning.co...essments/18599

Tab Stops Using the Tab Dialog Box
You can also add and move tab stops using the tab dialog box. To reach it, go to the Paragraph dialog box in the Home tab.
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Then click the Tabs button at the bottom-left corner of the Paragraph dialog box.

You have now reached the Tab dialog box.

Choose which type of tab stop you want in the Alignment area (Left, Center, Right, Decimal, or Bar). Type the distance of the tab
stop in inches, then click Set or OK to apply that tab stop to whichever lines are selected.
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Use Clear to remove tab stops. You can also still click and drag the tab stop along the ruler to change its location or drag the tab stop
off the ruler to delete it.

Leader

The leader is a filler for the tab space. Instead of leaving the tab space blank, you can fill it with periods or other characters. This is
particularly useful for a table of contents, but it can have other applications too. To choose a leader, select one of the options under
the Leader section of the Tab dialog box.

Optional: Bar and Decimal Tabs

Two of the other tab stop types are the bar and decimal tabs.

The bar tab icon is a straight vertical line (|). Bar tabs do not align text. Instead, a bar tab adds a straight vertical line at the point of
the bar tab. The line will be the length of the selected lines.
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The decimal tab icon is . Decimal tabs align text based on the placement of periods (or rather, decimal points). This is useful when
lining up numbers, especially dollar amounts.

Side-by-Side Comparison of Decimal Tab Alignment

Notice that when a decimal tab is applied, the decimal points will line up regardless of what is on either side of the decimal point.
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4.4: Columns

Learning Outcomes
Create columns.

Reference books, magazines, and newspapers commonly use a layout with two or more columns.

Columns can help you fit more text on a page or provide better readability. Some documents, such as a newsletter or newspaper, are
customarily formatted with columns. Columns are typically used for shorter pieces of text (like dictionary definitions or short
articles) rather than longer readings.

To add columns, either select the text you want to arrange into columns or place your cursor where you want columns to start.
Then, go to Layout>Columns and select the number of columns. (For more than three columns, select More Columns… at the
bottom of the menu.)
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You can also end a column with a column break. Place the cursor where you want to end a column, then select
Layout>Breaks>Column Break.

Adding a column break will end the column and send text to the next column. Note that a column break is tied to the location
within the text, not the location on the page. Putting a column break before the Mobile Commerce headline will put a column break
before the Mobile Commerce headline, regardless of how much text comes before or after the Mobile Commerce headline.

Practice Question
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4.5: Headers and Footers

Insert text into header and footer.

Headers and footers are the top and bottom sections of the document respectively. They are separate sections from the main document, and are often used
to hold footnotes, page numbers, titles, and other information.

The header and footer controls are in the Header & Footer group of the Insert tab. (Insert>Header & Footer)

The Header and Footer options each contain a dropdown menu. Click one of the Built-in options to insert it, or select Edit Header (or Edit Footer) to edit
the header (or footer).

The header/footer will be represented by a dotted line. While in header/footer mode (when the dotted lines are visible), you cannot edit the main text. You
can go back to editing the main text by selecting the Close Header and Footer option on the right side of the ribbon.

Header

Footer
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The information in the header or footer is repeated in every header or footer in the document.

First page

Second page

https://assessments.lumenlearning.co...essments/18601

Page Numbers
You can number the pages in your document automatically in the header/footer options with the Page Number option. 

Choose a location on the page by going to the Top of Page,
Bottom of Page, Page Margins, or Current Position options and selecting an alignment. (Current Position refers to where the cursor is located.)

The page number will be repeated on every page in the header or footer, but the number will change to reflect the appropriate page number. You can also
change the way the pages are numbered by going to the Format Page Numbers option.
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4.6: Introduction to Text Boxes

What you’ll learn to do: create and modify text boxes.

Things in a Microsoft Word document that are not text are called “objects.” The first object we will cover is a text box. Many of the
controls and features of text boxes are also applicable to images, another important object in Microsoft Word.
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4.7: Text Boxes

Create and modify text boxes.

Text boxes are containers for text that can be customized and moved around. They are useful for emphasizing or decorating text.

Some examples of text boxes.

To add a textbox, go to Insert>Text>Text Box. There are a few pre-created Built-in options to choose from. Click one of the Built-ins to add it to the
document. You can also draw your own by choosing Draw Text Box, then clicking and dragging where you want the text box to be.

Text Box menu

Learning Objectives
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Drawing a text box

Once created, you can type in the text box, change the size of the text box, move the text box around, and even rotate the text box.

1. Anchor point. The anchor is the point at which the text box intertwines with the rest of the document. Click the anchor icon to select the entire text
box.

2. Rotation control. Click the circular arrow and then drag to rotate the text box.
3. Wrap text. This controls how content in the rest of the document interacts with the text box. Text can go around the text box, in front of the text box,

or skip over the text box. Text wrap is covered in more detail in the Images section.
4. Resize points. The white dots on the border of the text box control the width and height of the text box. Click and drag any of the white dots to move

that side or corner.

To move the text box, hover your cursor near the edges of the box. When you see four arrows behind the cursor, you can click and drag the box wherever
you want it.

Formatting Text Boxes
When you create a text box, a new tab will appear on the ribbon called Format. There are a lot of different tools in the Format tab, some of which may
look familiar.

1. Shapes

The Shapes group (at the far left) allows you to change the shape of the text box. Click the Change Shape button in the Shapes group and then Change
Shape to see a dropdown menu with many shape options. Click an option to apply it to the text box.
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You can also create a custom shape using the Edit Points option (just below Change Shape). The points of the text box will be outlined. Click and drag
the black dots to alter the shape of the text box.

2. Styles

Click the dropdown arrow to open a dropdown menu with a variety of styles for your text box. Some styles may have a gray checkered pattern. The gray
checkered pattern indicates transparency. Hover over each effect to preview the results; click to apply the effect.
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3. Text

The Text group of the Format tab gives you additional control of the text in the text box.

Text Direction

By default, text runs horizontal in the text box. But you can choose to rotate the text so that it runs vertically by choosing Rotate all text 90° or Rotate all
text 270°.

Text Alignment

Text alignment of text boxes works much like text alignment in the main document. Instead of the margin or border of the page, the text aligns with the
border of the text box.
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Create Link

Create Link lets you create a link between two or more text boxes so that text can flow, or continue, from one text box to the next.

Select a text box, then click Create Link. The cursor will change into a paint bucket. Click on the second text box to link them. Once linked, anything
typed in the first text box will flow over to the second. (Note that the second text box must be empty before you link to it.)

https://assessments.lumenlearning.co...essments/18602

4. Arrange

The arrange option controls the order of text boxes and other elements on a page. Although a Word document is a two-dimensional file, arranging
elements requires a bit of three-dimensional thinking.

The main document, where the main text is, is the bottom layer of the document. When you create a text box, the text box is on top of the rest of the
document. Adding another text box puts the new text box on top of the first one.

With the Arrange option, the text box order can be rearranged.

Bring forward brings the text box forward one spot.
Send backward sends the text box backward one spot.

These options are also available when right-clicking on a text box:

Practice Question
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Bring to front brings the text box to the very front so that it is on top of everything else.
Send to Back sends the text box to the very back so that everything else is on top of it.

The yellow text box has been brought to the front, while the blue text
box has been sent to the back.

Shapes

Sometimes you may want just a shape with no text, or you may want to figure out what shape you want a text box to be before you add text.

To insert a shape, go to Insert>Shape and select a shape from the menu.

Once you select a shape, click and drag to draw the shape. You can then apply a text wrap, rotate the shape, or send the shape in front of or behind text.

Click and drag
Square text wrap

You can change the color or add other effects to the shape from the Format tab, which appears when you click on the shape.
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If you decide you do want to add text to the shape, double-click on the shape and start typing to make the shape a text box.
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4.8: Introduction to Tables

What you’ll learn to do: create tables to organize information in a Word document.

Inserting tables into your Word document can help organize and display data.
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4.9: Creating Tables

Learning Outcomes
Create and edit a table.

Inserting tables into your Word document can help organize and display data.

To create a table, click Insert>Table. A small menu will open with a grid that represents table cells. Mouse over and select how
many rows and columns you would like in your table.

You can also choose the Insert Table… option below the grid instead. This will take you to a dialog box where you can choose how
many rows or columns you want, as well as the column width. Using the Insert Table… option is also a good choice if you need
more cells than the grid provides.

If you ever want to change the dimensions of your table, you can right-click in the table and choose to insert more columns and
rows, as shown below.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46475?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/04%3A_Microsoft_Word_Intermediate_Skills/4.09%3A_Creating_Tables


4.9.2 https://biz.libretexts.org/@go/page/46475

You can select multiple cells or even entire rows or columns by clicking and dragging your mouse across the cells. Right-click on
selected cells for more options to insert or delete cells.

To enter data into the table, simply select a cell and start typing.

Practice Question
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4.10: Converting Text to a Table

Learning Outcomes
Convert existing text into a table.

Let’s say you already have some data, but it’s not in a table yet. Is there an easy way to put the data in a table without having to
type everything again? Yes, there is! Let’s look at the example below.

Here, information is separated by tabs. Select the information, then go to the Table menu and choose Convert Text to Table to turn
this data into a table.
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Notice that you can use other things to separate your text and still get a clean table, such as paragraphs (the Enter key) or commas.
You can also enter your own character in the Other box.

When you’ve finished choosing settings, hit OK to convert the text to a table.
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Practice Question
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4.11: Formatting Tables

Learning Outcomes
Apply table styles and formatting.

Once the table is created, you can make the table more interesting to look at and easier to read by applying formatting such as
colors, spacing, and borders. Click somewhere in your table, and some new menu options will appear in the top menu, Design and
Layout.

There are many options in the Design menu. A table style will do a lot of formatting for you. Click on the Table Styles dropdown
menu (circled in the screenshot above) and hover over each style to see a preview of it. Click on a style to apply it to the table.

You can add borders to individual cells, rows, or columns. Select the cells, then go to the Borders area of the menu in the top-right
corner to customize the border settings. In the screenshot below:

1. This changes the type of border. There are solid, dotted, and dashed borders to choose from.
2. This changes the width or thickness of the border. The smaller the point, the thinner the line.
3. This controls which side or sides of the cell the border appears on. From here, you could make only vertical borders appear,

only outside borders appear, and so on.
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It’s a good idea to create a table in Microsoft Word and fiddle with the table design settings yourself. Remember, you can always
hit Ctrl+Z (Command+Z on Mac) to undo a previous action.
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4.12: Introduction to Images

What you’ll learn to do: place images in a Word document.

Images are a huge asset for certain documents. A brightly colored image can draw customers in to look at a flyer, or a graph can
explain a concept better than a paragraph. Placing images into your document can really make it pop.
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4.13: Adding Images

Learning Outcomes
Insert images.

To add an image, put your cursor where you want the image to appear (at the beginning of a paragraph is a good place). Then go to
Insert>Pictures.

A window will pop up to let you choose a picture saved on your computer.

The image will appear where you placed your cursor. You can click and drag the image to anywhere within the text.
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You may recognize a lot of these controls from the Text Boxes section, such as the resize dots at each side and corner that you can
use to increase or decrease the size of the image. To maintain the proportions of the image, hold down the Shift key while clicking
and dragging a corner. You can also rotate the image by clicking and dragging the circular arrow at the top of the image.

Practice Question
https://assessments.lumenlearning.co...essments/18606
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4.14: Text Wrap

Change image layout options.

Notice that wherever the image is placed, the line spacing dramatically increases to fit the size of the picture. This is because images are treated as an
inline text character. In other words, Word treats the image like it would treat any word or letter of text. You can change this by applying a text wrap.
Text wrap causes all of the text to wrap around the image so that the image does not interfere with line spacing.

Text wrap

There are a couple of ways to get to the text wrap options and apply a text wrap.

Method 1: Quick Apply
Click the box to the right of the image with a rainbow-shaped icon.

Method 2: Format Tab
When you click on the image, the Format tab will appear in the ribbon. From the Format tab, you can choose Warp Text.
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Method 3: Position

Go to Format>Position for options that not only apply text wrap but also position the image on the page.

Position in Top Center with Square Text Wrapping

Text Wrap Options

Regardless of which method you use, the text wrap options are the same. The text wrap you will probably use the most is the square text wrap, but there
are other text wraps too.

Square—Text wraps around the image in a square shape
Tight/Through—Text wraps around image, regardless of what shape the image is. This text wrap works best with images that have no background.
Top and Bottom—Text stops when it hits the top of the image and continues at the bottom of the image; no text is to the left or right of the image
Behind text—Image is behind text. Text will cover image.
In front of text—Image is in front of text. Text behind the image is not visible.
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Square text wrap Tight text wrap

Top and bottom text wrap

Behind text
In front of text

After the text wrap is applied, you can click and drag the image to anywhere in the document, and the text will wrap around it accordingly.

https://assessments.lumenlearning.co...essments/18607
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4.15: Introduction to Hyperlinks

What you’ll learn to do: add a hyperlink.

Hyperlinks allow you to send your audience to the internet to see background information or a reference source. Hyperlinks can
also provide a shortcut for the audience if after reading the document they need to visit a particular website or send an email to a
specific address.

Hyperlinks only work when a document is viewed on a computer, not when a document is printed.
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4.16: Hyperlinks

Add a hyperlink.

A hyperlink is a piece of text that when clicked takes the user to a webpage. Hyperlinks can also link to email addresses; when
clicked, these hyperlinks will open an email program (likely Microsoft Outlook) to send an email to that address. Hyperlinks are
formatted with a different color (blue, by default) and an underline.

Inserting a Hyperlink
To add a hyperlink to a Word document, select the text to be changed into a hyperlink.

There are three options to add a hyperlink:

1. Use the shortcut Ctrl+K.

2. Right-click the selected text and select Hyperlink…

3. Insert>Links>Hyperlink.

Any of these options will open up the Hyperlink dialog box.
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The Text to display textbox at the top contains the text that will be formatted as a hyperlink. It can be changed from this window.

The Address textbox at the bottom is where the hyperlink will send users. Type a webpage URL or email address in the Address
textbox.

Note that in the screenshot above, the Address textbox contains a file path. You can type in a file path to link to files stored on your
computer or in a shared database. Be aware that a hyperlink is only a path to a file, not the file itself—if a user does not have the
file on his or her computer, they will not be able to open whatever file you have linked.

When the hyperlink is inserted, the text will change to the hyperlink style. By default, this is blue and underlined, but this is
customizable in the Color Theme options. (Design>Colors>Customize Colors…)

Visiting a Hyperlink

Hover over the hyperlink to see a preview of where the link will take you. Be careful when following hyperlinks to unfamiliar
websites.

Hold down the Ctrl key while clicking on the hyperlink to open the webpage or email (on a Mac, you don’t have to hold any key—
just click). If the link was to a webpage, Microsoft Edge (or Internet Explorer) will open and load the hyperlinked page. If the link
was to an email address, Microsoft Outlook will open and create a new message with that email address in the To field.
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https://assessments.lumenlearning.co...essments/18608

After the hyperlink has been clicked, the color will change to indicate you have already been to that link. By default, the color
changes to purple.

Tip

If you prefer a different browser such as Firefox or Chrome, set that program as your default browser and Word will open
hyperlinks in that browser instead.

Editing Hyperlinks

To edit a hyperlink, right-click the hyperlink and select Edit Hyperlink.

Practice Question
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The hyperlink options on the dialog menu are as follows:

Edit Hyperlink… Takes you to the same dialog box for inserting a hyperlink, allowing you to change what the hyperlink links
to.
Open Hyperlink. Performs the same function as Ctrl+click. Opens the hyperlink in Microsoft Edge or Internet Explorer (or
default browser).
Copy Hyperlink. Copies the hyperlink (not the text that changes color).
Remove Hyperlink. Removes the hyperlink, restoring the text to plain text.
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4.17: Putting It Together- Microsoft Word Intermediate Skills

Now that you have some of the basic layout techniques down, you are ready to move on to
adding more elements to your document.

Remember if you get stuck or can’t remember how to do something from this module, you can always come back and review.
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4.18: Assignment- Create Document with Tables and Images
For this assignment, you will format a document with a table and an image. Follow the directions, then submit your assignment. If
you get stuck on a step, review this module or previous modules and ask your classmates for help in the discussion forum.

1. Download the report document and open it in Microsoft Word.
2. Save the document as BA132_LastName_Report.docx, replacing “LastName” with your own last name. (Example:

BA132_Hywater_Newsletter). It is a good idea to save your work periodically.
3. Convert the text after “The top ten are listed in the table below” and before “The Retail Industry” heading into a table. Separate

text at Tabs. 

4. Apply any table style. 
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5. Download this image to your computer. 

6. Insert the shopping cart image into the document at the beginning of the first paragraph (It starts with “Retailing is important to
understand”). 
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7. Apply a square text wrap and move the image so it is aligned with the right side of the document. 

8. Optional: Resize the image. (Remember, hold down the Shift key while dragging a corner to keep the image proportional.) 
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9. Download this graph image to your computer. 

10. Insert the graph image into your document after “creating greater contact efficiency for consumers.”
11. Add a top and bottom text wrap to the graph image. 

12. Look for the phrase “You can view the number of jobs and retail presence in your state at the National Retail Federation (NRF)”
in your document. Add a hyperlink to “National Retail Federation (NRF)” that leads to this website:
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https://nrf.com/advocacy/retails-impact 

13. Save your document again and submit your work in your course online.
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4.19: Discussion- Cover Pages
The techniques we learned in this module can be applied in many different ways. The video below uses many techniques you have
learned and some you haven’t. Watch the video below, looking for ways that some of the tools you have learned are used to create a
cover page.

A link to an interactive elements can be found at the bottom of this page.

You can also view the transcript for the video “How to create a CUSTOM COVER PAGE” here (opens in new window).

Discussion Questions
What tools that we’ve previously covered were used in the video?
What other applications could these tools have?

Share your opinions below and respond to two of your classmates’ thoughts.
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5.1: Why It Matters- Microsoft Word Advanced Skills

Why learn to complete advanced skills in Microsoft Word?

We have previously covered the basics of creating a document, but there is more to business
communication than just text.

Using the tools covered in this module will add variety to your document and help convey more information.
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5.2: Introduction to Advanced File Creation and Text Formatting

What you’ll learn to do: use templates and text effects.

We have now learned how to create a document and how to format text. We will now build upon that knowledge to use templates
and text effects. Both serve as a formatting shortcut by applying existing styles and layout. This means that you can save a little
time and effort in return for a little less personalization.
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5.3: Creating a New Document from a Template

Create document from template.

A template is a pre-created document that already has some formatting. Rather than starting from scratch to format a document,
you can use the formatting of a template to save yourself a lot of time. You can use a template that comes with Word, download one
from the internet, or create your own. For now, we’ll focus on creating a document from a template that comes with Word.

From the backstage view (File tab), you can scroll down and see what templates are available.

Near the top of the screen is a search box and some suggested searches. You can type a word or click on one of the suggested
searches to help find a suitable template for your project. For example, clicking the suggested search “Business” will take you to
templates related to business, with further subcategories on the right. (See below.)
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Select a template, then click Create. You may have to wait a moment for the template to download.

Once the template is open, you can replace the placeholder text with your own text.
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Creating a Document from a Downloaded Template
First, download the template. You may download a template from this course or from Microsoft’s template page. Note that the file
extension for a template is .dotx, which is different than the file extension for a normal Word document. In fact, if you save any
document with the file extension .dotx, that document will become a template.

Double-click on the downloaded template in File Explorer to open Word and create a new document based on the template. Any
changes you make to this new document will not affect the original template; the new document is merely a copy.

To edit the template itself, open Word and go to File>Open>Browse, then select the downloaded template. Opening the template
file this way opens the actual template, so any changes will be reflected in future documents you create from this template.
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5.4: Text Effects

Change text using text effects.

In addition to formatting changes we previously discussed in Fonts, you can also apply effects to text with the Text Effects option.
This was known as WordArt in previous versions of Word. You can add shadows, bevels, reflections, and much more.

The Text Effects button is in the Font group of the ribbon.

The top options in the Text Effects menu have some pre-created styles to choose from.

The Text Effects menu also has the options Outline, Shadow, Reflection, and Glow.

Outline
Outline applies a border around the letters of the text.
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Hover over each color to preview what the outline will look like. Click on the color to apply it. If you want to change the outline to
a color not in the menu, pick More Outline Colors… for more options.

Text with a black outline

Use the weight option to change the thickness of the outline.

Text with a 3-pt outline

The Dashes option lets you make a dashed or dotted outline. There are many different kinds of dashes and dots to choose from.

Text with a dashed 3-pt outline

Shadow
Shadow applies a shadow to the letters of the text. Hover over one of the A icons to preview the effects. Click on the A to apply
that shadow style.

There are a lot of different shadow options.
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Text with outside shadow

Text with inside shadow

Text with perspective shadow

The Shadow Options… option at the bottom of the menu allows you to customize the shadows even further by changing the color,
transparency, blur, angle, and distance of the shadows.

Color: The default shadow is black, but you can change the color to anything you want.
Transparency: The higher the the transparency, the lighter the shadow.
Blur: An increased blur makes the borders of the shadow more fuzzy, while a decreased blur makes the borders of the shadow
more concrete.
Angle: In real life, the direction of a shadow is determined by the angle of the light. The Angle option in the Shadow Options
lets you change the direction of that imaginary light to alter the path of the shadow.
Distance: The shadow can be very close, almost behind the letters, or it can be far away.

Reflection

Reflection reflects the letters of the text as if held up to a mirror. Hover over each option to preview, and click the option to apply
it.

There are a couple variations of reflections to choose from. You can also select Reflection Options… to customize the transparency,
size, blur, and distance of the reflection.
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Glow
Glow applies a fuzzy colored shape around the letters of the text that makes the letters appear to be glowing. Hover over each
option to preview, and click the option to apply it.

A glow can be any color. Go to More Glow Colors to choose a color not already visible in the menu. You can also select Glow
Options… to customize the size and transparency.

https://assessments.lumenlearning.co...essments/18610

Contributors and Attributions
Lumen Learning authored content

Text Effects. Authored by: Lumen Learning. License: CC BY: Attribution

5.4: Text Effects is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Practice Question

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46489?pdf
https://assessments.lumenlearning.com/assessments/18610
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/05%3A_Microsoft_Word_Advanced_Skills/5.04%3A_Text_Effects
https://creativecommons.org/licenses/by/


5.5.1 https://biz.libretexts.org/@go/page/46490

5.5: Introduction to Watermarks and Icons

What you’ll learn to do: Insert watermarks and icons

A watermark is an identifying image, shape, or piece of text that overlays the document. Watermarks are usually very light so that
they don’t interfere with reading the text.

Icons are small images, usually embedded within a line of text. They’re typically used to add visual interest.
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5.6: Watermarks

Insert a watermark.

Text Watermark
You can add a watermark to documents in Word by going to Design>Watermark. (In older versions of Word, it is often found in the
Page Layout tab rather than the Design tab.)

Choosing a watermark from the menu will apply it to every page in the document.

To change the text of the watermark, click Custom Watermark... at the bottom of the Watermark menu to open the Printed
Watermark dialog box.

Here, you can customize the text and appearance of the watermark. Unchecking the semitransparent box will make the watermark
more visible (although the watermark will still not obscure the text).
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Picture Watermark
To add an image as a watermark, go to Design>Watermark>Custom watermark… and select the Picture watermark in the Printed
Watermark dialog box.

Click Select Picture… and then Browse to choose an image on your computer. Uncheck the Washout box if you want a darker,
more visible watermark. Then click OK in the Printed Watermark dialog box.
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5.7: Icons in Word

Learning Outcomes
Create a Word document with inserted icon.

There is one more thing Rosamine wishes to incorporate into her document—a final icon.

Rosamine’s GM has a good sense of humor, so Rosamine chooses a different icon to end with in each of her reports. This time she
wants a little piggy bank icon. To do this, she puts her cursor where she wants the icon to go, clicks on the Insert tab, and selects
the Icon button. After scrolling down, she finds the piggy bank icon, selects it, and clicks the Insert button.

The little piggy is now in the document but needs a bit of adjusting. Like she can with the table and chart, Rosamine can drag the
little image circle boarder to make the icon smaller. She also selects the button to have the icon move behind the text.
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Practice Question
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Now the little piggy bank is in place, and Rosamine has finished her report. She makes sure to save her file where she can easily
find it again and emails it to her General Manager. Well done, Rosamine!
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5.8: Introduction to Citations

What you’ll learn to do: Insert citations

Certain formatting and style conventions must be followed when writing a research paper or manuscript, especially when
identifying sources. Instead of footnotes, in-text citations can be inserted to acknowledge sources of quotations or borrowed ideas
rather than plagiarizing information. Word supports three popular styles for citing references: the APA (American Psychological
Association), the CMS (Chicago Manual of Style), and the MLA (Modern Language Association).
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5.9: Citations

Learning Outcomes
Insert citations

To enter in-text citations, Word provides a dialog box to capture the pertinent information.

1. Click References.
2. Click Insert Citation.
3. Click Add New Source in drop down.
4. Type necessary information into the fields provided.

After filling in the dialog box, click OK and Word automatically places the citation at the insertion point.
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5.10: Introduction to Mail Merge

What you’ll learn to do: Perform a mail merge

Most Word users only use a small fraction of the features available to them. One of the most powerful features of Word is merging
documents. Mail merge is very helpful when you want to send the same letter to a number of people. Word will even create an
addressed envelope for each letter.
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5.11: Mail Merge

Learning Outcomes
Perform a mail merge

The Mail Merge feature creates letters, labels, envelopes, and emails all with personalized data. A merge usually requires two
documents—the data source file that contains the variable information to be inserted, and a main document with the text and fields
that identify where the variable data is to be inserted.

Word has a handy wizard to guide you through the mail merge process.

1. Click Mailings > Start Mail Merge > Step by Step Mail Merge Wizard.
2. Click Select Document Type and then click Next: Starting document hyperlink.
3. At the second Mail Merge task pane, click Start from existing document.
4. Click the Open button. At the Open dialog box, browse to the data file containing the information to be inserted, and double-

click it.
5. At the third task pane, click on the Use an existing list and then Browse.
6. At the Select Data Source dialog box, navigate to your storage file and then double-click it.
7. At the Mail Merge Recipients dialog box, click OK.
8. Click the Write your Letter hyperlink.

Continue to follow the instructions provided by the wizard to complete your document.
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5.12: Introduction to Internet and Word

What you’ll learn to do: Use internet tools to enhance Word documents

There are several features that can help you take advantage of the internet and its capabilities in your Word documents.
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5.13: Internet and Word

Learning Outcomes
Use internet tools to enhance Word documents.

Rowan Retail Store #1 is using Word to present their plan for the Q3 sales campaign. The campaign for this store will be through
social media and the focus on selling more sporting goods in the store. Shanda Bates is creating the Word document.

First, Shanda opens Word on her computer and decides she will use a report template. She searches for business reports. Word’s
search bar uses the internet to find thousands of report templates for Shanda to use. This is one way the internet is integrated into a
Word document.

After Shanda selects and downloads the report template, she types in the titles and other information on the first page.
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Next, Shanda begins to compose the plan and wants pictures and icons to add where appropriate, so she opens a web browser and
searches for images. To find usable images she selects the Tools>Images for reuse option, which sorts the images to fit this
parameter. Shanda finds a little shop icon, copies (Ctrl+C or Cmd+C) and pastes (Ctrl+V or Cmd+V) it into the report. She then
drags it and resizes it to fit.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46499?pdf


5.13.3 https://biz.libretexts.org/@go/page/46499

Practice Question
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She continues to search for images, but this time she uses the Online Pictures button within Word to find a usable Facebook icon.

She searches and finds an appropriate icon and clicks to insert it in her document.
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After resizing the icon, Shanda wraps the text by the icon so that it fits on the page with the text.

Shanda thinks that including a link to the social media strategy video she watched to create this plan is a good idea. She searches
and finds the video in YouTube, then copies the link and pastes it into the plan. Alternatively, she could click the share button and
share the video on various social media platforms.
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She continues to fill in the text of the plan and finish this report off. Let’s have a quick recap of the integration actions she took.

1. Store icon. Shanda searched the internet for an appropriate icon, copied it, pasted it, resized it, chose a layout, and dragged the
icon to the place in the document she liked.
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2. Hyperlinked YouTube page. Shanda included a link to the video by finding the video on YouTube, then copying and pasting
the link into the report. The link can now be clicked to take the reader to watch the video.

3. Graphic chart. Shanda searched with Word’s Online Picture button and found a chart to display her social media campaign
plan’s purpose. Like before, she copied the chart, pasted it, resized it, chose a layout, and centered the chart.

4. Facebook icon. Shanda searched with Word’s Online Picture button to find the Facebook icon to put next to the Facebook
section in her report. She copied it, pasted it, resized it, and picked the appropriate layout option, then dragged the icon to the
appropriate place in the document.

These same processes of search, find, copy, paste, resize, and so on are going to be the same in Excel and PowerPoint.

Practice Question
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5.14: Putting It Together- Microsoft Word Advanced Skills
We have now explored Microsoft Word. After careful reading and a bit of practice, you can now create a great variety of documents
that will suit your business needs.

Remember that Microsoft Word still has many more features and tools to offer. If you are interested in learning more, Microsoft’s
website is a good place to check, or you can run a web search for how to use a particular feature.

And of course, if you get stuck or can’t remember how to do something from this module, you can always come back and review.
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5.15: Assignment- Edit a Newsletter
For this assignment, you will be using what you have learned so far and format a newsletter draft. Follow the directions, then
submit your assignment. If you get stuck on a step, review this module and ask your classmates for help in the discussion forum.

1. Download the newsletter template to the Rowan folder on your desktop.
2. Open the template in Word by either double-clicking the downloaded template in File Explorer or opening it in Word by going

to File>Open>Browse and then selecting the downloaded template. 

3. Save the file to the Rowan folder on your desktop as BA132_LastName_Newsletter.docx, replacing “LastName” with your
own last name. (Example: BA132_Hywater_Newsletter) If you opened the template through Word, remember to select Save As
and change the file extension to .docx. It is a good idea to save your work periodically.

4. Change the “RowanGo App Lets Customers Shop Anywhere” and “Employee of the Month: Shanice Jones” articles to two
columns. 
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5. Use Find and Replace to change every “Rowango” to “RowanGo”.
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6. Add a right tab stop to the sales in the “Splash into Summer with Sales!” text box and right-align the dates of the sales.

7. Apply at least one text effect (out of Outline, Shadow, Reflection, or Glow) to the words “Rowan Retail” at the top of the
newsletter. Be sure the words are still within the text box.

8. Add a citation of the Wikipedia page (https://en.Wikipedia.org/wiki/Mobile_payment) for mobile payment in the second
paragraph after the words “mobile payment.”
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9. Finally, add a sideways DRAFT watermark across the newsletter.

10. Save your work again and submit your document in your course online.
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5.16: Discussion- Advanced Shortcuts
We have previously covered some commonly known shortcuts that speed up a lot of basic functions, such as copying and pasting
and doing some basic formatting. Watch the video below to see a sample of other shortcuts that are available, then answer the
questions below. While the video shows an older version of Word (Microsoft Word 2016), the same shortcuts work in other
versions of Word, including 2019 and 365.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Practical Word 2016 Shortcuts #2” here (opens in new window).

Discussion Questions
Do you find shortcuts to be helpful or overwhelming? Why?
As you’ve worked through the projects in this class, is there anything you wish had a shortcut?

Share your opinions below and respond to two of your classmates’ thoughts.
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6.1: Why It Matters- Microsoft Excel Basic Skills

Why learn to complete basic skills in Microsoft Excel?

Imagine that you have a lot of business data. Perhaps you have names and addresses for a mailing list. Maybe you have inventory
data or quarterly sales values. All this information could be kept in a Word document, but Microsoft Office actually has an
extremely useful program for organizing, storing, and even manipulating data: Microsoft Excel.

In this module, you will learn the basics of using Excel, focused on rearranging information into tables and changing style
elements. Before we begin, here is some key information about Excel to remember before we start using this program.

1. The entire Excel file is called a workbook. Each individual page of the workbook is called a worksheet. When you are actually
working in Excel, the page in which you enter data is a worksheet. We will discuss worksheets in more detail later but just
remember, a worksheet is like a page in Word.

2. Also just like in Word, Excel has a ribbon area at the top of the window with different tabs for different controls.
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6.2: Introduction to Using Excel

What you’ll learn to do: create a worksheet and add data.

Learning to use Microsoft Excel is one of the most helpful and versatile workplace skills you can acquire, and creating a worksheet
in a workbook is the first step. Many of the skills you learned for Microsoft Word can also be applied to Microsoft Excel, such as
basic text formatting and file extensions. The file extension for a Microsoft Excel workbook is .xlsx, although pre-2003 versions of
Excel might use .xls.
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6.3: Creating a New Workbook

Learning Outcomes
Create a new Excel workbook.

You can open Excel from the Start menu (or the Applications folder on a Mac) by clicking on the Excel icon. The Excel icon comes
in a variety of forms depending on your OS and version of Excel, but it always features the color green and the letter X.

When you open Excel, some versions of Excel may take you straight to a new blank workbook. Newer versions such as Excel 2019
will take you to a menu called backstage view to choose to open a new blank workbook or open a new workbook from a template.
If you already have a file open in Excel, you can create a new document by clicking File>New. You can also use the shortcut
Ctrl+N (Cmnd+N for Mac).

Note that the backstage view on a Mac computer is a little different.
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Practice question
https://assessments.lumenlearning.co...essments/18618

To open a blank workbook, double-click the blank workbook option.

Before using a workbook, it is helpful to know a few key terms.
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Practice Question
https://assessments.lumenlearning.co...essments/18619

1. Cell. This is the area where you will enter data.
2. Row. Rows are cells aligned horizontally.
3. Column. Columns are cells aligned vertically.
4. Worksheet. A worksheet is a single page within a workbook. Like the tabs in an internet browser, the tabs in an Excel

workbook show different pages, or worksheets. A workbook may have many worksheets included in it. In this screenshot, the
workbook only has one worksheet and one tab, which is labeled Sheet1. The selected tab shows the selected worksheet.
Clicking the + button will add another worksheet. When you save a workbook in Excel, all of the worksheets in that workbook
are saved.

Contributors and Attributions
CC licensed content, Original

Creating a New Workbook. Authored by: Shelli Carter. Provided by: Lumen Learning. License: CC BY: Attribution

6.3: Creating a New Workbook is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46504?pdf
https://assessments.lumenlearning.com/assessments/18619
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/06%3A_Microsoft_Excel_Basic_Skills/6.03%3A_Creating_a_New_Workbook
https://creativecommons.org/licenses/by/


6.4.1 https://biz.libretexts.org/@go/page/46505

6.4: Entering Data

Learning Outcomes
Add data to a table.

Excel workbooks are used to organize data very clearly. Numerical data can be used in a variety of ways, some of which we will
examine in later modules. The first step, however, is simply to enter data into a table.

First, open a blank workbook. Next, click on the first cell for your data: this will almost always be A1.

If you wish to organize your data in a column, you will hit ENTER to move to the next cell down. In this case, A2.
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If you wish to organize your data in a row, you will hit the Tab key to move to the next cell over. In this case, the next cell over is
B1.

Enter all of your data into each individual cell until you are ready to save your workbook.
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6.5: Introduction to Basic Formatting and Layout

What you’ll learn to do: change formatting, layout, and styles in Excel.

Like any Microsoft program, Excel will default to certain fonts, texts, and styles when you create a new worksheet. It is also very
easy within Excel to format individual cells with cell styles or multiple cells with a table style. Not only can formatting help make
your tables more attractive, but it can also help indicate information about the contents, such as whether the data in a cell reaches a
target goal. In this section, we will address how to change several default styles within Excel.
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6.6: Table Styles

Learning Outcomes
Apply table styles.

One very common task in Excel is to format a table with a particular style. The controls for table styles are found in the Styles group of the ribbon under

the Home tab.

There are many default table styles within Excel, as shown in the screenshot below. Among other uses, styles let you apply color schemes to tables that
can make them more readable. In order to apply a particular table style:

1. Select all the cells that belong in your table.
2. Click on the “Format as Table” button.
3. Choose which table style to apply.

Select all the cells that belong in your table. Click on the “Format as Table” button. Choose which table style to apply.

In the screenshot example, each column is a particular type of information (Last name, First Name, Address). These are known as headers. When
applying the table style, be sure to check the box if your table has headers that you have already entered.
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Practice Question
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Practice Question

https://assessments.lumenlearning.co...essments/18622

Your final table would look something like the table below using the options shown in the screenshots.

Contributors and Attributions
CC licensed content, Original

Styles within Excel. Authored by: Shelli Carter. Provided by: Lumen Learning. License: CC BY: Attribution

6.6: Table Styles is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46507?pdf
https://assessments.lumenlearning.com/assessments/18623
https://assessments.lumenlearning.com/assessments/18622
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/06%3A_Microsoft_Excel_Basic_Skills/6.06%3A_Table_Styles
https://creativecommons.org/licenses/by/


6.7.1 https://biz.libretexts.org/@go/page/46508

6.7: Cell Styles

Learning Outcomes
Apply cell styles.

You can also apply a style to a cell or series of cells. There are many default cell styles within Excel.

In order to apply a particular cell style:

1. Select the cell(s) you wish to format.
2. Click on the appropriate style for your cell.

Practice Question
https://assessments.lumenlearning.co...essments/18624

In the screenshot below, two cells have a style applied.

1. “Good” cell indicates the data in that cell is good or correct.
2. “Check” cell indicates you may need to verify the information in that cell.
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6.8: Cell Format

Change cell format.

As mentioned previously, Excel will default to certain styles when you create a new worksheet. In particular, this includes the way
that numbers are displayed and whether or not commas are automatically included. In this section, we will take a look at changing
these defaults.

When you type numbers into an Excel workbook, it will often default to a specific format. For example, if you type “12/15/17,”
Excel will convert this to read “12/15/2017,” assuming you were entering month, day, and abbreviated year. Similarly, “3/4” will
display at “4-Mar,” the fourth day of March. However, it is possible that you may have been entering fractions, so “3/4” was meant
to indicate three-quarters instead.

If this is the case, you will need to format your cells to properly display the information you are entering. When possible, consider
formatting your cells before you enter the data. Otherwise, Excel may convert some of the entries and you will need to re-enter that
information.

Method 1

1. Begin by highlighting the cells you plan to use.
2. Select the Format dropdown from the Cells group of the ribbon.
3. Select the Format cells option at the bottom of the dropdown menu.

https://assessments.lumenlearning.co...essments/18626

There are several available format options for cells in Excel. When you select one, Excel will provide you with a description and
examples of how the information will display in the cells.
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Method 2

You can perform the same actions using the “Number” group in the ribbon. In this case, you simply select the cell format you wish
to apply using the dropdown menu.
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6.9: Comma Styles

Change comma style.

At times, you may also wish to use a specific comma style with numbers entered into an Excel worksheet. For example, you may
wish “1234” to display as typed or with a comma like “1,234.”

Comma styles are easy to change in Excel using a quick select option in the Number group in the ribbon.

Method 1

When using the Format cell dropdown option from this area, select the “Use 1000 Separator (,)” option to include a comma. You
can also choose if you would like any decimal places to be displayed in this same window.

Method 2
The easiest option to include a comma is simply to click on the Comma Style button in the Number group.
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When clicking the comma style button, the comma style default is to display numbers with a comma in the thousands place and
include two decimal places (Ex: “1200” becomes “1,200.00). This will also change the visible cell styles in the Style” area of the
ribbon so you can easily select different options for comma and display format.
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Below are three different options for comma and display format.

1. Comma: Comma with two decimal points
2. Comma [0]: Comma with no decimal points
3. Currency: Comma with two decimal points and a dollar sign

Practice question
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6.10: Rearranging Tables

Add, delete, and move columns and rows.

At times, you may find it necessary to change the number of rows or columns within your table, move columns or rows, or even
alter the standard width of rows and columns. All these tasks are easy to accomplish within Excel, often with only a few clicks of
your mouse.

Add Columns and Rows
Note for this section, the word column will be used throughout but the same steps can be used to add a row.

Method 1

After you have entered several columns of data into a worksheet, you may realize you need to add another column in the middle of
what you have already typed. The easiest way to add a column within an existing set of columns involves only two clicks of your
mouse.

1. Identify the area where you want to insert a new column.
2. Right-click on the column to the immediate right of the area where you wish to add a column.
3. From the menu select Insert.
4. A new column will appear to the left of the column that you right-clicked.

Method 2

The same result can be achieved using the Insert button in the Cells group of the ribbon. The new column will be inserted to the left
of the column you clicked on. In this screenshot, a column has been inserted.
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Note that when you insert a new row, it will appear above the row you click on.
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Delete Columns and Rows
Note for this section, the word column will be used throughout, but the same steps can be used to delete a row.

Method 1

After you have entered several columns of data into a worksheet, you may realize you need to remove one column. The easiest way
to delete a column uses two clicks of your mouse.

1. Right-click on the column you wish to delete.
2. From the menu select Delete.

Practice Question
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Method 2

The same result can be achieved using the Delete button in the Cells group of the ribbon. The column currently selected will be the
one deleted. In this screenshot the column has been deleted.

Move Columns and Rows
Note for this section, the word column will be used throughout, but the same steps can be used to move a row.
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Method 1

After you have entered several columns of data into a worksheet, you may realize you need to move a column to a different
location within the set. Once again, Excel makes it quite easy to move data around a worksheet.

1. Right-click on the column you wish to move.
2. From the pop-up window select Cut. The column you have selected should become outlined in a dashed border.

3. Next, right-click on the column you wish to move your column to the LEFT of.
4. A new dialog window will appear. Select Insert Cut Cells. The column you selected to move should then appear in this new

location.

Method 2
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The same result can be achieved using a combination of keyboard shortcuts and dialog windows.

1. Right-click on the column you wish to move.
2. Press Ctrl+X. The column you have selected should become outlined in a dashed border.
3. Next, right-click on the column you wish to move your column to the LEFT of.
4. A dialog window will appear. From it select Insert Cut Cells. The column you wish to move should then appear in the new

location.
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6.11: Changing Width of Columns and Rows

Learning Outcomes
Change width of columns and rows.

After you have entered several columns of data into a worksheet, you may realize you cannot read all the information in every cell.
In this case you may want to resize the column. Microsoft Excel allows you resize column width to AutoFit the text, meaning each
column will be sized according to the longest string of text in the column. Alternatively, for visual appeal, you may want all the
columns in your table to have the same length; you can easily change multiple columns at the same time to have the same width.
As in previous pages, the steps below explain how to resize a column, but the same steps can be used to resize a row as well.

AutoFit Column Width to Text

First, we will discuss making a column width AutoFit to the length of text in that column. Note that when you AutoFit column
widths, Excel will make the column length match that of the longest string of text in any cell in that column.

Method 1
1. Identify the column you wish to resize.
2. Hover your mouse on the right boundary of the topmost cell of that column so that you see a cross or T shape. (If you are

resizing a row, you will hover over the bottom boundary)
3. Double-click on that right boundary.
4. The column will automatically resize to fit the longest string of text in that column.

Compare the three columns on the left with the three on the right to see the results.

Method 2

You may also use the Format button in the Cells group of the ribbon to achieve the same results. From the dropdown menu, you
will choose AutoFit Column Width or AutoFit Row Height. Note that if you wish to resize multiple columns, simply select them all
before clicking on the Format button.
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Practice Question

https://assessments.lumenlearning.co...essments/18632

Set all columns to the same width
At other times, from visual reasons you may wish all columns (or rows) to have the same width (or height), regardless of the
amount of text in them. Or you may want a single column to have a specified width.

Method 1

In this case, you will use the pixel information provided by Excel to manually resize the columns.

1. Identify the column width you wish to resize.
2. Hover your mouse on the right boundary of that column so that you see a cross or T shape. (If you are resizing a row, you will

hover over the bottom boundary)
3. Hold down your mouse button and drag the right boundary until you reach the desired pixel width. The pixels will be displayed

in the parentheses.
4. Release the mouse button.
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Method 2

You may also use the Format button in the Cells group of the ribbon to set a specific column width. From the dropdown menu, you
will choose Column Width or Row Height and manually type in the size you wish each column (or row) to be. Again, if you wish
to resize multiple columns, simply select them all before clicking on the Format button.

Practice Question
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6.12: Introduction to Using Multiple Worksheets

What you’ll learn to do: create a new workbook with more than one worksheet.

When you open a new Excel file, there is automatically a single worksheet. However, there are a number of reasons why you may
want more than one worksheet in a single workbook. For example, consider the following ways multiple worksheets in a workbook
can help with keeping data organized:

1. A workbook with monthly sales figure with each year on a different worksheet
2. A workbook with mailing lists for weekly flyers on one worksheet and coupon mailings on another
3. A workbook with inventory data with each month on a different worksheet

In any of these cases, or others, it is very easy to add more worksheets to an Excel workbook.
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6.13: Creating a Workbook with Multiple Worksheets

Create a new workbook with more than one worksheet.

Method 1
The easiest method to add additional worksheets to a workbook is by using the Insert Worksheet shortcut represented by the +
button at the bottom of the workbook window. You can use this shortcut button multiple times to insert additional worksheets into
your workbook.

Method 2

You can also use the menu option Insert>Insert Sheet from the Cells group of the ribbon.
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6.14: Putting It Together- Microsoft Excel Basic Skills
Now that you understand the basics of Microsoft Excel, let us consider some ways to use this program to manage business
information.

1. You could organize the coupon flyer mailing list into a table with names and addresses formatted the same.
2. You could collect annual sales data and AutoSum the monthly sales figures.
3. You could display inventory data including item, quantity, and store location.

This module focused on the basics of using Excel as an organizing tool for easy display. In our next module, we will expand our
use of Excel to more advanced features.
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6.15: Assignment- Organize Sales Data
For this assignment, you will manipulate an Excel worksheet to organize and display data about sales totals throughout a year.

Download this Excel workbook. It already contains the data you need. Follow the directions, then submit your assignment. If you
get stuck on a step, review this module and ask your classmates for help in the discussion forum.

1. Open the workbook. Save it to the Rowan folder on your desktop as BA132_LastName_SalesData.xlsx, replacing “LastName”
with your own last name. (Example: BA132_Hywater_SalesData) It is a good idea to save your work periodically.

2. Format the data as a table with the name of the months and sales total as headers. You may use any table style you like. 

3. Change the cell format so that all the sales totals display as currency with a dollar sign and two decimal places. 
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4. Indicate that the data for June and October needs to be verified by applying a different cell style to those cells. 

5. AutoFit the column width. 

6. Save your work and submit the workbook in your course online.
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6.16: Discussion- Merging and Centering Cells
We have learned a variety of tips you can use to create visually appealing tables in Excel, including applying table and cell styles
and changing the size of rows and columns.

Another helpful Excel tool is the ability to merge and center cells and to wrap text within a cell.

1. Select the cells you wish to merge into one larger cell.
2. Click “Merge & Center” from the “Alignment” group of the ribbon.

3. When you type in this merged cell, the text will automatically be centered left to right in the cell.
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Discussion Questions
In what situations would this feature be useful?
Would you ever use this feature? Why or why not?

Share your opinions below and respond to two of your classmates’ thoughts.
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7.1: Why It Matters- Microsoft Excel Intermediate Skills

Why learn to complete intermediate skills in Microsoft Excel?

In the last module, we focused on some basic functionality in Excel. But this program is capable of a lot more, including
automatically organizing data (known as Sort), hiding data (Filter), and even more advanced functions that will automatically
format cells visually if they meet certain conditions.

Before we move into the mechanics of each of these tools, let us consider for a moment the types of questions you may have when
looking at data in an Excel worksheet.

1. You want to see which month had your highest sales volume.
2. You have a total clothing inventory but you want to know how many pants you have in stock.
3. You want to know how many months from last year you were under budget.
4. You want to see a graphic that represents your data instead of the actual numbers.

All of these questions can be answered with the valuable tools available in Excel and most importantly, without manually looking
through all of your data!
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7.2: Introduction to Using Excel for Data Analysis

What you’ll learn to do: analyze data with Excel.

In this section, you will learn how to sort and filter data, as well as find other connections within data.
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7.3: Sorting Data

Sort data in a table.

After data has been entered into an Excel worksheet, and even after it has been organized into a table, it can still be manipulated
and reorganized. One of the easiest options is to sort the data in a particular order. For example, you can sort the data alphabetically.

Method 1
1. Select (by clicking and dragging) the data you wish to sort.
2. From the Sort & Filter button in the Editing group in the ribbon, click the Sort button.
3. From the menu, choose how you would like to sort the data. For example, A to Z or Z to A. Note that A to Z is equivalent to

Smallest to Largest and Z to A is equivalent to Largest to Smallest.

Method 2
1. Select (by clicking and dragging) the data you wish to sort.
2. From the Data tab in the ribbon, click the appropriate Sort button. For example A to Z or Z to A.
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A quick note about Custom Sort: the Custom Sort option allows you to define how your data will be sorted within a column. For
example, perhaps you want to sort information by clothing size, rather than alphabetically. In this case, you must create a custom
list for your sort order.

1. Select (by clicking and dragging) the data you wish to sort.
2. Click the Sort command followed by the Custom Sort option in the dropdown menu.
3. The Sort window will appear, allowing you to specify which column you will sort and how. You can use the default options

(days of the week or months) or you can enter a new list. To create a new list, select Custom List from the Order column and
then NEW LIST.

4. If you are making a custom list, type in order the way you would like the data sorted. In our example, we are sorting by size
from small to large.

5. Click Add and your custom ordering list will appear in the original Order dropdown menu.
6. Select your custom list and then click OK.
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7.4: Filtering Data

Filter data in a table.

After entering data in Excel, it is also possible to filter, or hide some parts of the data, based on user-indicated categories. When
using the Filter option, no data is lost; it is just hidden from view.

Method 1
1. Select the column or row you wish to sort.
2. From the Sort & Filter button in the Editing group in the ribbon, click the Filter button.
3. When the Filter menu appears, you can choose which categories of data to hide and deselect the appropriate buttons. For

example, you can deselect the button next to large and you will no longer see the large cells in your table.

Method 2

You can similarly access the Filter menu through the Data tab; the same menu will appear.
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7.5: Functions

Use the COUNTIF function.
Use the IF function.

Excel can perform a variety of really nice data analysis features for you. We’ve already touched upon how you can filter data. But
you can also look for other connections, or screen large numbers of cells to determine how often something occurs.

COUNTIF
COUNTIF is a way for you to ask Excel to count how many times a certain piece of information appears in your worksheet. For
example, perhaps you want to know how often “shirt” appear in an inventory list. All you need to do is ask Excel to count the
number of cells that contain the word “shirt.”

1. Determine which cells you want Excel to look at. In our example, we will look at A2 though A13.
2. Click on the cell you wish your count to be displayed in.
3. Type the formula for a count 

=COUNTIF(A2:A13, “shirt”)

Here you are telling Excel which cells to examine—A2 through A13—and what to look for: “shirt.” Note that your text must match
exactly what is typed in the cells, and if you are looking for a specific word it needs to be enclosed in quotation marks (so “shirt”
instead of shirt).

4. Hit enter and your results will appear.

https://assessments.lumenlearning.co...essments/18640

IF

Another commonly used function in Excel is the “IF” function. In this case, you are asking Excel to look for something and then
tell you if that something occurred. For example, perhaps you want to compare whether your monthly expenses were under your
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monthly budget. That is the scenario we will look at in our example.

In this case, let us just ask for a simple “yes” or “no” answer. Looking at the screenshot below, you can see how the worksheet has
all the data at hand. We are looking for whether the information in the C column is less than the information in the B column. We
would like the D column to display the answer (yes or no).

1. Click on D2 and enter the “IF” function for what you want Excel to compare and do. 
=IF(C2<B2, “Yes,””No”)

2. You do not have to manually reenter the formula into the other cells in D. Instead you can copy and paste the formula from D2
into D3, D4, and so on. Each time you do this, the formula should automatically update with the correct cell number to
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compare.

As you can see, the D cells begin to display “Yes” or “No.” “Yes” means that the expenses in the C column were less than the
monthly budget entered into the B column. “No” means that expenses were higher than the budget. Just as in the COUNTIF
function, you need to enclose text in quotation marks.
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7.6: Introduction to Automating Data Entry

What you’ll learn to do: use Flash Fill and AutoSum.

The tools covered in this section will help you enter or generate data quickly.
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7.7: Flash Fill

Learning Outcomes
Use Flash Fill.

Like many modern software programs, Excel is designed to recognize certain patterns. For example, perhaps you are creating a
table that lists the last and first names of attendees at a company training session. After all the names have been entered into two
separate columns, you realize you would like a single column to correctly display the full name. An easy way to achieve this
without having to manually retype the entire list is to use Flash Fill.

1. Create a new column for the combined information you wish to display.
2. In the first cell, type the name as you wish it to display. In our screenshots, this would be “John Smith.”
3. Begin typing the next piece of data in the next cell. Excel should automatically suggest a Flash Fill option.
4. If the Flash Fill suggestion matches how you would like the information displayed, simply hit the Enter key and the rest of your

column should fill in automatically.

Flash Fill is especially helpful if your data is initially in different forms but you want the final information to display in the same
fashion. For example, in our attendee list, some of the names were capitalized, in all caps, or had no capitalization. Sometimes you
may need to manually update more than one option but Excel will detect your pattern.

Practice Question
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Flash Fill should automatically be turned on in Excel but if it is not, you can turn it on using the File>Options>Advanced menus.
You can also turn Flash Fill on or off using the shortcut Ctrl+E. Be aware that the Mac version of Excel does not have Flash Fill.
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https://assessments.lumenlearning.co...essments/18643

Contributors and Attributions
CC licensed content, Original

Flash Fill. Authored by: Shelli Carter. Provided by: Lumen Learning. License: CC BY: Attribution

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46524?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/07%3A_Microsoft_Excel_Intermediate_Skills/7.07%3A_Flash_Fill
https://assessments.lumenlearning.com/assessments/18642
https://assessments.lumenlearning.com/assessments/18643
https://creativecommons.org/licenses/by/4.0


7.7.2 https://biz.libretexts.org/@go/page/46524

7.7: Flash Fill is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46524?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/07%3A_Microsoft_Excel_Intermediate_Skills/7.07%3A_Flash_Fill
https://creativecommons.org/licenses/by/


7.8.1 https://biz.libretexts.org/@go/page/46525

7.8: SUM Data

Learning Outcomes
Use AutoSum button.

One of the main uses for Excel is to organize and manipulate numerical data. Often you may wish to add up all the numbers in a
column or row. Excel has formulas and commands to automatically add your data, and the easiest way to use this feature is the
AutoSum button.

1. Once your numbers are organized in either a row or column, click on the cell where you would like the total sum to display. In
the screenshot below this was A13.

2. Click on the AutoSum button from the Editing group of the ribbon.
3. Excel will highlight the cells that it is adding up and will apply the SUM formula.
4. Hit Enter to accept the highlighted cells and see the total value of your data.

Note that it is possible to SUM several columns (or rows) at once. Select all the cells you wish to display a SUM and click
AutoSum. Excel will individually add up the columns.
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Practice Question
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The AutoSum option can be found in two areas:

It is contained in the Editing group of the ribbon, as shown in the first example above.
It can also be found under the Formulas tab.
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7.9: Simple Math

Complete simple math functions in Excel

Excel spreadsheets are often used for calculating numbers with simple math. There are a few things to learn to set up using simple
math calculations in Excel. You’ve already learned about the SUM function. This next section will teach other simple math steps to
use in spreadsheets.

The basic math calculation steps in Excel are set up with the background of first quarter sales numbers for a department store. The
example table includes the product type, sales price, number of items sold and the total for each item. Start by figuring out the total
sales for each product type for the quarter.

Multiplication
Total sales for each product requires the multiplication of sales price and number sold.
Select the cell in Q1 total sales column and type in = Price Cell * Number Cell.
Press the keyboard Enter key and the total is calculated.
Type the same formula in for each cell or use the flash fill way by dragging the bottom right corner down the entire column and
it will fill with the total sales for each product.

 

https://assessments.lumenlearning.co...essments/18646

Addition
To find total sales for just small appliances, add their sales totals together by using the plus sign.
Select the cell under total the Sm Appliances and type in = Q1 Total Sales Cell Reference for Product1 + Q1 Total Sales
Cell Reference for Product2 + Q1 Total Sales Cell Reference for Product3 + Q1 Total Sales Cell Reference for Product4 ,
etc. (for this example, the Microwave is not a small appliance).
Press the keyboard Enter key.
Total sales for all small appliance sales is displayed.
Another way to write this addition formula is by using brackets =SUM(D2+D3+D9+D12+D13).
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Subtraction
For the total sales for all products, except small appliances, subtract the grand total from the small appliance total using the
subtraction sign.
Select the cell under total the Non-Appliance and type in = Grand Totals Sales Cell Reference – Sm Appliance total.
Press the keyboard Enter key.
Total sales for all products minus small appliances are displayed.
Another way to write this subtraction formula is =SUM(D16-F2).

 

Division
Maybe you need to know what the average unit sale would be across all products for the first quarter. In that case, divide the
grand total sales by the number of units sold using the division sign
Select the cell under Average Unit Sales title and type in = Grand Totals Sales Cell Reference / Number.
Press the keyboard Enter key.
You will now see what the average product sale was for Q1.
Another way to write this division/average formula is =SUM(D16/C16).

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46526?pdf


7.9.3 https://biz.libretexts.org/@go/page/46526

 

https://assessments.lumenlearning.co...essments/18647

Percentage
To find what the percentage of sales for small appliances out of total sales was, divide the total small appliance sales by the
grand total sales using the division sign.
Select the cell under Appliance Percentage title and type in = Sm Appliances / Grand Totals Sales Cell Reference.
Press the keyboard Enter key.
The average product sale was for Q1 displays as a decimal point.
Another way to write this percentage formula is =SUM(F2/D16).

 

To have the results display as a percentage, click the % button on the Home tab in the Number group.

Practice Question
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More than one calculation can be included in a single cell’s formula. For example, you want to know the total sales of a few
specific items for Q1; coffee maker, tea kettle and microwave.

If the Q1 totals hadn’t been calculated yet, you’d need to multiply the number and sales price of each item then add up the
total. This can be written in one formula by placing a comma between calculations. It is calculated like this
=SUM(B2*C2,B10*C10,B14*C14).
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7.10: Introduction to Graphics

What you’ll learn to do: Add and format graphics

Graphics can be very useful to help illustrate information in Microsoft Excel. Let’s learn how to add and modify graphics!
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7.11: Graphics

Learning Outcomes
Add graphics

Excel is primarily used to manage and analyze numerical data. There are times when using graphics to visually represent data
makes the numbers more memorable. Excel contains multiple types of graphics from which to choose. Here is how to add and
format graphics for any type of graphic chosen in SmartArt. To begin, open an Excel spreadsheet in which the graphic should be
added.

1. Select Insert on the bar menu, and in the Illustrations Group dropdown box select SmartArt. There are many different
graphics from which to choose; Pictures, Shapes, Icons, etc. The Block Cycle graphic of SmartArt will be used as the example,
but the actions are similar for the graphic as well. 

2. A SmartArt Graphic dialog box will open with a variety of options for graphics from which to choose.
3. Select the type and layout of the graphic which fits the spreadsheet data best. The Cycle (1), Block Cycle (2) graphic is used for

this illustration by clicking the OK button (3). The selected graphic is then inserted into the Excel workbook.

Here is the inserted graphic in the workbook.
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Once a graphic is inserted into the workbook, the SmartDesign tools automatically are selected and the graphic can now be
modified.

Practice questions
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7.12: Modify Graphics

Modify graphics

Once a graphic has been inserted into a worksheet, text or data will need to be entered and edited. The graphic can also be modified
to fit the scale and style desired for a worksheet. The following actions can be taken for any graphic selected in Excel:

1. Adding/editing text
2. Resizing graphic
3. Changing design style
4. Moving graphics
5. Rotating graphics

Adding/Editing Text
Type text into the graphic by either selecting the [Text] area in the graphic, or by selecting [Text] in the Type your text here dialog
box to the left. If there is no text dialog box on the left, click on the graphic and the box will open. If there is data or text from
within a worksheet such as labels, values, etc. you wish to add to the graphic, select the desired text and copy and paste into the
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graphic. Editing text in a graphic is the same process as adding a graphic’s text. 

https://assessments.lumenlearning.co...essments/18650

Resizing Graphic
Select a point on the outer edge of a graphic, hold down the left mouse button (or cursor) and drag the graphic to fit the size
desired. 

Changing Design Style
Roll the cursor over the layout or SmartArt style sections to see the various options that are available for the selected graphic.
Select the style best suiting the purpose of the graphic. 

Moving Graphics
To place a graphic next to an Excel table or other desired spot, hold down the cursor until the four-way arrow appears, while
continuing to hold, drag the graphic within the worksheet to the desired location. 

Practice Question
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Rotating Graphics
To rotate a graphic in an Excel worksheet, place the cursor on the circular arrow and drag to rotate the graphic. 

https://assessments.lumenlearning.co...essments/18651
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7.13: Format Graphics

Format graphics

There are times when the format of a graphic needs to be changed and Excel provides tools to simplify those modifications.
Formatting tools are located within the SmartArt Format ribbon bar. In order to see these tools, select a section within a graphic you
wish to modify, then select Format in the ribbon. Like with the SmartArt Design area, the Format areas can be rolled over with a
cursor to see the graphic change with the various possibilities.

There are three main areas for formatting a graphic.

1. Shapes
2. Shape Styles and Effects
3. WordArt Styles

Formatting Shapes

These options allow the shape of the graphic text boxes. A different shape may be used to highlight specific types of information or
to make one stand apart from the areas of a graphic. First select the area you wish to change in the existing graphic. Select the
Change Shape button in the Shapes group, select a shape from the dropdown menu options and click on the desired shape for the
object in a graphic.

Learning Objectives
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Change more than one object at a time by holding down the CTRL key (Shift key on a Mac) and select all objects you wish to
change to the same shape before selecting a new shape.

Formatting Shape Styles and Effects
Excel offers options to change the fill color, outline style color and weight, as well as adding effects to the shapes or objects in a
graphic. These formatting tools allow you to customize your graphic to enhance the Excel worksheet. Select the dropdown arrow to
open the dropdown menu illustrating the various options for the graphic. If a style has a gray checkered pattern this implies
transparency. Roll over the options to display a preview of the objects selected in a graphic. Click an option to apply the new
Shape style or Shape effect.

Shape Styles

Note: Change multiple objects simultaneously
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Shape Effects

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46530?pdf


7.13.4 https://biz.libretexts.org/@go/page/46530

Formatting WordArt Styles

A different text style can make a graphic more memorable. Formatting options available include changing text outlines, effects,
color and textures. Each style option is changed by the same method; open menu options, click on the option desired to change
graphic word style.

There are two ways to display these menu options from which to choose the WordArt Style changes:

Method 1

Select the small down arrow next to the words and a drop-down menu will be displayed. Choose your desired WordArt effect style,
click on option to select and change graphic.
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Method 2

Select the small arrow in the lower right area of the section and a Text Effects task pane will open to the right of the graphic.
Highlight the text you wish to change, choose your desired WordArt effect style, and click on the desired option to select and
change the graphic’s text style.
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https://assessments.lumenlearning.co...essments/18652
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Many of the ribbon area groups (not just WordArt Styles group) have a small downward pointing arrow visible in the corner of
a group. This can be clicked to open a menu displaying all options for a specific group to the right of a worksheet.
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7.14: Introduction to Charts

What you’ll learn to do: Create and modify charts

Excel is not just used for organizing and processing data and formulas. It also can be used to visually represent data in the form of
charts and graphs.
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7.15: Charts

Learning Outcomes
Add charts

In Excel charts are a primary way to convey the analyzation of numerical data. If you’ve heard the adage “A picture is worth a
thousand words” then you know it also holds true for pictures to interpret numbers. Charts make sales trends, marketing numbers
and comparisons of all sorts of numerical data come to life.

Excel contains multiple types of charts to choose to make the data speak. Follow these steps to add a chart to a worksheet.

1. Open a worksheet with the numbers already entered or enter the data to be used in the chart. Make sure to organize the data into
the order in which you wish it to be displayed in a chart. Select all the data making sure to include the headers and labels for the
data. This should be at least two columns of data.

2. Select the Insert tab and find the Charts Group on the ribbon. Select the style of chart to use for that data. For this example, it
is a Bar chart style, in the 2-D Column, Cluster column chart. If you are uncertain of what type of chart to use, select the
Recommend Charts button and a dialog box with a few options will open. 

3. The chart opens with the data information in it and can be moved, edited and resized like a graphic. Notice that when the chart
is selected, the data associated with it is highlighted in different colors

4. There are two main ways to edit a chart:

1. To the upper right of the chart area are three buttons that can be used to change Chart Elements, modify the style or color,
and edit the valued or names.

2. Modifying the chart style, color and design can also be accomplished by rolling the cursor over the options in the ribbon and
selecting the style desired.
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Practice Questions
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Learn More

There are many types and styles of charts and graphs from which to choose. The same process of adding a chart as it was done
above is used to insert other types of charts. Here are three other examples of types of charts based on the same data as the first
chart. See which one seems to represent the data the clearest.

Contributors and Attributions
CC licensed content, Original

Charts. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY: Attribution

7.15: Charts is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46532?pdf
https://assessments.lumenlearning.com/assessments/18654
https://assessments.lumenlearning.com/assessments/18655
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/07%3A_Microsoft_Excel_Intermediate_Skills/7.15%3A_Charts
https://creativecommons.org/licenses/by/


7.16.1 https://biz.libretexts.org/@go/page/46533

7.16: Clustered Column Charts

Learning Outcomes
Create a clustered column chart.

Excel is not just used for organizing and processing data and formulas. It also can be used to visually represent data in the form of
charts and graphs. In this page, we will work on creating a basic chart, the clustered column chart, and then modifying a chart style.

A clustered column chart is sometimes called a bar graph, because it shows data organized in solid shapes like pillars. A clustered
column chart organizes these pillars up and down, so they are “columns.” On the other hand, a clustered bar graph organizes these
pillars left to right, so they are “bars.” Bar graphs are useful charts when looking at changes from month to month or across
employees.

The first step to creating any chart is to organize your data. It is definitely a good idea to include headers in the first cell of each
column. By default, a clustered column chart will cluster the data by the columns in your table, so try to keep that in mind when
setting up the worksheet.

1. After organizing your data, select the cells you wish to include in the chart. This should be at least two columns.
2. Click on the Insert tab and find the Charts group of the ribbon.

3. “Clustered column chart” is actually a recommended chart. Click on that chart.
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4. When you select the chart, you will see colored boxes surrounding the data that connect to the different categories of the chart.

Practice Question
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7.17: Chart Styles

Learning Outcomes
Modify chart style.

Once you have created a chart, or if you are given a worksheet that contains a chart, it is very easy to change the chart style.

1. Click on the chart you wish to change. The Design tab should appear in the ribbon area.
2. Click on Change Chart Type button

3. Click on the type of chart you would like.
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From this same window, you can also switch the data that is being charted. For example, you can switch which data from a row to a
column or change which data is arranged on the x- or y-axis.

Practice Question
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7.18: Putting It Together- Microsoft Excel Intermediate Skills
Now that you know some of the more advanced tools available in Excel, let us take a look at our opening list of possible questions
and match those with an Excel function we just covered.

1. You want to see which month had your highest sales volume. You could see this by sorting your data Z to A (largest to smallest
number).

2. You have a total clothing inventory but you want to know how many pants you have in stock. You could see this using the
COUNTIF function.

3. You want to know how many months from last year you were under budget. You could see this with the IF function, just like in
our learning example.
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7.19: Assignment- Analyze Yearly Trends
In this assignment, we will pull together everything you have learned about Excel so far to analyze trends in sales data over several
years.

To complete this assignment, you will need the assignment you completed last module that you saved as
BA132_LastName_SalesData.xlsx (or you can download the original assignment here) and a new workbook you can download
here. Follow the directions, then submit your assignment. If you get stuck on a step, review this module and ask your classmates
for help in the discussion forum.

1. Open both workbooks. Save the new Module 7 file to the Rowan folder on your desktop as
BA132_LastName_YearlyTrends.xlsx, replacing “LastName” with your own last name. (Example: BA132_Hywater_Memo)
It is a good idea to save your work periodically.

2. First, we need to combine the information into a single workbook. Add a new worksheet to the Module 7 file and copy the table
from the Module 6 assignment to that new tab. Name the new tab “2014.” Be sure to set the number type to currency. 

3. Add another new worksheet. Now we want to set up the spacing for the table we are about to make. Merge the 1 and 2 cells of
column A, B, C, D, and E individually (so A1 and A2 merge, B1 and B2 merge, etc). Then name the cells as shown in the list
below and center the text in those cells. 
A = Month 
B = 2012 Sales 
C = 2013 Sales 
D = 2014 Sales 
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E = Total by Month 

4. Copy the following columns of data over in order: “2012 Sales Total,” “2013 Sales Total,” and “2014 Sales Total.” Remember,
you can just copy and paste each column in order, using the columns you have already labeled. When you AutoFit the column
to the data width, your header cells will change. 

5. Now apply Autosum to the sales data for both the total by month and by year. When you have the totals, apply bold to them to
make them stand out more and type “Totals” in the cell under December. 
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6. Next to the ‘Totals by Month’ column, type ‘Above $50k’ in the column title. In the first cell in the new column use an IF
function to identify True or False if the totals by month are greater than $50,000 or not. Remember, after you create the first IF
functions in January, you can Flash fill the other cells by dragging the bottom right of the highlighted cell down the other cells. 

7. Return to the individual tabs for each year. For each year of data, sort the sales total “Z to A” so that the month with the highest
sales is at the top. When you chose the “Sort” option, be sure to “Expand the Selection.” That will make sure that the months
change as well. The screenshot below shows you only what 2012 should look like, but when you finish you should see October
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as the highest in 2012, August for 2013, and May for 2014. 

8. Finally, go back to Sheet4 and create a clustered column chart from the three year columns of your data. 

9. Save your work and submit it in your course online.
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7.20: Discussion- Hard Return within a Cell
For visual reasons, there are times that you may wish to have multiple lines of text within an Excel cell rather than one long string.
Do you know how to do this? Hint: you don’t want to use the TAB or space bar button because this spacing will be incorrect if you
resize your cells! Instead you want to place what is known as a “hard return” (or a new line of text) within the cell.

A hard return is very easy to insert in a cell. Simply type your first line of text. When you reach the end of that line, hold down the
Alt button of your keyboard as you hit the Enter (or Return) button. A new line will be started inside the cell.

You can add as many lines of text as you would like this way. When you are finished with that cell, simply hit Enter or Tab as
normal to proceed to the next cell. Your cell should automatically resize to accommodate the multiple hard returns you have created
in the cell. Best of all, if you manually resize your cells, columns, or rows, the hard returns will remain in place and the separate
lines of text will remain separate lines of text!
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Discussion Questions
In what situations would a hard return be useful?
Would you ever use this feature? Why or why not?

Share your opinions below and respond to two of your classmates’ thoughts.
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8.1: Why It Matters- Microsoft Excel Advanced Skills

Why learn to complete advanced skills in Microsoft Excel?

With a lot of data comes a lot of repetition. You may find yourself completing the same tasks over and over again, or you may find
yourself re-creating tables, because they weren’t organized the way you need them to be. Excel is a powerful tool, and you can
automate a lot of these repetitive tasks.

If you ever find yourself doing the same thing over and over again, it’s always a good idea to pause and look if there’s a faster or
easier way that you could be doing that task.
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8.2: Introduction to Sparklines

What you’ll learn to do: Create Sparklines

In using Excel, there are a variety of ways to display your data visually. One such method is a sparkline: a small graph that is
created to offer simple visual clues about the data in your sheet.
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8.3: Sparklines

Learning Outcomes
Create sparklines.

Now that you have seen the value of data visualization in charts, we can address a much simpler and compact visualization: a
sparkline. Sparklines are small graphs that are created to offer simple visual clues about the data graphed. Basically, they are tiny
charts inside a single cell.

There are three types of sparklines:

1. Line: visualizes the data in a line graph form
2. Column: visualizes the data in column form, similar to the clustered column chart
3. Win/Loss: visualizes the data as positive or negative based on color

The best use of a sparkline is to place it close to the data you are visualizing. You may be wonder what use a sparkline is since you
know how to create a chart. Well, the great thing about sparklines is they automatically print when you print a worksheet. Charts do
not print when you print a worksheet; they must be separately printed or moved to another program like Word or PowerPoint.

Sparklines are also great in that they automatically update if you change the data they display.

Practice Question
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To create your own sparklines, follow the steps below.

1. Click on the cell where you want your sparkline to appear.
2. Click on the Insert tab and find the Sparklines group. Select the type of sparkline you want to create.
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3. A new data box will appear. This is where you will enter the range of cells to be graphed by your sparkline.

4. Hit Enter.
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Note that like any other chart, you can change the display options of a sparkline, including colors and style, after you have created
it. To change a sparkline, you will need to access the Design tab that appears under Sparkline Tools once you have created a
sparkline. This tab will only appear if you have selected the cell with your sparkline in it.

Practice Question
https://assessments.lumenlearning.co...essments/18661
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8.4: Introduction to More Formatting and Layout

What you’ll learn to do: apply conditional formatting and change page layout.

In this section, you will learn how to automatically apply formatting when certain data is entered. You will also learn how to
change the page layout and how the Excel workbook looks when it is printed.
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8.5: Conditional Formatting

Learning Outcomes
Create and apply conditional formatting.

As we have learned so far, Excel has a wide variety of easy to use tools for organizing, sorting, and otherwise marking information.
Think back to when we applied styles to a cell to indicate good information or information that needs to be verified. Excel also has
the ability to automatically apply such markings through conditional formatting.

With conditional formatting, you provide Excel with a rule, such as “less than 10,” and the program will scan through your data and
highlight all the cells that meet that rule. There are several rules already available, but you can also create and apply your own rules
and visual clues.

1. Select the cells, rows, or columns you wish to have conditional formatting.
2. From the Styles group, click on the Conditional Formatting button
3. Select the style of formatting you would like. Here we have Highlight Cell Rules.
4. Select the specific type of rule you would like to use and then apply your target value. Here we have selected Less Than.

5. The formatting will appear automatically so you can see what it will look like. Note that Excel will automatically provide a
value, but you can manually change it.

6. Hit OK if you wish to apply the formatting. Otherwise, when you leave the formatting menu, it will disappear.
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One important tool to keep in mind is the ability to enter your own rules. This can include applying formatting to specific date
ranges, to specific text (like names), or even cells that are blank. In this case, you also set the format, so instead of highlighting
cells you can choose to strikethrough text or change the font, change the size, or bold the text.
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Practice Question
https://assessments.lumenlearning.co...essments/18662
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8.6: Viewing a Worksheet

Change page layout orientation
Change margins

Now that we’ve learned a variety of applications and tips for using Excel, this final section will focus on options for viewing and
printing worksheets. There are two important considerations here: the way the page is oriented and the margins. Both can be
adjusted with just a few clicks in Excel.

Page Layout Orientation

Just like in Word, by default Excel is set to a portrait orientation (which means it is taller than it is
wide). Depending on how many columns your worksheet has though, this may not be the best orientation. The other option is the
landscape orientation, where the page prints left to right along the long side of a page.

1. Click on the Page Layout tab
2. Within the Page Setup group you will find the Orientation dropdown.
3. Click the arrow to access the menu and then select the orientation you want. Again, by default Excel is set to portrait, so you

will generally use this to switch to landscape.

https://assessments.lumenlearning.co...essments/18664

Margins

Sometimes your worksheet will not quite fit within the standard margins for a printed page. This can occur in portrait or landscape
orientation, and the easiest fix could be to print closer to the physical edge of the paper. At other times, for visual reasons you may
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want your margins to be a bit larger than normal. In this case your printed worksheet would be farther away from the edge of the
paper. This can be helpful if you are making a binder and need to punch holes into the edge of the sheet.

In either case, to change margins in Excel:

1. Click on the Page Layout tab
2. Within the Page Setup group you will find the Margins dropdown.
3. Click the arrow to access the menu and then select the margins you want.

By default, the page is at Normal margins.
Wide margins will move the printed area away from the edge of the paper.
Narrow margins will move the printed area toward the edge of the paper.

You may also set custom margins if you need to.
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8.7: Introduction to Pivot Tables

What you’ll learn to do: Pivot tables

The PivotTable tool allows you to easily reorganize the data in your spreadsheet with out a lot of manual work. Let’s take a look at
how and why you might use this tool.
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8.8: Pivot Tables

Pivot tables

In Excel, the PivotTable tool creates ways to reorganize data in a spreadsheet. Reorganizing data in this way, brings about
additional information and insights that foster better understanding of your data. PivotTables allow you to forgo creating many
summary calculations by hand, because a PivotTable does the work for you.

The example below includes a multicolumn table of sales data containing just over a year’s worth of information. Looking at the
raw data in the table you may be able to pull out a few salient points, but with a pivot table, you can quickly answer questions like:

What was the largest order by sales or by product quantity?
What was the grand total sold of furniture for 2019 per region?
Which sales region had the lowest sales figures?
What sales representative had the highest total sales?

https://assessments.lumenlearning.co...essments/18666

Now that you understand that PivotTables can be a powerful assistant with your Excel data, let’s look at a few examples and the
two main ways to create a PivotTable; the Recommended PivotTable button, or by creating a PivotTable from scratch.
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Create by Recommend PivotTables Button
If you are unfamiliar with pivot tables, this process is the recommended option to use until you become more familiar with them.
The dialog box displays various options for a given data set, giving you a range of choices so you can select the one best suited for
your data analysis.

Follow these steps to use this tool:

1. Open an Excel spreadsheet with existing data, click on any cell within the data table and click the Insert tab.
2. Click the Recommended PivotTables button in the Tables group. The entire table has been selected, indicated by the dotted line

around the border of the data table.
1. Alternative short-cut for data selection if the data set is large: While holding down the Shift + Ctrl keys, tap the right arrow

key on your keyboard. Then while still holding down the Shift + Ctrl keys, click the down arrow key on the keyboard. All
the data should now be selected in the entire data table.

3. In the Recommended Pivot Tables window, a variety of Pivot Tables are available to be selected. Scroll through the options,
select one and click OK. In this example, the Sum of Unit Sale by Region is selected.

If you decide at this point a blank PivotTable is preferable, select the Blank PivotTable button on the bottom left.

4. A new tab is opened containing the information of the selected PivotTable. Notice that the PivotTable will calculate the sum of
unit sales per region in the table that was selected even without any of the total cost column filled out in the original data table.

Note
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5. This new PivotTable, summing up the sales, is the first step in rearranging the original data to be able to take a more in-depth
analysis of the data. You can stop here or repeat the process and create other recommended tables.

6. If an additional PivotTable is desired, such as sales per sales rep, or sum of unit sales per item and region, return to tab
containing the original data, follow the same steps using the Recommended PivotTables button, scroll until you see the desired
table, and select it. Here are two other examples of PivotTables created from the same data set.

 

Create by PivotTables Button
If you are more familiar with pivot tables, or simply wish to create one from the ground up, this button allows you select and
reorganize the data however you want to see the data interpreted. Follow these steps to create a PivotTable from scratch.

1. Open an Excel worksheet containing data for the PivotTable tool and select a cell anywhere in the data set.
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2. Click the Insert tab, and the PivotTable button on the ribbon. Excel will automatically select the data it identifies as the
information for this table. 

1. If the selected area missed data, start again by clicking on the beginning data table cell, drag the cursor over all the desired
data to select. Once the area is selected, click the PivotTable button under the Insert tab, Tables Group.

2. Another option to select the correct table data: Click on the PivotTable button and open the Create PivotTable dialog box.
In the box under the “Choose the data you want to analyze” area, type in the table/range area for the table; for example
‘Sales Orders’!$A$1:$G$4, or drag the cursor over the data area for the table and the range will be added to the Table/Range
field.

3. After making sure the data selected is correct, select New Worksheet option, and click the OK.
4. A new worksheet is created. On the right side of the worksheet, a PivotTable Fields task pane is open. In it are four areas

(Filters, Columns, Rows, and Values) where various field names can be placed to create a PivotTable. The task pane also
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includes a checklist area of the fields from which to choose from the data. 

5. Drag one field name into different areas to create a PivotTable. Alternatively, you can check the boxes for fields to be added to
the table. Each of the areas operate in the following manner in a PivotTable:
1. Columns: The filed used to measure and compare data.
2. Rows: The field for data you want to analyze.
3. Values: The field containing the values a table uses for comparisons.
4. Filter (optional): A field used to sort table data. It is displayed in the upper left corner of a table and is an optional field for

tables. 
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6. The PivotTable in the screenshot above is created based on the sales data of these fields added to these areas:
1. Columns: Region
2. Rows: Item
3. Values: Sum of Unit Sales

7. Rearrange fields in a variety of ways by dragging them into a new area or clicking the option in the list of fields above the
areas. Each action will affect the PivotTable. Move fields around into new areas until you have created a table giving you the
best insight into your data. Congratulations! You have created a PivotTable from scratch.

You may run into scenarios where a data field is dragged into an area that does not work well. Simply drag the field into
another area and quickly see whether that field in the new area works better. Excel made the PivotTable tool flexible so you
can easily change the structure of fields and areas if you make a misstep along the way.

https://assessments.lumenlearning.co...essments/18667
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8.9: Introduction to Macros

What you’ll learn to do: Use macros to complete actions in Microsoft Excel

In the workplace, people often find themselves completing repetitive tasks: completing the same calculations on different numbers,
counting wins versus losses, etc. In Excel, you can create macros, programs that can automate these repetitive tasks.
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8.10: Macros

Use macros to complete actions in Microsoft Excel

Macros are programs used to automate frequently used processes or tasks in Excel. A macro records operations and re-uses the
sequence of mouse actions or keystrokes of anything you can do in Excel with keystrokes or a mouse. Some of those actions
include; cleaning up data, formatting cells, creating tables or organizing data in an Excel spreadsheet. If you have done repetitive
tasks with a spreadsheet before, you may already have discovered macros. If you have not discovered them, learn this advanced
Excel tool to speed up your efficiency and save time.

First, watch the following video which gives an overall example of how to program a macro in order to change the formatting on a
sales report. After the video, we’ll walk through a macro step by step and highlight a few of the commonly used actions to be
program into a macro.

A link to an interactive elements can be found at the bottom of this page.

https://assessments.lumenlearning.co...essments/18668

Macro Recording Locations
A macro has three main ways to be recorded. Two are from the ribbon area and one is not. Experiment and find your favorite way
to record it.

How to record a macro:

1. From the View tab, click the Macros button, and then the Record Macro button. 

2. The video demonstrates how to make the developer tab appear in the menu. Here are the steps to follow:
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Go to File, Options, Customize Ribbon, then check the Developer check box and click OK. 

Going back to the main menu, the Developer tab is now visible. Click on it, and go to the Code group, and select the
Record Macro button. 

3. The last main recording area is for the Macros button is at bottom left of spreadsheet window. Click on the button and a Macro
dialog box opens to be filled out to begin recording. 
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Macros are recorded in a program called Visual Basic. To edit a macro, the developer tab needed to access the Visual Basic
program. We will not be diving into Visual Basic this time as an entire course all on its own. For now we will stay with the macro
recording basics.
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8.11: Recording a Macro

Use a macro to add a filter to column headers
Use a macro to remove duplicates
Use a macro to select blank rows

In business, you may have spreadsheets filled with data from different departments, divisions or even
other companies requiring updating, reformatting or cleaning up on a regular basis. There are a few
macros examples that help make this repetitive work easier.
These next spreadsheet actions are created from the View > Macros > Record macro path.

Adding Filters to Column Headers

Each quarter you receive a spreadsheet filled with information. To make it easier to sort data you’d like to add filters to each new
spreadsheet. Here are the steps to follow to make a macro for this:

Open worksheet > View > Macros > Record Macro
In Record Macro dialogue box;

Type in macro name with no spaces or by using _ to connect words (e.g. Filter_Macro).
Create a shortcut key (optional). If you do choose one, make sure it isn’t Ctrl + C, Ctrl + V, or other already existing shortcut
keys.
Decide where to store the macro recording.
Add a description (optional) to help identify the functions done by the macro and click OK. The macro is now recording.

Highlight the entire row of column headers > Data tab > Filter button.
Go back to View > Macros > Stop Recording. This macro is now available to use on the next set of data needing filters added.
Run macro: To run the macro on the new set of data open the data, go to View > Macros > View Macros. A dialog box will
open then select the macro for adding filters and click Run.

Watch this short video to see these tasks done in sequence and used on a fresh data set.

A link to an interactive elements can be found at the bottom of this page.

https://assessments.lumenlearning.co...essments/18670

https://assessments.lumenlearning.co...essments/18671

Remove Duplicates
Spreadsheet data is often filled with duplicate information and needs to be sorted through in order to be useful. For this example, a
single list of the salespeople is needed from the large data set. To start recording the macro, follow the order in the example for
recording above, then follow these steps:

Highlight the column containing the Salesperson names. Right click > copy OR use Ctrl + C
Open a new tab > select a cell > right click and paste OR Ctrl + V
Click Data tab > Remove Duplicates button
Go back to View > Macros > Stop Recording. This macro is now available to use on the next set of data needing duplicates
reduced.
Run macro: To run the macro on the new set of data open the data then go to View > Macros > View Macros. A dialog box
will open, select the macro for removing duplicates and click Run.

Watch the short video to see these tasks done sequence and used on a fresh data set.

A link to an interactive elements can be found at the bottom of this page.
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Selecting Blank Rows

Many times, a worksheet or data set is filled with blank rows that can stop a successful analysis of the data or cause errors in
formulas. In order to clean up a data set with a macro, follow these steps.

Like with the other functions, open the spreadsheet and set up a macro for recording. An alternative way to quickly record is to
select the record button at the bottom left corner of the Excel window to start.

Create a new column > label it Empty (or another name). Make sure it has a filter added in the header.
In the first cell, type in the function that counts how many values are in the list of arguments, that function is =
COUNTA(B4:G4) your table range and press the Enter key.
With the H4 cell highlighted, pull the corner down the entire column covering all the rows.
Click filter arrow in “Empty” header and deselect “All” the select “0” and press OK.
Select all the rows that are “0” > right click delete
Click filter arrow in “Empty” header, then select Clear filter from “Empty” and data rows appear with no empty rows.
Go back to View, Macros and Stop Recording. Alternatively, click the little square in the bottom left corner to stop the
recording. This macro is now available to use on the next set of data needing duplicates reduced.
Run macro: To run the macro on the new set of data open the data, go to View > Macros > View Macros. A dialog box will
open, select the macro for selecting blank rows and click Run.

Watch the short video to see these tasks done in sequence and used on a fresh data set.

A link to an interactive elements can be found at the bottom of this page.
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Unlike other actions, running a macro cannot be reversed with the Ctrl + Z (Cmnd+Z) short-cut or the Undo arrow so make
sure you have a copy of the original data worksheet before running a macro for the first time.

Macros take a little practice to get used to, but once you use them more frequently, you will see the variety of things that a macro
can accomplish. Remember, a macro allows you to record operations and re-use the sequence of mouse actions or keystrokes of
anything you can do in Excel with keystrokes or a mouse. Start using them and see how far you can go.
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8.12: Introduction to Statistical Functions and Formulas

What you’ll learn to do: Use functions and formulas

We’ve already learned some basic functions and formulas in Excel; however, there are more powerful and complex functions that
Excel can do. In this section, we’ll take a look at some of these more complex functions.
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8.13: What is a Function?

Learning Outcomes
Define functions in Microsoft Excel

A function is a preexisting formula in Excel that does calculations based on specific values. In previous modules, you learned a few
Excel functions: COUNTIF, IF, and SUM. Excel offers hundreds of functions from broadly used to highly specialized. For now, we
will focus on financial, logical and look-up functions and formulas.

Practice Question
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A few general tips to remember about functions and formulas:

Functions begin with an equal sign. Excel will begin suggesting functions as soon as you begin typing the equal sign.
Functions take one or more arguments, with cell references or numbers, enclosed in parentheses.

When a function needs more than one argument, enter a comma between the arguments without a space and close the
formula inside of parentheses.
There are multiple ways to enter functions in Excel; type in the formula bar under the ribbon (1), clicking on the fx button
by the formula bar (2), select a cell and type = (3), select the Formulas tab Insert Function button (4) or select a specific
function based on a category in the Formulas tab (5).

Practice Question
https://assessments.lumenlearning.co...essments/18677

These next functions and formulas build out your skills in Excel and assist you with business, science, statistics and many other
types of data analysis. Let’s get started.

Contributors and Attributions
CC licensed content, Original

What is a Function?. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY: Attribution

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46550?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.13%3A_What_is_a_Function
https://assessments.lumenlearning.com/assessments/18676
https://assessments.lumenlearning.com/assessments/18677
https://creativecommons.org/licenses/by/4.0


8.13.2 https://biz.libretexts.org/@go/page/46550

8.13: What is a Function? is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46550?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.13%3A_What_is_a_Function
https://creativecommons.org/licenses/by/


8.14.1 https://biz.libretexts.org/@go/page/46551

8.14: Lookup Functions and Formulas

Use lookup functions and formulas

Lookup functions in Excel are used for looking through a single column or row to find a particular value from the same place in a
second column or row. This often takes place when there are multiple worksheets within a workbook or a large amount of data in a
worksheet. Lookup functions are very helpful with large sets of data to find specific information across many rows or columns.

VLOOKUP (Vertical Lookup)
Looks for a value in the leftmost column of a table and returns a value in the same row from the vertical column you define. The
lookup value must always be in the leftmost column of the table.

The Excel formula is written =VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup])

This table includes the sales totals for salespeople. In this case you want to find out what the sales were for certain salespeople.
This is a small example but imagine a long list of names and numbers to search through. Using the VLOOKUP function quickly
brings you the results you want. Be sure to use F4 to create the absolute references and keep the table array the same for each
lookup. Also make sure and make the col_index_num use the second column in the table (column 2 in the table) with a return for
the range_lookup as FALSE. By using FALSE in all cases, there is no need to sort your tables into ascending order. Here is what
those results look like.

For another VLOOKUP example, watch this video of how to use this function to find parts that are in stock and the supplier for
particular parts.
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A link to an interactive elements can be found at the bottom of this page.

HLOOKUP (Horizontal Lookup)
Looks for a value in the topmost row of a table and returns a value in the same row from the horizontal column you define. The
lookup value must always be in the leftmost column of the table.

The Excel formula is written =HLOOKUP(lookup_value,table_array,row_index_num,[range_lookup])

A link to an interactive elements can be found at the bottom of this page.

MATCH and INDEX Functions

Now we’ll learn two additional lookup functions, Match and Index. Watch this video to learn how to use Match and Index lookup
functions. Here are the descriptions and formulas for creating them in Excel.

A link to an interactive elements can be found at the bottom of this page.
MATCH – Function that returns a position of a value in a range which can be a row, column or table. The Excel formula is
written =MATCH(lookup_value,lookup_array,[match_type])
INDEX – Function that returns a position of a value in a range which looks at the intersection of a column and row position in a
table. The Excel formula is written =INDEX(reference,row_num,[column_num],[area_num])

As you become more familiar with lookup functions, try out a few more by selecting the Formulas tab, Lookup & Reference button
and see what others are available for you to try.
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8.15: Logical Functions and Formulas

Use logical functions and formulas

Excel logic functions evaluate whether the statement and data are considered true or false according to how the formula is
established. We will cover the top used Excel logical functions in this section. Exactly like the financial functions, you can use the
Formulas tab as before to insert the function or you can begin by typing an equal sign in a cell.

Nested IF
Taking an IF function and adding more than one logic test inside the IF function. In other words, start with and IF function and add
another IF function inside the original IF function. A Nested IF formula looks like this: =IF(logical_test,[value_if_true],
[value_if_false],IF(logical_test,[value_if_true],[value_if_false]))

Previously, you learned how to use the IF function as a logical way to test your data. Let’s consider that we want to see two
variables run at once to create a logical outcome. We’ll now look at Regional Sales for five salespeople over a year and see if they
meet the requirements for an annual commission and what the commission amount would be.

Two shortcuts for locking down a cell to make it absolute instead of relative. You’ll need to know these to work faster through
creating formulas.

Short cut key F4 automatically adds in $ to a cell location information to lock it down and make it absolute to stop it from
changing as it is dragged into other cells or ranges (e.g. $D$3).
Name Range locks down a cell like $. To create a Name Range, highlight the cell, click on the Formulas tab, Define Name
button. After the dialog box opens, name the location (no spaces) to make it unique for navigation or for formulas (e.g.
Commission_Rate).

With a sales spreadsheet open, look at the tiered commission structure. There are two possibilities to earn commission. A Nested IF
function is a perfect formula to calculate which salesperson receives how much commission.

Follow these steps to create a Nested IF function:

1. First let’s define names for the two types of commissions as this will make it easier to distinguish in the formula. Select the 20%
cell and click on the Formula tab, Define Name button and name it Commission_Rate_20. Follow the same steps to name the
10% commission cell too. 
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2. Select the first cell under the commission heading and begin typing =IF, then hit the Tab key and a bracket will automatically
appear displaying the logic formula for an IF function. 
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3. Select the total sales for Henry (G4) and type in whether the total sales is less than or equal to the sales goal (G4>=I2). Be sure
to hit the F4 button and the absolute $ will fill I2 so it will not change in any way if the formula is moved ($I$2), then type a
comma. 

4. The next portion of the formula is for the percentage of commission to be paid if the goal has been reached. After the comma,
choose the sales total again (F4) multiplied by the commission percentage by selecting the name you created earlier
(F4*Commession_Rate_20), then a comma to separate the next part of the formula. 

5. The next portion of the formula is for the other percentage of commission to be paid if that lower goal has been met. After the
comma, type another IF and hit the Tab key. Create the same formula again but use the Commission_Rate_10 this time and at
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the end a comma. 

6. The last portion of the formula is asking what to do if the logic comes back as a false answer. In this case, it will return a 0.
Now finish with two end parentheses, one turns red indicating the second IF function, and then an additional end parenthesis to
enclose the entire function begun with the first IF function. 

7. Now copy the formula down the column all the way to the last salesperson’s total. These are the commissions paid based on the
Nested IF formulas created. A nice logical function to make a more difficult task easier in a spreadsheet.

AND
This function returns TRUE if all the arguments in its formula are TRUE and returns FALSE if any of the conditions are false. The
Excel formula for this is =AND(logical1,[logical2],…).

In this example the AND function returns TRUE if the first score is greater than or equal to 60 and the second score is greater than
or equal to 90, otherwise it returns FALSE.
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OR
The OR function returns TRUE if any of the arguments are TRUE. The Excel formula for this is =OR(logical1,[logical2],…).

In this example the AND function returns TRUE if the first score is greater than or equal to 65 and the second score is greater than
or equal to 100, otherwise it returns FALSE.

IFERROR
If your formula errors out, you can add in a value you specify how you would like it displayed. This logic function is beneficial to
use if you occasionally run into errors and wish to have a cleaner looking spreadsheet to present.

The Excel formula for this is =IFERROR(value,value_if_error).

In this example there is an error in the Profit Margin row that is displayed at #DIV/0!. By using the IFERROR function an error
like this can be displayed as a zero or even as text like “Ouch” if so desired. Here is what it looks like:
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8.16: Financial Functions and Formulas

Use financial functions and formulas

Excel provides specific formulas and functions to assist with financial calculations. We will cover the top five most often used
financial functions. The following scenario will inform the next example of financial functions.

A person secured a loan from a bank to purchase an apartment at an annual interest rate of 6%, over 20 years, with monthly
payments. The loan has a present value (PV) of $100,000 (amount of new loan) and a future value (Fv) of 0 (because the goal of
the loan is to have it completely paid off at the end of the time period). For the monthly payments use 6%/12 = 0.5% for Rate, and
20*12 = 240 for Nper (total number of payment periods). If only annual payments were made, then it we would use 6% for the
Rate and 20 for Nper.

Payment (PMT)

Payment terms for a loan or investment. The Excel formula for it is =PMT(rate,nper,pv,[fv],[type]). This assumes that payments
are made on a consistent basis.

Follow these steps to find the monthly payment amount for this loan:

1. Enter all the information into a table.
2. Using the Formulas tab, Financial button, scroll until you find PMT in the drop-down menu. 

3. A dialog window asking for the inputs opens. Click on the cells matching the correct information for that field and the data will
be entered into the formula automatically. Using the cell location instead of typing in the straight data, means the formula will
automatically update if new data is entered into those cells. For the last two areas (Fv,Type) for loans, Fv can be omitted (or
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enter 0) and Type can also be left empty. Type left empty assumes that payments come due at the end of the period. 

4. After the calculation, the monthly loan payment is $716.43. The figure is red because it is a debt paid against the total loan. (If
you wish to have it not show as a red/negative number, type in a minus sign before the B2 Rate (-B2) and the PMT will show as
a black, positive number.) The second screenshot shows the PMT formula and the corresponding cells associated with the
formula. To see the formula correspondence, double clicking on the cell. This correspondence association works with any
formulas used. 

5. With the formula established, when you change the rate, present value or nper, you can see the change in monthly payment it
will take to pay off the loan.

Number of Periods (NPER)

Number of periods per loan or investment. The Excel formula for this is =NPER(rate,pmt,pv,[fv],[type]).

Follow these steps to find the number of periods for this loan:

1. Enter all the information into a table.
2. Using the Formulas tab, Financial button, scroll until you find NPER in the drop-down menu.
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3. A dialog window asking for the inputs opens. Enter the corresponding cell locations. 

4. The Nper is 240 months (20 years of monthly payments). The second screenshot shows the NPER formula and the
corresponding cells associated with the formula. Double click on the cell to see its corresponding cells.

5. With the formula established, changing the monthly payment amount shows the change in the number of periods needed to pay
off the loan.
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Rate (RATE)
The interest rate for a loan or a rate of return required to attain a specific amount on an investment over a period of time. The Excel
formula for this is =RATE(nper,pmt,pv,[fv],[type],[guess]). The “guess” for our purposes can be left out for this scenario.

Follow these steps to find the interest rate for this loan:

1. Enter all the information into a table.
2. Using the Formulas tab > Financial button > Scroll until you find RATE in the drop-down menu.
3. Dialog window opens > Enter the corresponding cell locations.
4. The Rate is 0.50%. The second screenshot shows the Rate formula and the corresponding cells associated with the formula.

Double click on the cell to see its corresponding cells.
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Present Value (PV)
Present value of a loan or investment based on a constant interest rate (like a mortgage or loan). The Excel formula for this is
=PV(rate,nper,pmt,[fv],[type]).

Let’s change the scenario a little to find a PV for a different loan. If you know that the monthly payments are $952.69, the interest
rate is 6%, and the life of the loan is 20 years, what is the present value of that loan?

Follow the same steps to insert the formulas like before to find the present value for this loan.

After filling in the values for the above scenario the PV for this loan is $120,999.66 or if rounded up $121,000.

Future Value (FV)
Future value of an investment assuming constant, periodic payments with a constant interest rate. The Excel formula for this is
=FV(rate,nper,pmt,[pv],[type]).

Let’s change the scenario again and find FV for a different loan’s time frame. If you know that the monthly payments are $895.54,
the interest rate is 5%, and the life of the loan is 20 years, is the future value of that loan payed down to 0 in that 20-year time
frame?

Follow the same steps to insert the formulas like before only using the FV function to figure this out.

The answer is that, yes, the future value of the loan comes to zero in the timeframe.
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Now you know how to use these five financial functions and formulas in Excel.
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8.17: Introduction to Add-Ins

What you’ll learn to do: Use add-ins

There are a variety of third-party programs that can be “added in” to Microsoft Excel. While it’s important to be cautious about
which programs you use, there are some powerful options out there that can help you with a variety of tasks.
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8.18: Add-Ins

Use add-ins

Microsoft Office allows for a variety of additional programs to be added into Excel as well as the other Office programs. An add-in
specifically adds optional features or commands into Excel either from Microsoft or from third-party companies. Excel’s default is
to not make add-ins immediately available, therefore, in order to access them, you must install and sometimes activate the add-ins.

Here are general pieces of information to know before we dive into Excel add-ins:

Add-ins are available for both Windows and for MacOS.
The Options window is the main way to access and manage Excel add-ins. Find them by going to File, Options, Add-ins path.
The Excel Options, Add-ins options selected is displayed in the screenshot below. Notice how you can see which add-ins are
Active, Inactive and Disabled as well as any Documents related to add-ins. 

There are three main categories for the different types of add-ins: Excel add-ins, Custom add-ins, and Downloadable add-ins.
We’ll go over an example for each of the three types to give you a good idea how to find, add-in, activate and run an add-in in
Excel.

Excel Add-ins
These add-ins include ones with the extensions .xlam (marco-enabled add-in), .xla (Excel 97-2003 add-ins), .xll (DLL add-in or an
automation add-in. Examples include the Analysis ToolPak, Analysis ToolPak – VBA, or the Euro Currency Tools add-in.
Microsoft add-ins are listed in the Options window.

Here is how to enable an included add-in from Microsoft. Let’s say you wish to have the Analysis ToolPak available in Excel.
Follow these steps:

1. After opening the Options window, Add-ins on the left-hand menu selected, search and click on Analysis ToolPak in the list to
see that it is disabled.

Learning Objectives

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46555?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.18%3A_Add-Ins


8.18.2 https://biz.libretexts.org/@go/page/46555

2. At the bottom of the Options window, in the Manage drop-down menu, select Excel Add-ins, click Go.
3. The Options window closes, and a new small dialog box opens. See the ToolPak box isn’t checked. Check that box and click

the OK button. 

4. Excel takes a few seconds loading up the add-in and then it will show up in your ribbon area usually. In this case, in the Data
tab, on the far right a new group appears called Analysis, Data Analysis button. 

This ToolPack adds-in many additional data analysis tools you can use. Scroll through the menu to see the options. Many are
additional statistical analysis options.

5. Now if you return to the Options window you will see that the Analysis ToolPack is activated. If you wish to deactivate this
add-in, return to the Options, Add-ins, Manage, Excel Add-ins, and click Go to open the Add-ins dialog box again. Simply
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uncheck the box and click OK to disable the Analysis ToolPack. 

6. This same process is used for the included Microsoft Add-ins in Excel. COM Add-ins are also Microsoft’s add-ins that are
available in Excel as well and can be added or disabled by opening its dialog box and clicking on the available add-ins as well.

Downloadable Add-Ins

If you are surfing the internet looking for a good add-in for Excel, you will find many add-ins provided by a large variety of
program providers, software developers and businesses. Let’s walk through a scenario to see how to install a downloaded add-in
into Excel.

Let’s say you found the website www.excelcampus.com or some other website, and decided you would like to use the Excel
Pivotpal add-in to make your pivot tables a bit more customized. Follow these steps to get the add-in into your Excel program.

1. After purchasing the add-in, download it into your download folder on your computer. (Double clicking does not add it
automatically to Excel, you need to go through the Add-in in the Options menu.)

2. Open Excel, File, Options, Add-ins menu and the window displays the available add-ins.
3. At the bottom of the window, in the Manage, choose the Excel Add-in, and click Go.
4. The Add-ins window will open but you will not see the file you downloaded. You need to now go find that file. Click on the

Browse… button and it will open a new window. It usually defaults to the Microsoft > AddIns folders. Navigate to where you
saved the downloaded add-in file and select it, click OK.

5. It will now be added into the Add-ins menu in the small window. Now check the box and click OK to enable the downloaded
add-in. 

6. Once an add-in is enabled, there is no need to re-install, it loads and opens each time you open Excel.
7. To disable it follow the same path to open the Add-ins window and deselect the custom add-in.

Custom add-ins
A custom add-in is one you create yourself–this is useful when you must run a macro often for different workbooks—or created by
solution providers or programmers based on the COM (Component Object Model). These custom add-ins often require Visual
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Basic or other programming languages to build. As you become more proficient in Excel or Visual Basic, you may wish to create
your own custom Excel add-in.

The flexibility of Excel allows for all kinds of custom add-ins. Many custom add-in files may be added into Excel just like with a
downloaded add-in file process.

Additional access to Microsoft Add-ins

Excel, and the other Office 365 and 2019 programs, have an additional way to find other add-ins available from Microsoft. In the
Insert tab, find the Add-ins button. Once you click on that button choose one of the options. Here is what this looks like:

After selecting the Get Add-ins option, a new window opens, and you can scroll through and select a variety of add-ins to use for
Excel and the other Office products.
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Add-ins can be powerful tools to assist with Excel’s already useful functions. Now that you know how to search, find, download
and add in these tools, find the ones that fit your needs the best and enable them to make your work life more efficient.
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8.19: Introduction to Internet and Excel

What you’ll learn to do: Use internet tools to enhance Excel workbooks

There are several features that can help you take advantage of the internet and its capabilities in your Excel workbooks.

8.19: Introduction to Internet and Excel is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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8.20: Internet and Excel

Use internet tools to enhance Excel workbooks.

Rowan Retail Store #2 is using Excel to plan their campaign for the Q3 sales campaign. The campaign for this store is to create a
loyalty program and start with selling more dairy groceries. Like Word and PowerPoint, the same skills apply to copy, paste images
and address from the internet. There is one other feature that is unique to Excel which we’ll go over.

Maurice has opened his Q3 sales campaign Excel file and wants to insert pictures of each store in the table he has made. He
searches the web for the photos by first clicking the Insert tab and Online Pictures button. After finding the second store’s photo, he
clicks the Insert button and then resizes the photo in the worksheet.

He finds and inserts the third store’s photo and now his table is complete. He wants to keep a reference for a webpage next to the
table. With a browser open to the website, Maurice copies the web address and goes back to his Excel workbook. He selects a cell
and pastes the address directly into the workbook.
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Bonus Advanced Integration
Maurice wants to conduct research on current dairy prices to help him decide on the sales percentage. Excel has a function to allow
tables from websites to be imported into a worksheet. Maurice already knows the website he wants to follow
(www.dairy.com/market-prices).

He takes the following steps to set up the table in a new workbook tab.

1. First, he clicks on the Data tab, then selects the Get Data > From Other Sources > From Web.

2. He then types in his webpage address into the dialog box and clicks OK.

3. This sends Excel out looking for the website and its data. It then displays a dialog box with the information it can read. Maurice
selects Table 1 and clicks the Load button.
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4. The data table from the website is now pulled into his spreadsheet. Hooray!

5. Maurice wants to make sure he has the most up-to-date information. He clicks the Data tab > Properties button > Query
Properties button.

6. A new dialog box opens and he checks the box to Refresh every 60 minutes. He can change this to whatever time frame he
desires to make sure he always has updated data.
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7. The data table now refreshes and Maurice can conduct his research on the market price of dairy commodities.
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8.21: Putting It Together- Microsoft Excel Advanced Skills
Now that you’ve learned more about Microsoft Excel, let’s revisit a few of the hypotheticals we talked about in the beginning of
this module:

You may find yourself completing the same tasks over and over again. This can often be automated, either with a function or
with a macro.
You may find yourself re-creating tables, because they weren’t organized the way you need them to be. The PivotTable tool may
be a good solution for this.

As with Word, there’s more that Microsoft Excel can do. If you find yourself curious, Microsoft’s website is a good place to check,
or you can run a web search for how to use a particular feature.

8.21: Putting It Together- Microsoft Excel Advanced Skills is shared under a CC BY license and was authored, remixed, and/or curated by
LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46558?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.21%3A_Putting_It_Together-_Microsoft_Excel_Advanced_Skills
https://support.office.com/en-US/Excel
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.21%3A_Putting_It_Together-_Microsoft_Excel_Advanced_Skills
https://creativecommons.org/licenses/by/


8.22.1 https://biz.libretexts.org/@go/page/46559

8.22: Assignment- Create Macro for Car Loan Spreadsheet
In this assignment, we will record a macro and run it to modify a spreadsheet of car loan data received on a weekly basis. After
recording a macro for the first week, run the macro on a new set of data for week two.

To complete this assignment, download the car loan file here. Follow the directions, then submit your assignment. If you get stuck
on a step, review this module and ask your classmates for help in the discussion forum.

1. Open the workbook and save the new Module 8 assignment file to the Rowan folder on your desktop as
BA132_LastName_CarLoans.xlsx, replacing “LastName” with your own last name. (Example: BA132_Hywater_Memo) It is a
good idea to save your work periodically.

2. Scenario: Each week you receive a worksheet filled with car loan data. To make it easier to analyze on a weekly, record a
macro and change the worksheet look, calculate the monthly loan payment amount and identify which loans are leases. (Hint:
Read through all the instructions first and practice going through the steps before starting the macro recording.) 

3. Record Macro: Open the spreadsheet and from the View tab or the Developer tab start a macro recording. Name the macro
whatever you would like, add a short-cut key (optional), and write a description for it.
a. Once the recording is started walk through these steps, then stop the recording. 
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b. Change the title row to any color, change the font color if needed, and bold the titles. 
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c. Change all the currency columns to a currency format (this includes the PV, Annual Income, Total Payment). 
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d. Change the Interest Rate column to a percentage (%). 

e. Add in a new column to the right of the Interest Rate column and call it PMT.
f. Financial Function: In the new column use the PMT function and calculate the monthly payment amount for the first loan.

(Remember the rate needs to be divided by 12 to get the monthly payment and place a minus sign before the PV cell (-B2) if
you don’t want the negative red numbers.)
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g. Autofill the rest of the column with the formula to discover each loan’s monthly payment amount.
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h. Add filters to column titles and sort the monthly payment amount from the highest to the lowest. 
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i. Use conditional formatting in the ‘Ownership Type’ column to highlight all car leases in red. 

j. Select the entire table and autofit the columns to be wide enough to fit all the data
k. Stop the macro recording.

4. Select ‘Week 2’ worksheet tab containing a new week of information. (Note: Make a copy of this tab first in case you need to
redo the Macro. Remember once a Macro is run there is no going back with ‘Undo Typing’ option.)
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5. Run the new macro and watch the new information change almost instantly. 

6. Save your work by selecting Save As and choose Excel Macro-Enabled Workbook. 

7. Submit the document in your course online.
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8.23: Discussion- Excel Worksheet as a Webpage
There may be occasions in school or at work where more people need to have access to see what you have put together on an Excel
spreadsheet. There is a way to make a worksheet more accessible and get it ready to put on the internet.

Watch this video showing how to take an Excel worksheet and publish it to be a web page. While the video shows an older version
of Word (Microsoft Word 2016), the same steps work in other versions of Word, including 2019 and 365. After watching the video
consider a few questions to discuss.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Publish Worksheet as Web Page” here (opens in new window).

Discussion Questions
Are there occasions when this would be a useful skill?
What types of situations would facilitate using this tool?
If you were to use this skill how would you use it?

Share your opinions below and respond to two of your classmates’ thoughts.

Contributors and Attributions
CC licensed content, Original

Discussion: Excel Worksheet as a Webpaget. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY:
Attribution

All rights reserved content
Microsoft Excel 2010: Publish Worksheet as Web Page. Authored by: Kirt Kershaw. Located at: https://youtu.be/WV2CzUI8-
60. License: All Rights Reserved. License Terms: Standard YouTube License

8.23: Discussion- Excel Worksheet as a Webpage is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46560?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.23%3A_Discussion-_Excel_Worksheet_as_a_Webpage
https://course-building.s3-us-west-2.amazonaws.com/ComputerApps/Transcripts/PublishWorksheetAsWebPage_Transcript.txt
https://creativecommons.org/licenses/by/4.0
https://youtu.be/WV2CzUI8-60
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/08%3A_Microsoft_Excel_Advanced_Skills/8.23%3A_Discussion-_Excel_Worksheet_as_a_Webpage
https://creativecommons.org/licenses/by/


1

CHAPTER OVERVIEW

9: Microsoft PowerPoint Basic Skills

Create and save a new presentation
Edit and organize a presentation
Add objects to a presentation

9.1: Why It Matters- Microsoft PowerPoint Basic Skills
9.2: Introduction to Creating Presentations
9.3: New Presentations
9.4: Themes
9.5: Introduction to Using PowerPoint
9.6: Editing a Presentation
9.7: Organizing Slides
9.8: Views
9.9: Introduction to Objects in PowerPoint
9.10: Text Boxes
9.11: Images and Clip Art
9.12: SmartArt
9.13: Arranging Objects
9.14: Grouping Objects
9.15: Putting It Together- Microsoft PowerPoint Basic Skills
9.16: Assignment- Present Sales Information
9.17: Discussion- Infographics and Custom Shapes

9: Microsoft PowerPoint Basic Skills is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Learning Objectives

https://libretexts.org/
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.01%3A_Why_It_Matters-_Microsoft_PowerPoint_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.02%3A_Introduction_to_Creating_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.03%3A_New_Presentations
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.04%3A_Themes
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.05%3A_Introduction_to_Using_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.06%3A_Editing_a_Presentation
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.07%3A_Organizing_Slides
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.08%3A_Views
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.09%3A_Introduction_to_Objects_in_PowerPoint
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.10%3A_Text_Boxes
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.11%3A_Images_and_Clip_Art
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.12%3A_SmartArt
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.13%3A_Arranging_Objects
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.14%3A_Grouping_Objects
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.15%3A_Putting_It_Together-_Microsoft_PowerPoint_Basic_Skills
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.16%3A_Assignment-_Present_Sales_Information
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills/9.17%3A_Discussion-_Infographics_and_Custom_Shapes
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/09%3A_Microsoft_PowerPoint_Basic_Skills
https://creativecommons.org/licenses/by/


9.1.1 https://biz.libretexts.org/@go/page/46561

9.1: Why It Matters- Microsoft PowerPoint Basic Skills

Why learn to complete basic skills in Microsoft PowerPoint?

In previous modules you learned how to analyze data and create reports and graphs. Often after completing any of these steps, you
may be asked to share your work with others. While it is possible to simply send along a copy of the report or graph, it is also quite
common to be asked to present the data to a group of people in the form of a presentation.

Microsoft also has a powerful presentation application, known as PowerPoint. In this learning module, you will learn the basics of
using PowerPoint, focused on editing a pre-existing presentation and changing style elements. Before we begin, here is a quick
tutorial on some key information about PowerPoint and some handy tips to remember before we start using this program.

1. When you are actually working in PowerPoint you are working on a presentation. Individual pages within a presentation are
called slides. You can think of slides similarly to a page in Word: each is a standalone piece in a presentation.

2. Just like in Word, PowerPoint has a ribbon area at the top of the window with different tabs. Refer to the first Microsoft Word
module for a refresher on these terms if you need one.
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9.2: Introduction to Creating Presentations

What you’ll learn to do: create and save a new presentation.

Creating a new presentation is important because you may not always be given a presentation to edit. Sometimes you may need to
start from a blank slate. Creating a new presentation is much like creating a new document or new spreadsheet.
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9.3: New Presentations

Learning Outcomes
Create and save a new presentation.

You can open PowerPoint from the Start menu (or the Applications folder on a Mac) by clicking on the PowerPoint icon. The
PowerPoint icon comes in a variety of forms depending on your OS and version of PowerPoint, but it always features the color
orange and the letter P.

When you open PowerPoint, some versions of PowerPoint may take you straight to a new blank presentation. Newer versions such
as PowerPoint 2019 and 365 will take you to a menu called the backstage view to choose to open a new blank presentation or open
a new presentation from a template.

Note that the backstage view on a Macintosh computer is a little different.
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To open a blank presentation, double-click the blank presentation option. You can also choose to select a theme for a new
presentation, but remember: themes can be changed at any time.

If you already have a file open in PowerPoint, you can create a new presentation by clicking File>New. You can also use the
shortcut Ctrl+N (Cmnd+N for Mac).

Once you have a new presentation open, you save it the same way you would a Word or an Excel file. Refer to the Word lesson if
you need a refresher.

Practice Question
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9.4: Themes

Learning Outcomes
Change the theme on a presentation.

A theme is the overall visual look and scheme to a presentation in PowerPoint. Like many other features, it is quite easy to change
the theme after a presentation has been created.

1. Click on the Design tab.
2. Select a new theme from the available options.
3. Double-click on this theme.

The overall look and color scheme of your presentation will change. Compare the first screenshot to the one below.
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You can also change the color scheme of a theme, before or after you apply it to a presentation. This is done from the Variants and
Customize groups of the Design tab.

Below are just a few of the options available in the Variants menu.
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Practice Question
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9.5: Introduction to Using PowerPoint

What you’ll learn to do: edit and organize a presentation.

Learning to use Microsoft PowerPoint is one of the most helpful and versatile workplace skills you can acquire. Many of the skills
you learned for Word and Excel can also be applied to PowerPoint. The file extension for PowerPoint is .pptx, with versions older
than 2003 using .ppt.
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9.6: Editing a Presentation

Learning Outcomes
Edit an existing presentation.

To open an existing presentation, simply double-click on the presentation file, just the same as opening a Word document or Excel
file that you have already been given.

You may also open a presentation using the Ctrl+O (Cmnd+O) shortcut or through the File menu if you already have a presentation
open.

Practice Question
https://assessments.lumenlearning.co...essments/18692

Once you have opened an existing presentation, one of the first steps you may want to take is to edit content within that
presentation. However, before we begin that step let us look at the default view when we have opened a presentation, and review a
few terms.
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1. Slide thumbnail view: this shows you smaller images of all the slides in a presentation. It has its own scroll bar if there are
more slides than will fit in a single viewing window.

2. Active slide thumbnail: the active slide is highlighted in an orange box in the thumbnail view.
3. Active slide: this is the main view of the active slide you are currently viewing and can edit. You can see the scroll bar on the

right that allows you to move quickly through the presentation.

You can move between slides in a presentation using either the slide thumbnail view of the slides or in the main window. The slide
shown in the main window is the active slide for editing.

Practice Question
https://assessments.lumenlearning.co...essments/18693

In order to edit what a slide displays, click on the text or image you wish to edit. For example, the slide shown above says
“Quarterly Sales Data.” In the image below, the text box containing that phrase has been selected. The green arrow is pointing into
the active text box, specifically at the location of the cursor.
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In the next screenshot, “Quarterly” has been edited to read “Monthly.”
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9.7: Organizing Slides

Add, delete, and move slides.

Besides text edits on individual slides, you may also need to make more global changes, including adding, deleting, or moving
slides within a presentation. Each of these tasks is easiest to accomplish using the slide thumbnail view. The steps for these are
outlined below.

Add a Slide
1. To add a slide, simply click between two existing slides where you wish to insert a new blank slide.
2. Add a slide using the New Slide dropdown display in the Slides group of the ribbon.

Learning Objectives
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The New Slide dropdown display will show you various slide layouts you may want to use.

The layout name gives you a basic idea of when to use what format. For example, you can use the Comparison slide if you wish to
present two images side-by-side for direct comparison. There is space above each comparison box to provide a descriptive title,
such as “Before editing” and “After editing.”

Don’t worry; it is very easy to change the slide layout if you decide you want a different one later. Note that when you add a slide,
the new slide becomes the active slide in the main window.

You can also add slides using the the New slide dropdown menu in the Insert tab.
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https://assessments.lumenlearning.co...essments/18694

Delete a Slide
1. To delete a slide, click on the thumbnail image of the slide you wish to delete in the thumbnail view.
2. Then use either the Backspace or Delete button on your keyboard to remove that slide. Compare the two screenshots below. In

the first there are four slides visible in the thumbnail. Slide 2 is selected and deleted, so you do not see it in the second
screenshot.

Practice Question

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46567?pdf
https://assessments.lumenlearning.com/assessments/18694


9.7.4 https://biz.libretexts.org/@go/page/46567

Note that when you delete a slide, the next slide in the presentation becomes the active slide in the main window.

https://assessments.lumenlearning.co...essments/18695

Move a Slide
1. To move a slide, click on the slide you wish to move in the slide thumbnail view.
2. Drag that slide to a new position in the slide thumbnail view.

Compare the screenshots below. Slides #2 and #3 have been switched.

Practice Question
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Note that the slide you move remains the active slide in the main window.
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9.8: Views

Learning Outcomes
Use the Outline and Normal views

Another commonly used option in PowerPoint is the view you use to examine the slides. There are two major views: Normal and
Outline.

By default, PowerPoint opens presentations in the Normal view. This is the view you have seen in screenshots throughout this
module, with the slide thumbnails on the left, and as shown below.

But as you can see, it is difficult to see what the text on slides actually says from the Normal view. If you wish to still have an
overall thumbnail view of the slides in the presentation, but want to be able to read the text on the slides, you can use the “Outline”
view.
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Note that you can read the text that has been typed on a slide, but you cannot see tables or a thumbnail view of any images. In the
Normal view, the table in Slide 3 is visible, but in the Outline view all you can see of Slide 3 is the title.

You can still add, delete, and move slides from the Outline view. You can also directly edit text from the thumbnail slides in the
Outline view, which you cannot do from the Normal view thumbnails. To do this, double-click on or near the text you would like to
edit and type as normal.
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Practice Questions
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9.9: Introduction to Objects in PowerPoint

What you’ll learn to do: add objects to a presentation.

You have previously learned to add text boxes, headers, and footers to Word documents. You can also add these objects and more
to PowerPoint presentations.

PowerPoint is a helpful tool for organizing textual information in short, direct sentences or bullet points. It is also useful for
displaying tables, as you saw in the previous module. Tables are not the only graphics that you can embed in a presentation
however. You can also add images, clip art, and dynamic art to slides that help convey your message.
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9.10: Text Boxes

Learning Outcomes
Insert text boxes.

Another type of edit you may wish to perform on a presentation slide is to add a text box. Text boxes are used for emphasis or as
supplements to the standard layout space. For example, perhaps you want to draw attention to a specific feature on an image or in
data. An easy way to do this is with a text box.

1. Select the slide you wish to edit with a text box.
2. Click on the Insert Tab
3. Select Text Box from the menu in the Text group of the ribbon
4. Click on the slide to place your text box.
5. Enter your text.

After placing your text box, you can move it by clicking on the text box and dragging it to a new location. On the screenshot below
the text box has been moved to the left side of the table, from the right.
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Practice Question
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9.11: Images and Clip Art

Add images and clip art

To add an image, insert a new slide. For our purposes, it is helpful to start with a Title and Content slide, but remember you can
always change the format of your slide later.

Method 1
1. Click inside the content box so that it becomes the active portion of the slide.
2. If you hover your mouse over any of the icons shown in the green box below, you will see a description of what type of object

you can insert.
3. Select Pictures, the bottom left icon. 

4. By default, your computer’s Pictures folder will pop up. If your images are stored elsewhere, navigate to the appropriate
location to find your image.

5. Click on the picture or image you wish to insert.

Learning Objectives
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6. Click Insert 

Your image will be automatically sized by PowerPoint. You can then type in a title, add a text box, or even resize your image if you
wish.

Method 2
Another way to add an image to a slide is to use the Pictures option in the Insert tab. Pictures embedded this way are automatically
sized as well.
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Clicking the Pictures button uses images stored on your computer. Clicking the Online Pictures button allows you to use an
embedded search engine to use images directly from the internet. Note that the term pictures is used to represent really any graphic:
it can be a photograph, an icon, or a graphic file. Older versions of Microsoft Office included something called clip art. Clip art was
basically a graphic icon, such as the image shown below. This type of image can still be used and searched for using the Online
Pictures option.
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9.12: SmartArt

Learning Outcomes
Create and insert SmartArt.

SmartArt is a dynamic type of image that you will often see in PowerPoint slides. SmartArt can be used to group lists of
information together, through bullet lists for example, or to show a process, through cycles. Fortunately, you do not need to be a
graphic designer to create and insert simple and effective SmartArt into a PowerPoint presentation.

Before you actually insert SmartArt, you should determine what you are attempting to convey and the best way to convey it. One
helpful item here is the descriptions provided for each basic SmartArt graphic shape. You can access these descriptions by selecting
the Insert a SmartArt Graphic option on a new slide. When you do, you will see this window:

The graphic styles displayed immediately under All are the commonly used ones, but you can navigate to specific styles using the
menu on the left. For this walkthrough, we will create a basic cycle SmartArt graphic. This type of graphic is useful when
describing a process, such as what happens when a customer returns a defective item. This example will be used to describe how to
create a SmartArt graphic.

Once you click OK, the graphic is automatically sized into your slide, just like inserting any image. Remember: at the end of the
day, a SmartArt graphic is just an image. Therefore, you add them to slides using the same steps shown on the previous page. You
have to insert a SmartArt graphic before you can actually create the graphic.

The graphic inserts into the slide with default options, but those are very easy to change, as we will soon see
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Using the text box on the left, type in what should be displayed in each portion of the graphic. To move between portions of the
graphic, in this case the circles, click on the next bullet in the text box or on the next shape in the graphic. Below, all text has been
updated and a title has been added to the slide.

You can edit the text at any time by clicking on the “Type your text here” box or the circle you wish to edit. If you have left the
slide or presentation and come back to edit it later, you will need to click on some part of the SmartArt graphic to bring the “Type
your text here” box back onto the screen.
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Practice Question
https://assessments.lumenlearning.co...essments/18703

If you want to change the color scheme, layout, number of shapes in the graphic, or any other option, you can do so using the
Design tab and the options available in that ribbon. Note this Design tab is only available after you have clicked on the SmartArt
graphic. This is not the standard Design tab that is always available in PowerPoint.

Once you have created your SmartArt graphic, you can use the Convert to Shapes option to make your SmartArt graphic a static
image. Once you do this, you can still edit the text inside the shapes, but you cannot change other options such as color, layout, or
number of shapes.
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9.13: Arranging Objects

Learning Outcomes
Arrange objects

At this point, we have learned how to add a variety of items to PowerPoint slides, including different types of images and videos.
There are times when you may have multiple objects on a slide together and wish to position them in a certain way. Alternatively,
you may wish to position a single item in a very specific fashion. This is called arranging objects on slides. Like many other tasks
in PowerPoint, there are automated ways to do this.

1. The “Arrange” menu is found in the “Drawing” group of the Home tab.
2. You must select a specific object to arrange. For this example, the image of the flower on the left has been selected.

3. The dropdown Arrange menu provides you a variety of options. Align will specifically position the selected object somewhere
on the slide. 
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When you have multiple overlapping objects, you can choose which one is in the background or forefront using the Order Objects
selections. You should Bring to Front the image you wish to be in the forefront, but keep in mind it will then hide anything it
overlaps. Consider the images below.
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If you have multiple objects together on a slide, you can make them into a Group using the “Group Objects” menu. Grouping
different objects together turns them into a single object. In this way, they can be moved, aligned, or resized as a unit instead of
individually. Note that you can only group the same type of objects together. You can group multiple images together, but you
cannot group an image and a video.

Practice Question
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9.14: Grouping Objects

Group objects
Modify grouped objects

PowerPoint allows you to insert shapes or objects and position them in various ways in a slide. In the previous module you learned
how to arrange objects. Now we’ll walk through how to group objects. The main reasons to group objects are to make it easier to
move, align or resize objects together. In this example we assume objects have already been arranged and now need to be grouped.

Group Objects
1. Open a slide in a PowerPoint presentation containing various shapes or objects arranged in the slide.
2. Start from a corner of the slide, hold the left-mouse button down and drag it to include all objects to be included in a group. 

3. Release the mouse button and all the objects should be showing that they have been selected by each object showing its rotate
arrow, resizing dots, etc.
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4. On the Home tab, select the Arrange button, and in Group Objects, select Group. 

5. Now all the selected objects will be in one group and can be moved, resized, rotated, copied, flipped or rearranged as one group. 
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Modify Group Objects
Once objects are grouped, they can be modified in a variety of ways including ungrouping and regrouping. We’ll walk through a
few steps of how to modify within a group object.

Text

If a group object has resized by either enlarging or shrinking and there is text involved within the group, check to see if it now
needs to be modified. When a group is resized, text retains its original font size. To resize it, triple click on the text and all text in
an object is selected. A menu will appear to change the size to fit the object.

Practice Questions
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Shapes

Within a group, an individual object can be moved around without affecting the other objects. To move a specific object in a group,
select the object and drag it to a new position.
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Ungroup/Regroup

If after repositioning or adjusting a group you no longer want the objects to act as one group, go back to the Home, Arrange, Group
Objects, selecting Ungroup. If you decide that you’d rather have them as a group again, select all the objects and select the Regroup
option.
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In Office 365 PowerPoint, grouping can be done with all kinds of objects; video, audio, pictures, shapes, etc. It was not
possible in earlier PowerPoint versions to group video and pictures together.
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9.15: Putting It Together- Microsoft PowerPoint Basic Skills
Now that you understand the basics of Microsoft PowerPoint, let us consider some ways to use this program to share information.

1. You could present quarterly sales data, copying graphs or sparklines from Excel.
2. You could provide a summary of the high points from a report, such as key metrics or conclusions about ways to improve

business operations.
3. You could display inventory data previously collected in Excel, including item, quantity, and store location.

This module focused on the basics of using PowerPoint to edit an existing presentation and adding simple objects. In our next
module, we will expand our use of PowerPoint by learning to add other features.
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9.16: Assignment- Present Sales Information
For this assignment, you will edit a short PowerPoint presentation that contains sales information.

Download the PowerPoint presentation you will use to start your assignment. Follow the directions, then submit your assignment.
If you get stuck on a step, review this module and ask your classmates for help in the discussion forum.

1. Open the presentation. Save it to the Rowan folder on your desktop as BA132_LastName_SalesInformation.pptx, replacing
“LastName” with your own last name. (Example: BA132_Hywater_SalesInformation) It is a good idea to save your work
periodically.

2. Edit the first slide to say “Annual Sales Data” under the Title “Rowan Retail” 
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3. Move the current slide 3 in front of the current slide 2 

4. Add a text box on slide 3 next to the month with the highest sales data that reads “Highest Month.” Your text box should be to
the left of the month. 
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5. Add three slides to the end of the presentation. The layout of these slides does not matter. 

6. Choose one of the new slides and add three to five objects or shapes. Make a group out of all of those objects or shapes and
resize the group to be large and centered in the slide.

7. Save your work and submit it in your course online.
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9.17: Discussion- Infographics and Custom Shapes
In this PowerPoint module, we discussed a variety of visual tricks and tips such as inserting images and creating SmartArt
graphics. With these tools and a little cleverness, you can also create your very own infographics!

Watch the first video below:

A link to an interactive elements can be found at the bottom of this page.

You can also view the transcript for the video “How to Create Infographic Elements in PowerPoint” here (opens in new window).

Discussion Questions
What applications might the techniques in this video have?
How can you improve your presentations with this feature?

Share your opinions below and respond to two of your classmates’ thoughts.

Learn More

If you are interested in learning more, here are some other videos that build upon the first video to finish creating the infographic:

A link to an interactive elements can be found at the bottom of this page.

You can view the transcript for “Step 2: Creating and Masking Effect for Your Graphics” here (opens in new window).

A link to an interactive elements can be found at the bottom of this page.

You can view the transcript for “Step 3: Creating the Percentages” here (opens in new window).
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10.1: Why It Matters- Microsoft PowerPoint Intermediate Skills

Why learn to complete intermediate skills in Microsoft PowerPoint?

In the last module, we focused on some basic functionality in PowerPoint. But this program is capable of a lot more, including
incorporating images and videos as well as allowing you to precisely position items.

Before we move into the mechanics of each of these, let us consider for a moment the types of information you may wish to convey
in a presentation.

1. You want to show a clip from an advertising campaign.
2. You want to add information to every slide

All of these questions can be answered with the valuable tools available in PowerPoint.
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10.2: Introduction to Transition Effects

What you’ll learn to do: change the theme and transitions of a presentation.

Adding some design effects such as an attractive theme or smooth transition between slides can help your presentation stand out.
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10.3: Transition Effects

Learning Outcomes
Change slide transition effects.

Another major edit you may make to an existing presentation is to change the transition effects on a slide.

Transition effects are animation options within a presentation. You cannot see the transitions in action from the static presentation
view of slides. But when you start the actual slideshow, transitions will dictate how the presentation progresses from one slide to
the next. Transitions can be used to set specific time intervals before moving forward in the show, or can be used to make slides
change with the click of a mouse button. Transitions also change the way a new slide enters or exits the screen.

To edit transition effects, you need to access the Transitions tab. From this area you can edit, delete, or add transitions to a slide.

If you hover your mouse over a transition option, you will see a brief description of that transition. Some effects have several
options. For example the Wipe transition could start from the right, top, left, bottom, or other directions. The Effect Options
dropdown menu is to the right of the transition options.
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Practice Questions
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10.4: Introduction to Headers and Footers

What you’ll learn to do: Add header and footer to slides

When creating a presentation, you may want to add the title of the deck to every slide. Or you may want to add slide numbers to the
bottom of each slide. Either way, you’ll want to add a header or a footer to put this information in your deck.

10.4: Introduction to Headers and Footers is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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10.5: Headers and Footers

Learning Outcomes
Add header and footer to slides.

Another common addition to slides is to include headers and footers. The options to add headers and footers are in the same
dropdown menu of the Text group. Once there, you will see the menu below.

From this menu, you can choose a variety of options for your header and footer. Footers are often used for a running title or to
identify a particular author.

You can see the results of adding
these options on the screenshot below. The final position of the boxes matches the Preview shown to the right of the header and
footer box.
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Practice Questions
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10.6: Introduction to Videos in PowerPoint

What you’ll learn to do: Put a video into a PowerPoint slide

PowerPoint is a versatile presentation tool which often uses videos to add more in-depth information to a presentation. Video can
be instructional and communicate more than simply words, tables or pictures alone. This section shows examples of how to
integrate video into a PowerPoint presentation’s slides.

Many, if not most of the videos used in PowerPoint are linked in from external sources and websites like YouTube or other web
pages. We will follow along as she embeds, links, and uploads videos into slides for her presentation. After learning this material,
your presentations can be more dynamic and interactive and hold the attention of your presentation audience.
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10.7: Inserting Videos in PowerPoint

Learning Outcomes
Insert an online video into a PowerPoint slide

Karen is creating a work presentation to introduce her team to a few different concepts. She begins by adding in her video slides
first. Later she will fill in the rest of the presentation around them. The first video is about using creative commons licensed
material. She has already opened a new presentation in PowerPoint and has a video she wishes to insert into her slide.

Placing the cursor on the small box with the six different choices, she selects the Insert Video icon.

The insert video window will appear and since Karen knows the video she wants is on YouTube so she searches in the YouTube
box. She searches for Creative Commons and presses the Enter key. Her search results appear and she scrolls through to find the
video she wants.
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Karen selects the video and clicks the Insert button (she can also double-click on the video to insert). Once the video is inserted,
she has a variety of options. Let’s take a look at what she can choose.

Practice Question

https://assessments.lumenlearning.co...essments/18714

1. Video Tools. This is a special tab that automatically appears when inserting a video.
2. Video Styles. Karen can select a variety of different styles to display the video in this slide.
3. Resizing Tool. Karen wants to make the video appear larger on the slide. She can click the Height and Width arrows to

increase the size.
4. Resizing by Dragging. Alternatively Karen can resize the video by clicking on a corner or side and dragging the cursor to the

desired size.

Practice Question
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Karen decides she doesn’t like the hard edges on the video. She moves up to the video style ribbon and selects the Visual Effects
button.
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She selects the Soft Edge > 2.5 Point option. To play the video, she double-clicks on it and waits until she sees the YouTube red
icon.

Now when Karen clicks the red button, the video plays.

Contributors and Attributions
CC licensed content, Original

Inserting Videos in PowerPoint. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY: Attribution

10.7: Inserting Videos in PowerPoint is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46584?pdf
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/10%3A_Microsoft_PowerPoint_Intermediate_Skills/10.07%3A_Inserting_Videos_in_PowerPoint
https://creativecommons.org/licenses/by/


10.8.1 https://biz.libretexts.org/@go/page/46585

10.8: Embedding Videos in PowerPoint

Learning Outcomes
Embed a video into a PowerPoint slide.

Karen has another video she wishes to embed in a new slide about collaboration. She opens a browser window to the YouTube
website and finds her desired video. She then clicks the Share > Embed buttons and sees a text box with an address in it. She
copies the text by making sure all is selected and then uses Ctrl+C to copy it (or right-click > copy).

Next, Karen toggles (Alt+Tab) back to her PowerPoint presentation window and opens a new blank slide. She clicks on the Insert
tab, then the Video button on the ribbon, and selects the Online Video option. This brings up the same Insert Video window as
before.

Karen places her cursor in the From a Video Embed Code box, pastes the link from her YouTube video with Ctrl+V, and presses
the small arrow (or presses the Enter key).
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Now the video is in her new slide and needs to be resized. Karen drags the video so it is almost as large as the slide. It is a little off-
center, so Karen clicks on the Align button in the Format ribbon area and selects the Align Center option.

Next, she decides she would like to have this video play automatically when she moves to this slide in the presentation. She clicks
the Playback tab and navigates to the Video Options area on the ribbon. She then selects the Start button and the Automatically
option.
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10.9: Uploading Videos in PowerPoint

Learning Outcomes
Upload a video into a PowerPoint slide.

Lastly, Karen has a video on her computer to add for the end of the presentation. She creates a new slide, titles it The End, and
clicks on the Insert Video icon. Now the insert video window appears, and she selects the From a file option.

She finds her file in her computer’s folders, selects it and clicks the Insert button (or double-clicks on the file).

The video is added to her slide.

Practice Question

https://assessments.lumenlearning.co...essments/18719

Note: Many people upload videos from their computers for presentations just in case the internet connection is slow when running
their presentation. With a video on your computer, you can count on it working when the time is right.

Karen wants to modify the ending of the video. After dragging and resizing it, she clicks on the Playback tab and makes a few
changes.
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1. Video Tools. This is the highlighted menu for editing video.
2. Playback Tab. This regulates playback for videos in the slide.
3. Start Button. Karen selects the option to play the video automatically.
4. Loop until Stopped. Karen wants this video to keep playing until she stops it.
5. Trim Video Button. This opens a trim video box for Karen to change her video.
6. Start Time Toggle. Karen moves the toggle to start the video a few seconds in from the original beginning of the video. She

wants the seagulls to be further out of the way when the video starts.
7. End Time Toggle. Karen wants the dusky sunset video to end at this point before looping and playing again.
8. OK Button. To set these changes Karen clicks the button.

Practice Questions
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To make sure the video is set exactly how Karen wants she clicks the Preview Play Button or the Arrow Button underneath the
video.

Karen is all set with her video slides. We will now leave Karen to finish her presentation.
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10.10: Introduction to Lists

What you’ll learn to do: Use lists

You’ll most likely want to include some form of list within your PowerPoint presentation. There is a wide array of types and
formats that you can choose from.

10.10: Introduction to Lists is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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10.11: Creating Lists

Create a list

If you have experienced PowerPoint presentations, you’ve seen lists presented. There are standard bullet point and numbered lists,
but there are additional ways to make lists in PowerPoint. Lists can be complex or as simple as you wish them to be.

Creating Lists
Many PowerPoint slides contain formatting in them with bulleted lists. If you see a slide with a bullet point stating “Click to add
text” in the slide it, the slide is ready for a bullet point list already. If you do not see a bullet point already, it can be added by going
to the Home tab, Paragraph group, and select either the bullet list or numbers list button.

With a new formatted slide follow these steps to create a list:

Click in the frame and begin to type in your list. 

Press the Enter key on your keyboard when done and the cursor moves down to the next list line.
Continue to type out points until you are finished with your list. This is how to create a basic list either with bullet points or
numbered list. Creating a standard list is a straightforward process in PowerPoint.

Learning Objectives
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10.12: Modifying Lists

Modify a list

Now that you have a list, it might need to be modified to fit your communication goal better. Here are a few options enhancing a
list in a PowerPoint presentation.

Adjusting Spacing
Lists need a bit of space to breath to make it easier for an audience to read. To add space between the points, you can walk through
each line and add another line by pressing the Enter key, but a faster way is to use the line spacing button in the paragraph group on
the Home tab.

Highlight the list, select the line spacing button, roll the cursor over the spacing parameters until you find what works best with
your text, and select it.

Alternatively, select the Line Spacing Options on the bottom line of the line spacing dropdown menu and a dialog box appears
where a more granular level of spacing options is offered.

Creating Sub-Points

Indenting list sub-points can highlight additional details. This is done by either pressing the Tab key or using the Indent button in
the Home tab, Paragraph group.

Learning Objectives
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Modifying Sub-Point Style

Occasionally changing the style of a sub-point adds further emphasis to it to make it more memorable. To change the style,
highlight the sub-points, right click the mouse and select the bullet or number list options in the pop-up menu.
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Modifying Style of List
To change a bullet list to a numbers list or change the style of any list follow these steps.

Highlight the entire list and on the Home tab, Paragraph group, select the bullet or numbers list.
Hover the cursor over the various choices and each style will appear in the highlighted list.
Once you decide, click on the choice and the list will automatically be updated with the new type or style.

Practice Question
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Modifying a List to use Symbols
Highlight the entire list and on the Home tab, Paragraph group, select the bullet or numbers list.
At the bottom of the drop-down menu, select the Bullets and Numbering option.
On the bottom right of the dialog box, click the Customize button and a Symbol window will open with a selection of various
symbols to choose. Decide which one you’d like, select it and click OK.
It will be added into the options for the list menu which can now be selected for the list.
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Modifying List to Use a Picture or Icons
Highlight the entire list, go to the Home tab, Paragraph group, select the bullet or numbers list.
At the bottom of the drop-down menu, select the Bullets and Numbering option.
On the bottom right of the dialog box, click the Picture button and Insert Pictures window will open with three choices from
which to choose; From a File, Online Pictures, From Icons. 

Decide which one you’d like to do. For this example, we’ll enter an icon so click on the Icon option. A new window opens with
a large variety of icons from which to choose. 

Select an icon to use and click the Insert button.
The icon now replaces the bullet list with the chosen icon.

Modifying Colors of Bullets
There may be occasions when you wish to change the color of just the bullets or numbers in a list. Follow these steps to do so:

Highlight the entire list, click the Home tab, Paragraph group, select the bullet or numbers list.
At the bottom of the drop-down menu, select the Bullets and Numbering option.
On the bottom left in the dialog box, click the dropdown menu for the Color button and select the color you wish to use.
Once the color is selected, click OK. The bullets or numbers will change reflecting your selected color in the slide.
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The purpose of most PowerPoints is to get your points across as succinctly and clearly as possible. Here are a few key things to
keep in mind when creating lists:

Use a max of four to five points because more tends to be overwhelming to an audience.
Changing fonts, colors, or styles in a list makes it difficult to read or look at for too long.
Too many words can start audiences on the road to numbness. Keep it simple.
Colors that are high contrast, clash or overwhelm each other are best avoided.
Font size is very important. If your font is too small, and only you can read it, you lose audience attention.

Now that you know a few ways to create PowerPoint lists in PowerPoint. Start experimenting to see what works best for your
presentations.
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10.13: Putting It Together- Microsoft PowerPoint Intermediate Skills
Now that you know some of the more visual-based tricks in PowerPoint, let’s take a look at our opening list of possible
presentation goals and match those with the skills you just learned.

1. You want to show a clip from an advertising campaign. You can achieve this by inserting the video and even trim it to a shorter
segment.

2. You want to provide a visual introduction of newly hired employees. You can easily insert headshots of the new employees, and
can even use the grouping and arranging options to make sure everyone gets equal billing in photo size and position.
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10.14: Assignment- Create a New Presentation
For this assignment, you will create a short PowerPoint presentation that includes several objects as well as slide transitions. In this
assignment, imagine you have been asked to present at the next staff meeting. You know you will have lots of data tables and sales
figures to discuss, but you also want to keep the mood light by having some humor in your presentation. So the first thing you will
do is find some visuals to help break up the business discussion.

Follow the directions, then submit your assignment. If you get stuck on a step, review this module and ask your classmates for help
in the discussion forum.

1. Open a new blank presentation. Save it to the Rowan folder on your desktop as BA132_LastName_NewPresentation.pptx,
replacing “LastName” with your own last name. (Example: BA132_Hywater_NewPresentation) It is a good idea to save your
work periodically.

2. On the first slide, title the presentation “Module 10 Presentation” with your name in the subtitle box.
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3. Add three more slides with these layouts: “Title and Content,” “Two Content,” and “Title and Content.” 

4. Add an image of your choice to the second slide and align this image to the left. 
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5. Add clip art to the third slide. Align the left object to the top of the slide. Align the right object to the bottom of the slide. 

6. Create a SmartArt graphic on slide 4. You may copy the example, which shows a basic process. Choose your own color scheme.
Any color other than the default blue color is acceptable. 
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7. Add one new slide with the Title and Content layout. Insert an online video about Koala’s and title the slide.

8. Lastly, go to each slide in the presentation and add any type of transition you would like for each slide.

9. Save your work and submit it in your course online.
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10.15: Discussion- Making a PowerPoint Presentation into a Video
This PowerPoint module included a variety of ways to use and insert videos into a presentation. But what if you need to record a
presentation to be able to send it to absent colleges or be able to upload it to an internal website?

Watch this video below to see how to record your presentation as a video.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=440

Discussion Questions
How could you use this new skill in school or business?
What types of scenarios would call for being able to use or upload a recorded presentation?

Share your opinions below and respond to two of your classmates’ thoughts.
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11.1: Why It Matters- Microsoft PowerPoint Advanced Skills

Why learn to complete advanced skills in Microsoft PowerPoint?

There’s even more that you can do in Microsoft PowerPoint.

You can create a cohesive color theme
You can add tables and charts
You can integrate your presentation with online resources

We’ll look at these and other functions in this module.

11.1: Why It Matters- Microsoft PowerPoint Advanced Skills is shared under a CC BY license and was authored, remixed, and/or curated by
LibreTexts.
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11.2: Introduction to Colors

What you’ll learn to do: Use colors in PowerPoint

Color is incredibly important to a well designed slide deck. Your colors should be consistent throughout your presentation—and if
you’re creating a presentation for a business meeting, your colors should be consistent with your company’s branding.
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11.3: Color Themes

Learning Outcomes
Use color themes

PowerPoint includes advanced features such as making a custom template. In addition, color themes can be selected to enliven a
presentation or align the color scheme with a company’s logo, marketing campaign or advertising colors. PowerPoint’s flexible
tools also include the ability to create custom color themes for your presentation and be able to use it over again if you are using
Office 365.

At a team meeting this Friday Sharon is giving a presentation. She has selected a presentation theme which came with predefined
colors and has begun to work on the content. After talking with Jeff in the marketing department, Sharon realizes it would be better
to have the presentation align with the marketing campaign colors. Here is how Sharon changed the colors in her existing
presentation and how you can as well.

After opening the PowerPoint presentation, click on the Design tab, and navigate to the Variants group.

1. Click the down arrow in the corner of the variant scrollbar and a new dropdown menu appears.
2. Select the Colors option, and another color bar menu opens to the right. 

3. Scroll down or roll the cursor over each of the color options to see the current slide immediately change to fit the color themes
being rolled over.
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4. After deciding on a new color scheme, select it and the entire PowerPoint slide deck converts to the chosen color theme. 

5. If a new color theme for a presentation needs to change even after the content is completed, follow the same steps and select a
new color theme. This will automatically convert all the slides to match that color theme.
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11.4: Custom Color Themes

Learning Outcomes
Create a custom color theme

If a company is associated with certain colors, or you want to create a distinctive color theme for your presentation, follow these
next steps.

1. After opening a PowerPoint presentation, click on the Design tab, and navigate to the Variants group.
2. Click the down arrow in the corner of the variant scrollbar and a new dropdown menu appears.
3. Select the Colors option, and another the color bar menu opens to the right.
4. Scroll to the very bottom of the list and select the Customize Colors option. 

5. A Create New Theme Colors dialog box opens. On the left are the various areas and their associated colors. On the right side
is a visual layout sample of the colors associated with the different areas. Any of the areas can be changed to specific colors to
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match the custom theme.

6. Once new colors are selected, in the Name field, type in the name of your new custom color theme and click the Save button.
If after working on the colors for while you wish to start over, click the Reset button on the bottom left and all the area
colors return to the original starting colors.
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7. Now return to the Variants group, select the down arrow, colors, and look at the top of the color menu. The newly created
custom color theme is at the top. This is now saved and can be used over and over with new presentations.

8. If you are using Office 365, this new custom color scheme created in PowerPoint can be used throughout Microsoft 365
products (e.g. Word, Excel, etc.).
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11.5: Introduction to Tables in PowerPoint

What you’ll learn to do: Create tables in Microsoft PowerPoint

Often you’ll want to display data within your presentations. Tables are a great way to do so. Let’s take a look at how to add and
modify tables within PowerPoint.
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11.6: Create Tables

Create tables in slides

Creating tables in PowerPoint supports conveying data, financials or information about products, sales, services, or almost
anything. The most effective use of a table in PowerPoint is its ability to compare information at a glance. At the same time,
creating large, hyper detailed tables in a presentation can backfire and generate frustration since most presentations move quickly
or are projected at a distance making it harder to read quickly. The most effective use of a table in a presentation is as a summary of
simple comparative information.

There are the four methods that PowerPoint provides to add tables into a presentation. Let’s take a look at each method.

First Method
1. Open a new slide using the Table and Content slide. Enter the Title of the slide, then click on the Insert tab. 
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2. Select the Table button and drag the cursor over the number of rows and columns you want to use in the slide. The table will
now appear in the slide, colored in the presentation theme colors.
1. Type the information into the table.
2. If you wish to add an extra row, a short-cut way is to place the cursor in the bottom right, last cell and press the tab key. A

new row is now created in the table.
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Second Method
1. Another way to insert a table in a PowerPoint slide is to go to Insert tab and insert a new slide.
2. This time click on the small table icon in the center.

Alternatively, select Insert tab, Table button, Insert Table option and a dialogue box opens. 
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3. Once the Insert Table dialog box opens, enter the number of columns and rows for the table, click OK. 

4. A new, empty table will open in the center of the slide ready for data input. Notice two new tabs opened in the menu above the
ribbon as well; Table Design and Layout. Here styles can be changed, shading, SmartArt, and boarders, as well as a host of
other table layout options to change a table to suite the presentation best.
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Third Method
1. The third way to create a new table is go to Insert tab, Table button, select Draw Table option and the cursor becomes a pencil. 

2. Hold down the left mouse button and drag the pencil cursor to fit the size of table desired within the slide. 

3. Once the table is created, PowerPoint opens the two additional tabs; Table Design and Layout.
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4. The Table Design tab contains options to change the table style, effects, shading, boarders and WordArt styles. 

5. The Layout tab allows you to work on the rows and columns, merge cells, change cell size, alignment, the table size and
arranging the table position.
1. Tables function the same in PowerPoint as they do in Word with creating, entering data, changing layout or colors or boarder

styles.
2. A table in PowerPoint can also be treated like an object or graphic and brought forward, back, or rearranged like a drawing

through the Arrange group.
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Fourth Method
1. The last way to create a table in PowerPoint is to select the Excel table option in the Insert, Table, Excel Spreadsheet in the

dropdown menu. 
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2. Excel opens within PowerPoint giving access to the functions available in an Excel spreadsheet. This way calculations,
formulas and functions can be used to create a table within PowerPoint without the need to import a table from Excel. Start
typing information and data into the Excel table. 

3. Along with entering information to be included in the table, you can create formulas, or use other Excel functions in a
spreadsheet. 
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4. When the table is complete, click outside of the table area onto the slide and the table will be converted back into a PowerPoint
table view. 

5. If data in the Excel table needs editing, double click on the table and it will open Excel again allowing editing.
6. This table, or any of the tables, can be moved or resized like other objects in an Office program to match the scale needed for

the presentation.
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11.7: Format Tables

Format tables in slides

Once a table is created in a PowerPoint slide it needs formatting to match a presentation or emphasize an aspect of its information.
Here is how to format various areas of a table.

In a slide with a table inserted, click on the table and two new menu tabs appear; Table Design and Layout.

Table Design tab offers a variety of formatting and style options for a PowerPoint table. Here’s how to use some of those options.

Table Style
Change a table’s style by hovering over the colored tables or clicking the down arrow to see table style options. The options are
organized into Light, Medium, and Dark table colors. Select the style format by click on it and the table is automatically changed to
the new style in the slide.
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Best Match for Document

If you are unsure what style works best with the presentation, use the Best Match for Document option in the drop-down menu on
the top right. 

https://assessments.lumenlearning.co...essments/18730

Style Options
Other format and style options available for tables include shading, borders and effects. If a table needs to be formatted with
different borders, click the down arrow on the Borders button and select the border style for the table.

Practice Question
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Text

To change text format in a table use the WordArt button in the Table Design tab.

Border
Change a table’s border thickness, color, or pattern by selecting those options in the Draw Borders group under the Table Design
tab.
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Now you have learned new formatting skills for a PowerPoint table the next is to lean how to modify a table.
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11.8: Modify Tables

Modify tables in slides

There are times when a PowerPoint table needs modification after information or data is entered. Here is how to modify various
parts of a PowerPoint table.

Open a slide with a table, click on the table and the Layout tab appears. After selecting the Layout tab there are options available
to modify rows, columns, merge cells, change cell size, modify the alignment, the table size and arrange the table position. Here is
how to modify a table with those various options.

Many of the actions that can be done using the buttons in the ribbon can also be found if a table is selected and the right mouse
button clicked.

Rows & Columns
A table might need an additional row or column or to eliminate rows or columns.

1. Delete: Highlight the row/column to be eliminated, select the Delete button down arrow in the Rows & Columns group and
select the correct delete option (column or row). 
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2. Insert: Highlight a row or column, select either the Insert Above, Insert below, Insert Left, or Insert Right button to add in a
new row or column 

Merge

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46600?pdf


11.8.3 https://biz.libretexts.org/@go/page/46600

Highlight the cell, row, or column to be modified and select either the Merge Cells or Split Cells button to merge or split cells. 

Distribute Rows/Columns

Select the rows or columns and select either the Distribute Rows or Distribute Columns button to modify the spacing of the
rows/columns for a table. 
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Text Alignment
Highlight a cell, row or column with the desired text for alignment and select the desired type of alignment using one of the
alignment options. In this example, column titles are now left aligned and centered in the column cells 
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Arrange
Tables act like objects in PowerPoint like a picture or drawn shape. Because of this a table can be brought forward, backward or
aligned within a slide. To do this, used the options in the Arrange group in Layout tab to modify the table alignment in a slide. 
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Excel tables in PowerPoint act differently than PowerPoint created tables in a slide.

If an Excel table is clicked on once the Shape Format tab appears and its options can be modified as an object or shape.
To modify an Excel table’s data, format, etc., double click on the table and it will open Excel within PowerPoint. At this
point the format, data or any other modifications can be accomplished through Excel program options.

PowerPoint is very flexible with its ability to modify tables in many ways. These new skills to modify a PowerPoint table will help
elevate your PowerPoint presentation style.
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11.9: Introduction to Animations in PowerPoint

What you’ll learn to do: Use animations in PowerPoint

While it’s important to be judicious about how many animations you use in a presentation, their careful usage can add visual
interest. Let’s learn more about adding animations to your slide deck.
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11.10: Animations in PowerPoint

Use animations in PowerPoint

In a previous module you learned about transitions in PowerPoint, in other words, how a slide enters or exits the presentation stage.
PowerPoint also uses a tool to include animations on objects within slides. Take for an example, a slide with list in it where you
would like each of the bullet points to appear one at a time and in a different way. How do you make this happen? Animation.

PowerPoint Animation
In PowerPoint stock animations can be used or modified to fit a custom timeframe or pathway. For the most part, stock animations
are used in presentations, but if you have time and inclination you can create your own custom animations.

Returning to the Q3 Sales Campaign presentation, it contains a list slide that could benefit from animation. Here are some of the
ways to add animation into a presentation.

Adding Animations
1. Open a PowerPoint presentation and select the slide where the animation will be added.
2. Highlight the first section you wish to animate. In this case the first point in the list. 

3. Select the Animation tab and options in the ribbon appear.
4. Scroll through and choose one of the animation stars, in this case the ‘rise up’ star is selected. 

5. An alternative way to add an animation is to click the down arrow in the Animation area and a drop-down menu displaying all
the options appears. (Select the Animation Pane button to open the animation menu on the right side for easier navigation for
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the selected effects.) 

6. Once a few of the effects have been added to a slide, click the Preview button to watch the speed and effects on the slide.
Notice that the speed of the animations runs quick. You might need more time between effects to speak in your presentation.

7. To change the speed and duration, select a section, and navigate to the Timing group in the ribbon. Adjust the start time,
duration and delay time for each effect. 
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8. Notice that each of the text lines that are animated have numbers to the left of them. This is a visual way for you to easily
recognize what has animation already attached to it. Be sure to run the Preview again to test out your new timing and adjust
where needed.

9. If you find that the sequence needs adjustment, drag and drop the effects in the Animation Pane until the order matches what
you want or use the Reorder Animation buttons to move an effect to earlier or later in the slide. 
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10. Another option is to select how each of the animations will be triggered and started. Select the Trigger button, and choose how
each animation is begun, for example, when you click on the title of the slide. 

11. Now you have animated a slide. Be sure to run through the Preview as many times as necessary to get the animations and
timing correct for that slide before moving to the next slide. Continue to choose from animations for entrances, emphasis, exits
and motion paths as various animations are added to slides.

12. If you decide later to get rid of the animations, return to the Animation tab, and select the None option. This will remove the
previously added animation for that selected element.

https://assessments.lumenlearning.co...essments/18734
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Watch this video to get another example of how a PowerPoint can use animation to benefit a presentation.

Practice Questions
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A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=462

As with most things in PowerPoint, a little will go along way with animation. Be aware of the number of animations used in a
presentation. Think from the audience’s perspective when adding animations. Ask yourself if it is a benefit or a distraction in a
slide before settling on an animation. You want the effect to enhance your presentation, not pull attention away from what the
presentation is aiming at communicating.

Contributors and Attributions
CC licensed content, Original

Animations in PowerPoint. Authored by: Sherri Pendleton. Provided by: Lumen Learning. License: CC BY: Attribution

All rights reserved content
PowerPoint: Animating Text and Objects. Authored by: GCFLearnFree.org. Located at: https://youtu.be/kw_udjD2xwo.
License: All Rights Reserved. License Terms: Standard YouTube License

11.10: Animations in PowerPoint is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46602?pdf
https://creativecommons.org/licenses/by/4.0
https://youtu.be/kw_udjD2xwo
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/11%3A_Microsoft_PowerPoint_Advanced_Skills/11.10%3A_Animations_in_PowerPoint
https://creativecommons.org/licenses/by/


11.11.1 https://biz.libretexts.org/@go/page/46603

11.11: Introduction to Charts in PowerPoint

What you’ll learn to do: Use charts in PowerPoint

Charts can have a great impact within a presentation. Let’s learn how to add and modify them in your slide deck.
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11.12: Create Charts

Learning Outcomes
Create a chart

Charts are a great way to visually present data or information in a presentation. While tables may be the best way to communicate
information sometimes, often taking that data and making an understandable chart is even more effective in getting your point
across.

Here is how to use charts in a PowerPoint presentation.

1. Open a new slide in a PowerPoint deck and select a slide containing the area with the different options in it; table, chart,
SmartArt graphics, picture from file or movie from file. Alternatively, choose the Insert tab, Chart button and select a Chart
Option.
1. Alternatively, click on the small chart icon in the content area of the slide 

2. The drop-down menu appears and gives a good variety of charts from which to select for your slide.
3. Pick the slide that works best for the presentation and select it, click OK. 

4. An Excel spreadsheet for the chart will open waiting for your data input to create the chart. Input the chart information or copy
and paste the information from another data source into the small spreadsheet window. 
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5. On the right of the chart are three vertical buttons; chart elements, chart styles, and chart filters. Select the elements to use for
the chart. For example, changing the chart style to be a 3-D titled style. The chart style can also be chanted in the Chart Design
tab, Chart Style group in the ribbon. 

6. If there is a mistake or extra element needing to be deleted from the chart table, from the Chart Design tab, select the Edit
Data button and the spreadsheet window opens. Another way to edit the data is by clicking on the chart, right click with the
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mouse, and a menu opens where Edit Data can also be selected. 

7. There is an extra row in the table to highlight and delete. This cleans up the chart data and eliminates the extra, unlabeled blue
dot on the chart. To change any of the elements in a chart use the Add Chart Element button under the Chart Design tab. The
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legend, data labels, title, lines, trendlines, and up and down bars can all be adjusted. 

8. Like with other Office products, chart formats, shape styles, WordArt styles and colors, object arrangements, and sizes can all
be used to adjust a chart in PowerPoint.

Practice Questions

https://assessments.lumenlearning.co...essments/18736

https://assessments.lumenlearning.co...essments/18737

Charts assist people in gaining a visual perspective of a concept or data that a presenter tries to communicate. PowerPoint supplies
many types of charts to use in presentations and it is to your benefit to learn a few more types. Here is a video walking through a
few of the different types of charts and how to use them in a PowerPoint presentation.
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A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=466
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11.13: Format Charts

Learning Outcomes
Format a chart

Here are formatting options to use on charts in PowerPoint.

1. Open a PowerPoint chart slide and click on the chart. This opens the Chart Design and Format tabs. Make sure the Format
tab is selected for the next steps. 

2. Current Selection: On the far left of the Format tab ribbon is the Current Selection group.
1. The drop-down area indicated what in the chart is currently selected. To select a different area, either click on that area or

select it from the drop-down menu in this group.
2. Format Selection button opens a Format Chart Area (or another menu depending on what is selected in the chart) to the

right of the slide. Options to change the format of the chart are available; changing the fill, border, shadow effects, 3-D
effects, rotation, etc. are available to format a chart. 

3. Reset to Match Style: This option returns the chart elements to their original visual style before customization. If after
working on changing the style of a chart it doesn’t work, (for example, colors clash) this button allows the chart to clear
chart elements and return to their starting place.

3. Insert Shapes: If an additional shape or object needs to be added to a chart this is the group to use. For example, there are call
out shapes where additional notes can be made to highlight specific information about a chart. Select the shape, insert it into the
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slide and move it onto the best position for the slide. 

4. Shape Styles: This group changes a shapes style, fill, outline or effects. For example, if one of the shapes in the pie chart needs
to stand apart and be a different color, select it, use the drop-down menu of Shape Fill and select a new color. 
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5. WordArt Styles: To format the chart title or any of the text in a chart, select the text, WordArt Styles group, then choose the
style, fill, outline or text effects for the text. In this example, the chart title has been formatted with a new color and shadow
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effect. 

6. Accessibility: Used to input a text description of the slide and chart to use those who are visually impaired.
7. Arrange: Multiple charts to be treated as objects and arranged (sent forward or back) with other slide objects. These options are

restricted if only a portion of a chart is selected and not the entire chart.
8. Size: If a chart is selected and the size group arrow clicked, the Format Data Point menu opens to the right. From this menu a

section of a chart can be called out in this pie chart by increasing the Pie Explosion percentage or a chart is rotated by changing
the Angle of first slice option.
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Practice Questions
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11.14: Modify Charts

Modify a chart

PowerPoint provides tools to modify charts in several ways. Most of these options are found in the Change Design tab after
selecting a chart or in the buttons that appear to the right of a selected chart. Some of these same options are also available when
the chart is selected, and the mouse right clicked. We’ll now go over ways to modify an existing chart in PowerPoint.

Chart Buttons
The three vertical buttons to the right of a chart include chart elements, chart styles, and chart filters. The Chart styles button offers
the same modification options as the Chart Styles group in the ribbon and will be described with that group, but the other two offer
unique modification opportunities.

Chart Elements

Here you modify what elements are displayed in a chart. The options are Chart Title, Data Labels and Legend. Uncheck an
element to remove it from the chart or select the arrow that appears to reposition a given element in the chart.

For example, to modify the chart legend position on the slide, click the + button, move the cursor to Legend and click the black
right arrow that appears. Now move the cursor over each option and select the legend modification desired.

Learning Objectives
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Chart Filters

This element allows modifications of chart sections or how it is labeled. Hovering the cursor over each section brings it forward
highlighting which section of the chart is associated with which value. To change the data associated with the chart click the Select
Data on the bottom right of the filter dialog box and the table will be opened for data modifications.

Modification Tools

Chart Design tab offers tools for chart modification: chart layouts, chart styles, data, and change chart type. Here is how to modify
a chart using these tools.

Chart Layouts

This group is like the chart elements button but offers additional options for a chart’s labels, title, and legend. Hover the cursor over
each option to see how it changes a chart and select the best one.
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1. Add Chart Element: Modify the chart layout of labels, title, and legend.
2. Quick Layout: Predetermined chart layouts are available for changing a chart. 

Chart Style

group in the ribbon is where Change Colors or Chart Style can be found to modify a PowerPoint chart. Hover over the various
options and select which one to use. In the chart styles option, be sure to click the down arrow to open a window and see all the
chart style modification options.

Data

Modifying chart information is one of the most important skills to know. Here are the tools to use to modify a chart’s data.

1. Switch Row/Column: This tool is used with a chart plotted on an X and Y axis, but not a pie chart. If chart information needs
to be swapped to modify the chart, select this button otherwise it remains grayed out until the data table is open for
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modification. 

2. Select Data: If there is a mistake or extra element needing to be deleted from the chart table, use this button to open the data
table for a chart. An option to switch rows/columns in the select data source window is also available. Make any changes and
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they are reflected in the chart automatically. 

3. Edit Data: Opens a data table window to use to modify or delete data. A chart is automatically updated once data is edited. The
table can be opened as a regular table or as an Excel table allowing access to the tools in Excel. Another way to edit the data is
by selecting the chart, right click with a mouse, and select Edit Data in the menu. 
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Change Chart Type

After walking through a presentation you may want to change the type of chart on an existing slide, so here is how. Select the chart
and click the Change Chart Type button in the Type group. A window opens with a variety of options from which to select.
Decide on the new chart type, select and click OK. The new type of chart automatically replaces the previous chart.
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Knowing how to change and modify a chart in PowerPoint allows you to update, edit and eliminate elements in order to make
better charts for a presentation. The better you can make charts, the better the presentation information is communication.
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11.15: Introduction to Customized PowerPoint Template

What you’ll learn to do: Modify PowerPoint custom template presentation

PowerPoint templates allow for consistency across multiple presentations. Let’s take a look at how to customize and use templates.
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11.16: Customized PowerPoint Templates

Modify PowerPoint custom template presentation.

As a first step, Cameron first opens the PowerPoint application and creates a new presentation using the company sales campaign
presentation template—RR Sales Campaign. He finds the exact template he wants and selects it by clicking on it.

This is the template for the sales report and the first change Cameron needs to make is to change the title and subtitle.
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Cameron clicks on the title and subtitle areas and changes them. He titles the slide Q3 (for third quarter) Sales Campaign. He
misspelled one of the words, so he right-clicks and selects the correct spelling for promotions.

Now that the first slide’s content is done, Cameron wants to change the presentation theme and customize this report more.

Customize Presentation Template

The first change Cameron makes is to change the theme of the template. He changes the theme by clicking on the Design Tab and
selects the Theme changing the slides to a green color instead of purple.
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New Slide
Next, Cameron adds in a new slide between the first and second slide. First, he places the cursor between the two slides. Next, he
clicks on the Home tab and the New Slide button. This drops down a visual menu of the types of slides to choose from. He selects
the 3 Picture Column slide.

With the new slide open, Cameron now begins to edit the title. He will then click on the image and text boxes to add content.
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Cameron inserts pictures of the three stores.

1. Select Picture Icon. Cameron clicks in a picture box and a file window appears.
2. Select Picture File. He navigates to the folder with the pictures for the presentation and selects one by clicking once.
3. Open/Insert Picture. He then selects the Open button to insert the picture into the presentation slide (he can also double-click

on the picture and it is imported into the slide).

Now with two of the store pictures in place, Cameron needs to grab a photo of the third store from a Word document. These are the
steps he takes to accomplish that action:

1. Open Word. Cameron opens the Word document next to the PowerPoint presentation window.
2. Find Picture. He scrolls through the document and finds the picture he needs and right-clicks on it.
3. Copy Picture. He selects the Copy option in the pop-up menu and now navigates back to the PowerPoint presentation slide (he

can also use the toggle keys Alt+Tab to get back to the PowerPoint window). Cameron could also use the Ctrl+C keys to copy
the picture as well.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46608?pdf


11.16.5 https://biz.libretexts.org/@go/page/46608

1. Select PowerPoint. Cameron is back in the slide presentation and moves his cursor to the last picture box.
2. Select Picture Location. Cameron navigates to the final picture area, then right-clicks on it. A menu appears.
3. Paste Picture. He selects the Paste option and the picture is inserted into the presentation slide. Cameron could also use the

Ctrl+V keys to paste the picture. The image will automatically be sized to fit the image box size.

Now Cameron clicks in the text boxes and types in the appropriate titles and goals for each store.
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11.17: Introduction to Internet and PowerPoint

What you’ll learn to do: Use internet tools to enhance PowerPoint presentations

The internet is an integral part of business, whether you are searching for information, images, competitor’s websites, or
comparative product prices or communicating through video chats, online meetings, or email.

This section will walk through an example scenario and show how you can incorporate information from the internet into your
presentations for work.
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11.18: Internet and PowerPoint

Learning Outcomes
Use internet tools to enhance PowerPoint presentations.

Rowan Retail Store #3 is using PowerPoint to present their campaign plan for the Q3 sales campaign. The campaign for this store
is to use point-of-purchase displays to sell more gift cards for the company. Luke is creating the Q3 Plan PowerPoint presentation.
He has settled on a presentation template and added the title slide.

He has now added a number of slides and is ready to enter text and more.
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Luke selects two images and inserts them in the slide. He decides on the image on the right and selects a slide design with that
image. He also changes the name of the slide.
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Now he searches for and adds more images that show ideas for displaying the gift cards.

Luke opens a browser and searches for gift card display ideas. He finds a link to a webpage and is brought to a Pinterest page. He
likes the ideas and snaps a screenshot by pressing the PrtScn button on his keyboard. This copies the screen and he can now paste
(Ctrl+V) the screenshot into a slide.
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He now wants to add in the hyperlink to the webpage under the screen shot. He clicks on the Text Box button in the Home tab and
creates a text box under the picture. Next, Luke toggles back to the browser window (Alt+Tab), selects the website address, and
copies it with Ctrl+C.

Practice Question
https://assessments.lumenlearning.co...essments/18744

He pastes the hyperlinked address in the text box. He will now continue to add in text, tables, and charts associated with his point-
of-purchase plan.

Practice Question
https://assessments.lumenlearning.co...essments/18745
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11.19: Putting It Together- Microsoft PowerPoint Advanced Skills
Now that you’ve learned more about Microsoft PowerPoint, you’re prepared to create professional presentations.

As with Word and Excel, there’s more that Microsoft PowerPoint can do. If you find yourself curious, Microsoft’s website is a
good place to check, or you can run a web search for how to use a particular feature.

11.19: Putting It Together- Microsoft PowerPoint Advanced Skills is shared under a CC BY license and was authored, remixed, and/or curated by
LibreTexts.
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11.20: Assignment- Modify Existing PowerPoint Presentations
Sometimes when there are monthly presentations within a group, organization or business, instead of creating a new presentation
you simply modify an existing one to make it fresh and relevant now. In this assignment, you will work with an existing
presentation and modify it to meet a different objective from its original use, like the next quarter sales department meeting.

To complete this assignment, download the PowerPoint presentation here. Follow the directions, then submit your assignment. If
you get stuck on a step, review this module and ask your classmates for help in the discussion forum.

1. Open the presentation and save the new Module 11 assignment file to the Rowan folder on your desktop as
BA132_LastName_QuarterSales.ppxt, replacing “LastName” with your own last name. (Example: BA132_Hywater_Memo)
It is a good idea to save your work periodically.

2. Open the existing sales PowerPoint presentation from the Southwest region office. 

3. New Design: Choose a new style for this presentation and select it. The entire set of slides should change to this new design
style. 
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4. Modify Color Theme: Select a different color theme for the presentation. Keep in mind this is for a professional setting. Keep
the colors in the range where reading a slide is easy for the audience. 

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46612?pdf


11.20.3 https://biz.libretexts.org/@go/page/46612

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46612?pdf


11.20.4 https://biz.libretexts.org/@go/page/46612

5. Modify Title Slide: Select the ‘Design Idea’ button and choose a design that incorporates a place for a picture. 

6. Add Internet Picture: Modify the picture by searching the internet for a picture of a meeting and insert it into the slide. Select
the best design to highlight the picture. 
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7. Modify Text: Change the title and subtitle to read ‘Northwest Region, Quarter 2 Sales’ and move to the next slide. 

8. Update Team: Change the team members to all new names and modify the bullet-point list to highlight other things about the
team. 
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9. Modify Chart Data: On the next slide, update the states and chart table data to reflect the Northeast regional sales. Move the
text boxes and resize the chart to fit better on the slide with the additional states.
1. Northeast Region information for the chart table for Q2 Sales: 

State Product A Product B

Connecticut 4.3 2.4

Maine 2.5 4.4

Massachusetts 3.5 1.8

New Hampshire 4.5 2.8

Rhode Island 3.2 1.2

Vermont 2.2 3.1
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10. Delete Slide: Delete the next slide about Santa Fe, New Mexico.
11. New Slide: Add a new slide with the Title and Content layout.

1. Download this image to your computer. Then, insert a picture from a file and put in the background.
2. Add a table, resize to fit, make font large enough size to easily read, change the table and font color to something that

matches with the picture background. 

Product April May June

Soda 1500 2000 2350

Chips 625 954 1025

Gum 2654 1546 1751

Candy 465 498 321
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12. Delete Slides: Delete the last two slides.
13. New Slide with Video: Add a new slide with the ‘Title and Content’ layout. Type in the title ‘Redesigning Store Ideas’ and

insert the YouTube video https://youtu.be/O2vtw6TAbQ4. 
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14. Animations: Lastly, add in a variety of animations to a few slides in the presentation and save your work again.
15. Run Presentation: Run through the Slide Show to adjust any animations or other things.
16. Submit the presentation file in your course online.
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11.21: Discussion- Ten Extra Tips for PowerPoint
You have learned many powerful tools about PowerPoint in this course. Here are ten more ways to create a presentation and a few
quick tips that will help speed up and round out your presentation skills.

Watch this video and learn more PowerPoint skills. After watching the video consider a few questions to discuss.

A link to an interactive elements can be found at the bottom of this page.

You can view the transcript for “10 Powerful PowerPoint Tips” here (opens in new window).

Discussion Questions
Of these extra tips, which one would you use right away for your presentations and why?
Have you already used one or more of these tips? How did it enhance your presentation?
Were there any tips you wouldn’t use?

Share your opinions below and respond to two of your classmates’ thoughts.
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12.1: Why It Matters- Microsoft Access Basic Skills

Why learn to perform basic tasks in Microsoft Access?

In the prior two modules, we learned about the benefits of using Excel to manage spreadsheets. When it comes to quick data entry
by users, manipulating numerical data for fast analysis, having rich formatting features and mathematical functions, spreadsheets
are hard to beat. As the volume of data increases, databases become a viable option. Databases are geared for long-term data
storage of large data sets, maintaining multiple relationships between data values, and the ability to update forms, queries, and
reports automatically when values are updated.

Think of spreadsheets as ledgers: you have a list of customers and may wish to know who are your top five most important based
on annual revenue. Think of databases as intelligent file cabinets: you may wish to know who are your top five most important
customers, what was the date of their last purchase, and what products did they purchase. It is this ability to handle the relationships
within the data, in addition to the amount of data, that makes databases a powerful business tool.
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12.2: Introduction to Creating Database Tables

What you’ll learn to do: create database tables

The building blocks of relational databases are the tables that organize and store information within the database. In this section,
you will learn how to create a blank database, assign a name to it, and specify a location. Next, we will explore the different types
of tables based on the purpose they serve. Finally, we will create a database table using the appropriate commands in Access.
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12.3: Creating a Database

Create a blank database

You can open Access from the Start menu (or the Applications folder on a Mac) by clicking on the Access icon. The Access icon
comes in a variety of forms depending on your OS and version of Access, but it always features the color red or maroon and the
letter A.

 

New Database
There are two easy ways to create a blank database in Access. One way is to click the Blank Database option in the welcome
screen (Figure 1).

Figure 1.

The second way to create a new database is to use the File New option from the menu bar (Figure 2).
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1. On the File tab, click New, and then click Blank Database.
2. Type a file name in the File Namebox. To change the location of the file from the default, click Browse for a location to put

your database  (next to the File Name box), browse to the new location, and then click OK.
3. Click Create.

Access creates the database with an empty table named Table1, and then opens Table1 in Datasheet view. The cursor is placed in
the first empty cell in the Click to Add column.

4. Begin typing to add data, or you can paste data from another source, as described in the section.

Entering data in Datasheet view is designed to be very similar to working in an Excel worksheet. The table structure is created
while you enter data. When you add a new column to the datasheet, a new field is defined in the table. Access automatically sets
each field’s data type, based on the data that you enter.
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12.4: Naming Databases

Name the database and location
Discuss the role of tables in access
Differentiate among types of tables

Enter the name of your database in the “File Name” field. The database location can be changed by selecting the box to the right of
the “File Name” field and browsing to the location of your choice.

https://assessments.lumenlearning.co...essments/18747

Understanding Tables
Tables are one of the key objects in Access. Access uses tables to store data. To store data, you create one table for each type of
information that you track. Types of information might include customer information, products, or order details.

The example below is taken from the Microsoft Access “Northwind Traders” sample database. It is a table containing a list of
orders for the fictitious company with reference to Order Number, Order Date, Order Status, etc.

Types of Tables

There are three types of tables in Access: an object table, a transaction table, and a join table. Object tables contain data relating to
a real-world object, like a company or a customer or a product. Transaction tables store information pertaining to events, like when
an order is placed for a product or an invoice is sent to a customer. Finally, join tables are used to establish a relationship between
two tables, like a product table and a customer table.

We will focus on object tables in this section.

Learning Objectives

PRactice Question

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46617?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/12%3A_Microsoft_Access_Basic_Skills/12.04%3A_Naming_Databases
https://assessments.lumenlearning.com/assessments/18747


12.4.2 https://biz.libretexts.org/@go/page/46617

https://assessments.lumenlearning.co...essments/18748

https://assessments.lumenlearning.co...essments/18749

Contributors and Attributions
CC licensed content, Original

Naming Databases. Authored by: Robert Danielson. Provided by: Lumen Learning. License: CC BY: Attribution

12.4: Naming Databases is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

Practice Questions

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46617?pdf
https://assessments.lumenlearning.com/assessments/18748
https://assessments.lumenlearning.com/assessments/18749
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/12%3A_Microsoft_Access_Basic_Skills/12.04%3A_Naming_Databases
https://creativecommons.org/licenses/by/


12.5.1 https://biz.libretexts.org/@go/page/46618

12.5: Creating an Access Table

Learning Outcomes
Create a new table

You can add new tables to an existing database by using the commands in the Tables group on the Create tab. Access will
automatically create a new table with a table structure built in. Access will also set the field types based on the data entered. The
new table will be automatically displayed in Datasheet view, allowing you to take immediate action, i.e., enter change field names,
set properties, and enter data directly in to the table.

An alternate way to create a new table is to select Table Design in the Tables group. Access will create a new table and display it in
Design View. This approach provides a more traditional albeit manual method of setting the details of the table.

Learn More

For detailed, step-by-step instructions Microsoft Access Help is an excellent resource and can be found by following this link:
Creating Tables Access Help

PRactice Question
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12.6: Introduction to Fields in Access

What you’ll learn to do: Work with fields

If tables are the building blocks of databases, fields are the key component of tables. We will explore field properties which tells
Access what type of data will be entered into a specific field. Then we will discuss the importance of assigning names to each field
and the rules for ensuring a valid field name. Finally we will get into more detail regarding data types and field properties.

12.6: Introduction to Fields in Access is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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12.7: Field Properties

Learning Outcomes
Differentiate among field properties

Regardless of how you created your table, it is a good idea to examine and set field properties. While some properties are available
in Datasheet view, some properties can only be set in Design view. To switch to Design view, right-click the table in the Navigation
Pane and then click Design View. To see a field’s properties, click the field in the design grid. The properties are displayed below
the design grid, under Field Properties.

To see a description of each field property, click the property and read the description in the box next to the property list under
Field Properties. You can get more detailed information by clicking the Help button.

Field Properties sets boundaries on what/how data is entered into table fields. There are five types of field properties:

Field Size: sets the maximum number of characters that can be entered into a text field.
Format: sets how the data is to be displayed in the table field.
Input Mask: sets the rules as to how data can be entered so that data is entered correctly.
Default Value: sets the default value that will appear in the table field each time a new record is entered.
Required: sets whether a value is required to be entered into this table field.

Learn More
For more detailed information, Microsoft Access Help is an excellent resource and can be found by following this link: Field
Properties Access Help

Practice Questions
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12.8: Field Names and Data Types

Discuss field name requirements
Discuss types of data used in Microsoft Access

Field Names
A field name should be descriptive enough to identify the purpose of the field, without being overly long to prevent excessive
typing. Enter the field name by placing the pointer in the first row of the Table Design window under the Field Name column. In
order to ensure a valid field name, a field name:

Cannot exceed 64 characters,
Cannot include periods (.), exclamation points (!), accent grave (`), or brackets ([]),
Cannot include spaces,
Cannot include low-order ASCII characters,
Cannot start with a blank space.

https://assessments.lumenlearning.co...essments/18753

Data Types
The data type must be consistent with the data to be stored in the field. The “text” type is the most commonly used data type,
including numbers that will not be added like social security or street address numbers. Here is a partial list of Access data types:

Data Type Description

Short text Alphanumeric characters

Long text Alphanumeric characters

Number Numeric values

Large Number Numeric values

Date/Time Date and time data

Currency Monetary data

AutoNumber Automatic number increments

Yes/No Logical values: Yes/No, True/False, etc.

OLE Objects Pictures, graphs, sound, video

Hyperlink Line to an Internet resource

Attachment External files

Calculated Stores calculations based on other fields

Lookup Wizard Displays data from another table

https://assessments.lumenlearning.co...essments/18754
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12.9: Introduction to Table Primary Key

What you’ll learn to do: Set the table primary key

The primary key is crucial to the operation of a relational database—without it, the database would not be able to perform
operations on the data contained in the table. We will explore the uniqueness of the primary key, how to choose a strong primary
key, and how to set the primary key for a table.

12.9: Introduction to Table Primary Key is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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12.10: Primary Key

Discuss the importance of primary key uniqueness
Choose a primary key

Every table must have a primary key—a field with a unique value for each record. Otherwise there would be no way to distinguish
between records. A primary key consists of one or more fields that uniquely identify each record that you store in the table. Often,
there is a unique identification number, such as an ID number, a serial number, or a code, that serves as a primary key.

For example, you might have a Customers table where each customer has a unique customer ID number. The customer ID field is
the primary key of the Customers table. When a primary key contains more than one field, it is usually composed of pre-existing
fields that, taken together, provide unique values. For example, you might use a combination of last name, first name, and birth date
as the primary key for a table about people.

Choosing a Primary Key

Without the ProductID field, another field would be needed to uniquely identify each product in the database. Without a strong
primary key, the database engine would be at a loss to perform basic operations on the table properly.

Good primary keys must:

Uniquely identify each record,
Not be null,
Exist when the record is created,
Must remain stable,
Be simple and contain as few attributes as possible.
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12.11: Set a Primary Key

Learning Outcomes
Set the primary key

A primary key can be set for a table in one of three ways. Open a table in Design view and:

With the field to be used as the primary key selected, click the Primary Key button key in the Tools group.
Right-click the appropriate field and choose Primary Key from the shortcut menu.
Allow Access to automatically create the primary key by simply saving the table.

In this example, Field One was highlighted and Primary Key was selected in the Menu bar to designate it as the Primary Key.

Practice Question
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12.12: Introduction to Indexes

What you’ll learn to do: Create indexes

Indexes are another key concept in relational database technology. We will explore how indexes relate to the operation and
performance of databases. Then, we will learn that indexes have properties too, and they can help handle some inconvenient
situations. Finally, we will have a discussion of the advantages of indexing versus the disadvantages in certain cases.

12.12: Introduction to Indexes is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.
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12.13: What is an Index?

Define indexes
Set the properties of indexes

Imagine that you collect business cards in order to keep track of your professional contacts. Over time your collection of cards
becomes quite large. You want to know which of your contacts work for Company Z, so you must read each and every card in
order to develop your list. This could take quite a bit of time. But what if you had dog-eared the cards from Company Z
beforehand? Would that have reduced the time it took you to find that select group of contacts?

Indexing a table enables Access to establish a sort order on the data in the indexed field. Without an index, Access would have to
search each and every field—much in the same way you would have to look through each and every business card.

https://assessments.lumenlearning.co...essments/18758

Index Properties

Indexes in Access have properties too.

Primary. This property, when set to Yes, tells Access to use it as the table’s primary key.
Unique. This property requires that the index is unique within the table.
Ignore Nulls. If the index field of a record contains a null value, Access does not know how to handle the record. This property
tells Access to ignore such records.
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12.14: To Index or Not to Index?

Learning Outcomes
Determine when to use an index

Despite the stated advantages of indexing, there are some drawbacks as well. Indexes add metadata to the database, which increases
its size and disk space requirements. In addition, when a new record is added to an indexed table, there is a slight performance hit
—for 20 indexes on a table, Access will make 20 adjustments when a new record is added or subtracted. So, you will want to avoid
indexing on smaller tables or tables that are not frequently involved in queries.

Practice Question
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12.15: Putting It Together- Microsoft Access Basic Skills
Learning about Microsoft Access teaches us much about relational databases in general. Databases are made up of tables
containing information organized into columns and rows. The rows are records and the columns are fields that have specific
formats. Information is divided into multiple tables based on category—for example, a table for Customers, one for Orders, one for
Products, etc. These tables are linked through the use of primary keys.

In this section we have learned how to use Access to create a database. Some of the important basics covered are: naming the
database and designating its location; creating a new table; working with table fields; understanding data types; understanding field
properties; setting table primary keys; and, understanding and creating indexes.

12.15: Putting It Together- Microsoft Access Basic Skills is shared under a CC BY license and was authored, remixed, and/or curated by
LibreTexts.
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12.16: Assignment- Create New Access Database
In this assignment, you’ll create a new database and set it up for data to be entered. This year you decided to keep new business
cards (physical and electronic) you receive organized with by creating an Access database to store all their information for quick
access.

To complete this assignment, follow the directions then submit your assignment. If you get stuck on a step, review this module and
ask your classmates for help in the discussion forum.

1. Open Microsoft Access to the Home page 
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2. Chose New Database: Choose from one of the ways to create a new database and select the New database option. 

3. Name Database: Decide on a file name for the new database and its location on your computer where you’ll save it. Remember
this is to be created for collecting business card information so name accordingly. Save the new Module 12 assignment file to
the Rowan folder on your desktop as BA132_LastName_BCDatabase.accdb, replacing “LastName” with your own last name.
(Example: BA132_Hywater_Memo) It is a good idea to save your work periodically. 
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4. Create Database: A new data table is now open and ready for data input. 

5. Open Design View: Open the design view of the current table and name the table 2020_BusinessCards. 

6. Set the Primary Key: In the ‘Field Name’ with the little key to the left side create a primary key name to use for this table.
(Refer to the module about the various options of creating a key.) Make sure to keep the Data Type to AutoNumber and add in a
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https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46629?pdf


12.16.4 https://biz.libretexts.org/@go/page/46629

text description. 

7. Indexed: In the new table with the new key make sure the filed for Indexed is set to Yes (No Duplicates). 

8. Save File: Save all of your work again.
9. Submit the database file in your course online.
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12.17: Discussion- Selecting Primary Key Tips
There are many ways to make a primary key or have one automatically generated in Microsoft Access. For additional information
about selecting or creating a primary key watch this video which walks through a few examples and discusses various ways to
create a custom key for your Access table.

After watching the video ask yourself a few questions and discuss your answers to them.

A link to an interactive elements can be found at the bottom of this page.

You can view the transcript for “How to Select and Make PRIMARY KEYS in Microsoft Access” here (opens in new window).

Discussion Questions
Why is it important to choose a memorable primary key?
Is adding a description important for a primary key? Why or why not?
In what types of scenarios would you use this information?

Share your opinions below and respond to two of your classmates’ thoughts.
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13.1: Why It Matters- Microsoft Access Intermediate Skills

Why learn intermediate Microsoft Access skills?

In this section, we discuss additional database principles of both MS Access and relational database technology in general. In
addition, we see how these can be applied to create database applications for commercial use.

One of the most important relational database concepts we will discuss is the difference between data organized in “flat files” and
data that is “normalized.” Also important, we will explore the relationships between tables. Moving to Access specifically, we will
learn about datasheets and how to view and manipulate data.
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13.2: Introduction to Table Relationships

What you’ll learn to do: Discuss table relationships

To understand table relationships it is important to have an understanding of some basic database principles. We will explore the
underlying properties of relational databases, how they are organized, and how they add value to commercial enterprises. Then we
will discuss the important concept of normalized data versus flat file data organization, which is crucial to understand what makes a
relational database work. Finally we will learn about the three types of relationships between tables in relational databases like
Access.
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13.3: Database Principles

Learning Outcomes
Discuss database principles

A database is a shared collection of related data used to support the activities of a particular organization. A database can be viewed
as a repository of data that is defined once and then accessed by various users.

A database has the following properties:

It is a representation of some aspect of the real world or a collection of data elements (facts) representing real-world
information.
A database is logical, coherent and internally consistent.
A database is designed, built and populated with data for a specific purpose.
Each data item is stored in a field.
A combination of fields makes up a table. For example, each field in an employee table contains data about an individual
employee. A database can contain many tables. For example, a membership system may contain an address table and an
individual member table.

Managing information means taking care of it so that it works for us and is useful for the tasks we perform. By using a DBMS, the
information we collect and add to its database is no longer subject to accidental disorganization. It becomes more accessible and
integrated with the rest of our work.

Managing information using a database allows us to become strategic users of the data we have. We often need to access and re-
sort data for various uses. These may include:

Creating mailing lists
Writing management reports
Generating lists of selected news stories
Identifying various client needs.

The processing power of a database allows it to manipulate the data it houses, so it can:

Sort
Match
Link
Aggregate
Skip fields
Calculate
Arrange

Because of the versatility of databases, we find them powering all sorts of projects. A database can be linked to:

A website that is capturing registered users
A client-tracking application for social service organizations
A medical record system for a health care facility
Your personal address book in your email client
A collection of word-processed documents
A system that issues airline reservations

There are a number of characteristics that distinguish the database approach from the file-based system or approach. A database
system is referred to as self-describing because it not only contains the database itself, but also metadata which defines and
describes the data and relationships between tables in the database. This information is used by the DBMS software or database
users if needed. This separation of data and information about the data makes a database system totally different from the
traditional file-based system in which the data definition is part of the application programs.

In the file-based system, the structure of the data files is defined in the application programs so if a user wants to change the
structure of a file, all the programs that access that file might need to be changed as well. On the other hand, in the database
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approach, the data structure is stored in the system catalogue and not in the programs. Therefore, one change is all that is needed to
change the structure of a file. This insulation between the programs and data is also called program-data independence.

A database supports multiple views of data. A view is a subset of the database, which is defined and dedicated for particular users
of the system. Multiple users in the system might have different views of the system. Each view might contain only the data of
interest to a user or group of users. By its very nature, a DBMS permits many users to have access to its database either
individually or simultaneously. It is not important for users to be aware of how and where the data they access is stored.

Current database systems are designed for multiple users. That is, they allow many users to access the same database at the same
time. This access is achieved through features called concurrency control strategies. These strategies ensure that the data accessed
are always correct and that data integrity is maintained. The design of modern multiuser database systems is a great improvement
from those in the past which restricted usage to one person at a time. Control of data redundancy In the database approach, ideally,
each data item is stored in only one place in the database. In some cases, data redundancy still exists to improve system
performance, but such redundancy is controlled by application programming and kept to minimum by introducing as little
redundancy as possible when designing the database.

The integration of all the data, for an organization, within a database system has many advantages. First, it allows for data sharing
among employees and others who have access to the system. Second, it gives users the ability to generate more information from a
given amount of data than would be possible without the integration. Enforcement of integrity constraints Database management
systems must provide the ability to define and enforce certain constraints to ensure that users enter valid information and maintain
data integrity. A database constraint is a restriction or rule that dictates what can be entered or edited in a table such as a postal code
using a certain format or adding a valid city in the City field. There are many types of database constraints. Data type, for example,
determines the sort of data permitted in a field, for example numbers only. Data uniqueness such as the primary key ensures that no
duplicates are entered. Constraints can be simple (field based) or complex (programming).

Not all users of a database system will have the same accessing privileges. For example, one user might have read-only access (i.e.,
the ability to read a file but not make changes), while another might have read and write privileges, which is the ability to both read
and modify a file. For this reason, a database management system should provide a security subsystem to create and control
different types of user accounts and restrict unauthorized access.

Another advantage of a database management system is how it allows for data independence. In other words, the system data
descriptions or data describing data (metadata) are separated from the application programs. This is possible because changes to the
data structure are handled by the database management system and are not embedded in the program itself.

A database management system must include concurrency control subsystems. This feature ensures that data remains consistent
and valid during transaction processing even if several users update the same information.

Practice Question
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13.4: Flat File vs Normalized Data

Learning Outcomes
Differentiate between a flat file and a normalized data

In database terminology, the terms “flat file” and “normalized” data refer to how data is stored electronically. A flat file
arrangement refers to how data is stored in a spreadsheet—a two-dimensional structure using rows and columns. A normalized
scheme brings database capability, adding the use of another table(s) to store related data.

The difference between flat file and normalized schemes go back to the introduction of this discussion. Flat files (spreadsheets) are
great for quick data entry by users, manipulating numerical data for fast analysis, having rich formatting features and mathematical
functions for small to moderate data sets. When large quantities of data needs to be shared with multiple users using multiple
views, be independent from the application, and protected from unauthorized users, we see the need for normalized data provided
by database technology.

PRactice Question
https://assessments.lumenlearning.co...essments/18762

There is much more to normalization in database science. There are strict guidelines regarding normalization and how tables need
to be constructed in databases, i.e., first normal form, second normal form, third normal form, etc. These principles are essential to
building error-free database designs and will be discussed in a later session.
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13.5: Types of Table Relationships

Define one-to-one relationships
Define one-to-many relationships
Define many-to-many relationships

There are three types of relationships in Access between tables:

One-to-one
One-to-many
Many-to-many

One-to-One Relationships
A one-to-one relationship means that a record in the first table can have one and only one record related to it in a second table. For
example, a product listed in a products table would have only one country of origin record in a operations table.

https://assessments.lumenlearning.co...essments/18763

One-to-Many Relationships
One of the most common relationships between tables is the one-to-many relationship. In a one-to-many relationship, a record in
the first table is related to multiple records in the second table. For example, an employee table could have relationships with a
payroll table that contains multiple records of paychecks.

https://assessments.lumenlearning.co...essments/18764
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Many-to-Many Relationships
Many-to-many relationships are defined as a record in the first table having multiple relationships in the second table and those
records in the second table also having multiple relationships within the first table. For example, a streaming service would have
TV series that are selected to view by multiple customers while each customer of the service would watch multiple TV series.
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13.6: Introduction to Working with Tables

What you’ll learn to do: Work with tables

Access makes it easy to work with tables using an object called a datasheet. We will learn about datasheets and how to view
information, enter data, and change values already entered.
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13.7: Datasheets

Define datasheets
Discuss datasheet windows within Microsoft Access

A datasheet is a useful way of viewing data in Access. Most importantly, datasheet view allows a user to view many table records
at the same time. In datasheet view, information is displayed in rows and columns—similar to a spreadsheet. Records are displayed
as rows, so each row is an individual record. Within each row, columns represent fields within the record.

https://assessments.lumenlearning.co...essments/18766

Datasheet Windows

At the top of the datasheet window are the title bar, the Quick Access toolbar, and the Ribbon. The bottom of the window has a
status bar and on the right side of the window a scroll bar as you would expect.

Many of the features that are common to spreadsheets are present in Access datasheet windows. A user can modify row height,
column width, font size to change the amount of data that fits without scrolling. A user can also change the order of the rows or
columns displayed in the window.

Datasheet views are a common display tool for tables, queries, and forms in Access. There are some irregularities in the
functionality of the datasheet windows for these depending on the underlying data sources.
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13.8: Entering Data

Learning Outcomes
Enter data in datasheets

An empty datasheet will have an asterisk (*) in the first row indicating data can be entered as a new record. When the datasheet is
already populated, the New row will appear at the bottom of the datasheet. There are three ways to prepare the datasheet for new
record entry:

1. Click the “New” command in the Record group of the ribbon
2. Move the cursor to the New row by clicking “New Record” at the bottom of the datasheet
3. Click the last row containing the asterisk.

Practice Question
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13.9: Changing Values

Learning Outcomes
Change values in datasheets

Changing values in datasheets is very straightforward. In this example, the phone number of Supplier 11 is being changed. The
pencil icon appears to the far left of the record being edited.

There is an “Undo” in the toolbar that will roll back changes made to a record. However, after a second record is modified, Access
will not allow changes to be undone to the prior saved record.

PRactice Question
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13.10: Introduction to Working with Datasheets

What you’ll learn to do: Work with datasheets

In this section we will go into more detail regarding the functionality of datasheets in Access. We will learn how adding and
deleting table records is easily accomplished in datasheet mode. We will also begin to see how the functionality of Access is similar
to that of other Office applications which reduces the learning curve of using the application.
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13.11: Adding Values and Records in Datasheets

Add values in datasheets
Add records in datasheets

Adding Values in Datasheets
Adding and replacing values in Access is very straightforward.

In this example, a new record is being added to the Supplier table. The asterisk and “New” designation are automatically moved
down one row as soon as a value has begun to be entered. The “pencil” icon appears in the far left field to indicate that data is being
entered in to that record.

In this example, the value entered of job title in the Supplier table is being modified. Clicking on the field causes the “pencil” icon
to appear and the prior entry can be deleted and the new data entered and saved.

https://assessments.lumenlearning.co...essments/18770

Adding Records in Datasheets

As we see in the above example, adding new data into an empty field is as simple as positioning your cursor in the field and
beginning typing. Adding data into a field already containing data is not much more difficult. If using the keyboard, tabbing to the
field will highlight the entire field and the prior data will be replaced upon entering the first character of new data. If using the
mouse, clicking on the field will place the cursor where the prior data can be deleted one character at a time or left-click and hold
down the mouse to highlight the original data so it can be replaced.
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13.12: Deleting Records in Datasheets

Learning Outcomes
Delete records in datasheets

Deleting a record is as easy as selecting the far left field of the row and selecting “Delete.” Deleting multiple contiguous records is
also simple: start by selecting the first record in the list and hold down the “Shift” key while you click on the last record in the
group to highlight multiple records, then hit “Delete.”

Here is an example of a multi-record selection.

If the records to be deleted are connected to other tables and records through a parent/child relationship, etc. then Access will
prevent the deletion with the following error message.

Practice Question
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13.13: Introduction to Sorting and Filtering Data

What you’ll learn to do: Sort and filter data

We will continue to exploit datasheet mode to learn techniques to view—and change the view—of information in Access. You will
learn how to change the order of columns displayed in a datasheet for ease of analysis. Also, Access provides multiple methods for
sorting and filtering data, as well as aggregating data for better analysis.
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13.14: Displaying Records in Datasheets

Learning Outcomes
Display records in datasheets

There are many ways to display data—and change the way data is displayed—in Access to be more productive. Among these are
changing the order in which columns are displayed.

Here is a database table displaying a list of purchase order records.

To better visualize the information, we may wish to see the submitter adjacent to the record number. To move a column, first
highlight it by selecting the column heading.

Then, left-click on the column header until you see a black line appear along the left side of the column indicating that it is ready to
be moved. Then drag column to the desired location in the table view.

Another display function of Access is the ability to change font size, row (record) height, and column (field) width.
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The easiest way to make basic changes to font size, color, positioning, etc. is to highlight the record to be changed and use the tool
bar in the example above. Adjusting row height or column width involves a bit more. In the example below, the Job Title field is
slightly too small for one of the titles.

To accommodate the longer title in that field, right-click the column header to open the dialog box in the example below.

Select “Field Width” and set the value to the desired width to accommodate the longer title as shown in the example below.

Practice Question
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13.15: Sorting Data

Learning Outcomes
Sort and filter records

There are multiple ways to sort data in Access. The first option is to use the toolbar shown in the example below. The tools function
as you would expect from any MS Office tool bar.

Another way to quickly sort data in a table is to use the sorting capability built-in to the column headers, as shown in the example
below. Clicking on the arrow in each header will sort the records in ascending or descending order (alternating).

Filtering your view of the data set can be accomplished in several ways. Perhaps the quickest is to right-click on the value you wish
to filter by to open the dialog in the example below.

In this case, if we wish to filter by the value “Closed” and can choose one of four filtering elements: “Equals,” “Does Not Equal,”
Contains,” or “Does Not Contain.”

PRactice Question
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13.16: Aggregating Data

Learning Outcomes
Aggregate data

To aggregate data in Access, start by selecting the “Totals” button in the tool bar to create a “Total” row at the bottom of the
datasheet table view.

Then move the cursor to the field you wish to aggregate and right-click to expose the options.

From this approach, Access offers a Sum, Average, Count, Maximum, Minimum, Standard Deviation, and Variance aggregation
option.

PRactice Question
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13.17: Printing Records

Learning Outcomes
Preview and print records

Previewing and printing objects in Access follows the same paradigm as most Office applications. Selecting “File” – “Print” opens
a dialog box as shown in the example below.

“Quick Print” sends the print request directly to the printer without any other options presented. “Print Preview” displays the print
as it will be rendered and printed. “Print” offers all of the usual options from the Office suite such as: Print Range, Copies, Collate,
Printer, Properties, Margins, etc.

PRactice Question
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13.18: Putting It Together- Microsoft Access Intermediate Skills
In this section we spent a great deal of time learning how to work with Access datasheets: adding and deleting data, displaying
data, sorting and filtering data, aggregating data, and previewing and printing records. This is important as an MS Access user will
spend a good deal of time taking advantage of the ease-of-use of this view to get work done.

More broadly, we dove in to some important database principles and how database technology can be applied to create useful
commercial applications. The fact that multiple users can consume information—even utilize different views at the same time—
from a database application is of tremendous value. Database applications as simple as generating mailing lists to as complex as
airline reservations rely on the database principles we discussed.
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13.19: Assignment- Modify Access Database
In the previous module’s assignment, you created the beginning of a database. In this assignment you’ll work with an existing
database with business card information and use the skills you have learned in this module.

To complete this assignment, download the Access file here. Follow the directions, then submit your assignment. If you get stuck
on a step, review this module and ask your classmates for help in the discussion forum.

1. Open the database and save the new Module 13 assignment file to the Rowan folder on your desktop as
BA132_LastName_BusinessCardDB.accdb, replacing “LastName” with your own last name. (Example:
BA132_Hywater_Memo) It is a good idea to save your work periodically.

2. In the open Access database file open the 2020_BusinessCards table. The contact table entrees are now visible and can be
modified. 

3. Add Information: There are database cells missing data. Use the information in the table to fill in the missing information in
the right places. 

Contact ID FirstName LastName CompanyName Phone Website Email

3 Cardaso.com

6 8015556987
Footagesaces.inf
o

k.bush@footage.
com

7
Martin.l@marke
tp.co

10 Jenna
jennak@globalre
dial.com

13 2025557895 Peoplesocial.net
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Contact ID FirstName LastName CompanyName Phone Website Email

15
cyyoung@credit
booth.nz

17 Hamilton Jefferson
hammyjeff@swi
pesure.org

18 CarpetEZ Carpetez.com

20 Cheesezy Cheesezy.info

4. Edit Information: There is a misspelling in one of the contacts. Emile Zola should be spelled Emily Zola. Correct her name in
the database. 
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5. Delete Contact Info: One of the contacts is no longer at the company and needs to be removed from the database. Locate Joe
Jones and delete the record. 
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6. Add New Contact: Enter a new contact with the following information into the existing table.
1. Heath Karrick, Spry Life, LLC, 2025551423, sprylife.com, heathkck@sprylife.com 
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7. Filter: Sort the contact table by last name A–Z. 

8. Save: Save the file.
9. Submit the presentation file in your course online.
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13.20: Discussion- Moving Columns and Fields
A link to an interactive elements can be found at the bottom of this page. 
You can view the transcript for “Access 2016 Field Order and Size” here (opens in new window).

Discussion Questions
If there are a few different ways to rearrange fields, which way do you prefer and why?
What are some common mistakes made to move fields or records in an Access table?
What do you consider the best view (Design View, Datasheet View) for rearranging fields? Why?

Share your opinions below and respond to two of your classmates’ thoughts.
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14.1: Why It Matters- Microsoft Access Advanced Skills

Why learn advanced Microsoft Access skills?

How does database technology matter today? For one thing, there would be no eCommerce without underlying database
technology to support it. What about healthcare? How would we keep track of patients, appointments, and treatment history
without the use of database applications? Then you have online television streaming. Streaming services need database applications
to generate a list of shows to watch and track individuals’ viewing history. Very powerful database applications are needed to not
only track viewing but to analyze and recommend new viewing for each and every individual customer.

In this final section, we will get into some of the advanced capabilities of MS Access. Dealing with external data—data outside of
the current Access database—is a real-world situation that needs to be covered here. The concept of queries—how we interact with
databases to leverage the information stored within—is another important topic to be addressed in this section. Finally, forms and
reports are key to how we get data in and out of databases.
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14.2: Introduction to Importing and Exporting Data

What you’ll learn to do: Importing and exporting data

“Data, data everywhere!” With the mountain of data available today, the trick is how to leverage it for your business. Access has
multiple tools and methods to support importing and exporting data into your database. We will review the all of the options Access
provides to aid in the import of data. Also, we will cover how easy it is to export data from Access in a variety of formats.
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14.3: External Data

Learning Outcomes
Discuss the value of external data

Not all information necessary for business purposes may be stored in the same place. Even if the data resides in locations within the
firewalls of the business, it may be in different applications or formats. In the example below from an Oracle administrator’s
manual, data stored in different, distributed repositories can be a good thing, but there are many variables to consider.

This is an ideal example of a well-architected database system where users are getting maximum value from three separate systems
that seamlessly working together as one. In most cases, external data—or data not residing in the current database—is much
trickier to utilize. External data is usually stored in differing applications in differing formats. Access can use data in the following
formats: Oracle, SQL Server and other ODBC compliant databases, Excel, XML, HTML, Word documents and text files.

Practice Question
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14.4: Import and Export Options

Differentiate among import and export options
Import external data
Export data

Access provides several options that support exchanging data with external sources.

Linking. Using this option entails creating a permanent connection to the external source. The data stays in the source location.
The location cannot be moved without modifying the link or else Access will not be able to find it.
Importing. This method physically moves data from the outside source into the current Access database. The data is then
converted to an Access data type, stored in an Access table, and remains in Access from that point on.
Exporting. Exporting copies data from an Access table into either a text file or some other format that is readable by the
destination application.

https://assessments.lumenlearning.co...essments/18778

Importing External Data

Remember that importing external data makes a copy of the data within Access and does not affect the data in the external source.
After the import, no connection remains between the current database and the external source.

One of the keys to a viable business system is the ease in which it can work with other applications and data sources. In this regard,
Access is unmatched.

Access provides two groups of data sources as seen in the example below: “Import & Link” and “Export.” Within “Import & Link”
we have “New Data Source,” “Saved Imports,” and “Linked Table Manager.”

Selecting “New Data Source” opens a drop-down which exposes 4 options: “From File,” “From Database,” “From Online
Services,” and “From Other Sources,” as seen below.
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Choosing “From File” reveals “Excel,” “HTML Document,” “XML File,” and “Text File” as data formats. “From Database”
reveals 4 database formats “Access,” “From SQL Server,” “From Azure Database,” “dBase File.” “From Online Services”
represents “SharePoint List” and “Data Services” and “From Other Sources” yields “ODBC Database” and “Outlook Folder.”

It is obvious that Access has rich capabilities by virtue of its many options in which to process external data.

https://assessments.lumenlearning.co...essments/18779

Exporting Data

Exporting data from Access is a fairly straightforward operation. The “External Data” export group is shown below. As an
example, to export the contents of the Supplier table in the current database as a .PDF file, select “PDF or XPS.”
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Access then asks for a destination for the .PDF file.

Since most devices have an application that displays .PDF files, the exported data is populated in .PDF format as the example
below.

https://assessments.lumenlearning.co...essments/18780
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14.5: Introduction to Queries

What you’ll learn to do: Create and modify queries

Queries represent the most useful way we interact with a relational database. In this section, we will learn how to create basic and
advanced queries in order to “ask questions” of the information stored in Access. Database queries can be as simple as “show me
the top product line in XYZ territory this month” to as complex as “show me the lowest revenue stores in these five product lines in
the top producing territories”. In either case, without queries relational databases would not be very helpful in running the business.
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14.6: What Are Queries?

Define queries in Microsoft Access
Create a query

Having a database full of information is great, but it does not do the business any good if it cannot be used to make decisions. The
ability to extract information from a database so that it is useful for decision-making starts with the “query.” Simply speaking, a
query is a question being asked of the data to inform the business.

A query of a database like Access gives you the ability to bring data together in a coherent manner, whether it resides in one or
multiple tables. The query is the heart of “Business Intelligence” (BI) and the foundation of the Search. For example, a business
may wish to know where the sales of its new product are occurring by zip code; or, who the top 5 suppliers to the business are.

https://assessments.lumenlearning.co...essments/18781

Create a Query

Access provides query capability in the form of wizards to help create the query. To create a query, select “Create” from the tool
bar and then “Query Wizard.” This will open the “New Query” window where you can choose among 4 wizards.

In our example, choose “Simple Query Wizard.” This wizard gives the option of choosing the table and the field for the query.
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Let’s say that we are interested in knowing the status of Purchase Orders. Since this data is distributed across 2 tables, a query is the
ideal way to gather this information. For this query we will need to select the “Purchase Order” table and several fields contained
there as the example below.

We then need to add data from the “Purchase Orders Status” table, so we select that and the “Status” field as in the example below.
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The completed query brings together the information we requested in datasheet format and from here can be sorted, edited, resized
or otherwise revised.

https://assessments.lumenlearning.co...essments/18782
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14.7: Adding Criteria to a Query

Learning Outcomes
Add criteria to a query

More complex queries can be created in Access by using the “Database Designer.” Database Designer allows criteria to be added to
a query to include or exclude data elements to make queries more meaningful. Let’s say we want to develop a list of employees—
but limit the list to employees who are Sales Representatives.

Select “Database Designer” from the tool bar and choose the “Employees” table from the list.

Go to the “Criteria” field and enter “= Sales Representatives.” Access automatically adds the parenthesis to your entry.

Run the query and Access returns only the list of employees who have that title.

PRactice Question
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14.8: Saving Queries

Learning Outcomes
Save queries

To save a query, go to the toolbar and select “File” – Save As” and enter a name for the query to be saved.

Once the query has been saved, the query itself has been saved—not just the results. The query can now always be refreshed with
updated data in the future.

PRactice Question
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14.9: Introduction to Forms and Reports

What you’ll learn to do: Forms and Reports

Forms and reports are the primary method most business users use to interact with a relational database—forms for getting data in
and reports for presenting data out. In this section, you will learn how to create basic forms using built-in Access tools. We will
then learn how to create reports using Access wizards for users to consume data.
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14.10: Understanding Forms

Learning Outcomes
Define forms in Microsoft Access

Access gives us a window into our database data through an object called a form. Forms can be used to create user interfaces to
either enter data or to manipulate data. A ” bound” form is a form that is tied directly to a table or query and can serve as a user
interface into that data source. An “unbound” form does not directly connect to a data source, but gives the user controls that can be
used to run the database application.

Forms are important tools for usability of a database application. Users do not have to be familiar with the internal structure of the
database but instead can take advantage of a form to ensure usability—even that they are entering information correctly.

Practice Question
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Learn More
For detailed, step-by-step instructions Microsoft Access Help is an excellent resource and can be found by following this link: MS
Access Help: Understanding Forms

Contributors and Attributions
CC licensed content, Original

Understanding Forms. Authored by: Robert Danielson. Provided by: Lumen Learning. License: CC BY: Attribution

14.10: Understanding Forms is shared under a CC BY license and was authored, remixed, and/or curated by LibreTexts.

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46660?pdf
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/14%3A_Microsoft_Access_Advanced_Skills/14.10%3A_Understanding_Forms
https://assessments.lumenlearning.com/assessments/18785
https://support.office.com/en-us/article/introduction-to-forms-e8d47343-c937-44e8-a80f-b6a83a1fa3ae
https://creativecommons.org/licenses/by/4.0
https://biz.libretexts.org/Courses/Lumen_Learning/Book%3A_Computer_Applications_for_Managers_(Lumen)/14%3A_Microsoft_Access_Advanced_Skills/14.10%3A_Understanding_Forms
https://creativecommons.org/licenses/by/


14.11.1 https://biz.libretexts.org/@go/page/46661

14.11: Creating Basic Forms

Learning Outcomes
Create basic forms

Access makes it relatively easy to create a basic form.

1. Select the table or query containing the data you are interested in seeing on your form in the Navigation pane.
2. Go to the Create tab, and the Forms group and select Form.

Access will create a basic form and open it in Layout view. You should be able to see the data you selected. In Layout view, you
have some limited capabilities to make design changes to the form.

In addition to creating a basic form, Access will check to see if there are one-to-many relationships existing between the table you
selected to create the form and any other tables in the database. If so, it will add a datasheet based on the related table or query to
your basic form. For example, if you create a basic form based on the Customers table, and there is a one-to-many relationship with
the Orders table, Access will display all of the records in the Orders table that relate to the Customers table in Datasheet view.

Practice Question
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14.12: Form Controls and Views

Compare different form controls and views

There are two views in Access that can be used to modify forms and controls: Layout view and Design view.

Layout View
Using Layout view is the most comprehensive way to make changes to your form. Since the form is actually live in Layout view,
you can see the data as it will look when the form is being used. When you make changes that will affect the appearance or
usability of the form, you will see those design changes reflected on the data.

Although Layout view supports most design changes, there are a few outside its purview.

Design View
Access will inform you when you need to go to Design view to make certain changes. Design view is better for detailed aspects of
the structure of the form. In Design view, you see the Header, Detail, and Footer areas of the form. Unlike Layout view, the form is
not live in Design view, so you cannot see how the data is affected by your changes. But there are tasks that can be better
performed in Design view such as:

Adding the bound object frame, page break, and chart controls.
Editing text box control sources.
Resizing form sections.
Changing certain form properties.

https://assessments.lumenlearning.co...essments/18787

For detailed, step-by-step instructions Microsoft Access Help is an excellent resource and can be found by following this link:
MS Access Help: Form Controls
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14.13: Presenting Data on Reports

Learning Outcomes
Present data on reports

The best way to think of forms and reports is this: forms are for input and reports for output. Reports are the primary way that users
consume information. Luckily, Access wizards guide us through the process of designing reports.

In the example below, we are creating a report on inventory.

Select the fields that need to be in the report

The wizard provides several options for the display of the information, such as sorting.
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Here is the quick Inventory report for sake of example. The report has been sorted according to Product ID as was specified in the
wizard.

There is a rich set of formatting options for reports. There is also a robust “Print Preview” capability where professional-looking
touches can be added to the appearance of the report.

Practice Question
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14.14: Introduction to Analyzing Data

What you’ll learn to do: Analyze data

In this section we will explore a variety of topics that support data analysis. First, data must be “cleaned” in order to be useful. This
process is known as data transformation and Access has several features that aid in preparing data for analysis purposes. Next, we
will explore the rich set of calculations built-in to Access to be used for data analysis. Finally, we will touch on some more
complex topics: conditional analysis and subqueries—very powerful tools of relational databases to get the most of data analysis.
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14.15: Transforming Data

Learning Outcomes
Transform data

Transforming data is the process by which data is prepared for use in a database. One of the banes of a database administrator’s
existence is the need to “clean” data. Often, new data is available to be imported into a database but it is flawed in ways that make
it unusable. One example would be a dataset that includes duplicate data. Other examples of data that requires cleaning or
transformation are datasets with blank fields and concatenated strings.

Access provides some automated means of handling data transformation for duplicate records. If a dataset is suspected of
containing duplicates, select the “Create” command from the toolbar and click “Query Wizard” and select “Find Duplicates Query
Wizard,” identify the dataset in question and follow the instructions. A datasheet view will be created that shows records that
appear to be duplicates.

PRactice Question
https://assessments.lumenlearning.co...essments/18789

Dealing with impurities in datasets is a job not just for one application like MS Access. IT professionals in all disciplines are
confronted with the need for some sort of data “scrubbing” or another, and it is safe to say that there are no bullet-proof, automated
means of doing so. Using Access queries, views, and its programming language, does provide a means of identifying and
correcting faulty datasets.
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14.16: Understanding Calculations

Learning Outcomes
Discuss the use of calculations in Microsoft Access

Access has a rich set of calculations, functions, and expressions to assist in data analysis.

This library of calculations is easily opened and is fairly intuitive to use. In the example below, if the user is interested in using the
DateDiff function, Access lists the necessary arguments for that function in the top window.
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>, <<date1>>, <<date2>>, <<firstdayofweek>>, <<firstweekofyear>>)” width=”695″ height=”620″>

Practice Question
https://assessments.lumenlearning.co...essments/18790
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14.17: Using Conditional Analysis

Learning Outcomes
Use conditional analysis

In our discussion so far, getting information from Access databases has been a matter of creating queries, adding criteria and
calculations, saving the queries, and then formatting the data into reports that can be run over and over as needed. Conditional
Analysis comes into play when the basis of the analysis is in a state of flux or may otherwise need to change. Using parameter
queries in Access is a solid approach to deal with this condition.

In the example below, a query is being prepared to display data regarding Purchase Order shipped and invoice dates. A hard-coded
date is a criteria for the query.

But what if users from different departments need the flexibility to fetch this information from different time periods? Notice how
this draft query has been changed to a conditional query by bracketing user instructions in the example below.
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Now when the query is run, this dialog box would open and display the bracketed text to give the user the opportunity to enter the
desired date of the analysis.

Practice Question
https://assessments.lumenlearning.co...essments/18791
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14.18: Using Subqueries

Learning Outcomes
Use subqueries

A subquery is a query that is contained or nested within another query. The idea is to use the outcome of one query within the
execution of another query. It is analogous to asking a question of the results you have after answering another question, i.e., a
multi-part question. A plain English example of a subquery would be “show me all employees who have been with the company
more than ten years and then show me those who live in the state of Michigan.”

The actual use of a subquery requires a basic knowledge of SQL (Structured Query Language). In essence, SQL is programming
code and quite technical. Structured Query Language (SQL) is a database language designed for managing data held in a relational
database management system. SQL was initially developed by IBM in the early 1970s (Date 1986). The initial version, called
SEQUEL (Structured English Query Language), was designed to manipulate and retrieve data stored in IBM’s quasi-relational
database management system, System R. Then in the late 1970s, Relational Software Inc., which is now Oracle Corporation,
introduced the first commercially available implementation of SQL, Oracle V2 for VAX computers.

PRactice Question
https://assessments.lumenlearning.co...essments/18792

Many of the currently available relational DBMSs, such as Oracle Database, Microsoft SQL Server, MySQL, IBM DB2, IBM
Informix and Microsoft Access, use SQL. Here is an example of the SQL language being used to create a database table:

USE SW 

CREATE TABLE PROJECT 

( 

ProjectID       Int  NOT NULL IDENTITY (1000,100), 

ProjectName     Char(50) NOT NULL, 

Department      Char(35) NOT NULL, 

MaxHours        Numeric(8,2)  NOT NULL DEFAULT 100, 

StartDate       DateTime NULL, 

EndDate         DateTime NULL, 

CONSTRAINT      ASSIGNMENT_PK  PRIMARY KEY(ProjectID) 

);

Here’s an example of a subquery In Access using the Query Wizard in Design View (the subquery is written in SQL at the bottom
of the third column):
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14.19: Understanding Domain Aggregation

Learning Outcomes
Discuss domain aggregation

There are twelve aggregate functions that extract and group data from a larger data set.

DSum
DAvg
DCount
DLookup
DMin and DMax
DFirst and DLast
DStDev
DStDevP
DVar
DvarP

These functions all have the same structure:

FunctionName( “ [Field Name] “,” [Dataset Name] “, “[Criteria] “ )

FunctionName is the name of the domain aggregation function being invoked; Field Name refers to the field containing the data
in question; DataSet Name refers to the table in play; and, Criteria limits the inclusion of data per the scope necessary.

These functions can provide everything from a total of the values listed to an average of those values to the standard deviation of
the values listed. The Help menu has detailed information about the functions.

PRactice Question
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14.20: Putting It Together- Microsoft Access Advanced Skills
In this section we explored some of the advanced features of MS Access. First, we learned about external data and several methods
with which we could use the capabilities of Access to utilize it. We discovered multiple methods to both import and export data
from the Access database.

Then we explored the all-important concept of the query—how to create, modify, save, and print using Access’s tools and wizards.
Following the discussion of the query, we moved on to forms and reports. We saw the robust capabilities of Access to create forms
using multiple views and tools. Just as important, we explored Access’s capabilities to create reports using wizards to present data
in the most effective fashion. Finally, we discussed how Access could assist in the analyzing of data using powerful, built-in
functions and calculations.

Databases are the backbone of technology applications today. From social media, banking, cloud storage solutions, fantasy sport
apps, and online gaming, databases are indispensable. Even if we are not dealing with high-profile applications, most businesses
today could not run without a database system keeping track of inventory, sales, employees or other mission-critical information.
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14.21: Assignment- Create Queries for Access Database
In this assignment you’ll import and existing database of past orders from a bakery and use the skills you have learned in this
module to create a query in the data table.

To complete this assignment, download the Excel file here.  Follow the directions, then submit your assignment. If you get stuck
on a step, review this module and ask your classmates for help in the discussion forum.

1. Open a new Access database and save the new Module 14 assignment file to the Rowan folder on your desktop as
BA132_LastName_QueryDB.accdb, replacing “LastName” with your own last name. (Example: BA132_Hywater_Memo) It is
a good idea to save your work periodically.

2. Import External Data: With the Access new database open import the Excel data file into Access. 

3. Import Wizard: Set up the imported data into a new table, make sure the box with first row with column heading is checked
and let Access add the primary key, and name the table. 

[1]
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4. Create a Query: Use the Query Wizard and created a query that is a simple query and uses the ‘Product TableProduct Name’
and the ‘Quantity’ sections of the table. 

https://libretexts.org/
https://creativecommons.org/licenses/by/4.0/
https://biz.libretexts.org/@go/page/46671?pdf


14.21.3 https://biz.libretexts.org/@go/page/46671

5. Resize Columns of Query: Resize the first column to be able to read the names of all the products. 
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6. Query Design: Now create a second query, but this time from when you run the wizard button choose to ‘Modify the query

design’.
7. Add New Criteria: Now you wish just to see the number of orders that were chocolate chip cookies. Enter that in the criteria

field. 
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8. Run Query: Run the query, resize the first column and see how many orders there were for chocolate chip cookies. 

9. Run Third Query: Now, run another query but this time for “pecan” and when the results are displayed, add in an Autosum
total at the bottom and see how many pecan orders have been placed. Save this query. 
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10. Rename Queries: Rename the queries to match what is queried to better remember for what they are searching. 
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11. Save: Save the file as an Access database and make sure all the queries have been saved as well.
12. Submit the presentation file in your course online.

1. Data source: GCFLearnFree.org. Access – Designing a Simple Query.Database sample↵ 
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14.22: Discussion- Ways to Manage Access Tables
Now you have some experience with what you can do in Access. If you have seen an Access file that contained several tables and
many saved queries it may seem a bit overwhelming. What are a few ways to help manage the queries and tables as they begin to
accumulate?

While the video shows an older version of Access (MicrosoftAccess 2016), the same solutions work in other versions ofAccess,
including 2019 and 365.

Watch the video about tips for managing Access tables and ask yourself a few questions and discuss your answers to them.

A YouTube element has been excluded from this version of the text. You can view it online here: pb.libretexts.org/cafm/?p=608

You can view the transcript for “Tips for Managing Tables” here (opens in new window).

Discussion Questions
Do you think you will use the hide a table tool to keep the view manageable? If so, when and why?
Which of the different ways to rearrange tables and queries do you prefer? Why?
Would you use these tips if you had only a few tables or not? Why?

Share your opinions below and respond to two of your classmates’ thoughts.
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15.1: Why It Matters- Integration
Business needs drive collaboration, information sharing and business analysis. What that really means is that more ideas, data, and
information needs to be used in combination to bring about better interpretation and understanding of those ideas, data, and
information by people. The Microsoft suite of apps allows people to work together to move a business forward, communicate
effectively, and become increasingly more successful.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Modern Applications: The People Story for Business” here (opens in new window).

As this video mentions, the purpose of using these applications is to make business work easier between people. The purpose of
this course is to give you the skills necessary to be more comfortable with the various tools and applications in order to do your job
with ease.

At work, your to-do-list might include tasks such as ordering new products, completing purchase orders, creating sales charts, and
producing proposals and presentations. This module will draw on the lessons you have learned in those previous modules and show
you how to integrate various features from one application into another in order to finish these types of tasks.

Here is what you will be learning how to accomplish with this module:

Create a Word document with integrated Excel utilizing skills from the previous modules
Create a PowerPoint supporting presentation utilizing skills from the previous modules
Integrate a video into a PowerPoint slide
Integrate Excel and Access
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15.2: Introduction to Using Word with Excel and PowerPoint

What you’ll learn to do: Create a Word document with Excel and PowerPoint elements

Up to this point in the course, each of the computer applications has been treated as separate, standalone apps. In the world of
business however, each application can be integrated, in various ways, into the others to enhance the reporting, presenting, and
communication tasks of business on a daily basis. Integrating Word, Excel, and PowerPoint makes business communication more
effective by organizing separated information into one place for easy access and analysis.

These skills from this course to this point will now be used to see how these computer applications can be integrated to accomplish
business tasks. To accomplish this, let’s look at an example scenario.

The Rowan Retail store is about to have their annual review of their sales figures and Rosamine Ruiz has been asked to write up a
one-page report explaining the sales trends for the past three years for the store’s General Manager (GM). Rosamine has collected
all of the information she needs and is now ready to begin her report in Word. Follow her progress through the pages in this section.

There are many ways in which integration can take place in a Word document. At times new content must be created. Other times
content from other sources and documents need to be incorporated and integrated into the Word document. As Rosamine will
discover, each document can be a mix of both new and existing content. As you work more over time with Word, you will discover
additional ways to integrate many elements into one document.
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15.3: Customized Word Templates

Create a Word document with customized template.

As Rosamine creates the sales report, the first step she takes is to open the Word application and create a new document using
company templates—Rowan Retail Sales Report. She searches for the exact template and selects it by clicking on the image in the
Word window.

This is what the template for the sales report looks like. It is in newsletter form with two columns because that is the way the GM
prefers the report to be formatted.
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Rosamine wants to customize this report, so she starts to tweak it before she starts composing.

Customize Template
The first thing Rosamine decides is to change the look and feel of the template. She changes the theme by clicking on the Design
Tab then the Themes button on the far upper left. Rosamine picked the Retrospect theme, which changes the text and colors from
the golden yellow color to a red/orange theme.

Next, Rosamine removes the DRAFT watermark from the report.
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Still in the Design tab, she moves to the upper right buttons and selects the Watermark button.

1. Design Tab. Variety of possible changes for a document.
2. Watermark Button. This button inserts or removes a variety of watermarks.
3. Remove Watermark Button. Rosamine selects this and the DRAFT watermark is removed from her report.
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15.4: Excel Table in Word Document

Create a Word document with integrated Excel table.

There are a couple of ways to integrate an Excel table into a Word document.

Option 1 for Table Integration
Rosamine starts to type in her report. Along the way she decides to change the theme colors again to more of a brown color and repeats the theme change process like she did
previously. She continues writing her text and now needs to add an Excel table to her report highlighting the three different store Q2 sales numbers.

She has the second quarter sales information from another report, but doesn’t have the Excel file itself to copy into her Word document. Because she has no existing Excel file,
she creates her own table through the following steps:

1. Cursor Placement. Rosamine makes sure her cursor is placed in the area of her Word document where she wants to create the table.
2. Insert Tab. She clicks on the Insert tab to display the insert button possibilities and selects the Table button.
3. Excel Spreadsheet Option. This button creates a little Excel spreadsheet table within Rosamine’s Word document.

The Excel table is now in her Word document and ready for data to be entered. Notice how the color of the upper toolbar is displaying the Excel green and that the Home tab is
selected. This is an indicator to Rosamine to know she is now working with an Excel table. She can now begin to type in the data for the table.

Note: If at any time Rosamine clicks outside the table it will revert back to the Word document and she can double-click back on the table to open it up for data entry again.

Cell Style. AutoSum. Center. Color in Cells. Borders. Bold.
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Rosamine has entered the sales figures from the three different stores, and wants to make additional changes to the table. This is how she changes the table.

1. Cell Style. Rosamine selects and formats the column of numbers to be currency cells and to display the dollars generated from sales for the second quarter of the year.
2. AutoSum. With the bottom cell selected, Rosamine clicks the AutoSum button, which totals the three sales figures for all stores for the GM to easily see what total sales

were generated from the second quarter.
3. Center. Next, Rosamine centers the Quarter numbers by selecting the three quarter cells and clicking on the centering button.
4. Color in Cells. The table needs a contrasting color to make the titles and totals stand out. Rosamine selects the top and bottom rows, clicks on the paint bucket button, and

chooses a green color for the table.
5. Borders. To make the table look more defined in the document, Rosamine selects the entire table, then the Border button, then selects the “thick box border” to be placed

around the outside of the table.
6. Bold. The last table change Rosamine uses is to select the titles and totals rows and bold each of them to contrast with the other data.

Now the table is complete, but it still shows too many unused cells. Rosamine resizes the table by holding down the left mouse button and dragging the sides of the table to the

correct size for the report.

Her work complete, she clicks off to the right. Her Word document is ready for more text and additional data.

Option 2 for Table Integration
What if Rosamine has access to the store sales information Excel file directly? With this scenario, she can place it directly into her Word document with no need to make her
own table. Here is how Rosamine can insert an existing Excel file:

1. Word Document Open. Rosamine has the Sales Report Word document open on her computer.
2. Excel Application Open. Rosamine opens the Excel app.
3. Excel Document Open. Next, Rosamine opens the Rowan Retail_Q2_Sales_Totals file.
4. Sales Table. This is the sales table to be copied into the Word document. The next step is to copy and paste the table.

1. Select Table. With the file open, Rosamine selects the entire table (all rows and columns).
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2. Copy Table. Rosamine right-clicks with her mouse and selects the Copy function. She can also accomplish this by using the Ctrl+C keys to copy the table.

Next is getting back to the Word document. There are three ways to accomplish this:

1. One way is to simply click on the Word window and it will move forward in front of the Excel window.
2. A second way is to toggle back and forth with the keyboard by holding down the Alt key and tapping on the Tab key (Alt+Tab). This opens a small window displaying all

the apps currently running on the computer. She can continue to hold down the Alt key and click the Tab key to scroll through the options.

3. The third option is to place the two documents side-by-side on the computer screen. This typically requires resizing of the document windows.

Now that the Word document is selected, Rosamine now places the cursor where the table should be and right-clicks with her mouse. The menu appears again. She selects the
Paste Option small clipboard icon, and the table is copied into the Word document.

This is how the document looks with the Excel table pasted into the document.
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Here is an illustration of copy and pasting using the keyboard shortcut keys (Ctrl+C, Ctrl+V) where Rosamine would first select the Excel table, copy the table, then paste it

into the Word document.

Once the copied Excel table is in the Word document, it can be modified by double-clicking in the desired cell and then it can be changed however desired. It does not open a
small Excel spreadsheet as the table created within Word in Option 1 did.

The table is now set and Rosamine is ready for more text and an additional data chart.
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15.5: Excel Chart in Word Document

Create a Word document with integrated Excel chart.

There are a couple of ways to integrate an Excel chart into a Word document.

Option 1 for Chart Integration
The next piece of information needed in the report is the annual sales chart. To enter this data, Rosamine makes sure her cursor is at
the place in the report she wants the chart to go. She clicks back to the Insert tab and selects the Chart button.

The next step is to select the type of chart to use for her report. In this instance, Rosamine chooses a line chart.

1. Chart Button/Line Chart. Rosamine selects the chart button and then selects a Line chart to use in her report.
2. Chart Options. There are seven different variations for displaying a Line chart. Rosamine selects the first option.
3. OK Button. With the desired chart selected, Rosamine clicks the OK button and the chart is placed in her report.

Next, Rosamine selects the style of line chart to use and begins to enter information to create the chart itself.
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The chart will contain the total sales numbers from the last three years for each of the three retail stores. She puts the years in
Column A (purple color), the name of the stores across row 1 (pink color), and the sales figures in the rest of the cells (blue
color). Here is what her chart now looks like in the report.

Rosamine clicks on the chart title box and changes the name of the chart to Annual Total Sales. Rosamine notices that the numbers
are difficult to see, so she resizes the chart to make it easier to read.

Rosamine resizes the chart by clicking on the mid-points in the chart and dragging them to a larger size that still fits within the
document column width.
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The General Manager will now see the rise and fall of sales over the last three years in Rosamine’s report.

To finish the report, Rosamine types in the rest of the text. Next she needs to link a PowerPoint presentation file for a reference
mentioned in the report.

Option 2 for Chart Integration
What if Rosamine already had access to the Annual Total Sales chart file? She could copy and paste the chart into her document.
First she opens the Excel file with the chart in it. Since she has learned to copy and paste from the previous table, she puts the Word
and Excel windows side-by-side on her screen, then takes the following steps:

1. Select chart. Rosamine selects the chart in the Excel file by clicking once on the chart.
2. Right-click mouse. Rosamine clicks the right mouse button. She sees a menu appear and selects the Copy choice. She can also

use the Ctrl+C keys to copy the chart.
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3. Paste chart in Word document. With the desired chart copied, Rosamine moves over to her Word document and places the
curser in the correct spot and right-clicks again to bring up the menu. In the menu she selects the Paste option and the chart is
placed in the document. She can also use the Ctrl+V keys to paste the chart.

4. Resize chart. Rosamine now grabs one of the chart border area spots and moves it to the desired size in the document.

5. Change chart. If Rosamine needed to change something about the chart like the type of chart, the data in the chart, the labels,
and so on, she can right-click on the chart itself, and a menu will appear that allows her to change aspects of that chart. Any
changes made will not affect the original Excel file chart.
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If Rosamine wanted to use the copy and paste keyboard shortcut it would be exactly like the copy and paste from the table example
and look like this:

To finish the report, Rosamine types in the rest of the text. Next, she needs to link a PowerPoint presentation file for a reference
mentioned in the report.
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15.6: PowerPoint in Word Document

Learning Outcomes
Create a Word document with inserted PowerPoint hyperlink.

You can link to a PowerPoint document with a hyperlink in a Word document. The example with Rosamine’s document continues
on this page.

Once again Rosamine returns to the Insert tab and selects the link button. Towards the bottom of the dropdown menu, she selects
Insert Link and then finds the correct PowerPoint file location and adds that to the window.

Now when the GM hovers over the hyperlinked file, the location and file name will be displayed and can be clicked on to open that
third-quarter sales promotions presentation for more information.
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15.7: Introduction to Using PowerPoint with Excel

What you’ll learn to do: Use Excel elements in PowerPoint

PowerPoint is the primary computer application used for business presentations. Knowing how to integrate a variety of charts,
images, clip art, and so on is important to fill out a presentation and have it efficiently communicate to your desired audience.
Elsewhere in this module, a Word document was modified and integrated with other computer applications. This section focuses on
integration within PowerPoint.

PowerPoint integration skills will assist you to powerfully communicate whatever business information you are trying to get
across. To accomplish this, let’s look at an example scenario in which PowerPoint integration is helpful.

Rowan Retail is planning to increase store sales in all three of its branches in the third quarter of this year. In order to coordinate the
sales campaign, Cameron is creating the sales campaign presentation for the company’s next regional meeting. He has all the
information he needs and is ready to create his sales presentation.

As Cameron will discover, each presentation can be a mix of both new and existing content. There are many ways to incorporate a
variety of things into PowerPoint. Frequently creating and editing a presentation is a back-and-forth process. Presentations must not
only be filled with appropriate information, but also must be visually dynamic for an audience.

Over time, your experience with PowerPoint with increase and you will discover other ways to integrate things into your
presentations. They can be live, recorded, timed, and easily emailed to interested parties, so good PowerPoint skills is essential to
business.
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15.8: Excel Table in PowerPoint

Create PowerPoint slide with integrated Excel table.

Cameron has an Excel file with a pertinent table for the sales presentation. He selects slide 3, types in a slide title, and then follows
these steps to insert the Excel table into PowerPoint.

Option 1 for Table Integration
In the text box, Cameron hovers over the icons in the middle and clicks on the Insert Table icon.

He doesn’t have an Excel table in a file to copy into his PowerPoint presentation, so he creates one through the following steps:

1. Insert Table Box. This box appears where Cameron decides the size of his table.
2. Number of Columns. Clicks the down arrow until the number is 4 columns.
3. Number of Rows. Clicks the up arrow until the number is 6 rows.
4. OK Button. This button creates a little Excel table within Cameron’s PowerPoint presentation slide.

The Excel table is now in his PowerPoint presentation and ready for data to be entered. Cameron now enters his information into
the table.
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Note: If at any time Cameron wants to change the color of the table he can click on the Table styles in the bar above.

Cameron types in the sales figures from the three different stores, and wants to make additional changes. He has already bolded the
title rows (using the Bold button in the Home Tab), but the type is difficult to read from a distance.

1. He selects the table title.
2. He right-clicks to bring up the font size and selects size 40.
3. He selects the remaining rows and uses the upper font bar to change the font size to 20pt.
4. He decides to change the title by clicking within the title box, then typing in a new title.

Cameron steps back and looks at the table. He notices the table is not centered on the slide, so he clicks on the table and moves his
cursor to the edge of the table until he sees the four arrow symbol.  He drags the whole table to the center of the slide.
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He now makes a note under the table by clicking on the Insert tab and the Text Box button.

He puts his cursor under the table and begins to type his note into the slide. This step is now complete.

Cameron reads through the slide to make sure it is clear and decides to change the table title. He clicks in the table title and retypes
the words to say “Q3 Campaign.” Now the slide is complete, and he is ready for another slide.
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Option 2 for Table Integration

What if Cameron has an existing sales campaign Excel table he can use? With this scenario, he copies it directly into his
PowerPoint presentation so there’s no need to make his own table. Here is how Cameron inserts an existing Excel file table:

1. Open Excel application. Cameron has the RR Sales Campaign Excel file open on his computer.
2. Select the table. Cameron selects the entire table and clicks with the right mouse button.
3. Copy the Excel table. Next, Cameron opens the selects the Copy function. Cameron can also use the Ctrl+C keys to copy the

table.
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1. Select PowerPoint. Cameron clicks on the PowerPoint window to bring it forward (he could also toggle Alt+Tab if the
window is behind the Excel window).

2. Select table area. Cameron clicks with the right mouse button in the Table box.
3. Paste Excel table. Cameron selects the Paste function in the menu and the table is placed in the slide (He can also use the

Ctrl+V keys to paste in the table).

He can now resize, move, center, bold, add the text note, and change the font of the table like in the Option 1 example to optimally
display the table on the slide. The table slide is now set, and Cameron is ready for an additional slide with a chart indicating the
campaign funding divisions between stores.

https://assessments.lumenlearning.co...essments/18818
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15.9: Excel Chart in PowerPoint

Create PowerPoint slide with integrated Excel chart.

Option 1 for Chart Integration
The next slide in the presentation is the budget distribution chart. Cameron will create a chart from scratch in a new slide. He opens
the New Slide options and selects Content with Caption, then types in the title in the box. He moves the cursor over the large box
and clicks on the Insert Chart icon and decides on the type of chart.

For this slide, he selects a 3-D Pie chart. A small Excel spreadsheet pops up above the pie chart for Cameron to enter the data for
the chart.
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Cameron begins to type in the data by double-clicking on a cell and replacing the text or numbers in it. He changes the numbers
cells to percentages. There is an extra row he doesn’t need, so he selects it, right-clicks, and selects the Delete Row from the menu.
Cameron now clicks the X in the small window and closes it.
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Cameron decides to show the budget present age on the chart and needs to modify a few other aspects about the chart to make it
easier to see.

He takes the following steps:

1. Chart Elements Button. This + button allows Cameron to change aspects of the chart.
2. Elements List. Cameron clicks the Data Labels box to change the labels.
3. Arrow Button. Cameron clicks the small right arrow, and a new menu appears.
4. Data Label List. Cameron moves the chart numbers to the center of their respective areas.

Next, Cameron changes the area numbers to percentages and increases the font size of the chart text and the Store label sizes.
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The chart is now too close to the store labels. Cameron clicks on the chart and hovers over the border until the four-arrow cursor
appears. He drags the chart up, closer to the title. This centers the chart and makes it easier to read the labels.

Option 2 for Chart Integration

What if Cameron had an existing sales budget chart? He could copy and paste the chart into his presentation. First he opens the
Excel file with the chart in it. Since he has learned to copy and paste from the previous table, he puts the PowerPoint and Excel
windows side by side then takes the following steps:
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1. Select Excel. Cameron makes sure Excel is the current window and opens the chart file.
2. Select Chart. Cameron selects the chart in the Excel file by right-clicking on the chart.
3. Select Copy. Cameron sees a menu appear and selects the Copy choice. He can also use Ctrl+C to copy the chart.

https://assessments.lumenlearning.co...essments/18742

4. PowerPoint Presentation Paste Chart. With the desired chart copied, Cameron moves over to his PowerPoint presentation
and places the curser in the correct spot and right-clicks again to bring up the menu. In the menu he selects the Paste option and
the chart is placed in the presentation. He can also use the Ctrl+V keys to paste the chart.

5. Resize Chart. Cameron now grabs one of the chart border area spots and moves it to the desired size in the presentation.
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6. Change Chart. If Cameron needs to change something about the chart, such as the type of chart, the data in the chart, the
labels, and so on, he can right-click on the chart itself. A menu will appear that allows him to change aspects of that chart. Any
changes made will not affect the original Excel file chart.
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15.10: Introduction to Integrating Access

What you’ll learn to do: Use Access elements in other Microsoft Office products

Now that we’ve seen how Word, Excel, and PowerPoint integrate with one another, let’s take a look at how Access can be used
with other Microsoft Office products.
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15.11: Access and Mail Merge

Learning Outcomes
Create Word mail merge file from Access Data

Microsoft makes it easy to use data from one program and integrate it into another. One of the best ways to use Access with Word
is in a mail merge. Here is how to have Access and Word work together to create mail merged letters to go out to customers.

PRactice Question

https://assessments.lumenlearning.co...essments/18794

1. The first step is to open the customer contact database in Access you wish to use in the mail merger.
2. Open Access, and you will see the list of available sources in the navigation pane on the left, if not press F11 and the left

navigation pane opens showing the contact table. Double click to open it. 

3. Look through the table or query to identify the addresses to use in the mail merge for Word.

1. If the addresses are saved in various tables, first create a simple select query with the fields needed, then select the query for
the mail merge.

2. Make sure to check the data for errors or missing cells and correct it before starting the mail merge.
4. Select the External Data tab, and in the Export group select the Word Merge button. 
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5. A Word Mail Merge Wizard window then opens. 

6. Decide if the wizard should like the address data into a new blank Word document or into an existing document. Select the
option and click OK. For this example, we’ll create a new document.
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7. A Word documents opens, and the Mailings tab and Mail Merge pane are now open. 

8. In the mail merge pane at the bottom are the wizard steps to walk through using the Next or Previous links. In Step 2 you can
choose to compose your own letter or to pick from various templates. We’ll choose a template and then update it. Click the link
to move to the next step. 
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9. In Step 3, select the Access contact file. Select the Browse link under Use an existing list area and select the Access file.

10. If you need to edit the list select the Edit recipient list and sort, apply filters, find duplicates, remove contacts, etc. in the open
dialog box. In this case we’ll use all the contacts for the merge. 

11. Now is the time to in the Word document to edit the letter, select the area for the address data to appear and select the Address
block, Greeting line, etc. in the right side Mail Merge wizard menu and it inserts the Access data into the document. 

a. Besides using the Wizard, you can format each merging area from the Mailings tab, Write & Insert Fields group in the
ribbon.
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b. Select the style of greeting, the formality or informality or other options in the dialog boxes for each merge field. 

12. The wizard’s step 5 allows you to preview the merged data in the document before you print it. Even in this stage you may have
forgotten to add a space between the first and last name, too much space in the address field, or other errors. Now is the time to
correct them.
a. Use the Preview your letters area to arrow through the recipients and double check for errors.
b. If you decide at this point to exclude one or a few of the recipients click the Exclude this recipient button or click the Edit

recipient list link. 

13. Step 5 completes the merge and Step 6 of the wizard is where you Pint the merged document. There is an option at this step to
change individual letters by selecting the Edit individual letters link which generates all the letters in one Word file so you can
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edit. 

14. The last step is to save the new mail merged document for later printing or to send to someone else to print and send these
letters.

PRactice Question
https://assessments.lumenlearning.co...essments/18795

Now that you have walked through the steps of merging and Access table into a Word mail merge letters here is a six minute video
to watch and see the entire process to reinforce the steps.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Mail Merge Microsoft Access Data into Microsoft Word Documents” here (opens in
new window).
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15.12: Excel Table from Access Data

Create Excel table from Access Data

There are times when Access contains data you want to analyze in an Excel spreadsheet. This export may take place once or more
frequently depending on the situation. For example, let’s say at work you have a monthly report for your department head which
pulls monthly customer contact data from Access into an Excel table. Although Access can create reports, your department
manager is more comfortable with Excel and wants the data reported in that program. We’ll walk through setting this scenario up
and show you the integration capabilities of Access.

Exporting Data to Excel
Open the Access file to be exported and follow these steps to export the customer contact information into Excel.

Step 1

Before exporting data from Access look through the data to identify any errors (e.g. #Error, #Num!, #Name?, etc.). Fix any errors
—otherwise errors might multiply as incorrect information may be placed in incorrect Excel cells in a worksheet. Now that the data
is ready go to the next step.

Step 2

Select the External Data tab, Excel button and an Export – Excel Spreadsheet command window opens.

Step 3

Fill out the information asked for in the window:

a. File name: name for the exported excel file.
b. File format: older Excel versions are available as well as the current *.xlsx extension default.
c. Specify export options: Decide whether to export the data format and layout or not.
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i. If exporting the format, the next box/choice becomes available whether to open the destination file after the export is
complete or not.

d. Click the OK button.

How should you determine whether to export data with or without formatting?

With Formatting: Exporting a table or query with formatting allows the export wizard to use the format property settings,
have hyperlink fields exported as hyperlinks and have it use the format settings. With rich text fields text is exported
without formatting.
Without Formatting: Exporting a table or query without format means all records and fields are exported with formatting
ignored. Only lookup ID values are exported, and hyperlinks are exported as regular text.

Step 4

One more window opens indicating the export is successful and asks if these same export steps should be saved. This option is used
if you are frequently exporting this same data often. In this case we leave the box unchecked.

Note: To Format or Not To Format?
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Step 5

Choose the Excel workbook and file format. If you selected the open the file when done exporting an Excel worksheet will open
with the exported Access data. Now you can use the data to do anything in Excel you wish to do.
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This example was using contact information data in Access, but all kinds of data can be exported from Access to Excel. If an error
slipped through, you can either fix it in Excel or return to Access and fix the error there and re-export the data into an Excel
worksheet.

What is and isn’t possible to export to Excel:

There are a few types that can be exported to Excel; forms, tables, reports, queries or even a few selected records from a
datasheet.
Things that cannot be exported to Excel are modules or macros and if there are subreports, subdatasheet or subforum in the
data they are not exported and must repeat the export for each of them if you want them exported to Excel.
Only one database object can be exported in a single export, but multiple worksheets can be merged in Excel to cobble
together one table or report from the individual exports.

Now that you have walked through exporting a table from Access to Excel, watch this short video to see additional ways to export
tables, queries and reports from Access to Excel.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “Exporting Tables, Queries and Reports” here (opens in new window).
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15.13: Access Data from Excel Table

Learning Outcomes
Create Access data table from Excel data

There are scenarios where data has been created or stored in Excel and now needs to be added into an Access database. As an
example, say that the original company accountant only knew how to create Excel spreadsheets. Now, however all company
accounting information needs to be in an Access database. How would you do this?

We’ll walk through importing data from Excel into Access so follow these steps.

1. Open the Excel workbook and look through the data to:
a. Clean up the data if there are errors or gaps in the data fields.
b. Use the Data Tools group, Remove Duplicates button to eliminate any potential make duplicate information that may being

exported.
c. Check to see that columns have headings and are consistent data types (e.g. all currency, percentage, etc.) and correct if

necessary. 

2. Save and close the Excel worksheet and open Access.
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3. In the External Data tab, click the New Data Source button, From File, Excel option. 

4. The Get External Data – Excel Spreadsheet window opens. Find the excel file you wish to import into Access using the Browse
button.

5. Next is deciding where to store the imported data. The three options are:
a. A new table in current database,
b. Appending a copy of the records in an existing table, or
c. Linking to the data source by creating a linked table.
d. For this example choose to create a new table. 
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6. The Import Spreadsheet Wizard is now opened, and the Excel table is displayed. Make sure the checkbox for First Row
Contains Column Headings if that is the case. Click the Next button. 

7. The next wizard window allows you to be specific about the field information being imported by modifying the field
information in the Field Options area. For our purposes the defaults work. 

8. The next wizard window allows you to define a primary key for the new table. Primary keys uniquely identify every record in a
table to be able to return data quickly. For this example, we’ll let Access add the primary key. 
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9. Access is now ready to import the Excel file. There is a checkbox to select if you would like the table to be analyzed after the
data is imported. It will remain unchecked for this example. Now click the Finish button. 

10. Access now asks if you would like so save these import steps just walked through. If so, click the Save import steps checkbox.
We’ll leave it unchecked for now. 
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11. The Excel information is now imported into Access and can now be use in Access or even added to as more Excel information
is discovered.

Practice Questions

https://assessments.lumenlearning.co...essments/18798

https://assessments.lumenlearning.co...essments/18799
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Now that you’ve seen how to import Excel data into a new Access table, watch this video that walks through the steps and
demonstrates how to add Excel data to an existing Access table. While the video shows an older version of Word (Microsoft Word
2016), the same steps work in other versions of Word, including 2019 and 365.

A link to an interactive elements can be found at the bottom of this page.

You can also view a transcript for the video “How to Import Excel Data into Access” here (opens in new window).
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15.14: Putting It Together- Integration
With a few skills and tools learned from this module, you can now create and insert multiple types of charts, tables, hyperlinks,
videos, pictures, and icons into whatever Microsoft computer application you use. At the beginning of this module, the video talked
about the real goal of learning all of this information, working with what you and other people create to accomplish your tasks and
goals.

The variety of scenarios used throughout this module illustrated how you can use these integration skills at work. You can now
utilize these skills for school or personal projects as well. Communication with coworkers, management, and others, will now be
more easily accomplished through application integration skills. Here are a few instances that can call on those skills.

1. You want to break up the long presentation to your work team—add in a video.
2. Your boss asks for the latest financial information tables in your report—integrate an Excel table into your Word document.
3. You want to record a few types of resources in your Excel spreadsheet for future reference—add in hyperlinks to websites.
4. You want to send letters to a large amount of people—use your Access database to do a mail merge in Word.
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15.15: Assignment- Create Mail Merge Letters
For this assignment, you will create a Word document that is mail merged with an Access customer contact table. Mail Merge can
be used to create bulk labels, letters, envelopes, and emails. You will be creating letters to send with the newsletter you previously
edited. Follow the directions below, then submit your assignment. If you get stuck on a step, review this module and ask your
classmates for help in the discussion forum.

You have been tasked with mailing the newsletter you previously created to customers of Rowan Retail. In order to accomplish this
task, you need to merge the customer contact information in the Access file with a Word document in order to make mailing labels.
Follow these steps to accomplish the task.

1. The first step is to download the customer contact Access file and save it to the Rowan folder on your desktop.
2. Open Word and create a new document by clicking on the Blank document option in the window.
3. Save the document by using Save As and rename the document to BA132_LastName_MailMerge.docx, replacing

“LastName” with your own last name. (Example: BA132_Hywater_MailMerge)
4. Begin Mail Merge: Select the Mailings tab and use the Step-by-Step Mail Merge Wizard for this mail merge letter. 

5. Wizard: Walk through the wizard and click the Next: Starting document link leaving the selection of document type to ‘Letters’. 
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6. Create letter: Leave the document type to ‘Use the current document‘ and click the Next: Select recipients link. 

7. Contact List: You already have a file with a contact list. Leave the selection ‘Use an existing list’ selected and click on the
Browse link. 

8. Insert File: Find where you saved the Rowan Retail Customer Contact Info.accdb file and use this for the mail merge contacts
file. 
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9. Prepare contact file: Find Richard Castle and Britney Spears and uncheck their boxes. Go to the Next: Write your letter link
step. 

10. Compose the letter: Decide where to place your cursor in the document for adding in an address and use the Address Block
option from the wizard or the ribbon button, to select the naming style. 
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11. Decide Greeting: Decide where you would like the greeting to be in the letter. Select the Greeting line from the wizard or the
ribbon button and decide the style of greeting. 

12. Paste the following text to serve as the body of your letter. Enclosed is the quarterly newsletter for Rowan
Retail. Please enjoy the information therein and pay special attention to the dates for the special
sales this summer. If you have any questions or concerns, please contact us as soon as possible.
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13. Finish Letter: Close the letter with ‘Sincerely’ and then your name. Save your work and click Next: Preview your letters.

14. Check Letters: Scroll through the letters by clicking on the arrows. Britney Spears and Richard Castle should be missing in the
recipients. 

15. Complete the Merge: Once the merge is completed, click on Edit individual letters… if you need to make any changes to just
a few letters. 
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16. For this assignment don’t make any edits to individual letters and continue to the final step.
17. Optional Task: To double check the letters you can print them out. Make sure ‘All’ records are selected to make sure all print or

select specific ones if you want to print a few. 

18. Your merge mail file is now complete! Save your file once more, this time as a PDF (use the .pdf file extension), and submit the
PDF in your course online.
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15.16: Discussion- Audio Integration
In this module, we discussed integrating charts, tables, hyperlinks, and videos into Microsoft Word, Excel, PowerPoint and
importing external data into Access. These objects were found in both external (internet) and internal (within existing files)
sources. PowerPoint has audio options that can be integrated into slides. Like videos, audio can be uploaded from external sources,
trimmed, and edited.

Audio options can be integrated into PowerPoint from the Insert tab by uploading an audio file from your computer.

There are a variety of options available for audio, which you can see in the Audio Tools>Playback tab ribbon. Like video, audio
can be timed or started with a mouse click. You can play the audio across all slides, run it on a loop until stopped, or fade it in or
out.
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Discussion Questions
In what situations would this feature be useful?
Could you see yourself using this in PowerPoint? Word? Excel? Access? Why or why not?
What should you be aware of with audio?

Share your opinions below and respond to two of your classmates’ thoughts.
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CHAPTER OVERVIEW

16: Resources- Capstone Assignment
16.1: Assignment- Create Capstone Presentation
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16.1: Assignment- Create Capstone Presentation
You are now ready for your final capstone assignment. For this assignment you will need to download four files: one each for
Word, Excel, PowerPoint, and Access. In this scenario, you have been asked to give a presentation on the new RowanGo app. You
will create the presentation and a document, integrating Excel and Access in each and using tools covered throughout the course.

Follow the directions, then submit your assignment. If you get stuck on a step, review the modules in this course and ask your
classmates for help in the discussion forum.

Part 1: PowerPoint presentation
1. Download the PowerPoint presentation and Word document as well as the Access database and Excel table that you will

integrate into both documents. Save all four files to the Rowan folder on your desktop.
2. Open the PowerPoint presentation. Save it to the Rowan folder on your desktop as BA132_LastName_Capstone.pptx,

replacing “LastName” with your own last name. (Example: BA132_Hywater_Capstone) It is a good idea to save your work
periodically.

3. Here is what the final presentation should contain:
Five total slides
New theme from original one
Excel chart from file (the formatting may or may not change between Excel and PowerPoint and it is completely fine, just
make it legible in the slide.)
Access abbreviated contact table from file.
Word document file first paragraph on left side, and any image of a hand holding a smartphone from internet on right side in
slide.
Embed video from https://www.youtube.com/watch?v=N_ZlMNCl9UQ
Add transitions to slides

4. Here is an example of what the final version may look like. Use your own theme, style, colors and make sure to remember to
make it readable from a distance for a presentation. This is an example of what yours may look like: 
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5. Once you are done save your work. Congratulations, you are now done with Part 1!

Part 2: Word document
1. Open the Word document you downloaded in Part 1. Save it to the Rowan folder on your desktop as

BA132_LastName_Capstone.docx, replacing “LastName” with your own last name. (Example: BA132_Hywater_Memo) It is
a good idea to save your work periodically.

2. Here is what the final presentation should contain:
No watermark.
Easy to tell document has a new theme.
Excel table and chart centered.
Below the chart the words: You can review the presentation here and contact information examples here. Each ‘here’ links
to the PowerPoint presentation file and the Access customer contact file respectively.

3. Here is an example of what the final version may look like. Use your own theme, style, colors and make sure to remember to
make it readable. This is an example of what yours may look like: 
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4. Once you are done save your work. Congratulations, you are now done with Part 2!
5. Save your work and submit both your PowerPoint presentation and Word document in your course online.
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17.1: PowerPoint Presentations
Template:HideTOC
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�
ComputerApps_14_MicrosoftAccessAdva
nced.pptx
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